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1 General safety instructions 

Ensure that you read and understand all instructions. Failure to follow all the instructions listed below may 

result in electric shock, fire and/or serious personal injury. All locally legislated safety regulations with 

regard to installation, operation and maintenance must be adhered to at all times. Refer installation and 

servicing to qualified personnel only. 

1.1 Work area 

Keep the work area clear and well illuminated. Cluttered benches and unlit areas invite accidents. 

Do not operate power tools in explosive atmospheres, such as in the presence of flammable liquids, gases, or 

dust. Power tools create sparks, which may ignite dust or fumes. 

Keep bystanders, children, and visitors at a safe distance while operating a power tool. Distractions may 

cause you to lose control.  

1.2 Electrical safety 

Earthed tools must be plugged into a socket that has been properly installed and earthed according to 

appropriate regulations. Never remove the earth pin or modify the plug in any way. Do not use any adapter 

plugs. Check with a qualified electrician if you are in any doubt as to whether the outlet is properly earthed. 

Should the tools suffer electronic malfunction or breakdown, the earth provides a low resistance path to 

carry electricity away from the user. Applicable only to Class I (earthed) tools. 

 
This apparatus must be earthed. 

 

A Power Focus (PF) cannot be fitted with a galvanic isolated voltage as this would inhibit the function of 

the Ground Fault Interrupter (GFI). The test button on the GFI also activates the GFI in instances where a 

PF is equipped with an isolated transformer. Test the earth fault protector by pressing the test button located 

on the rear panel of PF. 

Test the earth protector every month by pressing the test button. Should the earth fault protector disconnect 

the system, be sure to find the primary reason before you resume operation. 

Avoid physical contact with grounded surfaces such as pipes, radiators, ovens and refrigerators. There is an 
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increased risk of electric shock if your body is grounded. 

Do not expose power tools to rain or wet conditions. Water entering a power tool will increase the risk of 

electric shock. This instruction does not apply to tools classified as watertight or splash proof. 

For minimum electrical interference, locate the controller as far as possible from sources of electrical noise, 

e.g. arc welding equipment etc. 

Do not abuse the power lead. Never use the power lead to carry the tool or to pull the plug from a socket. 

Keep the power lead away from heat, oil, sharp edges or moving parts. Replace damaged leads immediately. 

Damaged leads increase the risk of electric shock. 

1.3 Personal safety 

Stay alert, watch what you are doing and use common sense when operating a power tool. Do not use a tool 

while tired or under the influence of drugs, alcohol, or medication. A momentary lapse in concentration 

whilst operating power tools may result in serious personal injury. 

Dress properly. Do not wear loose clothing or jewelry. Tie long hair back. Keep your hair, clothing, and 

gloves away from moving parts. Loose clothes, jewelry, or long hair can become caught in moving parts. 

Avoid accidental starting. Ensure switches are in the off position before plugging in. Carrying a tool with 

your finger on the switch or plugging in a tool that has the switch set to “On” is inviting an accident. 

Remove adjusting keys or switches before turning the tool on. A wrench or a key that is left attached to a 

rotating part of the tool could lead to personal injury. 

Do not overreach. Keep proper footing and balance at all times. Proper footing and balance enables better 

control of the tool in unexpected situations. 

Use clamps or other practical means to secure and support the work piece to a stable platform. Holding the 

work by hand or against your body is unstable and may lead to loss of control. 

Do not force the tool. Use the correct Atlas Copco Tensor tool for your application. The correct tool will do 

the Job better and more safely in a manner for which it was designed. 

Do not use a tool if the switch does not work. Any tool that cannot be controlled by the switch is dangerous 

and must be repaired. 

Disconnect the plug from the power source before making any adjustments, changing accessories, or storing 

the tool. Such preventive safety measures reduce the risk of the tool starting accidentally. The mains plug is 

considered to be a disconnecting device. Disconnect the tool from the mains by removing the plug from the 

socket in order to cut the power. 

Store tools out of the reach of children and other untrained persons when not in use. Tools are dangerous in 
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the hands of untrained users. 

Check for misalignment, obstruction of moving parts, damage, and any other condition that may affect tool 

operation. If damaged, have the tool serviced before using. Poorly maintained tools cause many accidents. 

Only use accessories that are recommended by the manufacturer for your model. Accessories that may be 

suitable for one tool may become hazardous when used on another tool. 

1.4  Service 

Tools should only be serviced by qualified repair personnel. Service or maintenance performed by 

unqualified personnel could expose users to serious personal injury. 

When servicing a tool, only use original replacement parts. Use of unauthorized parts or failure to follow 

maintenance instructions may lead to electric shock or personal injury. 

Always refer to the Product Information for PF4000 (9836 3113 00) and Product Information for PF3000 (9836 2156 

01) for spare parts and instructions, and Atlas Copco spare part list for the tool used. 

 
There is a risk of explosion if batteries are incorrectly replaced. Replace only with the same 

or equivalent type recommended by the equipment manufacturer. Discard used batteries in 

accordance with the manufacturer's instructions. 
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2 Introduction 
This manual describes the Power Focus (PF) controller and how to configure it using ToolsTalk PF.   

 The first sections describe PF with hardware and software accessories, how to connect, and the user 

interface. 

 The main part of the user guide describes how to use the ToolsTalk PF software to configure PF. 

 The last part of the user guide lists the parameters and event codes used in PF. 

2.1 Revision history 
Apart from editorial updates, this manual has been revised as follows. 

 Updates to reflect functional changes: Contact Atlas Copco for a release description for the current 

release. 

2.2 Abbreviations 

 

Abbreviation Description 

R  
The center line  

X  The mean 

X  
The mean of the average 

<= => Arrow (button) 

 Sigma (standard deviation) 

α Alpha (often a symbol for angle) 

µ Mu (the values of the mean) 

% Percent 

A Ampere 

AC Alternating Current 

ACK Acknowledged 

Admin Administration 

Ang con Angle control 

Ang mon Angle monitoring 

bits/s Bits per second 

Abbreviation Description 

CAN Controller Area Network 

CC Control Card 

CCW Counter-Clockwise 

CD Compact Disc 

Ch Channel 

CL Clear (button) 

Config Configuration 

CW Clockwise 

DC Direct Current 

Deg Degrees 

Deg C Degrees centigrade 

DigIn Digital Input 

DigOut Digital Output (relay) 

DSP Digital Signal Processor 

ft.lb Foot-pound 

GFI Ground Fault Interrupter 

HW Hardware 



Introduction 

16 (428) 9836 3123 01 

Abbreviation Description 

Hz Hertz (unit of frequency) 

I/O Input/Output 

ID Identification 

in.lb Inch-pound 

IR Infra-Red 

IRC Industrial Radio Communication 

kpm Kilo pound meter 

LCD Liquid Crystal Display 

LED Light Emitting Diode 

LCK Tool Locked 

LCL Lower Control Limit 

MC Motor Card 

ms millisecond 

n Number (of values) 

Nm Newton meter 

No. Number 

NOK Not approved (tightenings) 

nxOK Number of approved (tightenings) 

OK Approved (tightenings) 

PF Power Focus 

PFNR Power Focus Not Ready (PF not ready) 

PLC Programmable Logic Controller 

PROG Program (button) 

Pset Parameter set 

PVT Prevailing Torque 

Abbreviation Description 

R chart Range chart 

RAM Random Access Memory 

RAS Remote Access Server 

RBU Rapid Backup Memory 

rpm Revolutions per minute 

RS232 Serial communication link 

S4/S7/S9 Motor sizes in Tensor S tools 

sec second 

SPC Statistic Parameter Control 

STAT Statistic (button) 

SW Software 

TNR Tool not ready 

Tq Torque 

Tq con Torque control 

Tq mon Torque monitoring 

TTPF Tools Talk Power Focus (SW) 

UCL Upper Control Limit 

UTL Upper Tolerance Limit 

V Volt 

VIN Vehicle Identification Number 

X-bar The mean 

X-bar-bar The average of means 

z subgroup size, group size 
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3 Introduction to Power Focus 
Power Focus is the latest generation of control and monitoring systems for advanced tightening 

technology. The system is designed for the modern assembly industry with high demands and stringent 

quality and efficiency requirements, and offers full modularity through the combination of hardware and 

software. 

This section includes an overview of the system, and a brief description of the options and accessories. For 

more information about the available system parts and their functionality, contact your Atlas Copco 

representative and consult the relevant user guide or catalog. 

 

 

 
This manual handles the ToolsTalk PF but is also applicable for Power Focus Graph. When 

programming on a Power Focus Graph display, we refer to the corresponding section in 

ToolsTalk PF. 
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3.1 PF 4000 
PF 4000 is a new generation of control systems suitable for most Tensor tools. Unlike its predecessor, 

PF 3100, PF 4000 is available in one model with two versions (Compact and Graph) that can handle all 

torque levels.  

Advanced control functions built into Power Focus 4000 prevent the operator from deviating from the 

required process. When it receives assembly information, the programmed Job function automatically 

selects the correct tightening sequence and parameters. When combined with barcode scanning for 

component identification, the Job function offers traceable, zero-fault process control. 

The controller is equipped with a USB connector for laptop access. It is located on the front of the unit for 

maximum accessibility. Communication is also possible over serial RS232, Ethernet TCP/IP and various 

fieldbus types. 

PF 4000 Graph has an easy-to-read LCD color display. 

Statistical data is collected, analyzed and presented on the 

screen. Changes and trends in the assembly process are 

indicated by diagnostics and statistical alarms, such as SPC 

monitor charts and capability (Cpk) alarms. Alpha-numeric 

keys allow on-unit setup and easy checking of traces and 

statistics. PF 4000 Graph model has a very compact design, 

and a standardized mounting plate ensures easy installation 

at every workstation. 

Completing the range, PF 4000 Compact has a basic operator 

interface with six-button keyboard and LED display. Pre-

programmed using ToolsTalk PF and with a PC as the 

interface, it offers the same functionality as the Graph 

model. 

 

  

PF 4000 Compact PF 4000 Graph 

 
For technical data, dimensions drawings, connections and spare parts list,  

see Product Information for PF4000 (9836 3113 00)  
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3.2 PF 3000/3100/3102 

The PF 3000 is a control system for Atlas Copco Tensor S and DS tools. PF 3100 is a control system for 

Atlas Copco Tensor ST tools (including functionality for S and DS tools). PF 3102 is the control system 

for Atlas Copco Tensor SL tools. 

 
Tensor STB tools require a communication kit to work with Power Focus 3100. The kit 

consists of a serial port adapter (access point); cable connector (supplies the serial port 

adapter with power).  
 

Two different hardware units are available, Graph and Compact. 

PF 3000 Compact offers minimum hardware expenditure and is easily stackable for multiple tool 

configurations. PF 3000 Graph models offer full stand-alone programming via an integrated keyboard and 

large display located on the front panel of the unit. PF Graph can also be used as a terminal for one or 

more PF Compact controllers. 

  

PF 3000 Compact PF 3000 Graph 

 

 
For technical data, dimensions drawings, connections and spare part list, see Product 

Information for PF3000 (9836 2156 01). 

For PF 3102 controllers (SL tool drivers) only the Compact model is available. 
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3.3 RBU 

RBU (Rapid Backup Unit) unlocks a specified level of functionality and acts as a back-

up unit for the configuration of PF. There are different types of RBU; Gold, Silver, 

Bronze, X (for ETX tool functionality) and DS (for Tensor DS tool functionality). The 

RBU Gold unlocks the full capacity and functionality of the Power Focus. Combine the 

RBU giving the required functionality with the chosen hardware. 

For a list of the current RBU functionality, contact your Atlas Copco representative.  

When an RBU is plugged in to an empty PF, the RBU configuration is transferred to the controller. This 

allows the quick installation and replacement of controllers on the assembly line. 

3.4 ToolsTalk PF 

ToolsTalk PF, a PC software package developed by Atlas Copco, offers easy and user-friendly 

programming and real time monitoring of Power Focus units. ToolsTalk PF is based on extensive 

experience and thorough analysis of existing manufacturing industry needs. 

ToolsTalk PF can be installed on standard PCs running Windows XP, Windows 7 (32-bit), or Windows 7 

(64-bit) 
1
 and communicates with PF via the serial port or via Ethernet TCP/IP. The real time monitoring 

functions include access to Cpk, Traces, Operator monitor, etc. 

3.5 Communication 

Built-in communication provides efficient use of modern communication technologies with Atlas Copco 

products. The Power Focus system can be built to suit the user’s needs, from a simple system offering 

many functions, to a complete factory system. Using open standards like TCP/IP, it is possible to connect 

and communicate with external systems and allows global communication. 

                                                 

 

 

 
1
 Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 
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Communicate with one PF at a time via the serial connection or with a complete network of PF units via 

the built-in TCP/IP connection. 

Power Focus communicates with a range of accessories via the internal I/O bus. PF units and accessories 

can be combined according to the customer’s requirements. 

The Power Focus can be configured to communicate via the most common buses on the market; ProfiBus, 

DeviceNet, InterBus, etc. Real time communication is done over a proprietary I/O bus for tool 

synchronization. Several outputs can be activated for communication with PLC’s and other external 

equipment. Each PF has four relay contacts, four optic isolated inputs and a 24 V DC / 1 A internal power 

supply for external control circuits. All inputs and outputs can be configured using the ToolsTalk PF 

software. The number of digital inputs and outputs can be increased using an I/O Expander on the I/O 

bus. 

With Power Focus, full networking capability is available in the controller as an integrated function, in 

relation to both hardware and software. ToolsNet is Windows NT compatible, which offers easy to use, 

effective database and data collection functions, using standard databases like SQL, Oracle and Microsoft 

Access. PF can be connected to a network for central programming and data collection using ToolsNet. 

With the modular concept, the Power Focus is the building block used to create complete and cost 

efficient solutions that satisfy the various needs of modern industrial assembly operations. 
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3.6 Tensor tools 
This is a brief overview of Atlas Copco Tensor tools and tool accessories. See tool specific information for 

a complete list of tools and options for each tool. 

Tensor STB communicates with the tightening controller systems through wireless digital communication, 

built on IRC (Industrial Radio Communication) technique.  

Tensor ST tools communicate with controllers through digital communication, allowing new tool features 

and greater flexibility due to not so many wires and leads. Compared with a Tensor S tool, it is also 

lighter with improved accessibility.  

Tensor SL is a range of low torque transducerized tools based on Tensor ST technology.  

Tensor S tools are available in different configurations and motor types. Fixtured applications can easily 

be installed and integrated with standard Atlas Copco components. 

The ultra-compact ETX tool is designed for fixtured applications.  

Atlas Copco’s Tensor DS tools have no transducer. Instead of receiving an electrical signal from a strain 

gauge, the tool derives the torque from several relevant parameters, such as voltage, speed, temperature 

and current.  

An open-end tool (or tube nut tool) is a 

Tensor tool equipped with an open-

ended head. It is used to tighten nuts 

on tubes and similar applications. The 

open-end is available for several, but 

not all, tools. 

 

Open-end tools can only be 

used with lock-off lever for 

personal safety reasons. 
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Tool parts  

Figure shows Tensor ST. 

 

STwrench is a torque wrench 

that can be controlled by the 

Power Focus. The STwrench 

communicates with the 

tightening controller systems 

through wireless digital 

communication, built on IRC 

(Industrial Radio 

Communication) technique. 

 

 

3.6.1  Tool accessories 

See Atlas Copco tool specific information for a list of options for each tool. 
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ST scanner is placed on the tool and works as a barcode reader. For more information 

about the function of identifiers, see section Identifier.  

 

 

GPIO  (General purpose I/O) is a digital input and output connector. The four buttons 

combined with four LED’s can each be configured as a digital input and/or digital 

output. 

 

ST selector has two different modes, mode 1 and mode 2. In Mode 1, the selector only 

utilizes the tool accessory bus as GPIO. This mode only supports a maximum of 15 Psets 

(1-15). In Mode 2, the selector takes full advantage of the bus capabilities. 

For more information about the ST selector, see section ST-selector connection. 

 

TLS ST Tag is an external positioning unit for positioning of the tool in the surroundings. 

The unit also has a 7-color LCD indicator for sending status messages to the operator.   
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3.7 Hardware accessories 

The Power Focus concept features a number of accessories that simplify the guidance and follow-up of 

performed tightenings. The accessory functions can be set up using ToolsTalk PF or a PF Graph unit. 

The benefit of using serial bus-based accessories (I/O bus) is that they can be connected in series, from 

accessory to accessory rather than hard wiring each accessory to the Power Focus. This arrangement 

increases flexibility and quick installation. 

Power Focus uses 24 V DC, 1 A to power the bus, which is also used to power external I/O's. If more 

current is needed, the bus must be powered externally. Every device has a 24 V DC input for this 

purpose. 

I/O Expander enables the connection of several inputs and relays when more 

than those built-in are required. There are 8 inputs and 8 relays with the same 

functionality as the four built-in I/O's. Each input and relay can be configured 

individually.  

 

 

 

I/O Expander, sealed 

The sealed I/O Expander is designed for more demanding environments than 

I/O Expander. It will add eight digital inputs as well as four digital and four 

relay outputs to your system.  

 

 

Indicator Box is a flexible display indicator used together with our Start 

handle for indication of status signals from the controller. The box can easily 

be connected to the Power Focus with premade cablings. 
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Socket Selector is a socket tray with LED’s that can be used to guide the user 

through, for example, a Job sequence. When using more than one Pset it is 

very convenient to use a selector. When a socket is lifted, the corresponding 

Pset will be selected. 

The Socket Selector is available with four or eight sockets, and 

communicates on the I/O bus.   

Operator Panel is an external device for PF. It is a general purpose lamp- and 

switchbox, replacing the customer specials that are made today. The Operator Panel 

communicates directly with Power Focus and the device configuration is made in 

ToolsTalk PF. 

 

Stacklight ESL-04 is a flexible light and switch device designed to interface with 

controllers equipped with an I/O Bus.  

 

Stacklight DSL-03 is a simple and customizable light and switch device, designed to 

interface with controllers equipped with Internal I/O connectors instead of I/O-bus. 

The stacklight comes with features such as buzzer, rotating light etc. 

 

MiniDisplay is a compact remote interface. It runs the Operator Guidance 

application program to give the operator visual support. It is equipped with a 

touch-screen and is fully configurable. The MiniDisplay is connected through 

Ethernet and does not support I/O-bus communication. 
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3.8 Software accessories 

3.8.1 ATS 

The ATS (Assembly Tools Software) works together with PF to complete the tightening process. The 

following software products are part of ATS.  

ToolsNet 

ToolsNet works together with the controllers and the selected database, MS SQL Server or Oracle to 

collect, store and visualize all historic tightening-related data. ToolsNet allows the user to get reports on 

shifts, lines, individual vehicles or controllers for process improvement purposes. All the reports can 

easily be exported to Excel. 

 ToolsNet can be used as a standalone product or together with the other modules from the ATS.  

Factory Overview 

Factory Overview is the portal to the tightening process. It visualizes the whole process and makes it 

possible to monitor all tightening applications from one central place. Factory Overview can be used both 

as a standalone product and together with the other modules from the ATS. 

Event Monitor 

Event Monitor offers real-time event reporting from the controllers in a centralized and filtered format. 

Event Monitor can be used both as a standalone product and together with the other modules 

from the ATS.  

Open Protocol 

The PF open protocol can be run using Ethernet or serial communication. It is a full duplex protocol, 

which means that data can be exchanged in both directions simultaneously. Every communication partner 

must be able to operate a send and receive facility simultaneously.  

The torque controller is the server and the station computer the client. The torque controller can accept up 

to 5 connections at a time. The protocol used is TCP/IP.  
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3.8.2 ACTA 4000 

An ACTA 4000 performs a full range of functions, from simple torque checks 

to advanced graphic tightening analysis. It comes in different models and it is 

easy to upgrade. 

ACTA 4000 measures torque, angle, and pulses and facilitates the conduction 

of statistical analyses of the tightening process. An ACTA 4000, together 

with the ToolsTalk QAT PC utility, is a complete SPC tool.  
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4 Connecting devices 
This section describes the connections on PF backplane. It also describes the start-up process for PF and 

for the tools.  

 

4.1 PF connections 

Backplane connections 

 

1 Digital input + internal 24 V DC 

2 Relays 

3 Ground Fault Interrupter (GFI) 

4 Serial #1 (RS 232) to MC-card 

5 I/O Bus #1 

6 I/O Bus #2 

7 Remote start 

8 Main fuse 

9 Main fuse power connector 

10 Ground connection 

11 Fieldbus card (optional) 

12 RBU 

13 Ethernet 

14 Serial #2 (RS232) to CC-card 

15 Printer 

16 Tool output 

 

In addition to backplane connections, 

PF4000 has a USB connection on the 

front underside. 
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4.2 RBU 
Connect the RBU to the 15-pin connector on the back panel of the Power Focus (see figure below). 

 
Make sure that the power is switched off when connecting and disconnecting the RBU. 

The RBU unlocks the software and works as a backup memory for the Power Focus setup data. 

The pin configuration is propriety information for Atlas Copco. This connector cannot be used for other 

purposes. 

Connector: 15-pin D-sub female. 

Function: For connection of Atlas Copco RBU. 

4.2.1 MAC-address 

Power Focus Ethernet address is 00-50-D6 -XX-YY-ZZ (from serial RBU). 

 
Cell network connection requires PF units with identical RBU types inserted. 

The RBU serial number is also part of the Power Focus Ethernet MAC address.  

Example: RBU with serial number C00015767: 

 00015767 (decimal) → 003D97 (hexadecimal) 

 003D97 (hexadecimal) → 00-50-D6-00-3D-97 (MAC address) 

4.2.2 PF start-up instructions 

At start-up, the Power Focus checks for differences between the controller and RBU configurations. If an 

inconsistency is detected the user is prompted to select either the controller or RBU configuration. This 

makes it possible to move/copy configurations between PF units by using the RBU. The user is also given 

the possibility to clear both configurations. 

 
When changing RBU type it is only possible to load the configuration from the RBU. 

 

Press the plus (+) or minus (-) key on PF Compact front panel to toggle between the selections. Confirm 

selection with the enter key. Press the corresponding soft key to make a selection on PF Graph. 

The table describes the selections available and how to choose configuration. If the Power Focus and RBU 

are incompatible for other reasons than a configuration mismatch (e.g. they have an older software 

version), either PF or the RBU is considered as NOK. 
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Message at start-up Action 

No message The memory areas of PF and the RBU are identical, and the checksums are 
correct. 

Clear / RBU / PF The memory areas of PF and the RBU show correct checksums, but they are 

different. You need to decide which memory content to use before continuing, 
or whether to clear both.  

PF / Clear / Stop The memory area of PF shows correct checksum, but the checksum of the RBU 

is incorrect, which could indicate a hardware problem. You can select between 
using PF setup or clear the memories. 

RBU / Clear / Stop The memory area of the RBU shows correct checksum, but the checksum of PF 

is incorrect, which could indicate a hardware problem. You can select between 
using the RBU setup or clear the memories.  

Clear / Stop  The memory areas of both PF and the RBU show incorrect checksums, which 

could indicate a hardware problem. Your option is to clear the memories. 

 

 
Changing RBU will clear the tightening result database in Power Focus. 

 
Selecting “Stop” will only prevent the result database from being erased if the RBU has been 

changed between RBU Silver and Gold (provided the previous RBU is re-inserted). A change 

between RBU Gold and Silver, or bronze and DS will clear the result database even if 

selecting “Stop”. If PF is turned on with no RBU or a PF Graph is turned on with a RBU 

bronze the tightening result database will be cleared without querying the user. 

4.3 Tool connection and start-up 

4.3.1 Tools with cable connection 

ST and SL tools are used together with a cable, especially designed for the particular 

tool type. The cables are equipped with memory devices used for storing information 

about the tool cable, number of tightenings etc. This information can be viewed in the 

Accessories branch. 

An ST tool can be connected and replaced when the PF is powered up. For S tools, 

use T460 Disconnect to replace tool without losing data.  
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4.3.2 Tensor STB 

For connection of the wireless Tensor STB, ensure the correct tool connection is configured before 

starting the pairing procedure. See PF parameters under Tool > Configuration > Connection and Tool > 

Configuration > Radio. For instructions on the pairing procedure, see Tensor STB documentation.  

 

STB tool 

1 Bus connector 

(hidden) 

2 Buzzer 

3 LEDs  

4 Function button 

5 Battery 

6 Direction ring 

7 Tool trigger 
 

 
Check tool documentation for compatibility between tool, PF 

and RBU. 

 

4.3.3 Start-up instruction for open-end tools 

The start-up instruction is recommended every time an open-end tool connected PF is started up 

(rebooted), or a hot swap of the tool has been made. The advantages of this are a faster tool rotation to the 

open-end position, possibility to select C230 OE forward positioning, and automatic generation of alarms. 

Note that the operator has the possibility to perform tightenings without completing the start-up 

configuration.  
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To do a start-up configuration, follow these steps: 

1. Reboot PF (or make a tool hot swap). 

2. Press the tool trigger on the open-end tool once. The tool head rotates slowly in order to find a 

reference position. The tool should now alternate between tightening and positioning when pressing 

the tool trigger. 

3. Perform ten consecutive tool trigger pressings without installing on a joint; five tightenings and five 

positionings, and let the open-end head rotate at least 360 degrees for every tightening. Note that 

during this setup phase the OE positioning type is torque based reverse and the max torque 

positioning limit is not valid. 

4. After five correct tightenings and five correct positionings, the open-end head should rotate with a 

faster speed meaning that correct reference point had been set. 

If an open-end positioning fails (which happens if positioning is performed with a tool head fixed on the 

tube), more tightenings and positionings are needed. 

 
To perform an open-end tuning, see section Open-end tuning. 

 

4.3.4 Wireless tools 

For wireless tools, performing a start-up configuration every time the battery is changed would be 

ineffective for the operator. Therefore, there is no start-up configuration for STB. Instead, when the 

trigger is first pressed after a battery change, the tool rotates slowly in order to find its reference position. 

Alternatively, if the operator has selected open-end tuning on PF before pressing the trigger, an open-end 

tuning is run. After a successful open-end positioning or open-end tuning, the tool is ready.  

 

4.3.5 ST GPIO connection 

The four buttons combined with four LED’s can each be configured as a digital input and/or digital output. 

Pin Function Input Output Duration Time 

1-4 Input or output Logical function Logical function Output duration Duration time 
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4.3.6 ST-selector connection 

Keep the left button on the selector pressed when powering up (this is done by 

hot swapping the tool or powering up PF). The selector will now enter the 

configuration mode. 

Press the right button on the selector to toggle between mode 1 and 2. Confirm 

mode selection by pressing the left button. 

Pin Function 
(input) 

4 Pset Select bit 3 

3 Pset Select bit 2 

2 Pset Select bit 1 

1 Pset Select bit 0 
 

If Mode 1 is selected the number of Psets (1-15) to use must now be set. Press the right button to select 

the number of Psets to use. Use the left button to confirm. The selector is now ready to use. When using 

mode 1 parameter T210 Mode must be set to “GPIO” with the GPIO device configured according to the 

table to the right. Parameter C200 Pset must also be set to “DigIn”. 

 

If Mode 2 is selected the T210 Mode must be set to “ST bus”. Parameter C200 Pset also must be set to “ST 

selector”. The selector has a number of configurable parameters (see table below). 

Selector parameter Selections 

Left button and right button Off: button disabled. 

Next Pset: select next Pset. 

Previous Pset: select previous Pset. 

LED status Off and On 

Display(1) Off: display disabled. 

Pset no.: displays selected Pset number. 

Pset target: displays selected Pset target value (torque or angle). 

Result: displays the tightening result. 

Pset no. + result: toggles between Pset number and tightening result (2). 

Pset target + result: toggles between Pset target and tightening result (2). 

Pset no. + Pset target: toggles between Pset number and target (2). 

Pset no. + Pset target + result: toggles between Pset number, target and tightening result (2). 

(1)
 Event codes always displayed, except for “Off“ 

(2)
 The Pset number (or Pset target) is displayed until a tightening result is generated. The tightening 

result is displayed until the next tightening is started or a new Pset is selected. In mode “Pset no. + Pset 

target” the Pset number and target toggle will show on the display until a result is generated. 
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4.4 Printer 

Connector: 25-pin D-sub female 

Function: Parallel printer 

Electrical data: Normal TTL levels 

High level signal: 1 

Outputs: High > 2.4 V; Low < 0.4 V 

Inputs: High > 2.0 V; Low < 0.8 V 

Pin Function Pin Function Pin Function 

1 Strobe 10 Acknowledge 19 Ground 

2 Data bit 0 11 Busy 20 Ground 

3 Data bit 1 12 Paper end (out of paper) 21 Ground 

4 Data bit 2 13 Select 22 Ground 

5 Data bit 3 14 Auto feed 23 Ground 

6 Data bit 4 15 Error 24 Ground 

7 Data bit 5 16 Initialize printer 25 Ground 

8 Data bit 6 17 Select input   

9 Data bit 7 18 Ground   
 

4.5 Serial connection  
There are two serial connection ports. 

 
The ToolsTalk PF software must be connected to RS232 port 2. 

It is necessary to check if connected device is fully supported by PF and properly configured. If device 

responds to unrecognized commands with error messages or sends unexpected data it can invalidate 

functionality. 

4.5.1 Serial RS232 #1 

Connector: 9-pin D-sub female 

Function: RS232 serial 

Connections: This port is used for 

communication with minor load, for 

example scanners.  

Pin Function 

1 Not used 

2 RD, Receive data 

3 TD, Transmit data 

4 Not used 

5 GND 

6 Not used 

7 Not used 

8 Not used 

9 Not used 
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4.5.2 Serial RS232 #2 

Connector: 9-pin D-sub female 

Function: RS232 serial connection. Use 

Atlas Copco serial cable to connect to a 

PC. 

Connections: This port is used for 

communication with high load, such as 

ToolsTalk PF or Open Protocol. It can 

also be used for connection with 

scanners. 

Pin Function 

1 Not used 

2 RD, Receive data 

3 TD, transmit data 

4 +5V max 200 mA 

5 GND 

6 Not used 

7 Not used 

8 Not used 

9 Not used 
 

4.6 Ethernet TCP/IP 

Connector: Shielded RJ45 for 10-baseT 

connection 

Function: 10 Mbit half duplex Ethernet 

communication  

Pin Function 

1 Out inverse 

2 Out 

3 In inverse 

4 ---- 

5 ---- 

6 In  

7 ---- 

8 ---- 
 

4.7 Digital inputs 

Connector: 10-pin detachable screw terminal. Mating connector phoenix MCVR 1.5/10 -ST- 3.81 or 

compatible. 

Function: Isolated optic-coupled digital input. Logical function is set in the configuration of the Power 

Focus. 

Electrical data: “High” input (10 - 40) VDC. Current needed to activate input is 5 mA at 24 V. 

This input can be connected to run both positive and negative logic (active high or active low). 
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Pin Function 

13 Digital input 1 + 

14 Digital input 1 - 

15 Digital input 2 + 

16 Digital input 2 - 

17 Digital input 3 + 

18 Digital input 3 - 

19 Digital input 4 + 

20 Digital input 4 - 

21 + 24 VDC isolated 

22 GND (+24VDC isolated) 
 

 

4.8 Digital outputs (relays) 

Connector: 12-pin detachable screw terminal. Mating connector phoenix MCVR 1.5/12-ST-3.81 or 

compatible. 

Function: Two ways dry contact relays, isolated outputs. Logical function is set in the configuration of the 

Power Focus. 

Electrical data: Max 50 V DC/AC. Switching load: min 1 mA, max 500 mA resistive loads. 
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Pin Function 

1 Relay 1 Normally open 

2 Relay 1 Common 

3 Relay 1 Normally closed 

4 Relay 2 Normally open 

5 Relay 2 Common 

6 Relay 2 Normally closed 

7 Relay 3 Normally opened 

8 Relay 3 Common 

9 Relay 3 Normally closed 

10 Relay 4 Normally opened 

11 Relay 4 Common 

12 Relay 4 Normally closed 
  

4.9 24 VDC output 

Isolated 24 VDC output. (19 V - 30 V), 1 A maximum load. This output can be used to feed external 

equipment such as stack lights and buzzers. Atlas Copco I/O bus accessories are also powered from this 

output. 

4.10 I/O Bus 
There are two I/O bus connectors. 

Connector: 9-pin D-sub male. 

Function: To connect Atlas Copco I/O bus accessories and interconnect several PF units in 

Synchronization mode. I/O bus connector #1 is parallel with I/O bus connector #2. 
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There is a range of Power Focus accessories that connect over the proprietary Power Focus I/O bus, for 

example Socket selector or I/O Expander. 

To have a well functioning I/O bus, always use bus connectors. All accessories and PF units are equipped 

with two parallel connectors. When all cables are connected, plug a lead into the empty connector. I/O 

bus connectors #1 and #2 are fully parallel and can be used in any combination.  

For I/O bus Sync configuration information, see section Sync.  

Pin Function 

1 +24 V iso. 

2 Signal Low 

3 0 V (+8V iso) 

4 0 V (+24 V iso) 

5 Not used 

6 0 V (+8V iso) 

7 Signal High 

8 Not used 

9 +8 V iso. (for I/O bus only) 
 

 

4.11 Remote start connector 

Connector: 4-pin detachable screw terminal. Mating connector phoenix MCVR 1.5/4-ST-3.81 or 

compatible. 

Function: Remote start input for use with external start switch. To run tool in reverse, first close the 

reverse switch and then close the start switch. Pin 1 and 2 must be connected at power on to be able to use 

the built-in tool trigger. If remote start is to be controlled from other inputs (I/O Expander, Sync, fieldbus 

or digital input), pins 2 and 4 must be connected at power on. 
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Pin Function 

1 Tool built-in start switch 

2 Common 

3 Remote reverse 

4 Remote start 
 

 

 
Remote start is not available for Tensor STB tools. 

 

 
Make sure that the power is switched off when changing the remote start connector. 

 

4.12 Main power connector 

Connector: IEC320 

Electrical data: Input voltage (90 - 120) VAC, (200 - 240) VAC, (50 - 60) Hz. Auto select of voltage input 

span. 
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5 PF user interface 

This section describes the PF user interface. Except for differences in the user interface, PF Graph and 

PF Compact have the same functionality and capacity.  

 
For a description of connections, see section Connecting devices, or documents Product 

Information for PF3000 (9836 2156 01), or Product Information for PF4000 (9836 3113 00). 
 

5.1 PF Graph 
PF Graph can be programmed in ToolsTalk PF, through a pre-programmed RBU, or by using the function 

buttons on the front panel. Another PF can also be programmed by the Graph unit if both controllers are 

members of the same cell. A Pset can also be programmed directly via the unit’s Auto set function. 

5.1.1 Front panel 

The front panel of PF Graph consists of a display, 

indicator lights, keys and a red and white power switch. 

 
 

Number Part Description 

1 Indicators Eight indicators 

2 Display The front panel has a configurable 

color display. A power-save function 

deactivates the backlighting on the 
display if it is not used for 30 minutes. 

3 Soft keys Five soft keys with functionality 

according to the display 

4 Function keys 

and keyboard 

Used to program PF. 

5 Power switch Red and white power switch. 
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Indicators 

Indicator Description 

OK The OK light indicates when the result of the tightening is within the specified limits. The indicator 

remains active until the next cycle starts. 

OK flash light indicates that it is safe to disconnect the tool. The LED goes off when the tool is 
disconnected. 

n x OK The n x OK light indicates when the number of approved tightenings corresponds to the number (batch 

size) programmed into PF. The indicator remains active until the next cycle starts. 

NOK The NOK red light indicates when at least one result of the tightening falls outside the specified limits. 

The light is active until the next cycle starts. NOK flashing red indicates that it is NOT safe to disconnect 
the tool. The LED goes off after three seconds. 

JOB OK The JOB OK light indicates when the result of the Job is finished. The light remains active until the next 
cycle starts or when the system is reset. 

ALARM The ALARM indicates that an alarm message needs to be acknowledged. The light is active until the 

message is cleared. The alarm light can also flash indicating an active alarm that does not need to be 
acknowledged, i.e. service indicator alarm. 

STAT The STAT light indicates when the calculated values fall outside statistical control limits. The light 

remains active until the values are within the control limits or the memory has been reset. 

Autoset (arrow 
target) 

The Auto set light indicates when the Auto set programming function is active. The light goes off when 
Auto set is finished. 

PROG. CONTROL 

(padlock symbol) 

If PF is in programming mode the Programming control light (illustrated by an open padlock) flashes 

green. Programming control can be undertaken via the unit itself, via another PF Graph or via ToolsTalk 
PF. A steady green light indicates that the programming keys on the front panel are unlocked. 

Soft keys and keypad 

Key Description 

Soft keys Each soft key is used to select an option or a menu block from the display. 

Channel [+/-] Select another controller within the configured cell. 

Pset [+/-] In result mode: Select Pset to use if C200 is set to PF keyboard. In programming mode: Select Pset or 
Job to configure. 

Question Mark [?] Pressing the Question mark key displays information about the software, RBU type and the connected 

tool. 

Print symbol Press the Print key to do a print-out to a connected printer.  

Arrows Up and down arrows: Scroll up and down in the menus 

Left arrow: Leave current option or view 
Right arrow: Execute selected function, select current option or view 

RESULT Select result mode. Menu block View has options for the result view. 

PROG Select programming mode.  

OK OK is used to execute selected functions and acknowledge event. 

CANCEL Cancel the current operation and return to the previous view. 

Keypad Numeric keypad. Press repeatedly to toggle between letters and numbers  

CL Clear the last input letter or number. 

ENTER Enter is used to activate inputs in the programming blocks   
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5.1.2 Display 

PF 4000 Graph features a large back-lit 72 x 96 mm color display with a dialog box-like interface to allow 

accurate measurement readings and simple programming.  

Header with three fields: channel number and 

current Pset or Job, Pset name, and number of 

tightenings (in batch). If the field is light-blue, 

this indicates that the displayed information is 

inactive or from another PF. 

Result or Programming dialog box. Available 

result view options are shown under the View 

menu block. This figure shows the Last Results 

view for one channel. 

The last result lower windows are configurable.  

Menu blocks representing programming tree 

functions, short-cuts, arrows. The menu blocks 

are controlled by the soft keys below. 
 

Menus  

The Menu blocks are located at the bottom of the display. Each soft key is used to select a menu block.  

When selecting a menu block with more than one 

item, a pull-up menu appears on the display. 

To select an option, do one of the following: 

 Keypad: Press the digit on the numeric 

keypad that corresponds to the desired option.  

 Soft keys: Scroll up or down using the soft 

keys under the arrows. Then press the soft key 

under Enter, or press ENTER on the keypad.  

 Arrows: Scroll up or down using the arrows. 

Then press the right arrow to confirm the 

selection.   
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Data input 

To access the data input boxes, do one of the 

following: 

 Highlight it and then press ENTER.  

 Press the digit on the numeric keypad that 

corresponds to the option.  

To enter data, do the following:  

 If it is a text box, use the keypad and press 

until the desired figure, letter or symbol 

appears. Press ENTER to confirm and exit the 

data field.  

 If it is a selection list, do one of the following: 

o Use the soft keys under the arrows to 

highlight the desired parameter. Press 

ENTER to confirm and exit the selection 

list. 

o Press the digit on the numeric keypad that 

corresponds to the desired parameter to 

confirm and exit the selection list. 

Press Store to save the changes in the controller 

and stay in the current display. 

Press OK to confirm changes and return one level 

up in the menu tree. More changes can be made 

before storing. 

Press Cancel to cancel any changes and leave the 

dialog box.  

 

Text box 

 

Selection list  

5.1.3 Programming PF Graph 

To program PF Graph, do the following:  

Press PROG. The padlock symbol starts blinking to show that the PF Graph has programming control, and 

the programming menu is displayed. Select and fill in applicable parameters.  
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If another person or program has programming control, a message is displayed.  

When a change has been made, Store is shown in a lighter color. Press the soft key below Store to confirm 

changes. 

Press RESULT to return to the result view.  

Programming another PF 

To program another PF through PF Graph, both channels have to be members of the same cell. The cell 

configuration is done through ToolsTalk PF.   

Press the Channel -/+ to access other controllers in the cell from the menu tree in the programming mode or 

from the result view. Do the applicable programming.  

Changing IP address  

To change IP address on a controller in the network, do the following:  

Press PROG and then 4,3,0,0 to open the IP 

address dialog box.  

Use the keypad to enter the correct IP 

address. 

Press Store and then RESULT to confirm 

changes and return to the result view. 

To change IP address on other channels in 

the cell, do the following:  

Press Channel -/+ to access the correct 

controller. This can be done from the menu 

tree in the programming mode, or from the 

result view. 

Change the IP address.  

Press Store and then RESULT to confirm 

changes and return to the result view. 

 

Programming the last result view 

The last result view can be programmed to show different parts of the last result, and also to show the 

result from one or two channels.  
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Press PROG and then 4,5,1 to open the result 

view.  

Press 0 or 1 to select one or two channels.  

 

 

The programming mode for the result view is 

displayed.  

Press the number in the area to edit, then press 

Enter to open the selection list for the result 

view area. Make a selection and proceed with 

the other result view areas. 

To view more than one channel, press 3 or 4 to 

access the lower part of the result view. Select 

another PF with Channel -/+, and another Pset 

with Pset -/+.  

Press Store and then RESULT to confirm 

changes and return to the result view. 

 

In the result view, press the Type soft key and select two channels to show the result from two channels. 

The upper part displays the viewed channel and the lower any selected channel in the cell. R means 

running Pset. 
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Print reports 

The print key opens the print menu.  

If print is selected from, for example the 

controller menu, the controller report is 

pre-selected.  

 

Trace 

One or multiple traces can be shown in the PF Graph display.  

 

To show traces select Trace in the View 

menu block. Select which type of chart to 

view via the Type menu block. 
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In Torque over time trace mode it is 

possible to plot several traces in the same 

chart. This is done by accessing the Select 

menu block and activating Multiple Traces. 

The last ten traces are displayed in the 

chart. The chart is scaled according to the 

reference. If a reference is not selected the 

chart is scaled according to the first plotted 

trace. 

 

 

 

In Multiple Traces mode a tightening trace 

can be set as a reference by using the Select 

reference command. The last tightening 

trace is set as the reference. When a 

reference is selected, all traces except the 

reference is cleared. The reference that is 

shown in red color is stored in the memory 

and is available after reboot. In Select 

reference mode the last nine traces and the 

references are displayed in the chart.  
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5.2 PF Compact 
PF Compact can be programmed in ToolsTalk PF, through a pre-programmed RBU, or programmed using 

the cell function on a PF Graph. A Pset can also be programmed directly via the unit’s Auto set function. 

Except for differences in the user interface, PF Compact has the same functionality and capacity as the 

Graph model. 

5.2.1 Front panel 

The front panel of PF Compact consists of a display, indicator lights, keys and a red and white power 

switch. The display is set up using parameter C512 Compact display. 

 
PF 3000 

 

 

PF 4000 

 

Number Part Description 

1 Display The front panel contains a 4-

digit, 7-segment display. 

2 Power Switch Red and white power switch. 
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5.2.2 Display 

After a tightening, result is presented on the display in configured presentation unit. If the presentation 

value is bigger than 9999, display shows ‘EEEE’. 

 

Engineering unit Convert factor 

Nm 1 

Nm to Ozfin 141.6 

Nm to Lbfin 8.851 

Nm to Lbfft 0.737562 

Nm to Kgfm 0.101972 

Nm to Kgfcm 10.197162 

   

Torque is presented as real numbers in the following format. The decimal point indicates that the number 

is a torque value. 

  

Torque (engineering unit) No of decimals 

0.00 – 9.99 2 

10.00 – 99.99 2 

100.0 – 999.9 1 

.1000 – .9999 0 

 

 
In the 1000-9999 interval, a decimal point is located to the left of the first digit to distinguish 

torque values from angle values which do not have a decimal point. The reason to the left 

position is HW related on the display card. 

Angle values are presented as integers in the interval 0-9999 degrees. When a tightening result is 

composed by torque and angle, the display alternating shows the torque and angle result (changes every 

0.8 sec) 

 

During tightening, the P-set number is displayed. Events are presented on the display with an event code, 

being a 3 digit number preceded with an ‘E’. 
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5.2.3 Indicator lights 

 

Indicator Description 

OK The OK light indicates when the result of the tightening is 

within the specified limits. The indicator remains active until 
the next cycle starts. 

OK flash light indicates that it is safe to disconnect the tool. 
The LED goes off when the tool is disconnected. 

NOK The NOK red light indicates when at least one result of the 

tightening falls outside the specified limits. The light is active 
until the next cycle starts. 

NOK flashing red indicates that it is NOT safe to disconnect 

the tool. The LED goes off after three seconds. 

JOB OK The JOB OK light indicates when the result of the Job is 

finished. The light remains active until the next cycle starts or 
when the system is reset. 

n x OK The n x OK light indicates when the number of approved 

tightenings corresponds to the number (batch size) 

programmed into PF. The indicator remains active until the 
next cycle starts. 

ALARM The ALARM indicates that an alarm message needs to be 

acknowledged. The light is active until the message is cleared. 

The alarm light can also flash indicating an active alarm that 

does not need to be acknowledged, i.e. service indicator alarm. 

PROG. 
CONTROL 

(padlock symbol) 

If PF is in programming mode the Programming control light 

(illustrated by an open padlock) flashes green. Programming 

control can be undertaken via the unit itself, via a PF Graph or 

via ToolsTalk PF. A steady green light indicates that the 
programming keys on the front panel are unlocked. 

If PF Compact keypad is locked, the only keys on the 

controller that can be used are question mark and enter. (If the 
keypad is unlocked, steady green, any key can be accessed.) 

AUTO SET 

(graph symbol) 

The Auto set light indicates when the Auto set programming 

function is active. The light goes off when Auto set is finished. 

STAT The STAT light indicates when the calculated values fall 

outside statistical control limits. The light remains active until 

the values are within the control limits or the memory has been 
reset. 
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5.2.4 Keypad 

 

 

Key Description 

Plus [+] Navigates through menus on the display and increases numbers. 

Minus [-] Navigates through menus on the display and decreases numbers. 

Autoset 

(arrow target) 

Press the Autoset key to enter Autoset programming mode. 

Aset/Ft alternates in the display and the Autoset LED comes on. 

Press Enter. Change the P113 Final target value (if required) by 
pressing the +/- keys. 

Press Enter to select the P113 Final target. Aset is shown in the 
display. 

Perform a number of tightenings. When Autoset is ready, the 

selected Pset number is displayed and the Autoset LED goes out.  

To abort Autoset press the Autoset key (exit and no save). 

Question 

Mark [?] 

Pressing the Question mark key displays the following 

information: 

RBU License level: rbu toggle with RBU type. Au = Gold,  

Ag = Silver and Br = Bronze.Software version: rEL followed by 
version number rolls on the display from right to left. 

Tool model name: type toggles with the tool model 

name.Current Pset: Pset toggles with the current Pset ID, e.g. 

P1. 

Current Job: Job toggles with the current Job ID, e.g. J3. 

Enter The Enter key is used to execute selected functions and for event 
acknowledgement. 

 
Function 
Key [F] 

Description  

 

General Press F (Function key) to display functions. To display function F1 press F once, to display function F2 press F 

twice etc. Press Enter to access and edit a function. When finished, press F repeatedly to display result mode 

again (or else it takes 30 seconds for the screen to update automatically). 

 

Note: The functionality is dependent on the RBU version.  

F1 

Setting Final 
Target value 

F1/Ft alternates in the display. If no Pset is selected F1/---- is displayed. 

Press Enter to select a new P113 Final target value. Change the value by pressing the +/- keys.  

Press Enter to save and exit. Press F to exit (no save). 

F2 

Setting 

Torque Tune 
Factor 

F2/tunE alternates in the display if the selected P100 Control strategy is equal to DS control. Otherwise F2/---- is 
displayed. 

Press Enter to access the torque tune factor. Change the value by pressing the +/– keys (range 80% - 220%, 
default value 100%).  

Press Enter to save and exit. Press F to exit (no save). 



 PF user interface  

9836 3123 01 53 (428) 

Function 
Key [F] 

Description  

 

F3 

Motor tuning 

 

Press the F key three times. F3/tool alternates in the display if a tool is connected. Otherwise F3/---- is displayed. 

Press Enter to activate the motor tuning process. The display shows the process status during progress, (1 to 7).  

Press the Tool trigger to start motor tuning. The trigger must be pressed during the entire process. 

Release Tool trigger or press F to abort the motor tuning process. 

When the motor tuning process ends, done (for succeeded) or Err (for failed) is displayed. 

After a few seconds F3/tool starts alternating on the display. 

F4 

Selecting 

Pset 

 

F4/Pset alternates in the display if the C200 Pset is set to PF keyboard. Otherwise F4/---- is displayed. 

Press Enter to access the available Psets. Browse existing Psets by pressing the +/- keys. 

Press Enter to select a Pset and exit. 

Press F to exit (no selection). 

F5 

Setting Batch 

count 

F5/batS alternates in the display, indicating that a Pset is selected. Otherwise F5/---- is displayed. 

Press Enter to access the Batch Size value (range 0 - 99). Change the batch size value by pressing the +/- keys. 

Press Enter to save and exit.  

Press F to exit (no save). 

F6 

Disconnect 
tool 

F6/DISC alternates in the display if a tool is connected. Otherwise F6/---- is displayed. 

If safe to disconnect tool is rolling on the display press Enter. The tool may now be disconnected. 

If Fail is displayed, DO NOT disconnect the tool. Press F or Enter to exit. 

F7  

Sync motor 
tuning 

Press the F key seven times. F7/stun alternates in the display. 

Press Enter to activate the Sync motor tuning process. The display shows two numbers simultaneously during 

progress. The number to the left is the percentage of Sync member that has finished motor tuning, and the 
number to the right is the process status (1 to 7). 

Press the Tool trigger on the Sync reference to start Sync motor tuning. The trigger must be pressed during the 
entire process. 

Release the Tool trigger or press the F key to abort the motor tuning process. 

When the motor tuning process ends, done (for succeeded) or Err (for failed) is displayed. After a few seconds 

F7/stun starts alternating on the display. 

F8  

Controller IP 
settings 

Press the F key eight times.F8/IP alternates in the display. 

Press Enter. Addr is shown. Press Enter to edit the first part of the IP address. Increase/decrease the number by 

pressing the Plus/Minus keys. Press Enter to confirm and edit the second part of the address. Repeat the 
procedure for all remaining IP address parts.  

Press Enter. Sub is shown. Press Enter to edit the first part of the subnet mask. Increase/decrease the number by 

pressing the Plus/Minus keys. Press Enter to confirm and edit the second part. Repeat the procedure for all 

remaining subnet parts.  

Press Enter. rout is shown. Press Enter to edit the first part of the default router. Increase/decrease the number 

by pressing the Plus/Minus keys. Press Enter to confirm and edit the second part. Repeat the procedure for all 
remaining router parts.  

Event code E857 Reboot needed before changes take effect will be blinking on the display when finished, if any 
changes have been made. Press Enter to acknowledge the event.  

Restart PF. 

F10 

Wireless tool 

pairing mode 

Press the F key ten times. F10/pair alternates in the display. 

Press Enter to activate the pairing process. The display shows the process status during progress (1 to 5).  

Event code E550 Radio contact with tool established, tool accessible is shown on the display when finished.  
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6 Getting started with ToolsTalk PF 

ToolsTalk PF is an application that acts as an interface between the user and the Power Focus. It is used 

for programming and monitoring Power Focus from a PC. 

With ToolsTalk PF installed, users can communicate with the Power Focus via the serial port (RS232) as 

well as over the Ethernet. 

Ethernet communication makes the management of Power Focus easy and efficient, since ToolsTalk PF 

can be installed on a PC anywhere in the network. 

ToolsTalk PF serves as an interface between the user and PF. With ToolsTalk PF, users can create and 

edit instructions and settings for the controller. The settings needed to control the tightening process 

performed by the Power Focus include; tightening strategies, control parameters, torque parameters, 

angle parameters, speed and ramp parameters and time parameters. 

The settings are transferred to Power Focus via an Ethernet connection, via the serial port, or via the 

USB port on PF 4000. Process data can be collected from the Power Focus and monitored in real-time. 

ToolsTalk PF makes management of Power Focus easy and efficient, since the software can be installed 

on any PC on the network. 

ToolsTalk PF is fully compatible with Microsoft Windows and supports widely accepted communication 

protocols such as; Ethernet, TCP/IP and RS232 (serial communication). 

6.1 Installing ToolsTalk PF 

ToolsTalk PF is easy to install: 

 Insert the installation CD and follow the instructions 

 It is possible to select installation of multiple instances of ToolsTalk PF. This 

means it is possible to open several ToolsTalk PF instances at the same time in 
your desktop. 

 Open ToolsTalk by selecting Start > Program > Atlas Copco Tools AB > ToolsTalk 

Power Focus  
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6.2 ToolsTalk overview  

Almost every function in ToolsTalk PF has its own window. The figure below shows the ToolsTalk PF 

interface with menu list, selection panel, toolbar and PF Map. 

There are several ways to start a function in ToolsTalk PF. With almost all functions, it is possible to use a 

menu item in the menu list. Click on a symbol in the toolbar or double-click on the text in PF Map. 

 

 

6.2.1 Menu list 

The following options are available in the PF Menu list. 

 
An additional menu appears in the Menu list when opening a function window. For example, 

when opening a Pset window, a new menu named “Pset” appears in the menu list. 
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Illustration Name Description 

 

File Read and store files, print and exit ToolsTalk 

PF from the File menu. 

If, for example, the Pset window is active, 

options for reading and storing Pset appear in 
the File menu. 

 

Edit Create a new Pset, Multistage, Job, Sound and 

Logic Configurator from the Edit menu. 

 

Focus The Focus menu specifies the type of 

connection to use when connecting to the 

Power Focus. Choose between an Ethernet 
connection and a Serial connection.  

The Offline mode allows access to ToolsTalk 

PF without the need for a connection to a 
Power Focus. 
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Illustration Name Description 

 

Options The Options menu includes: 

ToolsTalk interface settings: View Toolbar, 

Settings, Change language and Change Manual. 

See section Configuring ToolsTalk for more 
information. 

Get Event Log: Retrieves the event log from 
the connected PF 

Forced release progcontrol terminates the 

connection to the current PF and enables 

another user to take programming control over 
PF. 

Forced release progcontrol disconnects another 

ToolsTalk when programming control 

(progcontrol) over the database in PF is needed, 

for example for a configuration change. Forced 

release progcontrol can not disconnect a graph 
interface in the programming view. 

 

Reboot PF. A pop-up window prompts for 
confirmation before reboot. 

 

 

Window Set properties for windows and icons from the 

Window menu as well as enable and open the 
Activate menu. 
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Illustration Name Description 

 

Activate The Activate menu contains a list of all 

available functions (Pset, Job, Multistage, etc.). 

 

Help The Help menu allows access to the Power 

Focus help file. Pressing F1 on the keyboard 
gives access to the help file from any window. 

About ToolsTalk PF brings up details about the 
version of the ToolsTalk PF program in use. 

 

6.2.2 Selection panel 

Illustration Name Description 

 

Selected 

Controller 

The available options are: Serial connection, 

Ethernet connection and Offline mode. 

 

Running Job If parameter C201 Job is set to Ethernet/Serial, it is 
possible to select a Job to run. 
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Running 
Pset/Multistage 

If parameter C200 Pset is set to Ethernet/Serial, it is 
possible to select a Pset or Multistage to run. 

 

PF List To simplify the Ethernet connection to a Power 

Focus, use the PF List. Select an item and ToolsTalk 

PF connects to the corresponding Power Focus. The 

information in the list contains; name, IP address 
and port number. 

6.2.3 Toolbar 

The toolbar icons are short-cuts to the basic functions in ToolsTalk PF. See the corresponding section in 

this manual for a detailed description of each function.  

Icon Icon name Description 

 

Pset This icon opens the programming window for the first Pset. 

A Pset contains all the necessary information Power Focus needs to perform a tightening. 

There are a number of parameters included in a Pset, among them; control parameters, 
torque parameters, angle parameters etc. 

Click on the arrow to the right to select between existing Psets (shown along with number 
and name).  

Use the function in the PF Map to create a new Pset. 

 

Multistage This icon opens the programming window for the first Multistage. 

In some instances it is necessary to perform a tightening in several stages. These 

circumstances require specific tightening strategies. Multistage allows the user to create 

linear sequences of up to eight Psets to perform a tightening divided into stages. 

Click on the arrow to the right to select between existing Multistages (shown along with 
number and name). 

Use the function in the PF Map to create a new Multistage. 

 

Job This icon opens the programming window for the first Job. 

A Job is a collection of Psets or Multistages, which are useful when performing several 

multiple tightening operations, each with different requirements. This is convenient since the 
operator does not have to select a new Pset or Multistage for every tightening. 

Click on the arrow to the right to select between existing Jobs (shown along with number 

and name). 

Use the function in the PF Map to create a new Job. 

 

Controller This icon opens the first part in the Controller programming section. 

Controller contains information and settings for PF. This includes network, COM ports, 
display, memory and accessibility. 

Use the arrow to the right to select between the sub-menus. 
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Icon Icon name Description 

 

Tool This icon opens the first part in the Tool programming section. 

The Tool branch includes information, configuration, diagnostic and maintenance for the 

Tensor tool connected to PF. 

Use the arrow to the right to select between the sub-menus.  

 

Accessories This icon opens the first part in the Accessories programming section. 

In the Accessories branch are the digital inputs and outputs of the PF configured and 

diagnosed. It also includes information about the devices connected to the I/O bus and tool 
bus, and how to configure these devices.  

Use the arrow to the right to select between the sub-menus. 

 

Sync This icon opens the Sync programming section. 

Up to ten PF units in the same logical Cell can be Synchronized to perform the same task 

simultaneously, a function known as Sync. This type of operation requires Synchronization 
of the Power Focuses involved.  

 

Identifier This icon opens the Identifier programming section. 

It is possible to send an Identifier string to a PF. This string is normally sent by a barcode 

reader connected to one of the serial ports on PF. (This barcode is in car plants usually 

known as a VIN or ESN). 

 

Fieldbus This icon opens the fieldbus programming section. 

Fieldbus communication is useful for data communication between PF and PLC’s. It is an 
effective and fast way for the data transfer of short data packages. 

 

Logic Configurator This icon opens the programming window for the first Logical Configurator. 

The ToolsTalk PF software feeds the controller (PF 4000 only) with inputs, called 

Configurator sheets. The Configurator sheets consist of a Relay status array and a DigIn 

status array. The arrays have the status of each relay/digital input function (if the function is 
defined on the internal I/O’s or one of the I/O Expanders). 

Every Logic Configurator circuit instruction list is evaluated every 100 ms which 
corresponds to a tick or every time an input status changed. 

Click on the arrow to the right to select between existing Logical Configurators (shown 
along with number and name). 

Use the function in the PF Map to create a new Logical Configurator. 

 

Monitors Click on the arrow to the right of this icon to select an appropriate monitor; Result monitor, 

Job monitor, Operator monitor, Identifier monitor and Get all results. 

ToolsTalk PF provides a number of monitors designed to present extensive information 
about the various functions of Power Focus. 

 

Trace Click the Trace icon to bring up a graphical display of the tightening results. 

Via the Trace function it is possible to view tightening graphs with different display settings. 

 

Statistic Click on Statistic icon to display statistical results and graphs. Via the arrow to the right it is 
possible to select a statistic to run. 

 

PF Map This icon opens the PF Map if it is closed. 
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Icon Icon name Description 

 

Connect The Connect icon changes appearance depending on the connection status. When the PC is 

not in contact with the Power Focus, this icon is visible. Clicking on it establishes a 

connection between the PC and PF. Choose connection in “selected controller” list 
(ToolsTalk PF menu list).  

 

Disconnect Once a connection is established this icon appears. Clicking on it disconnects the PC from 

PF. 

 

Help This icon opens the Help section. 

6.2.4 PF Map 

The PF Map gives an overview of and shortcuts to all settings in ToolsTalk PF. Expand and collapse to 

open and close menus and double click on function names (Pset, Multistage, Job, etc.) to open the 

corresponding function. Right-click the function names to create a new instance of the function. 

Brief information about the selected setting is displayed in the right panel of the PF Map.  
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6.3 Configuring ToolsTalk settings 
This section describes some of the available ToolsTalk settings. The following settings are located in the 

Settings dialog box. The settings are configurable off-line. 

 Setup for communication with PF  

 Setup for viewing information inside the ToolsTalk PF application 

 Printout setup 

 Administration of the PF list 

On the menu bar, open Options>Settings.  

6.3.1 Communication 

The Communication tab has four areas; View event setup, Serial setup, Ethernet setup and LOG. 

 

In the View event setup area, make selections for viewing controller errors and warnings. 



Getting started with ToolsTalk PF 

64 (428) 9836 3123 01 

In the Serial setup area, select which Com port to use on the PC, normally Com1 or Com2, for 

communication with PF. The Baud rate can be set to 2400, 4800, 9600, 19200, 38400, 57600 or 155200.  

 
The TTPF baud rate must match the baud rate set in PF. The default value is 9600. 

In the Ethernet setup area, enter the data for PF. The Port number is default 6543 and does not normally 

need to be changed. If using an item from the PF list (PF available list) then all three parameters (type, 

port, IP) are set simultaneously. 

 
To edit Ethernet setup parameters, ToolsTalk PF has to be in disconnected mode. 

In the LOG area, enable the log function for communication between Power Focus and ToolsTalk PF. 

Messages are stored in the file stated in the log file area. Create rules for logging by clicking the Advanced 

key. 

If Split log in the Advanced log settings is activated the size of log.txt file can not exceed the value set in 

Log file size. When the file is full, the program copies the contents to a file called log~.txt and erase the 

content of log.txt. Data will then continue to be stored in log.txt. 
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6.3.2 Application  

The Application tab has three areas; Presentation, Automatic functionality, and Default directory.  

 

 

The first area concerns the ToolsTalk PF presentation.  

 If the Show hints checkbox is selected, then the limits for each parameter are displayed in the status bar 

when the cursor is placed over a parameter box.   

 

 If the Show parameter number checkbox is selected, then all parameter numbers are displayed in the 

windows. 

 If the Show VIN in result checkbox is selected, then the result parts selected in the Identifier function are 

displayed in the Result monitor.  



Getting started with ToolsTalk PF 

66 (428) 9836 3123 01 

The Automatic functionality area activates/deactivates the following functions:  

 Auto collapse tree views 

 Type of connection at startup: If Serial auto connection on startup or Ethernet auto connection on 

startup is checked, ToolsTalk PF connects to Power Focus immediately on start-up.  

 If the Auto store PF to file on disconnect box is checked, then ToolsTalk PF stores the PF data to file 

when disconnecting. 

In the Default directory area, specify where the log files and auto stored PF files are saved. 

6.3.3 Printout  

The Printout tab contains printout settings. 

Text entered in the Printout footer field appears on every printed paper. 

In the Printout format and Printout colors areas, make settings for printout. 
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6.3.4 PF List 

The PF List tab contains the PF available list box. Add, modify and remove items from here. PF Ethernet 

type defines PF in the net, seen from ToolsTalk. Note that the configuration of PF in the net is made from 

PF Map>Controller>Network.   
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6.4 Connecting a PF 
There are different types of connection possibilities; Ethernet TCP/IP, Serial RS232 and USB. USB 

connection is only available for PF 4000. 

6.4.1 Ethernet connection 

To make an Ethernet connection between PF and Tools Talk, PF must be configured with a unique IP 

address. This address must be stored in Tools Talk. 

Setting IP address in PF 

Do either of the following: 

 Connect a PC to PF through serial connection. Follow the instructions in section Network or set the IP-

address in PF from ToolsTalk.  

 Use the keypad directly on PF. For PF Compact, select F8 and enter the IP address.  

 For PF Graph, press PROG and open the Controller>Network>Ethernet branch. Enter the IP-address.  

Storing PF IP address in Tools Talk 

 From the Options menu, open the Settings dialog box. Do either of the following: 

 Click the Communication tab, Ethernet setup area, type the Controller IP address of the PF to connect 

to. Also click the option for NetMaster, CellMaster or Controller.   

 Click the PF List tab, and create a list of PF. Note: To configure a cell or net, see section Network 

 Save the settings and proceed to section To connect.  

6.4.2 Serial connection 

 
When using the serial connection, it is important to use the proper baud rate settings. In 

order to establish a connection between ToolsTalk PF and PF they must use the same baud 

rate. The default baud rate is set to 9600 bit/s. 

From the Options menu, open the Settings dialog box. Check the Baud rate for the PC Com port. 

Make sure that the serial cable is connected to the correct Com port on the PC and to Serial RS 232 (2) on 

PF. 

Open PF Map>Controller>COM ports and check the settings for PF, Serial 2 C410 Baud rate. 

Save the settings and proceed to section To connect. 
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6.4.3 USB connection 

 
A USB port is standard on PF 4000. The port is located under the PF front panel. 

Connect a USB cable between PF and the PC (PF acts as USB device). An extra COM port should now be 

visible on the PC. Open ToolsTalk and connect serially via the extra COM port. 

Prior to using USB connection, FTDI’s virtual COM port (VCP) drivers should be installed. The 

V.2.08.14 of the file is used for Windows 7, Vista, XP and 2000. 

1. Run the CDM20814_Setup.exe file 

2. Click Run  

 

3. The driver has been installed when the console window disappears 

 

4. A virtual COM port will appear when connecting to the USB on PF4000 to the PC. Select that 

COM port when running Tools Talk Power Focus 

 

If using a different OS then above or to get the latest version of drivers, this driver 

can be download from: http://www.ftdichip.com/Drivers/VCP.htm 

Also a detailed installation guides are available from: 

http://www.ftdichip.com/Documents/InstallGuides.htm . 

Contact Atlas Copco representative to obtain more information about available drivers. 

http://www.ftdichip.com/Drivers/VCP.htm
http://www.ftdichip.com/Documents/InstallGuides.htm
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6.4.4 To connect 

There are several ways to connect a Power Focus from ToolsTalk PF: 

 Select Focus in the Menu list and then choose between Serial connection and Ethernet connection. 

 In the drop-down list for Selected controller in Selection panel, click on either Serial PF or Ethernet PF. 

 In the PF Map, double-click on the controller under Serial PF or Ethernet PF. 

 Use the Connect icon on the Toolbar. By default, this icon creates a serial connection. However, it 

remembers the most recent connection. 

 Use predefined PF units from the PF List in the Selection panel. 

6.4.5 To disconnect 

To disconnect, click on the Disconnect icon on the Toolbar or select Disconnect in the Menu list (Focus > 

Ethernet/serial > PF name > Disconnect). 

6.4.6 Cordless tools 

If the Power Focus is connected serially to an IRC-module for communication with a cordless tool, special 

considerations must be taken before serial or USB connection can be established with TTPF. 

 The parameter T294 Serial connection in the Tool Configuration->Connection menu must be set to 

Internal. 

 The baud rate as mentioned in section 6.4.2 must be set the same on the PF 4000 as on TTPF. 

 If an IRC Focus is used, the serial connection is available for other use than the cordless tool 

communication, so no special consideration is needed. 

6.5 Storing programming on file 
To store the programmed settings on file, open the File menu. The following options are available: 

 Read <object> 

 Read PF from File 

 Save <object> 

 Store PF to File 

<Object> could be a section in the PF Map, for instance in Pset, Multistage, Job, Controller, Tool, Sync, 

Identifier, Fieldbus, Trace or Diagnostic.  
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See table below for option descriptions. 

Option Description  

Store PF to File Programmed settings in the Power Focus are stored to a file when connected to a Power Focus.  

Read PF from File Power Focus updates with programmed settings stored on file when connected to a Power Focus 
and performing Read PF from file.  

 
Read PF from file overwrites current programming and configuration in the 

connected PF. 
 

Save <object> 

(Controller, Pset, Job etc.) 

This function stores a single object to file. The selected window in ToolsTalk PF is stored to file.  

Read <object > 

(Controller, Pset, Job etc.) 

This function writes a single object file to the Power Focus. The selected window is updated with 

data from the file.  

6.5.1 Store PF to file 

When performing Store PF to File, the user should name the file. ToolsTalk PF stores the programmed 

settings for more than one file (for example one file for each Pset, Multistage and Job). 

When storing PF to file, it is possible to store files in Excel format. Select Excel as file format in the Save 

as dialogue. The overhead file has the extension pft. Extensions for the other stored files are xls. 

 

Open ToolsTalk PF and connect to PF. 

On the Menu bar, open File>Store PF to file. 

A Save as dialog box appears. State target, type name and 

save the PF text file (*.pf3). 

A Confirmation message is displayed. 

 
The “PF Text file” should be used for the 

restoring of data when the memory setup is done. 
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6.5.2 Read PF from file 

 
Command “Read PF from file” overwrites current 

programming and configuration in connected PF. 

 
It is necessary to perform “Read PF from file” TWO 

times and reboot PF one extra time for changes to 

take effect. 

Open ToolsTalk PF and connect to PF. 

On the Menu bar, open File>Read PF from file. 
 

A Confirm pop up window informs 

that restoring from file will replace 

everything on the controller. 

Select Yes to continue. 

Select No to abort operation. 

Read Selection window appears. 

Select functions to restore. An 

unchecked box means no 

replacement of data in that 

function area. 

Click OK to confirm. 

A Confirm pop up window 

appears. 

Select Yes to keep present Power 

Focus name and Network setup. 

Select No to restore Power Focus 

name and network setup from file. 
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6.6 Offline 

Offline mode gives the user the opportunity to conduct programming and configuration, without a PF 

connection. All programming is stored to or read from a file. It is possible to copy this file to one or 

more PF units. 

There are three different ways to select the offline mode: 

 In the main Menu list, select Focus>Offline. 

 In the Selected controller drop menu, select Offline. 

 In the PF Map, double-click Offline. 

The file can be located on the local hard drive, network, etc. There is a certain number of default files 

supplied when installing ToolsTalk PF. Also, find these files separately on the ToolsTalk PF installation 

CD-ROM. Depending on the RBU license level; just select the file to use. The different RBU types 

correspond to the names of the default files (“DS.pf3”, “Gold.pf3”, “Silver.pf3” and “Bronze.pf3”). It is 

recommended to make a backup of these files. 

Select a file with the same license level as PF. ToolsTalk PF opens the 

selected file and enables the user to change it. 

It is possible to continue to change the content of a file with a higher RBU 

license level, but when trying to use the file with a PF with a lower license 

level a warning message is generated. 

Note: It is also possible to modify the current configuration. Before 

disconnecting, use commend File>Store PF to File to store the current 

configuration file.  

To upload the file, connect PF and select File>Read PF from File. 
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6.6.1 Configuring a tool offline 

In offline mode, open Tool>Information in the PF Map.  

Click Set tool. The Set tool window appears.  

Select a tool or configure a new tool via the Create tool key. 
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7 Pset 

The set of parameters that controls the tightening process is contained within a Pset. This 

section describes how to setup the basic parameters necessary to perform a tightening. Create a 

Pset by using Autoset, Quick programming or by setting the parameter values manually using 

PF Graph or ToolsTalk PF. 

 

 
This section includes screenshots from ToolsTalk PF. The screenshots show examples of 

parameter settings and are NOT intended to be generally applicable. Check with your 

local Atlas Copco representative how to set up your specific system environment. 

See parameter list section Pset for a description of all available Pset options. 
 

The basic Pset parameters are located under the Programming branch: 

 Control 

 Torque 

 Angle 

 Speed and ramp 

 Time  

 Batch count 

 High speed rundown 

 Positioning 

 Additional settings are found under Programming+, Pset setup and 

Statistic programming. 

An easy way to program a Pset is to use the Autoset function. 

Quick programming is intended to help users to quickly configure a 

Pset. After completing a Quick programming procedure, the tool is 

ready to use for tightening. 

Programming help shows an image of the selected strategy.  

Every time a Pset changes, the ID of the person changing the Pset is 

stored in P409 PSet updated by. This information is useful for tracing 

who has made the last change in any given PSet. If no user has logged 

in the filed values are: TTPF if changed via ToolsTalk, OPER if 

changed via the controller, and BLANK if the Pset has been created in 

an earlier version of the software. (For being able to log users this 

functionality requires a special SW called ToolsUserAdmin, which 

handles the access level for users via TTPF.) 
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All Pset changes are reflected in ToolsNet. 

 

7.1 Create new Pset/Open Pset 

In the PF Map, right-click and select 

Create New Pset.  

Alternatively, double-click or right click 

on an existing Pset, to open the Pset 

configuration window. 

 
As default there is one Pset 

existing in ToolsTalk PF. 
 

 

The Create new Pset window 

pops up. 

Select available New Pset ID 

from drop down menu. 

Enter a New Pset Name 

(optional). 

Click OK to open the new Pset 

setup window. 
 

Continue with Autoset, Quick Programming or Programming. 
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7.2 Autoset 

An easy way to program a Pset is to use the Autoset function. Power 

Focus adapts the programming to the specific joint characteristics and 

sets all the parameters automatically. Autoset does not change any 

parameters outside the used Pset.  

Autoset uses P100 Control strategy DS con for DS tools and  

Tq con/ang mon for all other tools. 

Autoset can only be selected: 

 When a tool is connected 

 When PF is switched on  

 On the running Pset (displayed in the selection panel) 

 
If using an existing Pset, the parameters are erased and 

replaced by the Autoset calculated parameters. 
 

 

 

 

Click Autoset in the Pset window. 

A green light on the front panel of the PF indicates that Autoset is activated. When this signal is shut off, 

Autoset is finished and PF is now programmed for that joint. The Autoset procedure can be aborted by 

clicking cancel before the green light shuts off. 

Enter the P113 Final target value 

and click OK. 
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Perform a number of tightenings 

with the tool. 

The first two tightenings are 

completed at very low speed. 

Normally, three to ten tightenings 

are required in order for the 

Power Focus to calculate and set 

the required parameters for the 

specific joint characteristics. 

 

Click OK when prompted. 

Clicking Abort before the Autoset procedure is completed cancels the operation and restores the previous 

settings. 

7.3 Quick programming 

Quick programming is intended to help users to quickly configure a Pset 

and gives the opportunity to use the Power Focus after a fast and 

simple programming. 

The joint angle is the distance from when the screw (nut) head touches 

the surface and the torque starts to build up, until it reaches the set 

limit. It is possible to measure the joint angle by using a torque wrench. 

 

For hard joints, it is best to set the value at 30 degrees. For soft joints we recommend setting the joint 

angle above 100 degrees. This gives a better tightening during the first stage and a distinct second stage. 

Adjust the angle if the second stage is too long. It is important that there is a second stage; otherwise the 

tool may jerk at full torque (overshoot). 

 
If using an existing Pset, the parameters are erased and replaced by the Quick 

programming calculated parameters. 

For quick programming, the final target value must be larger or equal to 25 percent of 

T102 Tool max torque. 
 



 Pset 

9836 3123 01 79 (428) 

Open an existing Pset or create a 

new one. 

Click Quick programming in the Pset 

window. 

Select P100 Control strategy and enter 

the joint angle and P113 Final target. 

Click OK to finish. 

 

7.4 Programming help 

Via the Programming help function ToolsTalk PF can illustrate an 

example of the selected control and tightening strategy.  

Click Programming help in the Pset window. 
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7.5 Programming 

In the Pset setup window, expand the Programming branch. 

Select Control. 

 

Choose the desired P100 

Control strategy, P101 

Tightening strategy and 

settings for the other 

parameters. 

 

 

 
For more information, see sections Control strategies, 

Tightening strategies and Additional control options. 
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In the Pset Programming branch, 

select Torque or Angle. 

Make suitable parameter settings. 
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In the Pset Programming branch, 

select Speed and ramp or Time. 

Make suitable parameter settings. 
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In the Pset Programming branch, 

select Batch count,  High speed 

rundown, Positioning or Snug 

gradient. 

Make suitable parameter settings.  

Click Store to save the settings. 
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7.6 Control strategies 
For all Tq con and DS con tightenings the process starts when the torque reaches P110 Cycle start. When the 

torque reaches target and then falls below P115 Cycle complete the process ends. When the torque drops 

below P115 Cycle complete without having reached target before, a timer is started. In this case, if the 

torque does not increase above P115 cycle complete during P141 End time seconds, the process ends. 

For Reverse ang the tightening process also starts when the torque reaches P110 Cycle start. 

For Rotate spindle forward/reverse the tightening process starts immediately when the tool starts running.  

The P123 Target angle is defined by P121 Measure angle to and can be measured from P120 Start final angle to 

Torque peak, Angle peak, P115 Cycle complete, or Shut off. 

 
P124 Final angle max is always evaluated from P120 Start final angle to angle peak. 

For cordless tools some of the control strategies and options are not available. 

Please consult the relevant tool manuals for more information. 

7.6.1 Tq con 

The Tq con strategy controls the 

torque. This strategy is selectable 

for both one stage and two stage 

tightenings. The tool stops when 

the torque reaches the P113 Final 

target.  

If, for some reason, the tool 

should exceed P114 Final tq max, 

the tool shuts off and the (NOK) 

tightening result is shown. 

 

 

 

Torque 

Angle 

1. P112 Final torque min 
2. P114 Final torque max 
3. P113 Final target 

1. 

2. 

3. 
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7.6.2 Tq con/ang mon 

The Tq con/ang mon strategy 

controls the torque and monitors 

the angle. This strategy is 

selectable for both one and two 

stage tightenings. The tool stops 

when the torque reaches the P113 

Final target value.  

If the tool for some reason should 

exceed P114 Final tq max or P124 

Final angle max, the tool shuts off 

and the (NOK) tightening result is 

shown.  

 

 

 

7.6.3 Ang con/tq mon 

Ang con/tq mon strategy controls 

the angle and monitors the torque. 

This strategy is selectable for both 

one and two stage tightenings. 

P123 Target angle is then defined 

as the number of degrees between 

P120 Start final angle and angle 

peak. The tool stops at P123 Target 

angle.  

If the tool for some reason should 

exceed P114 Final tq max or P124 

Final angle max, the tool shuts off 

and the (NOK) tightening results 

are shown. 

  

Torque 

Angle 

1. P112 Final torque min 
2. P114 Final torque max 

1. 

2. 
6. 

4. 5. 

4. P122 Final angle min 
5. P124 Final angle max  
6. P123 Target angle  

Torque 

Angle 

1. P112 Final torque min 
2. P114 Final torque max 
3. P113 Final target 

1. 

2. 

4. 5. 

3. 

4. P122 Final angle min 
5. P124 Final angle max  
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7.6.4 Tq con/ang con (AND) / (OR) 

The Tq con/ang con (AND)/ (OR) 

strategy controls both torque and 

angle. This strategy is selectable 

for both one and two stage 

tightenings. 

For Tq con/ang con (AND), Power 

Focus controls the P113 Final target 

value and the P123 Target angle 

value. The tool stops when both 

targets are reached. They do not 

have to be reached at the same 

time. 

For Tq con/ang con (OR), Power 

Focus controls the P113 Final target 

value and the P123 Target angle 

value. The tool stops when the 

first of these two targets are 

reached. 

 

For both Tq con/ang con (AND) and Tq con/ang con (OR) the torque and the angle result must be within 

respective min and max limit. 

If, for some reason, the tool should exceed P114 Final tq max or P124 Final angle max, the tool shuts off and 

the (NOK) tightening results are shown. 

 

Torque 

Angle 

1. P112 Final torque min 
2. P114 Final torque max 
3. P113 Final target 

1. 

2. 
6. 

4. 5. 

3. 

4. P122 Final angle min 
5. P124 Final angle max  
6. P123 Target angle  
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7.6.5  Reverse ang  

The Reverse ang strategy reverses 

the spindle a specified number of 

degrees in the opposite tool 

tightening direction. This is useful 

when, for example, the bolt needs 

to be loosened before the final 

tightening. Create a Multistage to 

combine and perform several 

Psets as one. 

P123 Target angle is defined as the 

number of degrees between the 

P120 Start final angle and the peak 

angle. The tool stops at P123 

Target angle.  

 

If the tool for some reason should exceed P114 Final tq max or P124 Final angle max, the tool shuts off and 

the (NOK) tightening results are shown. The torque value shown in the result is torque at peak angle. 

Angle measurement starts when the P120 Start final angle is reached. 

 

 

For reverse ang, the “active” direction of the tool socket rotation is the opposite of the P240 

Tool tightening direction. For instance, to select CW turn the Direction ring to the left position. 

For safety reasons, it is not possible to loosen the joint in this way. 
 

 

Angle 

Torque 

1. P123 Target angle 
2. P120 Start final angle 
3. P114 Final torque max 
4. P122 Final angle min 
5. P124 Final angle max 

1. 2. 

4. 

3. 

5. 
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7.6.6 Rotate spindle forward/reverse  

The rotate spindle forward/reverse 

functions rotate the spindle a 

specified number of degrees, 

either forward or reverse, 

independently of torque. The only 

torque values monitored are P114 

Final tq max and P112 Final tq min. 

P123 Target angle is defined as the 

number of degrees between start 

of tightening and the peak angle. 

The tool stops at P123 Target 

angle.  

If, for some reason, the tool 

should exceed P114 Final tq max or 

P124 Final angle max, the tool shuts 

off and the (NOK) tightening 

results are shown. 

 

 
The tightening process begins when the trigger is pressed. 

For rotate spindle reverse, the “active” direction of the tool socket rotation is the opposite of 

the P240 Tool tightening direction. For instance, if “CW” is selected turn the direction ring to 

the left position. For safety reasons, it is not possible to loosen the joint with this strategy. 

7.6.7 Click wrench  

Select the Click wrench function if the Power Focus result data base should include a click wrench or a 

non-tightening operation in the work process, such as ocular inspections or the filling of fluid containers. 

It is possible to configure four independent click wrench operations. A click wrench Pset consists of a 

P107 Click wrench no, P113 Final target only. Each P107 Click wrench no. is associated with one digital input. 

Activating the digital input indicates to PF that the specified operation has been performed. Use P113 Final 

target to set the torque result level for click wrench operations.  

 

Torque 

Angle 

Time 

Time 

1. P112 Final torque min 
2. P114 Final torque max 

4. P122 Final angle min 
5. P124 Final angle max 
6. P123 Target angle 
7. Acceptance window 

2. 

6. 

5. 

1. 

4. 

7. 

7. 
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Resulting torque is the final target set by the Pset. 

7.6.8 Home position forward and reverse 

The home position function, 

suitable for fixtured tools, makes 

it possible to mark a socket 

position using the Set home 

position digital input. When 

triggered, the socket rotates (CW 

for Home position forward or CCW 

for Home position reverse) to the 

home position. The digital output 

Home position is triggered when 

the position is reached. The only 

torque values monitored are P114 

Final tq max and P112 Final tq min. 

The home position function is not 

available for open-end tools. 

If, for some reason, the tool 

should exceed P114 Final tq max or 

P124 Final angle max, the tool shuts 

off and the (NOK) tightening 

results are shown. 

 

 
The tightening process begins when the trigger is pressed. 

 
This strategy is suitable only for tools which are dedicated for fixtured solutions and 

full repeatability can not be guaranteed for normal tools. 

 

Torque 

Angle 

Time 

Time 

1. P112 Final torque min 
2. P114 Final torque max 

4. P122 Final angle min 
5. P124 Final angle max 
6. Acceptance window 

2. 

5. 

1. 

4. 

7. 

6. 
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7.6.9 Yield control (Yield) 

Yield control is activated by selecting the P100 Control strategy to Yield. The P101 Tightening strategy can be 

set to One stage, Two stage or Quickstep. Yield control interacts in the second stage of the tightening. P105 

Zoom step strategy ending is eliminated when yield control is selected.  

The settings for Yield are found under Programming+. For more information, see Yield control in section 

Programming+.  

7.6.10 Yield/Tq con (OR) 

Select Yield/Tq con (OR) in P100 

Control strategy.  

In addition to the settings for Yield 

(see Yield control in section 

Programming+) a final target is 

set. The tool stops when P113 Final 

target is reached if the yield 

function has not stopped the tool 

before. 

 

Torque 

Angle 

P113 Final target 
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7.6.11 DS con 

The DS con function controls the 

torque based on the current 

measurement and monitors the 

angle. This function is selectable 

for two stage tightenings only. 

The tool stops when the torque 

reaches the P113 Final target value. 

If the tool for some reason should 

exceed P124 Final angle max, the 

tool shuts off and the (NOK) 

tightening result is shown. 

 

 

 
When programming the DS control strategy it is of greatest importance to have a well-

developed second stage. The fastener/socket should allow some angle rotation in the second 

stage of the tightening, or else the torque may overshoot. The best way to determine this is 

simply by observing the angle rotation during the second stage. 

If the tool overshoots, a red toggling LED is displayed on the tool. The criteria for overshoot are a short 

or a non-existing second stage in combination with a high speed in the first stage. On the display event 

code E003 Torque measurement possibly invalid is visible. 

Torque tuning is performed either from the PF Graph user interface, ToolsTalk PF or automatically with 

ACTA 4000. It allows an easy adjustment to the reference system torque values (e.g. ACTA 4000) and 

compensates for tool-drive-programming and joint variations. One torque-tuning factor is stored with 

each Pset. When a tool is controlled against an external torque reference for calibration, it is 

recommended to calculate a new torque tuning value. There is one Torque-tuning factor for each Pset 

(when changing Pset settings a new torque tuning factor is needed): 

Perform a number of tightenings with the external torque gauge connected, preferably 20 tightenings or 

more to achieve a good mean value. 

Torque 

Angle 

1. P112 Final torque min 
3. P113 Final target 

1. 

7. 

4. 5. 

3. 

4. P122 Final angle min 
5. P124 Final angle max  
7. Acceptance window  
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 Calculate the mean value from the tightenings 

Factor Tuning Torque Old
  MeanMeasured

Target Final
  Factor Tuning Torque New   

 Enter and store the new DS torque tuning factor 

 Perform another set of tightenings to control the torque 

 If the torque is OK it is possible to run. If not, do the complete procedure over again. 

7.6.12 DS con/tq mon 

The DS con/tq mon function 

controls the torque based on the 

current measurement and 

monitors the transducer based 

torque. It also monitors the angle. 

This strategy is selectable for two 

stage tightenings only. The tool 

stops when the current based 

torque reaches the P113 Final target 

value.  

If the tool for some reason should 

exceed P114 Final tq max and P124 

Final angle max, the tool shuts off 

and the (NOK) tightening result is 

shown.  

Torque 

Angle 

1. P112 Final torque min 
2. P114 Final torque max 
3. P113 Final target 

1. 

2. 

4. 5. 

3. 

4. P122 Final angle min 
5. P124 Final angle max  
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7.6.13 Snug gradient 

The Snug gradient strategy runs 

the specified P123 Target angle 

from the observed Snug point. 

Snug gradient controls the angle 

and monitors the torque. This 

strategy is selectable for both one 

and two stage tightening. 

The Snug gradient is the slope 

calculated by P180 Delta angle and 

P181 Delta torque. The Snug point 

is defined as the position followed 

by two subsequent slopes larger 

than the specified Snug gradient. 

As soon as two subsequent slopes 

are larger than the Snug gradient 

the Snug-point is found. 

From this point, the spindle runs 

the specified P123 Target angle. 

If the tool should exceed P182 

Torque limit without finding the 

Snug point, the tool shuts off and 

the (NOK) tightening results are 

shown. 

  

 

 

2 

2 
Snug point 

3 

2 1 

1. P110 Cycle start 
2. P180 Delta angle 

3 

Torque 

Angle 
3. P181 Delta torque 

Snug gradient 
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3 
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Snug point 

4 

2 

2 

3. P182 Torque limit 
4. P123 Target angle 

1. P110 Cycle start 
2. P180 Delta angle 
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7.6.14 PVT comp with snug 

This tightening strategy is a development of 

the existing PVT comp strategy described in 

7.8.4. This strategy is useful when the PVT 

comp torque level is higher than P113 Final 

target. 

The PVT compensate value is retrieved using 

the Snug gradient method described above 

for finding the snug point and then 

calculating the torque compensate value 

defined by following parameters.  

 P183 PVT distance: a point a defined 

angle backwards from Snug point 

 P184 PVT interval: an angle interval 

during which the comp value shall be 

calculated 

 P185 Compensate value: option 'Peak' or 

'Average' torque value within the 

interval. 

P186 Delay monitoring after cycle start: is a 

parameter for filtering out a certain angle in 

the beginning of a tightening where 

monitoring for a certain 'gradient' is not 

interesting. (Useful when the gradient is high 

at cycle start etc.). 

  

 

1. P186 Delay monitoring after cycle start 
2. P184 PVT interval 
3. P183 PVT distance 
4. P113 Final target 
5. Final target + PVT compensate value 
6. P190 PVT min monitoring limit 
7. P191 PVT max monitoring limit 

1 

4 

3 

2 

5 

Average  

P110 
Cycle 
start 

Snug point 

Peak  

7 

6 

P185 compensate value   

 

After finding the snug point and the PVT comp value, the torque defined by P113 Final target is added to 

the PVT comp value for reaching a total torque target. The achieved torque and the PVT comp value are 

presented as in existing PVT comp strategy (i.e. dependent on C503). 

If any of the torque values measured while searching after Snug point are lower than Snug PVT 

monitoring min (P190) or higher than Snug PVT monitoring max (P191) the tightening shall stop when 

Snug is found. 

The presented final angle in the result is measured from the snug point. 
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7.7 Tightening strategies  
The Power Focus supports a number of different tightening strategies in order to achieve the best quality, 

speed and ergonomic behavior. Both standard and proprietary patented strategies are supported. This 

section provides a generic description of the tightening strategies available. 



Pset 

96 (428) 9836 3123 01 

7.7.1 One stage 

Tightening is performed in One 

stage until the P113 Final target 

torque has been reached. 

 

 

7.7.2 Two stage 

In a Two stage tightening, the 

tool operates at high speed 

during the first stage and a lower 

speed during the second stage. 

The tool stops for about 50 

milliseconds between the stages 

to reduce joint relaxation and 

then accelerates for the second 

stage. 

In this example the strategy ends 

with a P105 Zoom step, which 

reduces the risk of overshooting. 

 

 

Torque 

Tool 
speed 

1. P110 Cycle start 
2. P113 Final target 
3. P130 Soft start speed 
4. P135 Step 1 ramp 
5. P131 Step 1 speed 
6. P115 Cycle complete 

1. 

2. 

Time 

5. 

4. 

3. 

6. 

Torque 

Tool 

speed 

1.   P110 Cycle start 
2.   P111 First target 
3.   P113 Final target 
4.   P130 Soft start speed 
5.   P135 Step 1 ramp 
6.   P131 Step 1 speed 
7.   P136 Step 2 ramp 
8.   P132 Step 2 speed 
9.   P105 Zoom step 
10. P115 Cycle complete 

1. 

3. 

2. 

9. 

Time 

8. 
7. 

6. 

5. 

4. 

10. 
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7.7.3 Quick step 

Quick step is a type of two stages 

tightening with high tool speed 

during the first stage and a lower 

tool speed during the second 

stage. The speed changes from 

first to second stage speed without 

pausing in between. 

In this example the strategy ends 

with a P105 Zoom step, which 

reduces the risk of overshooting. 

 

 

Torque 

Tool 

speed 

1. 

3. 

2. 

9. 

Time 

8. 

7. 

6. 

5. 

4. 

10. 

1.   P110 Cycle start 
2.   P111 First target 
3.   P113 Final target 
4.   P130 Soft start speed 
5.   P135 Step 1 ramp 
6.   P131 Step 1 speed 
7.   P136 Step 2 ramp 
8.   P132 Step 2 speed 
9.   P105 Zoom step 
10. P115 Cycle complete 
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7.7.4 Ergo ramp 

Ergo ramp is a two stage 

tightening with a constant 

increase of torque during the 

second stage. It is set 

automatically using the 

programmed P137 Ergo ramp value 

and the hardness of the joint.  

This strategy has the ergonomic 

advantage of giving the user the 

same reaction torque in the second 

step for both soft and hard joints 

when using the same Pset.  

In this example, the strategy ends 

with a P105 Zoom step, which 

reduces the risk of overshooting. 

 

 

7.7.5 Additional control options 

Rundown angle 

The Rundown angle option monitors the angle at P116 Rundown complete. 

If the P104 Rundown angle option From start is selected the rundown phase starts when the tool trigger is 

pressed. If P104 Rundown angle option From cycle start is selected the rundown phase starts when the 

torque exceeds P110 Cycle start. The acceptance window for the rundown angle is set with the P125 

Rundown angle min and P126 Rundown angle max. 

Zoom step 

The Zoom step option reduces tool speed when the torque approaches P113 Final target. Tool speed is 

reduced gradually towards the P138 Zoom step speed, which can be set between 2 and 20 percent of the 

maximum speed. Zoom step produces very accurate results, low scatter and quick tightenings. 

Combined Zoom step and Ergo ramp 

By combining zoom step and ergo ramp, the advantages of both strategies is achieved. Tightenings are 

precise and, at the same time, ergonomically correct for the operator. 

Zoom step and ergo ramp strategies can be combined for most types of bolted joints. 

Torque 

Tool 

speed 

1. P110 Cycle start 
2. P111 First target 
3. P113 Final target 
4. P137 Ergoramp 
5. P105 Zoom step 

1. 

3. 

2. 

5. 

4. 

Time 

Hard joint 
Soft joint 
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7.7.6 Rehit detection 

The rehit functionality is designed to detect re-tightenings of an already tightened joint, thereby avoiding 

batch counting errors etc. Two parameters have been found to be good indicators of a so-called rehit, tool 

speed and tightening angle. If, for two stage torque control tightenings, the tool does not get up to speed 

before the first target occurs and the angle of the second stage is not great enough the rehit alarm is 

activated. 

For two stage torque control tightenings, the speed must reach more than ¼ out of P131 Step 1 speed 

between P110 Cycle start and P111 First target or the angle between P111 First target and P113 Final target must 

be greater than 120 degrees to avoid a rehit alarm. For one stage tightenings, the speed at P110 Cycle start 

and the angle between P110 Cycle start and P113 Final target are used as indicators. 

The large angle interval required means that for most normal tightenings it is the speed condition that is 

met. Only for very soft joints with a low P111 First target or one stage tightenings is the angle condition met. 

For two stage angle control tightenings, the rehit alarm is activated if the tightening is aborted on P114 Final 

tq max and the tool speed has not reached ¼ of the P131 Step 1 speed between P110 Cycle start and P111 First 

target. For one stage tightenings, the speed at P110 Cycle start is used as indicator. 

The rehit functionality is valid for most, but not all, control strategies. 

7.8 Programming + 

Expand the Programming + branch. 

This section has applications for additional Pset functionality. 

The Current monitoring includes parameters regarding the motor 

current.  

PVT selftap includes settings when the joint has a torque peak at the 

start of the tightening.  

PVT monitoring include settings where the prevailing torque during the 

rundown phase is monitored, and PVT compensate settings where it is 

included in the calculation for the target torque.  

The PVT options can be used together or independently of each other.  

The Options window includes settings for tool tightening direction and 

some alarm settings, for example.  
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Gradient monitoring, for monitoring joint hardness.  

Yield control, available for PF 4000, for individual joint control at the 

second stage of the tightening.  

The Post view torque function makes it possible to monitor torque 

values during two specified angular intervals. 

7.8.1 Current monitoring 

Select Current monitoring and make 

suitable parameter settings. 
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The spindle torque is 

proportional to the motor 

current. By measuring motor 

current, a method of 

measurement that is independent 

of the torque transducer is 

achieved. The torque forming 

current is expressed as a 

percentage of the nominal 

current at T102 Tool max torque. 

With P200 Current monitoring 

selected it is possible to set an 

acceptance window for the 

torque as a redundant process 

control. 

 

7.8.2 PVT selftap 

In the Pset Programming + branch, 

select PVT selftap. 

When the joint has a torque peak at 

the start of the tightening it is 

recommended to use the PVT 

selftap monitoring option, P210 

Selftap, to ensure that the tightening 

achieves the right characteristics.  

PVT selftap also makes it possible to perform tightenings where the start torque is higher than the P113 

Final target or P114 Final tq max. 

The selftap interval starts at P110 Cycle start. During the P211 Selftap interval the torque has to reach at 

least the P213 Selftap min level but must stay below the P214 Selftap max limit. The P214 Selftap max is 

monitored in real time during the selftap interval. The P213 Selftap min value is evaluated against the 

selftap interval peak value at the end of the interval. 

To reduce the effects of noise, mean values are calculated from P212 Number of selftap windows. A small 

number of windows means that more samples are grouped together, hence one odd sample has less 

1. P201 CM min 
2. P202 CM max 
3. Acceptance window 
4. Torque (transducer) 
5. Torque (current) 

2. 

3. 

1. 

4. 

5. 

Time 

Torque 
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impact on the calculated mean value and vice versa. A high number of windows make the monitoring 

more sensitive; a low number filters more noise. 

 

Graph illustrating PVT selftap 

7.8.3 PVT monitoring 

In the Pset Programming + branch, 

select PVT monitoring. 

PVT monitoring is used when the 

joint torque has to pass through an 

acceptance window prior to P116 

Rundown complete in order to pass as 

a correct tightening.  

 

Torque 

Angle 

1. P211 Selftap interval 
2. P110 Cycle start 
3. P213 Selftap min 
4. P214 Selftap max  
5. Acceptance window  

3. 

 

 
 

5. 

 

 
 

4. 

 

 
 

2. 

 

 
 1. 

 

 
 



 Pset 

9836 3123 01 103 (428) 

With P220 PVT monitoring selected, an acceptance window for the torque before P116 Rundown complete is 

set. The P225 PVT max limit is monitored in real time during the P222 PVT monitor interval. The tool stops 

immediately if this limit is exceeded. The P224 PVT min limit is evaluated against the monitor interval 

average value at the end of the interval. Monitoring starts at cycle start or after selftap interval. 

 

To reduce the effect of noise, the mean values are calculated from P223 No of PVT windows. A high 

number of windows make the monitoring more sensitive; a low number filters more noise. 

 

Graph illustrating PVT monitoring 

 

1. P221 PVT delay interval 
2. P222 PVT monitor interval 
3. P224 PVT min limit 
4. P225 PVT max limit 
5. Acceptance window 
6. P110 Cycle start 
 

1. 2. 

5. 

4. 

3. 

Torque 

Angle 

6. 
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7.8.4 PVT compensate 

In the Pset Programming + branch, 

select PVT compensate. 

 

Via the PVT compensate function, PF allows the P111 First target, P113 Final target and P114 Final tq max to 

be compensated for the prevailing torque during the rundown phase.  

The PVT compensation value is calculated at P116 Rundown complete as an average torque from an 

interval preceding the P231 PVT comp point. The PVT compensation value is used as a base reference for 

the torque used during tightening, and the torque levels can change dynamically for each new tightening. 

 
When setting P231 PVT comp point larger than the total performed angle at rundown 

complete, the tightening will be aborted and the error PVT compensate overflow is 

triggered. 

As default, the tightening results are presented with the compensation value subtracted, but can be 

presented with PVT compensation value added by checking the box C503 Torque with PVT comp. 

 

Graph illustrating PVT compensate 

1. P116 Rundown complete 
2. P231 PVT comp point 
3. Compensation value 
4. Final torque with compensation value added 
5. Final torque 
6. First torque with compensation value added 
7. First torque 

1. 

2. 

3. 

5. 

4. 

6. 

7. 

Torque 

Angle 

3. 
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7.8.5 Options 

In the Pset Programming + 

branch, select Options. 

Make suitable parameter 

settings. 

See parameter list section Pset 

for information on parameters 

P241-P247. P240 see below. 

 

Tool rotation direction 

There are different variables that control the tool rotation direction: tool direction ring, P240 Tool 

tightening direction and P101 Tightening strategy.  

Tightening a screw or nut is in accordance with the selected P100 Control strategy. Loosening is equal to 

reversing the screw or nut. Loosening speed and ramp can be programmed. Reverse is a control strategy 

that loosens the screw or nut a programmed number of degrees. The direction is always the opposite of 

the tightening direction. 

The position of the tool direction ring at the time the tool trigger is pressed decides the direction of 

rotation. If the ring is in the right position, the tool rotates clockwise (CW), and counter clockwise 

(CCW) if the ring is in the left position. However, the direction does not change if the direction ring is 

moved while the tool is running. 

With the parameter P240 Tool tightening direction the default tightening direction of the tool is selected. 

This means that the tool tightens the joint clockwise (right-hand threaded joints) if “CW” is selected and 

the direction ring is in the right position. Select “CCW” for counter clockwise tightenings. 

 
The direction ring adjusts the rotation direction of the tool socket, while parameter P240 

Tool tightening direction decides whether it is a right- or left handed threaded joint. 

 
If different tightening directions are used on the same tool, there is a risk that the 

operator will use the wrong direction for a specific screw. This could lead to unexpected 

reaction forces in the tool that could be dangerous for the operator. 
 

With regard to reverse angle or rotate spindle reverse, the “active” direction is the opposite from the 

P240 Tool tightening direction. For instance, if “CW” is to be selected turn the direction ring to the left 

position. For safety reasons, it is not possible to loosen the joint with these strategies. 

The remote start input is connected in parallel with the tool trigger and has the same functionality. If 
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remote start input is used the tool trigger is disabled.  

If a digital input is used as start signal input, the direction ring and trigger on the tool are bypassed and 

the tool starts tightening in the direction programmed in the parameter P240 Tool tightening direction.  

The fieldbus tool start input works in the same way as the tool start from digital input. The 4-pin 

connector must be wired correctly. 

 
The 4-pin connector on Power Focus back panel must be wired correctly. 

Do not use tool start from digital input via an I/O Expander on a Synchronized tool 

group. Use only the four internal digital inputs. 

Remote start is not available for Tensor STB tools. 

 
 

 

For information on setting of P245 DS torque tuning factor, see section DS con. 

 

7.8.6 Gradient monitoring 

In the Pset 
Programming + 
branch, select 
Gradient monitoring 

to find additional 

parameters for 

monitoring joint 

hardness. 

 

With P250 Gradient monitoring selected, monitoring starts when P254 Start torque and P255 Angle offset are 

reached. 

The gradient is defined as the mean torque difference between each interval as defined by the parameter 

P253 Joint hardness. A lower value indicates a hard joint and a higher value a soft joint. The calculated 

gradient is evaluated against P251 Gradient torque min and P252 Gradient torque max.  
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When this function is activated, a 

gradient is calculated for each new 

torque and angle sample available. 

Tightening is aborted and a gradient 

high or low result is displayed if the 

gradient exceeds the limits.  

 

 

7.8.7 Yield control 

Yield control is activated by selecting the P100 Control strategy to Yield or Yield/Tq con (OR). The P101 

Tightening strategy can be set to One stage, Two stage or Quickstep. Yield control starts at P260 Start torque. 

In the Pset 
Programming + 
branch, select 

Yield control. 

 

 

The spindle runs in the chosen direction until the yield point is detected. Search for the yield point starts 

when the torque has reached the threshold P260 Start torque. The average torque over the measurement 

window P262 Window angle is calculated [1]. 

[1]  
NoSamples

T
T Mes

n
  TMes : Measured torque value in sample. 

The sample frequency in Power Focus is 2 kHz. If the number of samples in the window is too low for a 

calculation of a torque average, the tightening is aborted and an event code is displayed. The procedure of 

1. P254 Start torque 
2. P255 Angle offset 
 

Torque 

Angle 

4. 

3. 

1. 

3. 

4. 

2. 

3. Intervals set as P253 Joint hardness 
4. Gradient 
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average torque calculation is repeated after Step Angle degrees and the difference between every second 

value is calculated (TDIFF in the illustration below): 

[2] 2 nn TTTDIFF  

Each value of difference in torque is compared and the maximal difference (Tmax) is stored. The yield 

point is considered reached when a calculated difference in torque is less than Yield slope ratio (expressed 

as a percentage) of the current Tmax: 

[3] YIELDTratioslopeYieldTDIFF  max..  

If the parameter P264 Extra angle step is set, then the tightening is continued for the stated angle after the 

yield point is reached. The figure below illustrates the steps of the yield control. 

 
Prerequisites and limitations for Yield control; 

- Gold or ETX RBU  

- PF4000  

- Fixtured application, parameter T101 Usage set to fixtured 

For the STwrench tool interfacing with the PF, the yield strategy is programmed in a 

different way. Only parameter P264 Extra angle step needs to be set together with the 

torque target and limits, and the angle limits. Check with your local Atlas Copco 

representative how to setup your specific application. 
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7.8.8 Post view torque 

In the Pset Programming + branch, 

select Post view torque. 

Make suitable parameter settings. 

 

 

Torque 

1. 
2. 

3. 

4.  

6. 

2. 

2. 

2. 

2. 
3.      5.  

3. 

3. 

3. 

3. 

4. 

4. 

4. 

7. 

1. P260 Start Torque  
2. P261 Step angle  
3. P262 Window angle  
4. Torque difference (TDIFF) 

5. P264 Extra angle step  
6. P262 Yield slope ratio, example 100% 
7. P262 Yield slope ratio, example 70% 

Angle 
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Some joints have a torque 

peak prior of P116 Rundown 

complete. Post view torque 

function makes it possible 

to monitor torque values 

during two specified 

angular intervals. The 

interval start is defined as 

angle prior to P116 Rundown 

complete. Torque is then 

monitored for a specified 

angular interval. Evaluation 

(OK/NOK) is done when 

rundown complete is 

reached. 

Click Store to save the 

settings. 

 

 

When reviewing a trace in TTPF, for a tightening made using the post view torque strategy, the limits (two 
boxes according to P281-P285) are only shown if the trace is in Torque over Angle mode, not in Torque over 
time mode. 

7.9 Pset setup 

Expand the Pset setup branch to access parameters handling 

administration, Pset results and comments.  

 

 

1. P281 Post view min torque 
2. P284 Post view max torque 
3. P283 Post view min monitor interval 
4. P286 Post view max monitor interval 
5. P282 Post view min monitor start 
6. P285 Post view max monitor star 
7. P116 Rundown complete 

7. 

1. 

4. 

5. 
6. 

2. 

3. 
Angle 

Torque 
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Add a name for the Pset 

(optional). 

This section also contains 

options for View existing Pset, 

Create new Pset, Copy Pset and 

Delete Pset. 

Click Delete Pset result to 

select the Pset result to remove 

from the Power Focus memory. 

When clicking Delete all results 

a confirmation window 

appears. Select Yes to accept or 

No to abort operation. 
 

The Pset specific comments are 

shown here.  

When parameter C600 is set to 

Pset comments, a comment can 

be entered each time a Pset is 

changed and stored. 

The Comment dialog box 

appears after a change, when 

pressing Store. 
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7.10 Statistic programming 

Expand the Statistic programming branch. 

In this branch it is possible to define conditions to be included in the 

statistical calculations for the tightenings (Psets). 

Click Store to save the settings. 

 

 

7.11 Running a Pset 

To run (activate) the Pset, select the Pset in the Selection panel or via any configured Pset control source. 

This must correspond with the selected source in C200 Pset, see information in section Controller 

Configuration and parameter list Configuration. 
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8 Multistage 

The Multistage feature offers a dynamic link to up to eight Psets in several steps for 

performing a sequence of operations. 
 

A typical application scenario such as joint conditioning, where the fastener is run to a torque level of 10 

Nm then backed off by 180 degrees and then fastened to a final torque level of 14 Nm. This operation 

would be regarded as a three step Multistage. This is performed by the operator when in a hand held 

configuration by depressing the trigger in the normal way until the end of the operation, or alternatively 

when used in a fixed operation where the start signal is either latched or externally triggered. 

 

 
When running a Multistage the ring button must always be in the CW direction, even if 

the first Pset is in the CCW direction. 

 
 

 

The Multistage tightening results and statistics are a combination of all the results from the different Psets 

within the Multistage. The default setting is all results from the last Pset in the Multistage.  

Individual Pset min and max limits function in all stages and the tool shuts off when a max limit is 

exceeded (or for any reason if the min limit is not reached) as per normal operation. The result displayed 

is then taken from the stage where the shut off occurred. 

 
This section includes screenshots from ToolsTalk PF. The screenshots show examples of 

parameter settings and are NOT intended to be generally applicable. Check with your 

local Atlas Copco representative how to set up your specific system environment.  

See parameter list section Multistage for a description of all available Multistage options. 
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8.1 Create new Multistage/Open Multistage 

In the PF Map, mark Multistage, 

right-click and select Create New 

Multistage. Alternatively, double-

click on an existing Multistage to 

open the configuration window. 

 

 

Select New Multistage ID, enter 

the New Multistage name 

(optional) and click OK to open 

the Multistage window. 

 

Click Add to select Psets to be included in the Multistage. 

In the left upper window part, make selections for Options, Results and Statistics (mark to activate). 

Click Store to save the settings for the Multistage. 

 
The selection of a Multistage (via PC, Selector, Digital input etc.) is handled in the same 

way as a Pset. 
 



 Multistage 

9836 3123 01 115 (428) 

 

 

 

The Multistage strategy is not supported 

by Power Focus with wireless tools. 
 





 Controller 

9836 3123 01 117 (428) 

9 Job 

The Job function is advantageous when an object has bolts or screws that require different 

torque and angle values for tightening. A Job is useful when an object needs different 

Psets and Multistages. Instead of manually selecting each Pset or Multistage, the Job 

functionality keeps Psets and Multistages in a predefined order.  

Power Focus allows 50 Psets/Multistages in a Job, and the storage of 99 Jobs (with the 

memory setup it is possible to store up to 400 Jobs, see section Memory).  

The Job function is RBU-dependent. 

 

A Job is normally pre-programmed (static). A static job is created and stored in the Power Focus or 

from ToolsTalk PF. A dynamic job is created externally and sent to PF via Open Protocol for 

immediate execution. The lifetime of a dynamic Job is the time for the Job to be executed.  

For more information on Open Protocol, see section MID 140 Execute dynamic Job request in the 

Power Focus Open Protocol User Guide. 

 
This section includes screenshots from ToolsTalk PF. The screenshots show examples of 

parameter settings and are NOT intended to be generally applicable. Check with your 

local Atlas Copco representative how to set up your specific system environment.  

See parameter list section Job for a description of all available Job options. 
 

9.1 Job concepts 
The Job function in Power Focus can be defined by two categories, Standalone Job and Cell Job. 

Standalone Job is when just one PF is involved in the Job, and Cell Job is a Job in which several PF units 

are involved. The Psets/Multistage included in a Job can be selected from a stand-alone PF or from several 

PF units in a Cell.  

All PF units that perform a Cell Job must belong to the same Job group. A Job group consists of a 

maximum of 20 controllers within the same Cell (see section Controller for more information). 

A single PF can only belong to one Job group, but it is possible to create several Job groups in the same 

Cell. 

In a Job group, all included controllers are Job members. One of the Job members acts as a Job reference, 

the others act as Job clients (see figure on next page). The Job reference retains a list of all Psets and 

Multistages available for all Job members. The Job reference is the main controller and remote controls 

the Job clients. 



Controller 

118 (428) 9836 3123 01 

Job example 

The figure to the right shows an example of an object 

with bolts that require different torque values: 

Four bolts that require a torque of: 39 Nm 

Three bolts that require a torque of: 70 Nm 

One bolt that requires a torque of: 88 Nm 

For this example three different Psets have to be 

created: 

 Pset1: final target 39 Nm 

 Pset2: final target 70 Nm 

 Pset3: final target 88 Nm 
 

 

By combining the Psets in the above example, the following Job list is created (see table below). 

PF Pset Pset 
name 

Batch 
size 

Max cohered NOK 

1 1 Pset1 4 3 

1 2 Pset2 3 - 

1 3 Pset3 1 - 

 

The Job in this example is performed by one single PF. “Batch size” means the number of times the 

tightening should be repeated with the same Pset. JOB OK is signaled when all tightenings within the 

Job have been performed correctly. 

If P153 or M208 Max coherent NOK’s, or P151 or M203 Batch size are used for the Psets or Multistages 

included in the Job, these settings are ignored by the Job setting. The same is true for other Job 

settings.  

 
If the torque controller is powered off before the completion of the Job, 

the Job is lost. 
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9.2 Job configuration 

9.2.1 Creating a Job group 

The PF units in a Job group must be working in the same Cell. Therefore, before creating Job groups a 

Cell has to be configured (see section Controller for more information). 

After cell configuration, the next step is to create a Job group including Job reference and Job client. 

In the PF Map, select Controller > Network. 

To define a Job reference, set the parameter C316 Job reference IP address equal to the parameter C300 IP 

address of the same controller. 

To define a Job client, set the C316 Job reference IP to the C300 IP address of the Job reference controller. 

Click Store to save the settings and reboot PF. 

 

 

 

Job reference settings 

 

Job member 

settings 
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9.2.2 Creating a new Job 

 
With the configuration setup it is possible to store up to 400 Jobs (see section Memory for 

more information). 

When creating a Cell Job the programming has to be done in the Job reference controller. 

Right-click Job in the PF Map 

and select Create new Job. 

Alternatively, double-click on an 

existing Job to open the Job 

configuration window. 

Every Job has a unique ID 

number. 

 

Select New Job ID in the drop list, 

give the Job a name (optional) 

and click OK to open the Job 

window. 

 

The upper part of the Job window shows the available Psets and Multistages and Job list, see J300 Job list 

in parameter list section Job for a description. 

Select Psets or Multistages and add them to the Job list by clicking on either Manual select or Auto select. 

With manual select the Pset is selected by the setting in C200 Pset, with Auto select the Pset is 

automatically selected. A precondition for Auto select is that J301 Job type is set to Forced. It is possible 

to change between manual and auto select by clicking in the table in the auto select column.  

To change Batch size for a Pset/ Multistage, click in the column in the Job list table and enter a value. 

To specify Max coherent NOK’s, click in the column in the Job list table and enter a value. 
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Auto select is not allowed for free order Jobs, with two or more Psets/Multistages selected 

from the same Power Focus.  

The batch size defined in Job overrides the batch size defined for a specific Pset/Multistage 

(see parameters P150 Batch count and M202 Batch count. It is not recommended to use the 

batch count function in Job and Pset/Multistage settings simultaneously. 
 

 

Continue and make settings for the options in Configuration, Batch, 

Timers, Line control, Result and View. See parameter list section Job for a 

description of the parameters. 

 

J330 Use line control must be set to Yes before the digital inputs and relay 

settings for line control can be activated. 
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9.2.3 Select Job 

Power Focus allows two different possibilities for Job selection; C201 Job and C202 Job override. To be 

able to select a Job at least one of the two parameters has to be set. The parameters are set from  

PF Map>Controller>Configuration>Select source. The system remembers the most recently selected source 

until the Job is either completed or aborted. After a Job has been started, it is not possible to select a new 

Job until Job done or Job aborted. 

C202 Job override has a higher priority than C201 Job. If a Job is selected from C202 Job override, then it 

always terminates a present Job and is selected instead. 

If a Job is selected from the select source in C201 Job, then it is only possible to select a new Job from 

the same source before the first tightening in the Job has been done (or after the Job has been ended). 

During the Job, it is only possible to select a new Job from the select source in C202 Job override. 

If a Job is selected from the select source in C202 Job override, it is only possible to select a new Job from 

the same source after the selection and during the Job. 

If a Job has been 'overridden' it will be aborted before the new Job is selected. 

 
To be able to select/abort a Job from the PF Graph display, C201 Job or C202 Job override 

must be set to “PF keyboard”. 
 

 

 
A Cell Job can only be selected or aborted from the Job reference.  

To be able to select a Cell Job the Job reference needs to communicate with the Job 

clients that form the selected Job. Otherwise the Job reference will not start the Job. All 

the Job clients detect communication failure with the Job reference and vice versa. If the 

Job reference loses communication with a Job client it will try to re-establish the 

communication. 
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Two cases when the Job reference loses the communication with a Job client during a running Job: 

 If the disconnected Job client has tightenings left to perform, the Job reference will abort the running 

Job immediately. 

 If the disconnected Job client did not have any tightenings left to perform, or had no part in the 

running Job, the Job continues. 

If a Job client loses communication with its Job reference, the Job client immediately stops running the 

Job and locks the tool. 

 
To select the Job from ToolsTalk PF, set 

parameter C201 Job to Ethernet/Serial. 
 

 

Select the Job to 

run in the Selection 

panel. 

 

 
If selecting an empty Job, without any Pset/Multistage included, Power Focus will 

send a Job OK signal. 
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In ToolsTalk PF, click on the arrow to the right of the Monitor icon and 

select Job Monitor. 

Job monitor displays the selected Job and provides a management 

function. 

For description of Job off, Restart Job, Decrement, Increment, Bypass 

and Abort Job, see section Functions in the Job monitor. 

 

 

9.3 Functions in the Job monitor 

 Function Description 

Restart Job This function allows the user to restart the running Job without needing to reselect the Job. All batch counters 

in the running Job are reset and the Job timer restarts. 

Decrement Batch decrement makes it possible to redo the last tightening/increment in a Job. The batch counter of the Pset 
or Multistage is decreased by one step. It is not possible to go back one step after the Job has been completed. 

The Job batch decrement function is accessible only from the Job reference controller. 

Increment Batch increment makes it possible to increment the batch counter value of a Pset/Multistage without 

performing a tightening. It is possible to complete a Job by using the batch increment function.  

After performing batch increment in a Job, the Job status will be NOK (not OK) when J311 Batch status at 

increment/bypass is configured to NOK, If set to OK, the Job status can be OK. 

In a Job with free order, only the Job client with the active Pset/Multistage is able to utilize batch increment. 

In Jobs with forced order, the Job client with the active Pset/Multistage and the Job reference are able to utilize 
batch increment. 
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 Function Description 

Bypass Bypass skips a specific Pset/Multistage in a running Job, independently of batch size. 

The batch counter will be set equal to the batch size value and the Pset will be considered as completed when a 

Pset/Multistage is bypassed. The Job status will be OK/NOK depending on the parameter J311 Batch status at 

Increment/bypass. 

In a Job with free order, only the Job client with the active Pset/Multistage is able to use the bypass function. 

In a Job with forced order, the Job client with the active Pset/Multistage and the Job reference are able to use 
bypass the function. 

Abort Job Abort Job is only accessible via the Job reference controller. Abort can be an external signal as well as an 

internal order (see J320 Max time to start Job and J321 Max time to complete Job). 

When a Job abort request is received the Job functionality will wait for completion of the ongoing tightening 
result before aborting the Job. 

Job off  This function offers the possibility to turn off the Job function and unlock all involved tools. 

Running Job: When selecting Job off for a running Job the tool/tools will always be enabled. The Job reference 

will order all Job members to select the latest Pset from the digital input, fieldbus or selector (in case one of 

these is C200 Pset) otherwise the latest selected Pset in the Power Focus will remain. 

No running Job: The Job reference will unlock the tools of all Job members. The Job reference will also order 

Job members to select the latest Pset, which was selected from the digital input, fieldbus or selector (in case 
one of these is the C200 Pset). Otherwise the latest selected Pset in the Power Focus will remain. 

When a PF is in Job off mode it is possible to perform tightening with any existing Pset or Multistage. As long 

as the Job reference is in Job off mode the user cannot select a new Job, the Job off mode must first be 
inverted. 

The only occasion when the Job off function affects the Job clients is when they have lost communication with 

their Job reference. In this case there is the possibility to unlock the Job clients locally by using the Job off 
function. 

 

Only the Job reference will remember the Job mode after a 

reboot. 
 

Job status 

(information) 

Job OK: Received if all Psets/Multistages included in the Job have been correctly performed, alternatively if 

batch increment/bypass has been used (presupposed that batch increment/bypass is configured as an OK 
event). 

Job NOK: Received if any Pset/Multistage included in the Job has not been correctly performed and if J310 

Increase batch at tightening  is configured OK+NOK. Alternatively it is considered as NOK (Not OK) if batch 
increment/bypass has been used (presupposed that Batch Increment/Bypass is configured as an NOK event). 

Job aborted: Received if a Job is considered aborted. 

9.4 Unlock the tool 

Unlock the tool by selecting a new Job, deleting all existing Jobs or select Job off.  

It is only possible to unlock the tool from the Job reference. 

 
It is not possible to unlock the tool by rebooting PF. 
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10 Controller 

The Controller section contains configurations common to all tightenings and is unique to each 

PF. 
 

 
This section includes screenshots from ToolsTalk PF. The screenshots show examples of 

parameter settings and are NOT intended to be generally applicable. Check with your 

local Atlas Copco representative how to set up your specific system environment.  

See parameter list section Controller for a description of all available Controller options. 
 

10.1 Information 

Expand the Controller branch in the PF Map. 

Double-click Information. 
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This window contains information 

about the ToolsTalk PF Software and 

the Power Focus Hardware. 

 



Controller 

128 (428) 9836 3123 01 

10.2 Configuration 

In the PF Map Controller branch, double-click on 

Configuration. 

 

Make settings for Select source.  

Selector: A selector configured on the I/O bus.  

Digin: A digital input can be a device on the I/O bus, an 

internal digital input, an ST GPIO device or a Logic 

configurator.  
 

Ethernet/Serial: ToolsTalk, Open protocol, or a customer specific protocol. 

Identifier: A scanner configured. See section Identifier.  

Fieldbus and Fieldbus selector: See section Select Pset from fieldbus and set batch size. 

PF keyboard: The Pset is selected from directly from the PF Graph (Pset + or -), or Compact (F-buttons). 

ST selector: An ST selector attached to the tool configured in Mode 2.  
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Make settings for Tightening, Loosening and 

Positioning. 

The parameter C230 OE positioning type defines 

how the open-end position is reached. In all 

C230 strategies the tools rotates slowly the first 

30° to detect that the tool is not in contact with 

the nut. Thereafter the tool rotates faster; the tool 

is stopped if the P171 Limit value is exceeded. 

The C230 parameter can be set to: 

Forward - The tool rotates forward to open end 

position  

Reverse - The tool rotates reverse to open end 

position 

For these two options, if the P171 Limit value is 

exceeded, the event E122 Open end positioning 

failure is triggered. 

 

 
To avoid that a nut is incorrectly loosened when the Forward / Reverse strategy is used, 

set P171 Limit as low as possible as long as the inner friction in the tool is exceeded. 
 

Reverse Torque Based - Open end position is 

found via a slow reverse rotation. However, if 

the P171 Limit value is exceeded before the 

open end position is found, the home position 

relay is set, but the event E122 Open end 

positioning failure is not triggered. 
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Make settings for Batch and 

Startup. 

Click Set under Date and Time to 

store computer and user time to 

PF. 

Note! 
If using Toolsnet, Toolsnet will 

act as the Date and Time master 
synchronizing the time in the PF 

to the time in Toolsnet. 

Click Events to configure which 

events to log and show. 

Click Store to save settings. 

 

10.3 Network 
Power Focus uses both Ethernet and serial communication, and works together with ToolsTalk PF and 

database applications such as ToolsNet, etc. 

The Cell and Net concept allows all PF units on an assembly station to communicate and work together. 

See also sections Cell and Net, Job and Sync. 
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In the PF Map Controller branch, double-click on Network. 

 

Make settings for Ethernet and Cell. 
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If used, activate and setup Multicast. 

 

Make settings for Open Protocol, Tools 

Talk and the Acta port.  

If used, activate and setup ToolsNet. 

Click Store to save settings. 

 

10.3.1 Cell and Net configuration 

The Power Focus software offers extended networking possibilities. The Cell and Net concepts are part 

of the RBU Gold and RBU Silver types. 

Ethernet TCP/IP networking makes it simple to program and overview all PF units in the network from 

a PC with ToolsTalk PF software installed. All data traffic from Power Focus could also be collected 

and compiled by ToolsNet. 

Via the Cell concept, it is possible to arrange all PF units at an assembly station in a group, giving extra 

functionality to the work station. The Net concept enables functionality to group all cells on the 

assembly line into one net. 

The figure below illustrates a cell consisting of four PF Graph controllers and a switch. 
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A cell consists of one Cell reference, a maximum of 19 Cell members, thus a total of 20 PF units. Cells 

can then be grouped into Nets; the maximum number of cells in a net is 1000. Each net has a Net 

reference. One PF can function as both Cell reference and Net reference. 

Every cell has a Cell identification number (Cell ID) unique to the network. Within a cell, every PF has 

its own unique channel identification number (Channel ID). With the PF Graph, the user can browse 

through the different channels and program and view the result from any other controller in the same 

cell. 

The Cell reference and Cell members can be configured through a PF Graph user interface or ToolsTalk 

PF. 

 
All PF units in a Cell must have the same software version and the same RBU-type 

installed. 

 
When configuring a remote PF, make sure it is not in use by anyone else. Otherwise it 

might lead to the damaging of the tool or a joint. It might also lead to personal injury. 
 

The RBU Gold also enables Sync functionality (see section Sync) and running Cell Jobs (see section 

Job). 

The figure below illustrates an example of a factory network configuration, a Net with three Cells. Each 

Cell has a Cell reference and three Cell members. One Cell reference also functions as the Net 

reference. 
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Net with three Cells 

 

1. Cell 

2. ToolsNet 

3. ToolsTalk 

4. Router 

5. Switch 

6. Cell master 

7. Net master 

 

Network setup 

 
This section includes screenshots from ToolsTalk PF. The screenshots show examples of 

parameter settings and are NOT intended to be generally applicable. Check with your 

local Atlas Copco representative how to set up your specific system environment.  
 

To set up a network, PF must have an IP-address. See section Connecting a PF.  
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Open PF Map>Controller>Network.  

Set the C300 IP address, C301 Subnet mask and C302 

Default router. 

Set the C312 Cell reference IP to the IP address of the 

Cell reference. 

Set the C315 Net reference IP to the IP address of the 

Net reference. 

 
To define a Cell reference or Net 

reference, set the Cell reference IP /Net 

reference IP the same as its own IP 

address. 

Set C310 Channel ID to a number unique within the 

Cell (1-20). 

C311 Channel name is optional. 

 

Set C313 Cell ID number to a number unique within the network (1-1000). Only available when the controller 

is the Cell reference.  

C314 Cell name is optional. Click Store to save the settings.  

 
After all the settings have been made, restart all Power Focus units. 

 

Power Focus connection 

When connecting to a controller, Cell reference or Net reference make sure that the following settings are 

correct. 

On the Menu list, open Option>Settings. 

Set the Controller IP address of the Power Focus to connect. 

Under Ethernet setup, check whether the connected Power Focus is a controller, Cell reference or a Net 

reference. 

To connect PF, Cell reference or Net reference, click the Connect symbol. 

When a Cell reference or Net reference is connected, clicking the corresponding line in the PF Map 

expands the Cell tree or Net tree. 
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If the C315 Net reference IP address has not been entered in a PF 

when adding it to the network, the added PF will be shown as a 

controller in the PF Map list of the Netmaster anyhow.   

 

 

 

10.4 COM ports 

In the PF Map Controller branch, double-click on COM 

ports. 

Make settings for Serial 1 and Serial 2. 

Click Store to save settings. 
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10.5 Display 

In the PF Map Controller branch, double-click on Display 

to make settings for the controller display.  
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Make settings for Presentation, Result 

view, Keyboard and Power save.  

Note that there are more selections 

available on the controller display. 

See parameter list section Display. 

Click Store to save settings. 

 

Make settings for screen colors:  

Color theme 

Background color for OK result 

Foreground (text) color for OK result 

Background color for NOK result 

Foreground (text) color for NOK 

result 

Click Store to save settings. 
 

10.6 Memory 

 
All data stored in PF, except parameters C300 IP address, C301 Subnet mask and C302 Default 

router, will be erased when changing memory setup. Therefore, use the ToolsTalk PF function 

“Store PF to file” to save the existing data configuration (including Psets, Multistages, and 

Jobs). The data can later be retrieved via function “Read PF from file”. 

 
When changing the memory setup PF must be rebooted for the changes to take effect. It is 

necessary to “Read PF from file” twice and reboot PF one extra time. 

It is recommended to reboot immediately. 

Configurable memory is only available for RBU Gold and RBU Silver. 
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Besides the 'default configuration' and 'totally configurable' (which gives the 

possibility to manually configure the Power Focus memory freely), Power Focus provides seven 

more configurable memory options; More Psets, More Jobs, More Results, More Events, More Identifiers,  

QDAS, and Pset comments. 

 

Selection Psets Jobs Results Events Identifiers Statistical 
events 

Identifier 
result parts 

Traces 

Default configuration  250 99 5000 100 100 100 1 8 

More Psets 300 100 4000  100 100 100 1 8 

More Jobs 100 400 4000 100 100 100 1 8 

More results 100 100 6000  100 100 100 1 8 

More events 200 100 5000  500 100 100 1 8 

More identifiers 200 100 5000  100 400 100 1 8 

Totally configurable 1-600 1-700 1-9000 1-800 400 1-500 1-4 1-100 

QDAS 250 99 4000 100 100 100 1 8 

Pset comments 200 100 5000  100 100 100 1 8 

 

Number of identifiers is the maximum number of significant identifier strings available for identifier Type 1 

(Identifier Type 1 is used to trigger Psets, Multistages or Jobs). Number of identifier result parts is the 

amount of Identifier strings to be stored together with the tightening result. For more information, see 

section Identifier. 

When increasing database elements, a decreasing of other elements might be necessary. For instance, if 

6000 results are required it is not possible to have more than 100 Psets (option more results). 

Memory setup 

Store existing data, see Store PF to file, including Psets, Multistages, and Jobs before changing the 

memory setup. The data can later be retrieved, see Read PF from file. 
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In the PF Map, select Controller>Memory. 

Make a selection for C600 Type. To manually configure the 

memory, select Totally configurable. 

Click OK to continue. 

 

Select number of Psets, Jobs, Results, 

Identifier result parts, Events, Statistical 

events and Traces. 

 
Indicator estimated memory 

usage is automatically updated 

in percent (a maximum of 100 

percent is allowed). 
 

 

Ensure that all data is stored before saving the settings.  

 
When changing the memory setup, PF must be rebooted for the changes to take effect. It is 

recommended to reboot immediately. 
 

After reboot, make a restore of the previous settings through function Read PF from file, see section Read 

PF from file. 
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Memory reset 

Store important data, see Store PF to file, including Psets, Multistages, and Jobs before resetting the 

memory. The data can later be retrieved, see Read PF from file. 

In the PF Map, select 

Controller>Memory. 

To reset the memory or parts 

thereof, click the corresponding 

button. 

 
 

10.7 Accessibility 

In the PF Map Controller branch, double-click on 

Accessibility. 
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Make settings for Password. 

Passwords should have between 1 and 8 characters (letters 

or numbers) and are case sensitive. There are separate 

passwords for communication and setup parameters. An 

identical password can be set for both. In this case only 

one password will be prompted in TTPF, but still both in 

PF graph. The password handling is configured with the 

two parameters C800 Use and C801 Entry. Change to 

C800 resets unused passwords. There is no prompting for 

empty passwords, both in PF graph and TTPF. When 

password Use is activated (other than: 'No') and Entry 

scope is set to Tools Talk, access to all parameters from 

PF keyboard is restricted even with empty passwords.  

 
When uploading/downloading PF 

configuration to/from a file, password strings 

will not be stored and restored. Software 

update performed by Software Loader will 

clear passwords in the unit but not C800 and 

C801. 

 
PF Compact units have access to password 

protected parameters only via TTPF, due to 

simplified keyboard functionality. 

 
FieldBus configuration is accessible only from 

TTPF and is not protected by any type of 

password. 

 
Total memory reset defaults all password 

settings. 

Click Store to save settings. 
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11 Tool 

The Tool section contains information for Tensor tools connected to Power Focus. The 

information available through PF includes for example general tool information and service 

status, as well as hardware- and software configuration.   

 
This section includes screenshots from ToolsTalk PF. The screenshots show examples of 

parameter settings and are NOT intended to be generally applicable. Check with your 

local Atlas Copco representative how to set up your specific system environment. 

See parameter list section Tool for a description of all available Tool options. See tool 

specific information for more information about the options for each tool. 
 

The tool parameters are visible depending on which tool is connected. For STB, most parameters are 

invisible when the tool is offline. 

11.1 Tool information 

Expand the Tool branch in the PF Map. 

Double-click on Information. 
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The Model and Motor sections contain 

information about the Tensor tool 

connected to PF. 

 

The Software section contains information 

about the application- and boot-code 

version for the tool. 
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11.2 Tool configuration 

In the PF Map Tool branch, double-click on 

Configuration. 

 

The following submenus are available: 

 

 

 

11.2.1 Tool start and Accessory bus 

Make settings for Tool 

start and Accessory 

bus. 

The main purpose of 
T200 Tool start select 

source option “Safety 

trigger” is to ensure 

that both hands are 

placed on the tool 

while it is running, and 

that the tool stops as 

soon as one hand is 

released.  

 

The safety trigger is suitable for applications where a high level of safety is desired.  

The safety trigger function requires the start trigger and safety trigger buttons to be pushed 

simultaneously in order to start the tool. The second button must be pushed within 0.5 seconds from 

pushing the first button, the order is arbitrary. If the safety trigger button or the start trigger is released 
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while the tool is running, the tool stops immediately. 

Once the tool has been started, the safety trigger function requires both buttons to be released before the 

tool can be started again. 

A safety trigger button is mounted on the ST tool and connected to GPIO 4. The parameter is only 

accessible when GPIO 4 is set to “Off”. 

The main purpose of the T201 Timer enable tool function is to prevent unintentional starting of the tool. It 

is immune to tape, i.e., it is not possible to override the function by putting tape on the “enable button”. 

The timer enable tool is suitable for applications where a reasonable level of safety is required and 

applications where both hands cannot remain on the tool during tightening (one hand must be used to 

hold the working piece during tightening etc.). 

When the T201 Timer enable tool is activated, the tool is disabled by default. In order to enable the tool, the 

user must enable the tool using the digital input function Timer enable tool.  

Once enabled, the tool will remain enabled for the configured period of time (timer enable tool time). As 

soon as the time period expires, the tool will be disabled again. 

If the tool is started during the period it is enabled, it remains enabled while it is being run. When the 

tool is stopped, it remains enabled for an additional period of time (according to release and 

configuration). This behavior is comparable to key lock functionality on cellular phones; once unlocked, 

the keys are locked when a given period of time has passed since the last key press. 

 
The “Timer enable tool” function was previously called “safety trigger”. 

Digital input Timer enable tool must be changed from status “low” to “high” in order to 

enable the tool (the tool will not remain enabled when the time period has expired, even if 

input to the digital input Timer enable tool remains high ). 
 

With T203 Direction alert and T204 Alert type parameters, a sound or an indicator can be configured to notify 

the operator of the direction of the tool. 

Parameter T210 Mode defines the function of the Tool accessory bus. 
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11.2.2 Sound and buzzer 

In the Sound window, the settings include the type of sound and the event that should trigger the sound.  

 

Make settings for Sound. 

Enable/disable sound and adjust the volume. 

Two types of sound files can be stored in the Power Focus memory, buzzer and sound (stream) waves. A 

Buzzer wave is a frequency-based sound generated by the tool. The buzzer wave can be programmed by 

the user (as default one buzzer is included in Power Focus). A Sound (stream) wave is a pre-programmed 

“wav file” that can be downloaded from disk (hard drive/ file). It is possible to use a microphone to 

record wav files and download them to Power Focus. 

To select an existing buzzer wave, select an ID number from the drop down menu (as default one buzzer 

wave is included). 

To create a new buzzer wave, click Add buzzer. It is possible to store up to 10 buzzer waves in Power 

Focus. 
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The BuzzerWave window appears. 

Give the Buzzer wave an E100 Name 

(recommended). 

Select E101 Frequency, E102 Time On, E103 Time 

Off, E104 Repetition and E105 Volume.  

The volume is a relative (in percent) of parameter 

T221 Volume, which could be set to high, medium 

or low. T221 Volume can be found in the sound 

setup window. 

After every change in setup, click Store to save 

settings into the tool memory.   

Click Play sound to listen to the buzzer sound in the tool (if not working, try to click Store). 

Click Delete buzzer wave to remove the selected buzzer. Click Store to save settings. 

To create a sound (stream) wave, select Add sound in the Sound window. To select an existing Sound 

wave, select an ID number from the drop down menu. 

 
It is possible to store up to 10 stream waves in Power Focus. 

 

The Create new sound window appears. 

Select a New sound ID and type new sound name (recommended). Click OK. 

The Wave window appears. 

Click Open wave file and search for the wave 

file to use on disk (hard drive/file). 

 
The wav file can use up to 8 bits and 

a frequency of up to 8000 Hz. It 

provides only mono playing and has 

an interval of maximum 3 seconds. 

Click Play sound to listen to a sound file. The 

sound is played in the tool. 

Click Delete sound to remove a sound file. 

Click Store to save settings. Close window. 
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To connect a 

configured buzzer or 

sound to an event, 

click Add in the Sound 

window. 

Select a digital output 

(relay) in the Event 

list. 
 

Select a sound or buzzer wave (created earlier) in the Sound Type list to connect to the event. 

Select a priority from the Sound Prio list connected to the specific sound event. 

 
The Sound Prio setting controls which sound event that has the advantage in the case 

of a collision between more than one sound file during tool operations. 

Click Remove to remove an event from the list. 

Click Store to save changes in the Window. 

 

11.2.3 Tool function buttons 

Make settings for Function buttons. 

The T230 – T235 function button settings are 

available for ST and SL tools. There are three 

possible user interaction types for this button; 

single push, double-push and pressed. (For 

available relay functions, see section Digital 

I/O and fieldbus items.) 

The parameter T236 Push detection interval states 

the maximum time (in milliseconds) between 

the button pressed and the button being 

released, for push to be detected. Parameter 

T237 Next push interval states the maximum time 

(in milliseconds) between the button being 

released after the first push and the button 

pressed again, to detect double pushed. 
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Button pressed

Button released

Push detection interval
Next push interval

Time

Timeout

Single push

 

Single push - the button is pressed down and released before the T236 Push detection interval expires. The 

T237 Next push interval expires before the button is pressed again. 

Button pressed

Button released

Next push interval

Time

Button pressed

Button released

Push detection interval

Double push

Push detection interval

 

Double push - the button is pressed down and released before the T236 Push detection interval expires. 

Then the button is pressed down before the T237 Next push interval expires and is released before the T236 

Push detection interval expires. 

Button pressed

Button released

Push detection interval

Time

Pressed

Timeout

Released

 

Pressed - the button is pressed down and is kept down for a longer time than the T236 Push detection 

interval. When the Push detection interval expires, the button function is considered to be pressed until it is 

released. Notice that if no function is configured for single push or double push in the current tool 

direction, the Push detection interval is ignored and the button function is considered to be pressed as soon 

as it is pressed down. 

It is possible to configure a digital input function, similar to the digital inputs on PF, for each user 

interaction type and tool direction. Tool direction is shown by the direction ring on ST tools and by the 

direction LED on SL tools. 
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From the digital input functions point of view, single push and double push user interaction types do 

generate pulses. This means that they do not have duration where input to the digital input function 

remains high. Single push and Double push user interaction types are therefore not suitable for digital 

input functions that are intended to “follow” the status of the button. The pressed user interaction type 

provides duration; i.e. input to the digital input function remains high as long as the function button is 

pressed and goes low when it is released. It can therefore be used with digital input functions intended to 

follow the button status. 

Feedback is provided to the user to indicate which user interaction type was detected. If a Single push is 

detected, the tool LED’s flash once and if a Double push is detected, the tool LED’s flash twice. 

Feedback is only given when there is a function configured for the currently performed user interaction 

type and current direction. For example, if a Double push is performed while operating in CCW mode, 

but T235 CCW double push is set to ”Off”, no response is given. 

For SL tools, the function button normally is configured to change tool direction in some way (“toggle 

CW/CCW”, “toggle CW/CCW for next run” and “set CCW”). 

11.2.4 Blue LED 

Make settings for Blue LED (if applicable). The Blue LED indicates when a predefined event occurs. The 

events are relays connected from Power Focus to the tool. 

To configure the T240 Events click Add and select type of Event, Duration and Time (if applicable).  

Click Store to save settings. 
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11.2.5 Tool illuminator and lights 

Make settings for Illuminator and Lights. 

The illuminator, which is a group of LEDs in the 

front of SL and ST pistol tools, provides light for 

the operator during tool operations. 

The parameter T250 Illuminator mode can be set to: 

 Off - illuminator is constantly off. 

 On - illuminator is constantly on. 

 Tracking event - illuminator follows status of 

specified T251 On event. 

 Event controlled - illuminator is turned on when 

specified T251 On event occurs and is turned off 

when specified T252 Off event occurs. If T252 Off 

event is set to ”Off”, the expiration of T253 On 

time turns off the illuminator.  

 

The parameters T251 On event, T252 Off event and T253 On time are related to the input from T250 

Illuminator mode.  

T253 On time sets the maximum time for the illuminator to remain on since the last occurrence of T251 

On event, if T250 Illuminator mode is set to Tracking event or Event controlled. 

The parameter T260 Control type is used to define the control source for the Tool LED light. The T260 

parameter can be set to: 

 PF-controlled 1 - Light is controlled via specified limits for torque and/or angle 

 PF-controlled 2 - Customer specific option 

 PF-controlled 3 - Tool LED’s used to acknowledge Event Code Tightening NOK / Tightening OK  

 Light off - Tool LED’s functionality disabled. 

The parameters T261 Use ON time and T262 ON time is used to specify that the tool LED's should light 

for a specified period of time (on) or continuously (off) after a tightening. 

T263 Indicator, used to show selected Pset (Pset 1-8) on the tool LED's. Applicable only if an ST tool is 

connected. 
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11.2.6 Radio and Connection 

Make settings for 

Radio and 
Connection. 

Some of the settings 

are explained in 

detail below. All of 

the tool configuration 

parameters are listed 

in tool parameter 

section 

Configuration.   

 

 
The radio section is accessible when Primary tool is other than Cable.  

T270 Power save timeout: IRC turns off after this time, if tool is inactive. To reconnect, press trigger once 

and Blue LED on tool lights up after approximately 10 seconds. 

T271 Start condition: The start condition if using IRC connection for tool. None: Up to 20 tightenings can 

be performed if IRC connection is lost (Blue LED off). Connected: IRC connection must be established 

(Blue LED on) to run tool. Start request: IRC connection must be established (Blue LED on) and link 

time out must not have started.  

T272 Link timeout: If the tool loses IRC connection it is considered offline and the connection LED (blue) 

on the tool turns off after the link timeout time. 

T277 Torque and angle trace: Switch on/off tracing of torque and angle. (Up to 10 traces can be stored in 

the tool if connection is lost.)  

T290 Primary tool. Note that PF needs to be restarted after changing primary tool setting. Click Store to 

save settings. 
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11.3 Tool diagnostic 

In the PF Map Tool branch, double-click on Diagnostic. 

 

 

Click Sensor tracking to introduce torque 

and angle readings in real time. 

Click Peripherals to diagnose tool LED's 

and buttons. 

 

Temperature parameters are for 

information only. 

 

Click Active response time under Radio to 

diagnose the wireless connection. 
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11.3.1 Sensor tracking 

 

To monitor Torque/Angle readings from the 

tool press Start. To set reference point for Angle 

value during monitoring press Reset. 

 

For S, DS tools it is even possible to read value 

of the transducer offset shown in percentage of 

the nominal torque range. 

 

For other tool families this parameter is not 

accessible (always set to 0.00%). 

 

 

11.3.1 Transducer calibration 

 

When tool is triggered, a check of transducer and transducer electronics is carried out. Results 

(offset and gain) are sensitive to temperature, material wear and even proper handling of tool 

during calibration. Don’t manually rotate gear when tool is triggered to obtain most accurate 

transducer readings. If program discovers offset or gain values being out of correction limits or 

that these parameters have changed too much since last calibration, the corresponding event 

(E544) will be displayed and rundown will be aborted. Following table shows these limits for 

different type of tools.  

 
As long offset and gain change is not caused by fast, manual rotation of the gear during 

triggering of the tool, even relatively big offset and gain changes are completely 

compensated in the system, not having influence on specified measurement accuracy. 
 

 

Parameter 
Tool family Event 

if failed S,ETX ST SL21 STP1 STP2 ST2 STB 

Offset range (% nominal torque) 36% 16% 16% 16% 16% 16% 28% E537 

Offset change (+-% nominal torque) 4% 2% 2% 2% 2% 2% 7% E539 

Gain* range (% nominal gain) 23% 21% 21% 51% 34% 42% - E538 

Gain* change (+-% nominal gain) 10% 3% 4% 4% 3% 3% - E540 

Nominal torque 100% 100% 100% 100% 100% 100% 100%   

Nominal gain* (% nominal tq) 114% 126% 125% 99% 148% 151% -   
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* There are different definitions of gain (shunt calibration) parameter for each tool depending on 

HW/SW solution implemented. STB uses no shunt calibration. 
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11.4 Tool maintenance 

In the PF Map Tool branch, double-click on Maintenance.  

 

 

 

The following submenus 

are available: 
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11.4.1 Calibration and Service 

Make settings for 

Calibrations and Service.  

Click Store to save the 

settings.  

 

 

11.4.2 Open-end tuning 

Before using an open-end tool, make sure that the tool head and tool body have been assembled and 

configured correctly. If not, the tool can run in the wrong direction and the mechanical stop in the open-

end head may be damaged. 

If performing an OK tightening (green tool LED’s are on) with C230 OE forward positioning set to “No” 

and pressing the tool trigger button, then the LED’s turn OFF and ON again. This behavior can only be 

seen on S and DS tools (not on ST and SL tools) and is normal. 

The “Reverse angle” and “Rotate spindle forward/reverse” strategies are not applicable for open-end 

tools. 

It is not possible to use open-end tools in a Multistage configuration. 
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For S, ST and DS tools, use 

parameter T420 Use open end to 

activate the open-end 

functionality. 

For SL and STB tools it is not 

possible to change the open-end 

parameters in Tools Talk or 

Graph. Use Tools Talk Service 

to modify open-end settings.  

 

T421 Inverted motor rotation should be checked if an open-end head is used which changes the rotation 

direction of the spindle. 

 
If the T421 Inverted motor rotation is set in the wrong way the tool may not operate in a 

correct manner and the mechanical stop may be damaged if a tightening is done. 

 

Set T422 Tightening direction to the direction that fits the application and open-end head. “CW” is selected 

for right hand threaded fasteners and “CCW” for left hand threaded. This setting is valid for all 

programmed Psets. 

 
Parameter P240 Tool tightening direction has no effect when running an open-end tool. 

 

When finished with parameter settings, press Store. 

Click open-end tune key in the open-

end parameters section. 

Make sure the open-end head can rotate 

freely and press the tool trigger. 

Open-end tuning measures the gear 

ratio and gear play and stores it to the 

tool memory. 

 
The old T103 Gear ratio value 

will be overwritten. 
 

 

A confirmation message is displayed if open-end tuning succeeded. 
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11.4.3 Wear indicator 

Wear indicator provides a 

mechanism to inform tool users 

with an event code when it is 

time for tool service. It is also 

possible to configure a 

controller to lock the tool with 

parameter T416 Lock tool on 

alarm.  

 

 

The amount of wear before an alarm is issued is set in T433 Alarm factor.  

 
If wear indicator is on it will be reset to initial state after a tool service when a Service 

counter reset is performed. 
 

11.4.4 ACTA 

The ACTA section contains a tool calibration 

session. 

 
The calibration does not work with 

Tensor DS tools. 

A tool calibration session is started by connecting 

the ACTA 4000 to the Power Focus and fitting the 

QRTT device to the spindle. One Multistage with 

three Psets is used when the calibration is run, one 

torque tightening (for torque calibration) and two 

different spindle rotations (for loosening and angle 

calibration) Psets. 
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Click Create QRTT to create the Psets and 

Multistages needed. The target torque and 

angle is then set by the ACTA 4000 before 

the start of each calibration. 

The tool calibration is started by a command 

from the ACTA 4000 or by pressing the tool 

trigger depending on if the tool is configured 

for remote start or not. The result of a 

calibration is displayed as a normal 

tightening. When a calibration batch is 

completed, event code E710 ACTA/QRTT 

calibration is displayed and stored in the event 

log of the Power Focus. 
 

It is necessary for the Power Focus to have enough memory space available to store the Multistages and 

Psets needed. If the calibration shows an unsatisfactory result the operator is assumed to take the 

appropriate action. No calibration value (calibration- or normalization value etc.) is changed 

automatically. 

11.4.5 Motor tuning 

Motor tuning adjusts the tool and motor control unit. Sync motor tuning feature is only available from the 

Sync reference of a configured Sync group with between two and ten Sync members. The Sync motor 

tuning process starts simultaneously for all Sync members when pressing the tool trigger of the Sync 

reference. For information about the Sync functionality, see section Sync. 

 
It is important that no torque is applied to the socket of the tool when it is subject to any 

kind of motor tuning. Make sure that the socket is able to rotate freely. 
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Standalone motor tuning 

Click Perform motor tuning. 

 

 

Press Tool trigger and keep it pushed 

during the motor tuning process (the 

status is displayed). 

Release Tool trigger or click Abort to 

cancel. 

When finished the result of the motor 

tuning is displayed. 

 

Sync motor tuning 

Click Sync motor tuning. 

Push Tool trigger and keep 

it pushed during the motor 

tuning process. 

Release Tool trigger or 

click Abort to cancel. 

  

 
Accessing Sync motor tuning is only allowed on a Sync reference. 

 

Channel ID and motor tuning status for Sync reference and all Sync members are displayed.  

When finished, the result of the motor tuning is displayed. 

11.4.6 Disconnect tool 

Click Disconnect tool and click 

OK to logically disconnect the 

tool. 
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Do not disconnect a tool during 

tightening, loosening, positioning, motor 

tuning, open-end tuning or tracking. 

Logical disconnection is not necessary for 

ST and SL tools (this tool types allows hot 

swap functionality). 
 

 

If the operation succeeded, the green OK LED flashes continuously (on the Power Focus) and the 

message “Command accepted” is displayed. Click OK to continue.  

If disconnection of the tool was not allowed, the red NOK LED flashes continuously for 3 seconds and 

the text “Operation failed” is displayed. Click OK to continue. 

When a tool is connected again, E131 Tool disconnected is displayed and then acknowledged automatically. 

 

In order to be able to use digital I/O to disconnect the tool, one digital input must be configured as 

Disconnect tool and optionally one relay can be configured as Safe to disconnect tool. 

Once configured, proceed as following to logically disconnect the tool using digital I/O: 

 Set voltage level on the digital input (configured as Disconnect tool) to high in order to logically 

disconnect the tool 

 If the operation succeeded, the relay configured as Safe to disconnect tool switches and the green OK 

LED (on PF) will flash continuously. If disconnection of the tool was not allowed, the relay 

configured as Safe to disconnect tool does not switch and the red NOK LED flashes continuously for 3 

seconds 

 Disconnect the tool 

 When a tool is inserted again, E131 Tool disconnected is displayed and then acknowledged 

automatically 

 
Do not physically disconnect an S or DS tool, unless it has first been successfully logically 

disconnected. This can damage the tool memory. If the user physically disconnects a non-

ST tool, without a successfully logically disconnection, PF has to be rebooted before 

connecting the tool again. 
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11.4.7 Hot swap 

It is possible to replace an individual tool with another tool, just by disconnecting the tool from the tool 

cable and attach the new tool. Hot swap is only available for S and ST type tools.  

 
When hot swapping a tool, the new tool must be of the same type to ensure that all 

parameter settings in the Power Focus will be interpreted correctly. 

Even if all settings are accepted by a new tool of another tool type, some parameters can cause the new 

tool to behave differently than the original tool.  

An example is the speed setting parameters (P130-P138). If P139 is set to "Percent", these parameters are 

stored in the PF database as percentage of max tool speed for the particular tool type, the value for the new 

tool type might differ from the original tool type. On the other side using absolute speed values (P139 set 

to "RPM") can generate strategy configuration errors for slower than swapped tools. 

11.5 Tool lock functionality 
The tool can be locked either by an internal state that does not allow the tool to be used, or intentionally by 

configurable functions in the Power Focus or by external sources. 

11.5.1 Locking of tools from an external source in time critical 
applications 

When production is arranged into line assembly, the tightening process is often planned in great detail. To 

assure that tightenings are performed on the correct joints, the user might wish to disable the tool in 

between operations on the same vehicle within a work station. In addition, there can be a timing 

requirement, meaning that the tightenings have to be made within a certain time period. 

If in these cases an external source (for example fieldbus) is used to disable and enable the tools, it is 

important to thoroughly analyze the risks. Otherwise reduced productivity or bad ergonomics can be the 

result. 

There is a small delay between the moments when the triggering event occurs, for example a ready signal 

from a positioning system, and when the tool is actually enabled or disabled. During a delay, the operator 

can unintentionally disturb the counting in the process by pressing the trigger several times.  

Therefore, the use of external sources for regularly locking and unlocking the tool in time critical 

applications is not recommended. In order to enable and disable the tool quickly enough in these cases, 

only Power Focus internal sources should be applied (only 1-2 ms reaction time). 

In time critical applications, the following general strategy could be used: 
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 For enabling the tool, use the external source for selecting the Pset in Power Focus when the conditions 

for “start tightening” are fulfilled 

 For disabling the tool, use functions P152 Lock at batch ok or J302 Lock at Job done, which are internal 

tool locking sources within Power Focus 

11.5.2 Intentional locking of tools 

By locking and unlocking the tool in certain situations, it is possible to prevent unintended usage of it. In 

this way it is possible to avoid some of the mistakes that could normally be made during assembly. 

11.5.3 Definition of a locked tool 

When the tool is locked, one or several services are disabled. Services are normally tightening and 

loosening, but do in some cases include positioning, motor tuning, open-end tuning and tracking. 

11.5.4 Tool locking event codes 

In case the tool is locked while a user attempts to start a service (normally tightening or loosening), the 

Power Focus shows an event code to explain why or by which functionality the tool is locked. In case the 

tool is locked while a service is being performed, the service is aborted and an event code explaining why, 

or by which function, the tool was locked is displayed. 

For more information, see section Event codes. 

Combinations and tool locking 

Different conditions, functions and external sources may simultaneously cause the tool to be locked.  

For example, the tool can be locked both by the digital input function Disable tool n o and by the “Lock on 

reject” function. For the tool to be unlocked, the digital input Disable tool n o must be altered and the “Lock 

on reject” lock must be unlocked using the digital inputs Unlock tool / Master unlock tool or the CW/CCW 

ring (depending on configuration). 

When event codes are generated while the tool is locked for multiple reasons, only one of the possible 

event codes is generated. It is not specified which of the possible event code messages that will be 

generated. 
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12 Accessories 

In the Accessories branch, the digital inputs and outputs of PF are configured and diagnosed. 

The branch also includes information about the devices connected to the I/O bus and tool bus, 

and how to configure these devices.  
 

 
This section includes screenshots from ToolsTalk PF. The screenshots show examples of 

parameter settings and are NOT intended to be generally applicable. Check with your 

local Atlas Copco representative how to set up your specific system environment. 

See parameter list section Accessories for a description of all available Accessories 

options. 
 

12.1 Digital I/O 

Power Focus has extensive I/O capabilities. Apart from the 

internal I/O ports it is also possible to connect up to 15 

external I/O devices to the Power Focus I/O bus, such as a 

Pset selector, I/O Expander or Stacklight. 

 

In the PF Map, open Accessories>Digital I/O and double-click 

Configuration, or right-click Configuration and select Open I/O 

set.  
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The I/O set dialog box appears. 

Select Device type. 

Select Digital inputs and Relays (with relay timer). For more information, see section Digital I/O and 

fieldbus items. 

Note that J330 Use line control must be set to Yes before the digital inputs and relay settings for line 

control can be activated. 
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In the PF Map, open Accessories>Digital I/O and double-click 

Diagnostic, or right-click Diagnostic and select Open I/O 

Diagnostic.  

 

 

The I/O Diagnostic window appears. 

Here the status of all internal and external I/O devices can be viewed. 

It is possible to set the status of relays. All configured I/O devices appear on the list of available devices. 

This function enables testing of the interaction between PF and different external devices. For instance, it 

could be useful when trouble shooting complex systems with one or several PLC units connected to the 

controller. 

The Read key shows the status of the selected I/O device. The read status key has to be clicked in order 

to update this view to reflect changes. 

Output test function activates and de-activates relays on a selected I/O device when Set is clicked. 

The Restore key restores the relays to reflect the current status of the PF. Click Read to update this view 

to reflect changes triggered by other events. 
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12.2 I/O bus 

Power Focus has extensive I/O capabilities. Apart from the 

internal I/O ports it is also possible to connect up to 15 

external I/O devices to the Power Focus I/O bus. 

 

In the PF Map, open Accessories>I/O bus and double-click 

Information. 
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Information for each device on the I/O bus is displayed. 

Click Config to configure the selected device. 

Click Diagnostic to diagnose the selected device. 

 

In the PF Map, open Accessories>I/O bus. Right-

click Configuration and select Create new I/O Device. 

 

Alternatively, double-click on an existing I/O 

Device to open the configuration window. 
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Select New I/O Device ID and 

Device type. 

Click OK to open the 

configuration window. 

 

 

Make settings for the device by clicking on the positions (the example below shows an Operator panel). 

 
See the user guides for each accessory device for more information. 

Click Store and Close when finished with configuration. 
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In the PF Map, open Accessories>I/O bus and double-

click Options. 

 

Make settings for Options. 

Click Store and Close window when finished. 
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12.3 Tool bus 

In the PF Map, open Accessories>Tool bus and double-click 

Information. 

 

Select Device type and click 

Device information. 

The Device information window 

appears with information about 

the connected device. 
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In the PF Map, open Accessories>Tool bus and double-click 

Configuration. 

 

In the Tool bus Configuration window, click General 

purpose I/O. 

Make settings for the digital inputs and outputs (see 

section Digital I/O and fieldbus items for descriptions of 

available selections). 
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In the Tool bus Configuration 

window, click ST selector.  

Make settings for the ST 

selector. 

The same settings are available 

for Internal ST selector. 

 

In the Tool bus Configuration 

window, click ST scanner. 

Make settings for the ST 

scanner. 

See section Identifier for 

information on identifier 

settings. 

Click Set Scan Engine Default 

Values to delete all custom scan 

engine settings and revert back 

to the Atlas Copco production 

defaults. 

 

Click Set Highest Security Level 

to set the scan engine Linear 

code type security setting to its 

highest level (4) and turn the 

Bidirectional redundancy on. 
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In the Tool bus Configuration 

window, click TLS ST Tag. 

Make settings for the ST Tag. 

 

 

12.4 Printer 

In the PF Map, open Accessories>Printer. 
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The connected A400 Brand and A401 

Paper size are setup here. If A402 

Continuous print is activated, then it is 

possible to also select A404 New page at 

Job done. 

Push the Print button on the Power 

Focus Graph front panel to view a list of 

available reports to print. 

Click Store to save configuration. 
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13 Sync 

Sync allows a group of spindles to perform the same task simultaneously. Examples where a 

Sync solution could be applicable are the tightening of car wheels and the tightening of 

cylinder head bolts. The Sync function is RBU-dependent.   

 
This section includes screenshots from ToolsTalk PF. The screenshots show examples of 

parameter settings and are NOT intended to be generally applicable. Check with your 

local Atlas Copco representative how to set up your specific system environment. 

See parameter list section Sync for a description of all available Sync options. 
 

A Sync group consists of PF units working in 

the same Cell.  

One of the controllers is defined as Sync 

reference. The other controllers are Sync 

members. 

The Sync reference handles the 

Synchronization between the tools, the 

selection of Psets and the result reporting for 

the Sync. A Sync group can be viewed as one 

PF with more than one tool.  

A Sync group can be part of a Job (see 

chapter Job). Note that it is the Job reference, 

and not the Sync reference, that counts the 

batch in a Job with Sync.  

The status information on each controller and 

tool shows the individual result for that 

spindle. The overall Sync OK/NOK can be 

given on the fieldbus, RE-Alarm or relays 

controlled by the Sync reference. The results 

from every spindle are registered separately.  

The status from individual Sync members 

can be viewed on the Sync reference 

controller. 

 

 

 

Sync is performed in steps or SynchroTork (PF4000 only). In step Sync, all Synchronized spindles wait 

for each other at a number of checkpoints before they continue with the next step. A typical two stage 

tightening has checkpoints at P111 First target and P113 Final target. SynchroTork allows continuous 
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Synchronization during the final tightening.  

13.1 Sync prerequisites and limitations 
A Sync group consists of two to ten PF units. The SynchroTork option is limited to six tools. 

All Sync members must be part of the same cell, but a cell can consist of more than one Sync group. The 

cell reference does not have to be a member of the Sync group. For creating a cell, see section Controller. 

All Sync members must have the same Sync reference. 

All Sync members must be connected via the internal I/O-bus, which is used for time critical 

Synchronization communication. Do not connect two Sync groups via the I/O-bus. 

The Sync reference can control external I/O bus units, such as RE-Alarm, Socket Selector and I/O 

Expander.  

All Psets must be configured from the Sync reference. 

Do not configure any external I/O devices (device 1-15) on the Sync members.  

No I/O bus cable connection is allowed from any of the sync group members to a non-sync group member 

PF unit. 

Ethernet communication is used for non-time critical communication such as start-up time, 

creating/updating Psets and Multistages and transferring result data between the Sync reference and the 

Sync members.  

To be able to use Sync start, the 4-pin remote start connector on the Power Focus back panel must be 

configured for remote start.  

If a sync group is used for loosening the entire group will be classified as OK when at least one sync 

member performs a successful loosening. 

 
In a Synchronized application, the Sync communication has top priority on the I/O bus 

when the tools are running. For that reason tool start, tool disable and other safety critical 

functions must not be connected to the I/O bus via I/O Expander. 

For a description of how to do Sync motor tuning, see section Tool. 
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13.2 Hardware configuration 

Connect all PF units in the Sync group via the I/O-bus on the back panel.  

Set the 4-pin remote start connector to remote start on each of the Sync members, and to the selected 

start source on the Sync reference.  

If applicable, connect external I/O devices (for example alarms or start source) to the Sync reference, but 

never to the Sync members. 

 

Sync reference  

I/O-bus connection 1 is 

terminated or external I/O 

devices are connected.  

Sync member  Sync member Last Sync member 

I/O-bus connection 2 is 

always terminated. 
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13.3 Sync configuration 

To set up a Sync group, configurations are made in Network, 

Tool and Sync windows.  

 

13.3.1 Sync members configuration 

Connect the Sync reference.  

In the PF Map, open Controller>Network. 
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Ensure that all PF units in the Synchronized 

group are part of the same Cell. Parameter C312 

Cell reference IP must be the same.  

In this example, PF is a Sync member, and the 

Sync reference is the same as the cell reference. 

Click Store to save settings. 

 

 

In the PF Map, open Tool>Configuration>Tool start, and set T200 Tool start select source to Sync start. 

Click Store to save settings and restart PF. 

Repeat the procedure for all Sync members. 

13.3.2 Sync reference configuration 

Connect the Sync reference.  

In the PF Map, open Controller>Network. Ensure that the Sync reference is part of the same cell as the 

Sync members.  

Set C317 Sync reference IP equal to C300 IP address. 

Click Store to save settings. 

Restart the Sync reference controller and connect ToolsTalk PF to it again.  

In the PF Map, open Sync. 

Select controllers in the Available Power Focus list and click Add to create a Sync group list. 

Note: The Sync reference (SR) must always be at the top of Sync group list. 

Make settings in the Options field. Store and close the window. 
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13.4 Troubleshooting 
Follow the procedure in this section. For more information, see section Event codes. 

Symptom Reason/Action 

Tools in a Sync group do not 

start or do not tighten 
correctly 

Programming errors: 

1. Check that all Psets are configured from the Sync reference. 

2. Check that all Sync members have T200 Tool start select source set to Sync start. 

3. Check that all Sync members have C317 Sync reference IP set to the IP-address of the 

Sync reference. 

4. Reboot any reprogrammed Sync member or Sync reference.  

 

Hardware-related errors: 

1. Check that the I/O Bus cables between the Sync members is correctly connected and 
without faults. 

2. Check that the remote start connector in the Sync members is correctly wired for 

remote start. 

 

Error elimination: 

1. Select a new Pset from the Sync reference. If all Sync members change to the same 

Pset, the Sync group programming is correct. If not, check the programming and the 
Ethernet cables and connections. 

2. Select normal loosening and start a loosening from the Sync reference. If not all Sync 

members start, check the tool trigger configuration in the Sync members and the 

wiring of the remote start input. Check also the I/O Bus connection and the I/O Bus 
cabling. 

3. If a single spindle does not start, the tool, tool-cable or controller might be broken. If 

all spindles in the group start loosening but not tightening, check that all Psets are 

configured in the same way. If not, restore them again from the Sync reference (all 
Psets must be configured from the Sync reference). 

An event code is displayed. See section Event codes. 
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14 Identifier 

The Identifier section describes the identifier concept, functions and settings.  

An identifier, or barcode string, can be used for example to select Psets or Jobs, identify motor 

vehicles (VIN) and other work pieces, variants, and operators. The tightening result can then be 

saved together with this information.  

 

 

 
This section includes screenshots from ToolsTalk PF. The screenshots show examples of 

parameter settings and are NOT intended to be generally applicable. Check with your 

local Atlas Copco representative how to set up your specific system environment. 

See parameter list section Identifier for a description of all available Identifier options. 

14.1 Identifier concepts 
There are three ways to use the identifier function, all possible to use independently of each other: 

 To select a Pset/Multistage or Job through scanning a barcode string (only Type 1). 

 To create a work order for identification of, for example, work pieces connected to a tightening. 

 To store additional information to the tightening result. 

An identifier (barcode) string can have different standards and lengths. It can be scanned and stored as it 

is, but PF can also be configured to identify parts of the string. These parts are called significant strings.  

The Type 1 identifier can be configured for selection of Pset/Multistage or Job in addition to being stored 

as additional information to the tightening result or being selected in a work order.  

The Type 2, Type 3 and Type 4 identifiers can be stored as additional information to the tightening result or 

be selected in a work order. These multiple identifiers are RBU-dependent.  

A significant string is a set of characters within a barcode string that can be defined. 

The significant positions are the positions where the significant strings are located. 

A wildcard character is represented by a ¤ symbol and means that a certain position in the significant 

string can have any character value. 

A work order consists of different types of identifiers (Type 1 is mandatory). It is configured when Power 

Focus should receive identifiers in a predefined order. An identifier not included in the work order is 

called Optional identifier. An optional identifier must not be identical to an identifier included in the work 

order.  
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The Result part is additional information stored together with each tightening result in the Power Focus 

database. This information can come from one or more of the defined identifier types independently. 

Multiple identifiers provide storage of up to four result parts (RBU-dependent) after memory 

reconfiguration. The additional information from the result parts is displayed in the Identifier monitor, and 

the result of the tightening is displayed in the Result Monitor.  

The result part additional information is stored with the tightening result in the Power Focus database.  

Example: 

An airbag is mounted in a car.  

Type 1 represents the airbag which can be of different 

variants that need different Psets. Type 2 represents 

the car (VIN) and Type 3 identifies the work station.  

A work order is configured where Type 2 (VIN) and 

Type 3 (work station) have to be scanned before Type 

1 (airbag).  

 

Each tightening result from the Psets listed under Type 1 is stored with the VIN, the airbag ID, and the 

work station ID. 

The Identifier monitor shows the Work order and the Result monitor shows the tightening result. The 

tightening result with all the additional information can be retrieved via command Get all results or via 

Tools Net. 

Part Id scan: This concept offers the opportunity to scan a variant of a part and select a specific Pset in 

the Job. (The job itself may have been selected by another identifier). The significant numbers and part 

id identifier length do not necessarily have to have a full match to select a specific Pset. This is achieved 

by means of wildcards. 

14.2 Identifier prerequisites and details  
Prerequisites for significant strings: 

 400 significant strings can be set for Type 1 

 A string can only be added once in Type 1 

 A Pset, Multistage or Job ID can be added to any string of Type 1 

 Wildcards can be used in Type 1 strings if the significant positions are different and outside the length 

of some Type 1 strings 
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 The number of characters in the significant string (for example 10) must be the same as the number of 

significant positions 

 The length can be max 100 characters 

 Standard alphanumeric characters are accepted. Apostrophe (’) and colon (:) are not accepted 

 Standard alphanumeric ASCII characters (33-126) are accepted 

 

 Max scanned 
characters 

Max significant 
positions 

Max significant 
strings 

Max stored 
characters 

Type 1 100 50 400 25 

Type 2 100 50 1 25 

Type 3 100 50 1 25 

Type 4 100 50 1 25 

Prerequisites for incoming data: 

 Identifiers can be sent to the Power Focus via a scanner (connected to the serial port), fieldbus, 

Ethernet, an ST scanner, or an STwrench Tag (connected to the ST tool). Input source must be correct 

(accepted). 

 The incoming identifier string must have the following barcode reader standard syntax:  

STX<data>ETX.  (STX=02H ETX=03H).  

 Scanner or similar device must not respond to unrecognized commands or send other data than the 

identifier string 

 An incoming identifier that goes directly to a Job or Sync member erases the received identifier that is 

sent to the member from the Job or Sync reference. 

Prerequisites for result parts: 

 If using more than one result part, the memory configuration C604 No. of identifier result parts must be 

updated (RBU-dependent). 

 If the system is set up in a Cell Job or Sync configuration, the parameter C604 No. of identifier result parts 

must be configured with identical values (1-4) for all PF units included in the Job/Sync group. 

 The information from the identifier types can be displayed in the result parts independently of result 

part number. For example, all result parts can display information from Type 1 (or even depending on 

the subtype of the Type 1). 

 A work order has to be completed before the Power Focus stores the accepted identifiers in the result 

database and selects a next Pset/Multistage or Job. 

 Autoselected Psets in a Job will inherit the result parts (if any) from the previous Pset. 

Identifier reset can be done if any of the following actions are taken: 

 Restoring of identifier configuration is made 

 A Reset all identifier command is issued from the identifier monitor or digital input 
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 The parameters J342 Reset all identifier at Job done and I183 Reset all identifiers at Pset batch done are 

activated 

After a reset, the following occur: 

 All identifiers are reset 

 Work order is (cleared) aborted 

 Tool is unlocked if I181 Tool locked during work order is activated 

14.3 Configuration of identifier functions 

The identifier functions are related to a number of parameters 

and views.  

Identifier includes settings for configuration of identifiers, result 

parts and work order. A command to send an identifier to PF 

directly is also located here.  

Configuration; Identifier can be set as the source to select Pset, 

Job, or Job override. 

Memory includes settings for Result parts. Note that memory 

reconfiguration requires saving of PF to file and reboot of PF. If 

a memory reconfiguration is needed, it is recommended to start 

the procedure here. See section Memory.  

Identifier Monitor displays the result parts. The following 

functions are also available here: 

 Bypass identifier 

 Reset latest identifier 

 Reset all identifiers 
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14.3.1 Configuring identifiers  

The procedure to set identifiers differs between identifier types 1 and types 2-4. Always start with Type 1.  

To set up identifiers, do the following: 

In the PF Map, double-click Identifier to open the Type setup window. The figure below shows a 

completely configured identifier setup. 

 

Select Input source for identifier Type 1.  

State Length of the incoming identifier. – (hyphen) means no length check. 

Click Set to open the pop up window Identifier significant position setup. 

 

 

Mark the significant positions for the identifier. The positions can be selected freely. Click OK. 

To define the significant string for identifier Type 1, click Set strings for Type 1 to open the Identifier 

Type 1 string setup window. 
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Note: To define the significant string for identifier Type 2-4, click the box and type the string directly. 

 

Write string name in field Add identifier string and click Add 

Wildcards can be used in Type 1 strings if the significant positions are different and outside the length of 

some Type 1 strings. 

Double-click a box to select Pset, Multistage or Job to each string. When finished, click OK. 

Click Store to save the settings, or continue with 

 Configuring a new type of identifier 

 Configuring a work order 

 Configuring Result parts. 

 
The STwrench TAG must be programmed in a special way in ToolsTalk in order to work 

properly, when using Identifier Input source STwrench tag.. The length must be 3 with 3 

significant characters. For example, if the tag number is 1 the configured string must be 

"001". 
 



 Identifier 

9836 3123 01 195 (428) 

14.3.2 Configuring a work order 

To configure a work order, do the following: 

Open PF Map > Identifier > Options. 

Add identifier types to the work order, and arrange the correct order using the arrow buttons. 

Note: Identifier Type 1 must always be included in the work order.  

If applicable, select Tool locked during work order and I183 Reset all identifiers at Pset batch done. 

When activating I183 Reset all identifiers at Pset batch done: 

 All identifiers are reset 

 Work order is (cleared) aborted 

 Tool is unlocked if I181 Tool locked during work order is activated 

To avoid re-selecting an ongoing Job, Pset or Mset by a work order (and override selected), check the 

I184 Ignore identical work orders option. 

Click Store to save the settings. 

Note: The Send Identifier button is described in Additional Identifier functions. 
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14.3.3 Configuring result parts  

To configure more than one result part, the parameter C604 No of Identifier result parts must be set to the 

correct number of result parts. If a memory reconfiguration is made, the PF data must be stored to file and 

PF rebooted. See section Memory for instructions. It is possible to configure up to 4 separate result parts. 

The results are displayed in the Identifier Monitor. See section Additional identifier functions.  

To configure result parts, do the following: 

Open PF Map > Identifier > Type setup. 

Select the identifier type to correspond with Result part 1 (2, 3 and 4) from the drop-down list.  

Click Set to open the pop up window Identifier significant position setup. 

Set Significant positions by marking character positions that should be added to the result part. 

Click Store when finished. 

In the example below, six positions from Type 4 are copied to result part 1 and stored together with the 

tightening result. Eight positions for Type 1 (any subtype) are copied to result part 2, and so on. 

 

For Type 1, it is possible to specify any of the subtypes Pset/Mset/Job in any of the Result parts. For 

example, result part 2 can have Type 1 subtype Job and result part 3 can have Type 1 subtype Pset. 
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14.3.4 Additional identifier functions 

The following functions are available in the Identifier Monitor window: 

 

Function Description 

Bypass identifier Skips a specified identifier type in a work order.  

It is not possible to bypass the first type in the work order if it simultaneously exist types outside 
the work order. 

Reset latest identifier The latest accepted identifier string is cleared with the command (or digital input) Reset latest 

identifier. 

It is not possible to perform Reset latest identifier for the last type in a work order. 

Reset all identifier All accepted identifier strings are cleared with the command (or digital input) Reset all identifiers. 

The following function is available in the Send Identifier window in the Identifier menu (see figure in 

section Configuring a work order). 

Function Description 

Send Identifier Sends an identifier string from ToolsTalk PF to PF manually.  The result is displayed in the 
Identifier Monitor. 

To select Pset/Multistage or Job from an identifier string, parameters C200 Pset, C201 Job or 
C202 Job override have to be set to Identifier. 
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15 Fieldbus 

Fieldbus communication can be used for data communication between Power Focus and a 

PLC (programmable logic controllers). It is an effective and fast way for the data transfer of 

short data packages. Fieldbus is normally used to send discrete I/O data instead of using a 

large number of cables that have to be hard wired to relays and digital inputs. 

 

There are many different fieldbus standards on the market and they all have different hardware and 

software protocols. To be able to communicate on the fieldbus, Power Focus must be equipped with a 

specific card for the preferred type of fieldbus. 

 
Power Focus acts as a client in a fieldbus system. A PLC or similar acts as the reference 

(master). 

This section includes screenshots from ToolsTalk PF. The screenshots show examples of 

parameter settings and are NOT intended to be generally applicable. Check with your 

local Atlas Copco representative how to set up your specific system environment. 

See section Digital I/O and fieldbus items for a description of all available fieldbus options. 
 

With ToolsTalk PF, the fieldbus functionality in PF can be configured to fit the user-specific bitmap. It 

also makes configuration or modification of a bitmap very easy. When the configuration is done, it can 

be downloaded to Power Focus or saved as a file for later use. 
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15.1 General setup 

In the PF Map, double-click Fieldbus. 

 

Select F100 Fieldbus type 

from the drop down menu. 

 

 
All fieldbus parameters are 

reset to default and data 

items cleared. 

Confirm by clicking OK. 
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The screenshot below displays available parameters for fieldbus type DeviceNet. Click Store to save the 

settings.  

 

15.1.1 Parameters in General setup 

The table below shows parameters available for all fieldbus types. For an explanation of the parameters, 

see parameter list section Fieldbus.  
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F100 Fieldbus type X X X X X X X X X X X 

F102 From PF data length X X X X X X X X X X X 

F103 To PF data length X X X X X X X X X X X 

F104 From PF global data length    X        

F105 To PF global data length    X        

F106 From PF Data Offset          X  

F107 To PF Data Offset          X  

F110 Set node address and baud rate from X          X 

F111 FB node address X           

F112 Baud rate X          X 
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F113 Connection mode X           

F120 Set node address from  X  X X X X   X  

F121 FB address from  X  X X       

F130 PCP length    X     X    

F131 Process data length   X     X    

F140 Set source address from    X        

F141 Source address    X        

F150 IP address      X X  X X  

F151 Subnet Mask      X X  X   

F152 Gateway      X X  X   

F155 Device Name         X   

F157 Assembly instance       X     

F160 Virtual fieldbus          X  

F161 Virtual from PF data length          X  

F162 Virtual to PF data length          X  

F163 Virtual from PF data offset          X  

F164 Virtual to PF data offset          X  

F170            X 

F171            X 

F200 FB update interval X X X X X X X X X X X 

F210 Tool stop at offline X X X X X X X X X X X 

F220 Read result handshake X X X X X X X X X X X 

F300 Bitmap select X X X X X X X X X X X 
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15.1.2 View fieldbus information 

Select General setup. 

Click Get fieldbus info to display fieldbus 

module type, module software version, 

module serial number and status of the LED’s. 

  

Select General setup. 

Click Get fieldbus info to display fieldbus 

module type, module software version, 

module serial number and status of the LED’s. 
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15.2 From PF setup and to PF setup 

Select From PF setup or To PF setup. 

Via From PF Setup the bitmap (defined in F102 From PF Data Length) sent out from the Power Focus can 

be configured.  

Via To PF setup the bitmap (defined in F103 To PF Data Length) sent in to the Power Focus can be 

configured. 

Click Add item… to activate a selection list. On the right side of the item list, see information about 

highlighted item.  

Highlight the item and double-click on it or click Add. The item is then entered to the item list on the first 

available line. 
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In the list, the start word, start byte, start bit, and length for the selected item are visible. It is easy to 

change the position in the bitmap by changing the start position in the item list and pressing Enter on the 

keyboard after each line is changed. If the length of an item is variable, it can also be changed here.   

It is also possible to drag and drop directly in the bitmap. In this case, the start positions in the item list 

are updated automatically. If the bitmap is changed, and a conflict occurs, this part is marked with red. 

To delete an item, highlight it in the item list and click Delete item. 

 
The max number of selected items is 60 in From PF setup and 60 in to PF setup. 

For detailed information of the available selections, see section Digital I/O and fieldbus items. 

15.2.1 Fieldbus modes 

The normal mode is when neither Diagnostic mode nor Monitor mode is selected. In normal mode, the 

operator can change position of a bit in a word (in a byte) for a selected item (not the content of the bit). 

For instance, the operator can change the Job off from bit position 7 to bit position 3 just by drag and drop, 

or by writing it into the Bit column and pressing Enter on the keyboard. 

Diagnostic mode 

In Diagnostic mode, it is possible to set fieldbus data in ToolsTalk PF and send the data to PF by clicking 

Set value. If Diagnostic mode From PF Setup is used, then the Power Focus passes data from ToolsTalk PF 

to the PLC and ignores the data from Power Focus. If Diagnostic mode To PF Setup is used, then the 

Power Focus activates functions, which are set in ToolsTalk PF and ignores PLC data. 

 
In Diagnostic mode the operator can only change a small part of the fieldbus setting data 

(only the content of a bit from zero <--> one).  

Monitor mode 

Monitor mode is used to monitor fieldbus data communication for testing purpose. This function works 

only when ToolsTalk PF is online (connected to PF). 

When Monitor mode is active, the data from Power Focus to PLC is visible in the From PF Setup 

window bitmap. Likewise the data from PLC to Power Focus is visible in the To PF Setup window 

bitmap. It is not possible to change and store fieldbus configurations in monitor mode. Data can be 

displayed in two formats, defined data type format and binary format. The data in the monitor windows 

is updated at a rate of three messages per second. 
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15.3 Storing fieldbus configuration  

To store or read fieldbus data, first activate the fieldbus window. On the Menu bar, use command 

File>Read Fieldbus, or File>Save Fieldbus. The fieldbus file extension is “*.pff”. 

15.4 Disable fieldbus carried signals 

It is possible to run PLC-selected Jobs over the fieldbus in automatic mode (i.e. “fieldbus” is selected for 

parameter C201 Job), and select Jobs with a digital input in emergency mode (i.e. “DigIn” is selected for 

parameter C202 Job override). When emergency mode is activated, the fieldbus signals could still disturb 

the communication. To avoid this type of problem it is recommended to use digital input Disable fieldbus 

carried signals. When this digital input goes high the following events occur:  

 Fieldbus communication is disabled 

 Relay Fieldbus carried signals disabled goes high 

 In ToolsTalk PF monitoring mode on fieldbus “To PF” side, it is possible to display changes in 

signals sent to PF over the fieldbus. (Note that the signals have no effect on the Power Focus, since 

all fieldbus communication is disabled). 

 On the fieldbus side “From PF”, bits are reset to zero (0) 

 The traffic of “keep alive” signals continues on the fieldbus. In this way no event codes (i.e. No 

connection on fieldbus) are displayed 

 All tools are enabled (presupposed that the tools were disabled from a source over the fieldbus before 

then) 

 If there is a running Job, which has been selected via the fieldbus, the Job is aborted 
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15.5 Fieldbus data format  
This section describes the different data types that are used in the fieldbus configuration. 

15.5.1 Bitmap select (Endian mode) 

Big endian (Motorola mode) is default setting for ProfiBus-DP, Profinet IO, InterBus, Interbus 2Mb, CC-

link, ModBusPlus and ModBus TCP. 

Little endian (Intel mode) is default setting for DeviceNet, ControlNet, Ethernet/IP and FL-net. 

Big endian (Motorola mode) 

Byte 0 (send 1
 
st) Byte 1 (send 2 nd) 

MS Byte (PF) LS Byte (PF) 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

 

Little endian (Intel mode) 

Byte 1 (send 2 nd) Byte 0 (send 1 st) 

MS Byte (PF) LS Byte (PF) 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

15.5.2 Fieldbus data types 

The Power Focus uses position format in all encoding and decoding data types. In PF position format the 

most significant bit (MSB) is the bit furthest to the left and the least significant bit (LSB) is the bit furthest 

to the right.  

If a data type is less than one word, the MSB is the bit furthest to the left. If data type is longer than one 

word, the MSB is the bit furthest top-left. If a fieldbus type uses Intel Endian, byte numbers are swapped 

before encoding or decoding to a specific data type. 

The data field in the fieldbus is from the beginning a blank data field without structure. In order to file 

Power Focus item data types into fieldbus we define fieldbus data type, which holds the information about 

placement and structure of a certain application data type mapped into the fieldbus data field. 

The table below shows the different data types used in fieldbus data. The section items from/to PF shows 

the data type available for different items. 
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Data type Description 

Bit One bit. Normally used for discrete I/O-data. 

BitField (BF) Length is 1-16 bits. All bits must be in the same byte. The left bit is the most significant bit and 
the right bit is the least significant bit, i.e. 0001=1, 1000= 8. 

Character (Char) One byte ASCII code. 

CharacterStringChange (CSC) Character string. Each character uses one byte ASCII code. Range: 2 - 25 bytes. 

CharacterStringInput (CSI) Character string with an extra “counter” byte in front. The extra byte is an integer counter and 

must increase each time when the character string is entered to be able to detect a new input. To 
enter the same value again (e.g. the same Job number), just change the counter.  

FixedPointNumber (Fixed 

point) 

Two-byte integer part and two-byte decimal part. The first two bytes hold the integer part and 

the last two bytes hold the decimal part. Used to represent torque value. 

Unsigned16 (U16) 16-bit unsigned integer. Decimal 0 – 65 535.  

Unsigned32 (U32) 32-bit unsigned integer. Decimal 0 – 4 294 967 295. 

U32_HNW 32-bit unsigned integer. MSW is the higher number word. Only shown in Intel Endian 

CharStringChangeIntel (CSCI) Character string. Each character uses one byte ASCII code. Range: 2 - 25 bytes. This type 

makes Intel Endian character string follows byte order; the first character is the lowest byte in 

the string. Only shown in Intel Endian 

CharStringInputIntel (CSII) Character string with an extra “counter” byte in front. The extra byte is an integer counter and 

must increase each time when the character string is entered to be able to detect a new input. To 

enter the same value again (e.g. the same Job number), just change the counter. This type 

makes Intel Endian character string follows the byte order; the integer counter is the lowest 
byte in the String. Only shown in Intel Endian 

OctetArray (OA) It contains several octet data in the byte order. 

LongCharStringChange 
(LCSC) 

It contains max 100 bytes character. 

LongCharStrChIntel (LCSCI) In Intel mode, only allows whole word, up to 100 bytes. Only shown in Intel Endian. 

 

 
Common for all data types is that a change must occur in PLC output area (To PF) to get 

Power Focus to detect a new data entry. For example, if selecting JOB number 3 two times in 

a row please select 0 in between. 

Character string 

Character String is in a reading order, i.e. from left to right, from top to bottom, regardless of the byte 

order. The difference between CharStringChange and CharStringInput is a counter byte added before 

character string in CharStringInput. A new input is considered when the counter changes. 
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Big endian (Motorola mode) 

 

Data type Word Byte 0 Byte 1 
Convert to PF 
data (hex) 

Convert to FB 
data (hex) 

CharStringChange 0 P  S    

 1 E  T    

 2 2  PSET2(00) PSET2(00) 

CharStringInput 3 1 (counter) P   

 4 S E   

 5 T 2 (01)PSET2 (01)PSET2 

 

Little endian (Intel mode) 

 

Data type Word Byte 1 Byte 0 Convert to PF 
data 

Convert to FB 
data (hex) 

CharStringChange 0 P S   

 1 E T   

 2 2  PSET2(00) SPTE(00)2 

CharStringInput 3 1 (counter) P   

 4 S E   
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 5 T 2 (01)PSET2 P(01)ES2T 

CharStringChangeIntelF 6 S P   

 7 T E   

 8  2 PSET2(00) PSET2(00) 

CharStringInputIntelF 9 P 1 (counter)   

 10 E S   

 11 2 T (01)PSET2 (01)PSET2 

 

Fixed point number 

Fixed point number integer part is in low number word, and decimal part is in high number word. The 

table below shows the conditions valid for the integer and decimal parts (i.e. if integer part is 1 digit or 2 

digits, decimal part is 2 digits): 

Integer part  

(in digits) 

Decimal part  

(in digits) 

1 or 2 2 

3 1 

4 0 

Big endian (Motorola mode) 

 

Data type Word Byte 0 Byte 1 Convert to PF 
data 

Convert to FB 
data (hex) 

FixedPointNumber 0 0 12   

 1 0 15 12.15 (00 0B 00 0F) 

Little endian (Intel mode) 

 

Data type Word Byte 1 Byte 0 
Convert to PF 
data 

Convert to FB 
data (hex) 

FixedPointNumber 0 0 12   

 1 0 4 12.04 (0B 00 04 00) 
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Integer 

Unsigned16 is a 16-bit integer and unsigned32 is a 32-bit integer. U32_HMW is a special case of 

unsigned32, which is used in Intel Endian. 

Big endian (Motorola mode) 

 

Data type Word Byte 0 Byte 1 Convert to PF 
data 

Convert to FB 
data (hex) 

Unsigned16 0 1 0 256 (01 00) 

Unsigned32 1 0 (MSB) 1   

 2 0 0 (LSB) 65536 (00 01 00 00) 

 

Little endian (Intel mode) 

 

Data type Word Byte 1 Byte 0 
Convert to PF 
data 

Convert to FB 
data (hex) 

Unsigned16 0 1 0 256 (00 01) 

Unsigned32 1 0 (MSB) 1   

 2 0 0 (LSB) 65536 (01 00 00 00) 

U32_HNW 3 0 1 (LSB)   

 4 0 (MSB) 0 1 (01 00 00 00) 
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15.6 Fieldbus selector configuration 
The Fieldbus selector function makes it possible for an external source (PLC) to control the selection of 

Psets on selectors via fieldbus.  

The intended type of working stations where the proposed software is to be installed are rework stations 

and similar, without fixed workflows. The tightenings are often unique for each work piece depending on 

the previously performed failed tightenings on that work piece. The external source (PLC) is responsible 

for setting the green LED’s on the selector(s) and for selecting the Psets in the Power Focus.  

 
To use this function the parameter C200 Pset must be set to Fieldbus selector. The fieldbus 

selector function can not be combined with the Job function.   

The selector is set up in Accessories>I/O bus>Configuration.  

Set selector LED 

Light on/flash/turn off for Selector green Led on positions where Pset is configured. Two bits for one 

position: 00 – off , 01 – flash, 10 – solid.  

In an eight-socket selector, the first four positions are for Selector LED 1-4, and the last four positions are 

for Selector LED 5-8. If a four-socket selector is used, only selector LED 1-4 is mapped. 

 

Big endian (Motorola mode) 

Byte 0  Byte 1 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Device ID Not used 

LED 4 LED 3 LED 2 LED 1 LED 8 LED 7 LED 6 LED 5 

Little endian (Intel mode) 

Byte 1 Byte 0 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Not used Device ID 

LED 8 LED 7 LED 6 LED 5 LED 4 LED 3 LED 2 LED 1 

Selector information 

Big endian (Motorola mode) 

Byte 0  Byte 1 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Device ID Bit 0-7 Socket 1-8  information  

(1- lifted, 0- not or not configured, FF-



 Fieldbus 

9836 3123 01 213 (428) 

all ones – more then one socket lifted) 

LED 4 LED 3 LED 2 LED 1 LED 8 LED 7 LED 6 LED 5 

Little endian (Intel mode) 

Byte 1 Byte 0 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Bit 0-7 Socket 1-8  information  

(1-lifted, 0- not or not configured, FF-

all ones – more than one socket lifted) 

Device ID 

LED 8 LED 7 LED 6 LED 5 LED 4 LED 3 LED 2 LED 1 

 

Selector Control Green (Red) Light 

 

For selector external controlled function A232. Set selector green (red) light. Two bits for one position: 00 

– off , 01 – flash, 10 – solid. Bitmaps are as in chapter Set Selector Led. 

 

 
To use this function the parameter A232 must be set. 

The A232 is set up in Accessories>I/O bus>Options.  

15.7 Select Pset from fieldbus and set batch size 
In order to set batch size and select Pset from fieldbus, parameter C200 Pset must be Fieldbus or Fieldbus 

selector. Also, parameter P150 Batch count must be set to Fieldbus. 

Big endian (Motorola mode) 

Byte 0 Byte 1 

Pset ID Batch size 

Little endian (Intel mode) 

Byte 1 Byte 0 

Batch size Pset ID 

Function (C200 Pset is set to Fieldbus) 

 0 < Batch size < 99 Batch size = 0, Batch size > 99 

Pset ID = 0 No Pset selected No Pset selected 
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0 < Pset ID < max 
number of Pset  

Select Pset and set batch size No Pset selected 

Function (C200 Pset is set to Fieldbus selector) 

  0 < Batch size < 99 Batch size = 0, Batch size > 99 

Pset ID = 0 Selector socket 
lifted correctly 

No Pset selected No Pset selected 

Selector socket 
lifted incorrectly 

Display event code E475 Fieldbus 

PsetID mismatch selector lifted 
socket  

No Pset selected 

Display event code E475 Fieldbus 

PsetID mismatch selector lifted 
socket  

No Pset selected 

0 < Pset ID < max 
number of Pset 

Selector socket 
lifted correctly 

Select Pset, set batch size and 
unlock tool 

Display event code E475 Fieldbus 

PsetID mismatch selector lifted 
socket  

No Pset selected 

Selector socket 
lifted incorrectly 

Display event code E475 Fieldbus 

PsetID mismatch selector lifted 
socket  

No Pset selected 

Display event code E475 Fieldbus 

PsetID mismatch selector lifted 
socket  

No Pset selected 

 

15.8 Fieldbus information 
This section lists the fieldbus types. 

15.8.1 ProfiBus-DP 

ProfiBus-DP is a fieldbus normally used in industrial automation, to transfer fast data for motor controllers, 

MMI, I/O units and other industrial equipment. ProfiBus has an international user organization called 

ProfiBus International, PI, and other local and national organizations. General technical questions 

regarding the fieldbus should be addressed to the local ProfiBus User Group in the first instance. 

A contact address list is available on the ProfiBus internet site: http://www.ProfiBus.com.  

For general help on ProfiBus, contact ProfiBus International on: 

ProfiBus_international@compuserve.com. 

http://www.profibus.com/
mailto:ProfiBus_international@compuserve.com
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Physical interface 

Interface Description 

Fieldbus type PROFIBUS DP EN 50 170 (DIN 19245) 

Protocol version 1.10 

Protocol stack supplier SIEMENS 

Auto baud rate detection (supported baud rate range) 9.6 kbit - 12Mbit 

Transmission media ProfiBus bus line, type A or B specified in EN50170 

Topology Server-Client communication 

Fieldbus connectors 9 pin female D-sub (standard) 

Cable Shielded copper cable, twisted pair 

Isolation The bus is galvanically separated from the other electronics with an on 

board DC/DC converter. Bus signals (A-line and B-line) are isolated via 
optic couplers. 

ProfiBus DP communication ASIC SPC3 chip from Siemens 

ProfiBus-DP module 

Variable Limits Information 

Node Address 1 – 124 

(1-99 with HW setting) 

Set Switches to 00 to enable the node 
address from SW (ToolsTalk PF). 

Number of nodes in a ProfiBus-DP 

network 

Max 126  

Baud rate Automatic (9.6 kbaud - 12 Mbaud) Automatically set from PLC at 
connection. 

Data to PF length 0 - 200 bytes  

The string length in PF is limited to 200 

bytes. ProfiBus-DP standard allows 244 
bytes. 

Must be the same in PF and PLC. 

Data from PF length 0 - 200 bytes  

The string length in PF is limited to 200 

bytes. ProfiBus-DP standard allows 244 
bytes. 

Must be the same in PF and PLC. 

The module only supports cyclic I/O 
data transmission 
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Hardware 

 

Fieldbus connectors 

The ProfiBus-DP standard EN 50170 (DIN 19245) recommends the use of a 9 pin female D-sub 

connector. Depending on the protection class and type of application, other connector designs are also 

allowed. 

Connector 9-pin female D-sub 

Pin Name Function 

Housing Shield Connected to PE 

1 Not connected  

2 Not connected  

3 B-Line Positive RxD/TxD according to RS485 specification 

4 RTS Request to send 

+5V BUS and GND BUS are used for bus termination. Some devices, such as optical transceivers 
(RS485 to fiber optics) may require an external power supply from these pins. 

5 GND BUS Isolated GND from RS484 side 

+5V BUS and GND BUS are used for bus termination. Some devices, like optical transceivers 
(RS485 to fiber optics) may require an external power supply from these pins. 

6 +5V BUS Isolated +5V from RS484 side 

+5V BUS and GND BUS are used for bus termination. Some devices, like optical transceivers 
(RS485 to fiber optics) may require an external power supply from these pins. 

7 Not connected  

8 A-Line Negative RxD/TxD according to RS485 specification 

9 Not connected  

Node address 

Node address is set with the two rotary switches on the fieldbus module; this enables address settings from 

1-99 in decimal form.  

Switch 1 x10 / Switch 2 x1. (See switches on the top drawing) 

Example: Address = (Left Switch Setting x 10) + (Right Switch Setting x 1) 
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Left switch is set to 5 and right switch is set to 2. This gives a node address of 52. 

If enable node address configuration from ToolsTalk PF the switches must be set to 00. 

 
Node address cannot be changed when the power is switched on. 

Baud rate 

The ProfiBus DP network baud rate is set during configuration of the master and only one baud rate is 

possible in a ProfiBus DP installation. As the Power Focus ProfiBus DP module has an auto baud rate 

detection function, do not configure the baud rate on the module.  

Supported baud rates: 9.6 kbit/s; 19.2 kbit/s; 93.75 kbit/s; 187.5 kbit/s; 500 kbit/s; 1.5 Mbit/s; 3 Mbit/s; 6 

Mbit/s; 12 Mbit/s.  

Functionality of the indication LED’s 

The module is equipped with four colored LED’s, used for debugging purposes. The function of the 

LED’s is described in the table and figure below. 

Name Color Function 

Fieldbus diagnostics 

(LED 4) 

Red Indicates certain faults on the fieldbus side.  

Flashing Red 1 Hz - Error in configuration: IN and/or OUT length set during initialization of 
the module is not equal to the length set during configuration of the network. 

Flashing Red 2 Hz - Error in user parameter data: The length/contents of the user parameter 

data set during initialization of the module are not equal to the length/contents set during 
configuration of the network. 

Flashing red 4 Hz– Error in initialization of the ProfiBus communication ASIC. 

Turned off - No diagnostics present 

On-Line 

(LED 2) 

Green Indicates that the module is On-Line on the fieldbus. 

Green - Module is On-Line and data exchange is possible. 

Turned Off - Module is not On-Line 

Off-Line 

(LED 3) 

Red Indicates that the module is Off-Line on the fieldbus. 

Red – Module is Off-Line and no data exchange is possible. 

Turned Off - Module is not Off-Line 

Bus termination 

The end nodes in a ProfiBus DP network have to be terminated to avoid reflections on the bus line. Use 

cable connectors with built-in termination. 

GSD file 

Each device on a ProfiBus DP network is associated with a GSD file, containing all necessary information 

about the device. The network configuration program during configuration of the network uses this file. 
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Contact the local Atlas Copco service representative for a copy of the GSD file.  

File name: pf3profb.gsd 

Icon file 

 

Contact the local Atlas Copco service representative to get a copy of the icon file for Power Focus. This 

file can be used to have a Power Focus Icon in PLC configuration SW. The file is a bitmap. 

File name: pf3profb.bmp 

15.8.2 DeviceNet 

DeviceNet is used for industrial automation, normally for the control of valves, sensors and I/O units and 

other automation equipment. The DeviceNet communication link is based on a broadcast-oriented 

communications protocol, Controller Area Network (CAN). This protocol has I/O response and high 

reliability even for demanding applications, e.g., brake control. 

DeviceNet has a user organization, the Open DeviceNet Vendor Association (ODVA) that assists 

members in matters concerning DeviceNet. Website: http://www.ODVA.org 

The media for the fieldbus is a shielded copper cable composed of one twisted pair and two cables for the 

external power supply. The baud rate can be changed between 125k, 250k and 500kbit/s. This can be done 

in two different ways. The first is simply by using the DIP switch, second is via SW configuration. There 

are several different DeviceNet scanners available on the market, both for PLC systems and for PCs. 

DeviceNet module 

Variable Limits Information 

Node Address (Mac ID) 0-63  

Number of nodes in a DeviceNet network Max 63  

Connection modes supported Polled I/O 

Bit strobe I/O 

Change of status/ cyclic I/O 

Use same as in PLC 

Baud rate 125kbit/sec (Default) 

250kbit/sec 

500kbit/sec 

 

Data to PF length 0 – 200 bytes 

The data string is in PF limited to 200 

bytes. DeviceNet standard allows 255 
bytes.  

Must be the same in Power Focus and 

PLC 

http://www.odva.org/
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Variable Limits Information 

Data from PF length 0 – 200 bytes 

The data string is in PF limited to 200 

bytes. DeviceNet standard allows 255 
bytes. 

Must be the same in Power Focus and 

PLC 

Configuration 

In a DeviceNet network, each node has a Mac ID (the address in the network). The Mac ID is a number 

between 0 and 63. Each node’s Mac ID has to be unique, since it is used to identify the node. In a 

DeviceNet network it is also possible to set baud rate, with the following baud rates being available: 125, 

250 and 500 Kbit/s. All nodes in the network have to communicate at the same baud rate. 

On the Power Focus DeviceNet module it is possible to set the Mac ID and baud rate using DIP switches 

mounted on the module or from SW using ToolsTalk PF. Dip 1 and 2 are used to set the baud rate and 

dips 3 to 8 are used to configure the node address (Mac ID). Dip 1 is the most significant bit on the DIP 

switch. See table on the next page.  

The Power Focus DeviceNet module is implemented in compliance with the ODVA specification for a 

Communication adapter (profile no 12). It acts as a “group two only server” on the DeviceNet network. 

Hardware 

 

LED 1: Not used 

LED 2: Network status 

LED 3: Module status 

LED 4: Not used 

 

On = 1 

Off = 0 
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Function Dip switch 
# 

AD0 8 

AD1 7 

AD2 6 

AD3 5 

AD4 4 

AD5 3 

BD2 2 

BD1 1 

Baud rate (bit/sec) Dip 1 - 2 

125k 00 

250k 01 

500k 10 

Reserve (SW-setting) 11 

 

Address Dip 3 – 8 

0 000 000 

1 000 001 

2 000 010 

3 000 011 

… … 

62 111 110 

63 111 111 

Mac ID (node address) 

To set the Mac ID from ToolsTalk PF all DIP switches must be set to “On” (11 111 111). 

 
The Mac ID cannot be changed when the power is switched on. 
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Fieldbus connector 

Connector 5-pin 5.08mm detachable screw terminal. 

Pin Color 
code 

Description 

1 Black V- 

2 Blue CAN-L 

3 Bare Shield 

4 White CAN-H 

5 Red V+ 

 

 
V- and V+ must come from a fully isolated power supply. That means that the voltage cannot 

have any reference to ground. This is to prevent the bus from interference caused by ground 

loop problems. If V- and V+ are connected from a Power Focus internal 24VDC (screw 

terminal) the same connection shall only power one DeviceNet module. This means that the 

DeviceNet cable connected to PF must not include voltage wires. Normally there is a central 

power supply that feeds all nodes in the network. 

Power consumption 

Current consumption at 24 VDC (V- to V+) is max 70 mA at power up and 25-30 mA continuously. 
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Functionality of the indication LED’s 

The module is equipped with four colors LED’s, used for debugging purposes. 

LED number Function Information Condition 

1 Not in use   

2 Network status Not powered / Not online Off 

2 Network status Link OK online. Connected Steady green 

2 Network status Critical link failure Steady red 

2 Network status Online not connected Flashing green 

2  Network status Connection time out Flashing red 

3 Module status No Power Off 

3 Module status Unrecoverable fault Steady red 

3 Module status  Minor fault Flashing red 

3 Module status Device operational Steady green 

4 Not in use    

Bus termination 

The termination of the fieldbus requires a terminating resistor at each end. These resistors should have a 

value of 121 Ohm. 

EDS file 

Each device on a DeviceNet network is associated with an EDS file, containing all necessary information 

about the device. The network configuration program during configuration of the network uses this file. 

Contact the local Atlas Copco service representative for a copy of the EDS file.  

File name: pf3devn.eds 

Icon file 

 

Contact the local Atlas Copco service representative to get a copy of the icon file for Power Focus. This 

file can be used to have a Power Focus Icon in PLC configuration SW.  

File name: pf3devn.ico 
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15.8.3 InterBus/InterBus2MB 

InterBus is normally used for industrial automation applications, such as valve, sensor and I/O unit control. 

InterBus is used in many different types of industry, including: automobile industry, food industry, 

building automation, plant construction, paper converting, wood processing and process engineering. 

InterBus has a user organization called the InterBus Club. The organization assists members on a wide 

variety of matters concerning InterBus. For more information, contact the InterBus Club: 

http://www.interbusclub.com 

The media used by InterBus is a shielded copper cable consisting of three twisted pairs. Two of these pairs 

are used for the bus connection and in the last pair only one cable is used. This cable is used to earth the 

bus. The baud rate for the bus is 500 Kbit/s with a total amount of data of 4096 I/O points. 

The Power Focus InterBus module is to be used on InterBus remote bus networks. In applications where it 

is necessary to exchange large amounts of data and where a parallel application interface is required, 

InterBus is the preferred option. 

InterBus has two ways of exchanging data. The first way is a fast cyclical I/O data, called process data. 

The other is a somewhat slower protocol called PCP, which is mainly used for configuring and setting the 

parameters of a device. The Power Focus InterBus module supports up to 10 words on the bus, out of 

which none, one, two or four words may be selected to act as the PCP –channel, necessary if the PCP-

protocol required.  

The PCP version supported by the module is version 2.0, which is fully backwards compatible. 

 
When using InterBus master boards where the PCP channel is not supported, the maximum 

input and output is 20 Bytes in and 20 Bytes out. 

Physical interface 

Interface Description 

Transmission media InterBus two differential lines. 

Topology Ring Structure. 

Fieldbus connectors 9 pin male D-sub. 

Cable Shielded copper cable, Three Twisted pair. 

Isolation The bus is galvanically separated from the other electronics with two DC/DC converters. Bus signals are 
isolated via optic couplers. 

ASICs and circuits Module is based on SUPI 3 and SRE1 chip from Phoenix contact. 

http://www.interbusclub.com/
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InterBus module 

Variable Limits 

Node Address Auto select 

Number of nodes in an InterBus network  

Baud rate 500 Kbit/sec, 2Mbit/sec 

Process string length <= 20 bytes 

Parameter string length (send with PCP) 200 byte – Process string length 

The string length in the Power Focus is limited to 200 bytes. InterBus standard 
allows 512 bytes. 

PCP length 0, 1, 2, 4 Words 

Parameter data index 0x6000 R/W + I (I = 0, 1, …) 

0x6040 RO + I (I = 0, 1, …) 

ID code (in PLC side) PCP 0 = 3 

PCP 1 = 0xF3 

PCP 2 = 0xF0 

PCP 4 = 0xF1 
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The following figure shows typical Data Map To/From PF for Interbus protocol. 

 

 
 

 
Due to Interbus standard specification it is necessary to cycle power on PF to validate 

changes in Fieldbus configuration. 

 

Hardware 

 

LED 1 = RBDA (Remote Bus Disable) 

LED 2 = TR (Transmit/Receive) 

LED 3 = CC (Cable Check) 

LED 4 = BA (Bus Active) 
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BUS-IN (9-pin D-sub male) 

Pin Name 

Housing PE 

1 DO1 

2 DI1 

3 GND 

4 Not used 

5 Not used 

6 /DO1 

7 /DI1 

8 Not used 

9 Not used 

BUS-OUT (9-pin D-sub female) 

Pin Name 

Housing PE 

1 DO2 

2 DI2 

3 GND 

4 Not used 

5 GND 

6 /DO2 

7 /DI2 

8 Not used 

9 RBST 

 
Always connect RBST to GND if it is not the last module on the bus. If the RBST is not 

connected to GND on the output connector, the Power Focus InterBus module will terminate 

the outgoing bus. 

Functionality of the indicator LED’s 

LED number Name Description 

1. RBDA Remote bus disable Active RED when outgoing remote bus is switched off. 

2. TR Transmit/Receive Active GREEN when PCP communication is carried out over the InterBus (0.6 s hold 

time to be visual). 

3. CC Cable check Active GREEN if the cable connection is good and the InterBus Master is not in RESET. 

4. BA Bus active Active GREEN. Is monitoring Layer 2. 
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Icon file 

 

Contact the local Atlas Copco service representative to get a copy of the Icon file for Power Focus. This 

file can be used to have a Power Focus Icon in the PLC configuration SW. File name: pf3intb.ico 

15.8.4 ModBusPlus 

ModBusPlus is a local area network system designed for industrial control and monitoring applications, 

developed by Modicon, Inc. The network enables programmable controllers, host computers and other 

devices to communicate throughout plants and substations. ModBusPlus transfers fast data for motor 

controllers, MMI, I/O units and other industrial equipment. ModBusPlus has an international user 

organization called Modicon Inc.  

General technical questions regarding the fieldbus should be addressed to the local ModBusPlus User 

Group in the first instance. 

A contact address list is available from the ModBusPlus Internet site http://www.modicon.com. 

Physical interface 

Interface Description 

Transmission media ModBusPlus uses one differential line (RS-485 twisted pair) and shield. 

Topology Token Bus Structure, virtual token ring. 

Fieldbus connectors 9 pin female D-sub. 

Cable Shielded copper cable, one twisted pair. 

Isolation The bus signals are separated from the other electronics with a transformer according to ModBusPlus 

interface description. 

ASIC’s and circuits Module is based on chip-set and software from Modicon Inc. 

Mechanical overview 

ModBusPlus module is a host device. This host device can be read and written to from another 

ModBusPlus host device or controller. ModBusPlus module does not initiate any point-to-point 

communication to other nodes, it only responds to incoming commands. It can although broadcast global 

data to all nodes on the network. 

Protocol and supported functions 

ModBusPlus has two ways of exchanging data. One through fast cyclic I/O data called global data and one 

through a somewhat slower ModBusPlus protocol for point-to-point parameter data transfer. The 

http://www.modicon.com/
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maximum global data is 32 words on the bus. The point-to-point data transfer is handled by using one of 

the following ModBus functions read holding registers, preset single register and preset multiple registers 

all 40000 registers. 

ModBusPlus module information 

Variable Limits Information 

Node Address 1 - 64 

 

The node address cannot be 

changed during operation. 

Source Address 1 - 64 The source address cannot be 
changed during operation. 

Number of nodes in a ModBusPlus 

network 

Max 32 (with repeaters 64)  

Bus length Max 2000 m with repeaters  

Bus cable length Max 500 m  

Data address 40001 + I (I = 0, 1, …) From PF 

41025 + I (I = 0, 1, …) To PF 

(Global data from PF data in the module starts 

from address 40001 and point-to-point data starts 

immediately thereafter. Global data to PF data in 

the module starts from address 41025 and point-

to-point data starts immediately thereafter. For 

example, if to PF string length is 8 bytes and to 

PF global string length is 4 bytes, the global data 

are mapped to address 41025 and 41026; the 

point-to-point data are mapped to address 41027 
and 41028.) 

This address is based on words. 

Baud rate Automatic (1Mbit/s) Automatically set from PLC at 

connection. 

Data to PF total length 0 - 200 bytes  

(The string length is in Power Focus limited to 

200 bytes. ModBusPlus standard allows 64 bytes 

global data and 250 bytes point-to-point data.) 

Must be the same in PF and PLC. 

Data from PF total length 0 - 200 bytes  

(The string length is in Power Focus limited to 

200 bytes. ModBusPlus standard allows 64 bytes 
global data and 250 bytes point-to-point data.) 

Must be the same in PF and PLC. 

Global string length (To/From PF ) 0 - 64 bytes Must be the same in PF and PLC. 

Host Firmware Rev. 77   
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Hardware 

 

LED 1: Not used 

LED 2: Error 

LED 3: MBP Active 

LED 4: MBP Init  

Functionality of the indication LED’s 

The module is equipped with four colored LED’s used for debugging purposes (LED 1 not used). The 

function of the LED’s is described in the table and figure below. 

Name Color Function 

Error  

(LED 2) 

Red Indicates that the communication is not OK. 

Turned Off – communication OK 

MBP Active 

(LED 3) 

Green Indicates different Node Status: 

Flashing every 160 ms – This node works normally, receiving and passing token. 

Flashing every 1 s - This node is in monitor offline status. 

2 Flashing, off 2 s - This node is in MAC IDLE never receiving-token status. 

3 Flashing, off 1.7 s - This node is not hearing any other nodes. 

4 flashing, off 1.4 s - This node has heard a valid packet that has a duplicated-node address sent from 

another node on the network, using the same Node ID. 

MBP Init 

(LED 4) 

Green Indicates that the peer interface is initialized 

Turned Off - peer interface is not initialized 

Fieldbus connectors 

ModBusPlus recommends the use of a 9 pin female D-sub connector. Depending on the protection class 

and type of application, other connector designs may also be used. 

Connector 9-pin female D-sub  

Pin Name 

1 Cable shielding 

2 Line-B 

3 Line-A 

4 PE 
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Node address 

Node address is set with the first DIP switch on the fieldbus module, allowing address settings from 1-64 

in binary format. If the set node address is from SW1, ModBusPlus takes SW node address regardless of 

hardware switch position. 

1 (MSB) 2 3 4 5 6 (LSB) Function  

ON ON ON ON ON ON Node address set to 1 

ON ON ON ON ON OFF Node address set to 2 

ON ON ON ON OFF ON Node address set to 3 

- - - - - - - 

OFF OFF OFF OFF OFF ON Node address set to 63 

OFF OFF OFF OFF OFF OFF Node address set to 64 

 

 
The Node address cannot be changed during operation. 

Source address 

Source address is set using the second dip switch (the one close to LED) on the fieldbus module; this 

enables address settings from 1-64 in binary format. If the set source address is from SW2, ModBusPlus 

takes SW source address regardless of hardware switch position. 

1 (MSB) 2 3 4 5 6 (LSB) Function 

ON ON ON ON ON ON Source address set to 1 

ON ON ON ON ON OFF Source address set to 2 

ON ON ON ON OFF ON Source address set to 3 

- - - - - - - 

OFF OFF OFF OFF OFF ON Source address set to 63 

OFF OFF OFF OFF OFF OFF Source address set to 64 

 
The source address cannot be changed during operation. 

Icon file 

 

It is not necessary for ModBusPlus to install a special file to recognize our product and it does not support 

icon files. 
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15.8.5 Ethernet/IP 

Ethernet is one of the most popular network technologies in use today. The major reasons for the 

popularity are a suitable mix of speed, cost and ease of installation. The technology benefits, the market 

acceptance, and the possibility to support, more or less, any non-real-time critical protocol, makes the 

Ethernet an ideal networking technology for most systems.  

More information, as well as links can be found at the web site http://www.iaona-eu.com.  

Hardware 

The module is based on a high performance CPU operating at 66 MHz. It features 8MB RAM and 2 MB 

FLASH. Both EthernetIP and ModbusTCP use the same interface card from HMS. 

 

 

 

 

LED # 

1. Link 

2. Module Status  

3. Network Status 

4. Activity 

 

 

 
All dipswitches have to be set in OFF position and parameter F120 (Set node address from) 

must be set to Hardware if DHCP server is to be used. 

. 

Supported fieldbus protocols 

ModBus/TCP 

The module supports the ModBus/TCP protocol and is conform to the ModBus/TCP specification 1.0. 

More information about the ModBus/TCP protocol can be found at 

http://www.modicon.com/openmbus/index.html 

Ethernet/IP 

The module supports the Ethernet protocol. 

Ethernet/IP is based on the control and information protocol, CIP, which is also the framework for both 

DeviceNet and ControlNet, to carry and exchange data between nodes. To be consistent with the other 

fieldbus modules that is based on the CIP, i.e., DeviceNet and ControlNet, the same vendor specific 

objects are implemented, together with new objects for servicing and monitoring the IT functionality. 

http://www.iaona-eu.com/
http://www.modicon.com/openmbus/index.html
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Ethernet/IP module 

Variable Limits Information 

IP address Do not configure the module to use any of them 

0.x.x.x 

127.x.x.x 

x.x.x.0 
x.x.x.255 

Devices on an Ethernet network are not 

allowed to be configured to the IP 
addresses listed in left column 

ModBus/TCP data address 000h + I (I = 0, 1, …) From PF* 

400h + I (I = 0, 1, …) To PF* 

This address is based on words. 

0000h + I (I = 0, 1, …) From PF* 

4000h + I (I = 0, 1, …) To PF* 

This address is based on bits 

EtherNetIP Assembly Instance 

0 

Input (Producing Instance): 100 (64h),  

Output (Consuming Instance): 150 (96h),  

Configuration Data Instance /size = 0/: 197 (C5h), 

Input-Only (Heartbeat): 198 (C6h), 

Listen-Only (Heartbeat): 199 (C7h) 

This is used to configure and transfer 
data to/from EtherNetIP module 

For Anybus FW >1.32 (For FW > 2.00 

and TTPF SW > 10.8 when Assembly 
instance parameter F157 is 0) 

EtherNetIP Assembly Instance 

1 

Input (Producing Instance): 100 (64h),  

Output (Consuming Instance): 150 (96h),  

Configuration Data Instance /size = 0/: 5 (05h), 

Input-Only (Heartbeat): 3 (03h), 

Listen-Only (Heartbeat): 4 (04h) 

This is used to configure and transfer 

data to/from EtherNetIP module 

For Anybus FW <1.33 (For FW > 2.00 

and TTPF SW > 10.8 when Assembly 
instance parameter F157 is 1) 

Data to PF total length 0 - 200 bytes*  Must be the same in PF and PLC. 

Data from PF total length 0 - 200 bytes* Must be the same in PF and PLC. 

* The data length is in PF limited to 200 bytes. ModBus/TCP and Ethernet/IP standard allows 1024 bytes data 

Fieldbus connectors 

The module uses standard Ethernet connector RJ45. 

The module uses twisted-pair cables, and no external termination is required. 

RJ45 (Standard) 

Pin Signal 

1 TD+ 

2 TD- 

3 RD+ 

4 Termination 

5 Termination 

6 RD- 

7 Termination 

8 Termination 
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Status indicators 

The module has four status LED’s. 

 

LED  State Summary Description 

LED 1 - Link Steady Off Not connected Module is not connected to Ethernet 

Steady Green Connected Module is connected to Ethernet 

LED 2 - Module Status Steady Off No power No power applied to the module 

Steady Green Device operational Module is operating correctly 

Flashing Green Standby The module has not been configured 

Flashing Red Minor fault A minor recoverable fault has been detected 

Steady Red Major fault A major internal error has been detected 

Flashing Green/Red Self-test The module is performing a power on self test 

LED 3 - Network Status Steady Off No power or no IP 
address 

Module has no power or no IP address  

Steady Green Connected Module has at least one Ethernet/IP connection 

Flashing Green No connections There are no Ethernet/IP connections established 

Flashing Red Connection timeout One or more of the connections in which this module 

is the target has timed out. This state is only left if all 

timed out connections are re-established or if the 
module is reset 

Steady Red Duplicate IP Module has detected that its IP address is already in 

use.  

Flashing Green/Red Self-test Module performing a power on self-test. 

LED 4 - Activity Flashing Green Active Flashes each time a packet is received or transmitted 

15.8.6 Modbus/TCP 

Modbus TCP is developed by Modicon, Inc. For more information visit http://www.modbus.org. 

Modbus/TCP uses the same hardware as Ethernet/IP. See section Ethernet/IP. The status indicators for 

Modbus/TCP are listed in the table below. 

LED  State Summary Description 

LED 1 - Link Steady Off Not connected Module is not connected to Ethernet 

Steady green Connected Module is connected to Ethernet 

LED 2 - Module Status Flashing green 1 Hz Connected IP address is not set using the configuration switch 

Flashing red 1 Hz Major fault Invalid MAC address 

Flashing red 2 Hz Major fault Failed to load Ethernet configuration from Flash 

memory.  

Flashing red 4 Hz Major fault Fatal internal error. 

Steady red Minor fault Duplicate IP address detected 

http://www.modbus.org/
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LED  State Summary Description 

LED 3 - Network Status Flashing green Number of 

connections 

The number of flashes on this LED indicates the 

number of established Modbus/TCP connections to 
the module. 

LED 4 - Activity Flashing green Package received Each time a packet is received or transmitted. 

15.8.7 ControlNet 

ControlNet is based on the Control and Information Protocol (CIP), which is also the application layer for 

DeviceNet and Ethernet/IP. 

The ControlNet module is classified as a ControlNet adapter, i.e., it cannot originate connections on its 

own, but a scanner node can open a connection towards it. The module is implemented according to the 

ControlNet International specification for a Communication adapter. 

ControlNet module is accessible by other nodes via UCMM (unscheduled) messages. Unscheduled 

messages are usually used for information such as configuration data. 

The module is also equipped with a NAP (Network Access Port) for temporary connection of 

configuration tools, e.g., a PC card. 

Features 

The ControlNet module includes the following features: 

 ControlNet adapter 

 Network access port (NAP) 

 Media redundancy support 

 Conforms to communication adapter, profile 12 

 MAC ID can be set via onboard switches or application interface 

 Up to 450 bytes of I/O data in each direction 

 UCMM Client/Server support 

 Galvanically isolated bus electronics 

 UL & CUL conformance 

EDS file 

Each device in a ControlNet network is associated with an EDS file, containing information needed for 

network configuration. The network configuration tool uses this file during network configuration. 
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Network Access Port (NAP) 

The NAP (Network Access Port) provides temporary access to the ControlNet network for diagnostic and 

configuration. (RJ45) 

ControlNet channels A & B 

The module is equipped with two BNC contacts for connection to ControlNet. If redundant operation is 

desired both connectors are used, otherwise connector A or B is used. (BNC) 

Mac ID switches (x10 and x1) 

On a ControlNet network, each node must be assigned its own unique node address. The module features 

on board switches for Mac ID configuration, providing an address range of 1 – 99.  

In the example below the Mac ID is set to 42 (4 x 10 + 2 x 1). 

 

Indicators  

ControlNet status indicators indicate run time status and errors to the user. 

LED Indication State Description 

1 Module status Green Connection in run state 

Green Flashing Connecting connection idle 

Red Major fault 

Red Flashing Minor fault 

2 and 3 Channel A and Channel B Off Module not initialized 

Red Major fault 

Alternating red/green Self test 

Red Flashing Node configuration error, duplicate Mac ID etc. 

2 or 3 Channel A or Channel B Off Channel disabled 

Green Normal operation of channel 

Green Flashing Temporary error (node will self correct) or not configured 

Red Flashing No other nodes, or media fault 

Red & Green Flashing Network configuration error 

4 Module owned Off No connection has been opened 

Green A connection has been opened towards the module 
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15.8.8 Profinet 

The embedded Profinet interface is a complete Profinet solution for a Profinet IO device. All analogue and 

digital components that are needed for a complete Profinet IO interface with soft-real time (RT) are 

mounted on the module. The module is based on the Siemens Profinet I/O software technology. 

The Profinet module works as an I/O-Device on the Profinet network. The module supports up to 512 

bytes of IO for both Input and Output data. The module baud rate is 100Mbit/s (full duplex). The IP-

address can be configured either via DHCP (BootP) or DCP. Three diagnostic LEDs continuously indicate 

the actual Profinet status and eventually error messages. The module also supports the normal Profinet 

Alarm functionality. In the standard version the module uses a normal RJ45 connector for the bus 

connection. 

Features 

 Up to 64 slots / 1 sub slot 

 Up to 1024 bytes cyclical I/O (512 input & 512 output) 

 2 ms cycle time 
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Indicators 

Led Indication State Description 

1 Link/Activity Green Link established 

Green flashing Receiving/Transmitting data 

Off No link or power off 

2 Communication Status Green Online, Run 

Connection with IO Controller established 

IO Controller is in Run state 

Green, 1 flash Online, Stop 

Connection with IO Controller established 

IO Controller in Stop state 

Off Offline 

- No connection with IO Controller 

3 Module Status Green Initialized, no error 

Green, 1 flash Diagnostic data available 

Green, 2 flashes Blink, Used by an engineering tool to identify the fieldbus module 

Red, 1 flash Configuration Error 

Too many modules/sub modules 

I/O size derived from IO controller configuration is too large 

Configuration mismatch (no module, wrong module) 

Red, 3 flashes No device name or no IP address assigned 

Red, 4 flashes Internal error 

Off No power or not initialized 

4 - - - 

GSD 

On Profinet, the characteristic of a device is stored in an XML data file. This file, referred to as the “GSD” 

– file is used by Profibus configuration tool when setting up the network. 

Connector 

Connector RJ45 standard Ethernet connector is used. 
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15.8.9 FL-Net 

FL-Net is a control network, primarily used for interconnection of devices like PLCs, Robot controllers, 

and Numerical Control Devices. FL-NET has both cyclic data and message data. There is no master on a 

FL-Net network; a token communication method is used for data transmission. 

The FL-Net network is based on IP/UDP broadcast messages. 

The module is classified as a “Class 1” FL-Net node as it can both send and receive cyclic data. 

PF only transfer cyclic data and only use area 2. 

Cyclic transfer 

FL-Net has two areas for cyclic data, Area 1 and Area 2. These two memory areas are shared by all nodes 

on the network. And every node configures the part of the area it updates. 

 Area 1 is 512 words. 

 Area 2 is 8192 words. 

The cyclic data is mapped to the module I/O area, which maximizes the size of I/O data to 512 bytes in 

each direction-for the module. 

The time from reception of a token until transmission should not exceed 1.56 ms. 

Indicators 

Led Indication state description 

1 Ethernet Link Green Module is connected to Ethernet 

Off No link 

2 Error Red Indicates that the unit must be replaced (For example, invalid MAC ID) or Anybus 

watchdog in was not updated. 

Red, flash Parameter error 

Off Normal state 

3 Activity (COM) Green No activity 

Off Flash green each time a packet is received or transferred 

4 FL-Net Link Green Participates in FL-Net 

Off No participation 
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Connector 

Connector RJ45 standard Ethernet connector is used. 

 

Address dipswitch 

A dipswitch with 8 positions is used to configure the low byte of the IP address. 

IP configuration 

The IP configuration can be set with DIP switch or mailbox message. Subnet mask is always 

255.255.255.0, gateway is not used. 

The different IP configuration options (see table below). 

Method Description Restriction 

Software setting Configure via ToolsTalk PF Software setting overrides the DIP switch. 

DIP switch Use 192.168.250.X where X is set with the DIP switch. See 

RFC 1918. 

 

This is the preferred method for FL-NET. 

 

Must be set before power on. 

15.8.10 CC-Link 

CC-Link is an open-architecture network managed by the CC-Link Partner Association (CLPA). For more 

information visit http://www.cc-link.org 

In brief: 

 Baud rate can be selected among 156k, 625k, 2.5M, 5M and 10 M. 

 Based on RS485 with networks up to 1.2 km, or extended to 13.2 km with repeaters  

 64 stations per network  

 Refresh time of <3.9mSecs for 65 I/O stations (distance dependent)  

 Master/Slave network with Floating Masters and hot swap of stations  

Hardware 

  Transmission media: shielded 3 line copper wire 

  Topology:  trunk line, multi drop 

  FieldBus connectors:  M12, CLPA, D-Sub9 

  PF connector: 5 pin DeviceNet/CANopen Open Style Connector 

http://www.cc-link.org/
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LED # 

1. Run 

2. Error 

3. Receive Data 

4. Send Data 

 

Connectors 

The PF standard connector is a 5 pin pluggable screw connector (same as for DeviceNet).  
 

Pin Color Code Signal 

1 Blue DA Communication line A 

2 White DB Communication line B 

3 Yellow DG Digital GND  

4  SLD Shield 

5  FG/PE Frame Ground  

 

 

 

Bus termination 

When repeater or CC-Link dedicated, high performance 130 Ohm cables are not used connect terminal 

resistor (110 Ohm 5% 0,5W) between DA and DB on each edge of the trunk line (CC-Link dedicated 110 

Ohm impedance cables should be used). 
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Functionality of the indication LED’s 

The module is equipped with four bicolour LED’s used for debugging purposes. The function of the 

LED’s is described in the table and figure below. 

 

LED Indication State Description 

1 Run Off Network non-participating or time out status 

Green Normal operation 

2 Error Off Normal operation 

Red CRC error, wrong station number or wrong baud rate 

3 RD Off No data reception 

Green Data being received 

4 SD Off No data transmission 

Green Data being transmitted 

 

Station Number 

Station Number is set with the two rotary switches on the FieldBus module; this enables address settings 

from 1-64 in decimal form (see switches on the top drawing): 

 

 

 

Switch 1 (SW1) digit x10 

Switch 2 (SW2) digit x1 
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Example:  

Address = (Left Switch Setting x 10) + (Right Switch Setting x 1) 

Left switch is set to 5 and right switch is set to 2. This gives a node address of 52. 

If you want to set the node address from TT the switches must be set to 99. 

 
The node address can not be changed when the power is switched on. 

The SW1 and SW2 are 2 most right placed! 

 

Baud rate 

The baud rate on a CC-Link network is set during configuration of the master and only one baud rate is 

possible in a CC-Link installation.  

 

Baud Rate Switch (SW3).This rotary switch is used to specify the baudrate of the module. This can also be 

specified by software (TTPF), in this case the switch must be set to ‘9’. 

 

 
The SW3 is placed to the left of SW1 and SW2! 

 

Pos Bauds rates supported by PF 

0 156 kbit/s 

1 625 kbit/s 

2 2.5 Mbit/s 

3 5 Mbit/s 

4 10 Mbit/s 

9 SW set 

 

 

CC-Link Configuration 

Set node address and baud rate from 

If set from “Software” backplane switches SW1 to SW3 should be set all to 9 (9-9-9). When “Hardware” 

is selected refer to information in APPENDIX B about configuring switches.  

Note: PF reboot is needed after change! 

 

Baud Rate 

Baud rate can be selected among 156k, 625k, 2.5M, 5M and 10 M. 
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Station Number 

Station Number can be set from 1 to 64. 

 

CC-Link Version 

In CC-Link data is transferred via virtual memory on the network. Each device has deterministic 

area in this memory. The minimum area is the 1 station area. One device occupy up to 4 station 

memory area for own slave communication. Following diagram shows typical data one station 

long: 

 

 
 

PF, classified as Remote Device Station can use both RY (bit data) and RWw (word data) for 

transfer of To/From PF Data.  

 

Max data size in CC-Link version 1 is 48 bytes, which include 128 bit points (16 bytes) and 16 

words (32 bytes) – when taking 4 station memory area.  

 

Max data size in CC-Link version 2 is 368 bytes, which include 896 bit points and 128 words. 

But PF limited the max data length to 200 for all the Fieldbus types. The length is depending not 

only on number station areas taken but also on number of extension cycles. Max occupied station 

is 4 and extension cycles are 8. 

 

Data representation with CC-Link version 1 

The module will use the data length defined in TTPF F102 and F103 to determine the number of 

occupied stations, actual IO data size used on CC-Link as follow: 

 

Data length  

(in bytes) 

Occupied 
stations 

Bit data 
(in bytes) 

Word data 
(in bytes) 

Description 

0 < length ≤ 4 1 s 0 No word data 

4 < length ≤ 12 4 length - 4 Word data range 1-8 bytes 



Fieldbus 

244 (428) 9836 3123 01 

12 < length ≤ 24 2 8 length - 8 Word data range 5-16 bytes 

24 < length ≤ 36 3 12 length - 12 Word data range 13-24 bytes 

36 < length ≤ 48 4 16 length - 16 Word data range 21-32 bytes 

48 < length ≤ 200 16 32 Data after 48 bytes not accessible from the bus 

 

Data representation with CC-Link version 2 

When using version 2, the module can optionally use an extended number of bus cycles to 

exchange larger data size. Note that this feature requires a CC-Link v.2 capable master. The 

relation between the occupied stations and the number of extension cycles are defined in the 

following table. The PF supported combinations are marked with yellow color. 

 

Occupied 
stations 

1 Extension Cycles 2 Extension Cycles 4 Extension Cycles 8 Extension Cycles 

Points Bytes Data 
length 

bytes 

Points Bytes Data 
length 

bytes 

Points Bytes Data 
length 

bytes 

Points Bytes Data 
length 

bytes 

1 32 bits 4 12 32 bits 4 20 64 bits 8 40 128 bits 16 80 

4 words 8 8 words 16 16 

words 

32 32 words 64 

2 64 bits 8 24 96 bits 12 44 192 bits 24 88 384 bits 48 176 

8 words 16 16 

words 

32 32 

words 

64 64 words 128 

3 96 bits 12 36 160 bits 20 68 320 bits 40 136 640 bits 80 272 

12 

words 

24 24 

words 

48 48 

words 

96 96 words 192 

4 128 bits 16 48 224 bits 28 92 448 bits 56 184 896 bits 112 368 

16 

words 

32 32 

words 

64 64 

words 

128 128 

words 

256 

 

When running version 2, the data length defined in TTPF for F102 or F103 must match the 

corresponding data sizes in the table above, otherwise, the module will indicate an error. In this 

position data length is selected from drop-down list. 
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16 Logic Configurator 

The Logic Configurator is a tool to combine and configure process signals coming from the 

screw tightening process or from an external device. It is available in the Power Focus 4000 

hardware only and is programmed over the ToolsTalk PF interface.  

The Logic Configurator consists of up to 8 different so called “Configurator sheets”, each denoted with a 

number (1 to 8, automatically chosen) and a name (25 positions, editable). 

Each Configurator sheet consists of; 

 inputs, i.e., selectable events from the Relay status array and the DigIn status arrays 

 instruction list, i.e., logic gate information 

 output configuration 

Every Logic Configurator circuit instruction list is evaluated every 100 ms which corresponds to a tick or 

every time an input status changed. 

  
If one digital input is configured several times, on two IO expanders for instance, the DigIn 

function status is the OR result of both digital inputs. 

The logical events used for input to the Logic Configurator are of the type tracking or 

pulse. The pulse type signals are reset after one tick.  

Example 1: OK relay is pulsed after an OK tightening and goes low after 100 ms.  

Example 2: Reset batch input is pulsed when activated and goes low after 100 ms. 
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16.1  Process description (an example) 

When a work piece is positioned, a proximity 

switch in the fixture detects its presence. The 

work piece is held in position by an air cylinder. 

The position work piece fixtured is detected by a 

second proximity switch.  

When the two proximity switches work piece in 

place and work piece fixtured are active, the 

tightening operation can begin. After finalizing 

the tightening operation, a green lamp lights and 

stays lit to indicate the OK result to the operator. 
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16.2 Logic operators and function blocks 

16.2.1 Logic gates  

Symbol Description Input Output 

 

The output signal is HIGH only if both inputs to the gate are HIGH.  

If neither or only one of the inputs is HIGH, the output is LOW. 

A B A AND B 

0 0 0 

0 1 0 

1 0 0 

1 1 1 

 

The output signal is HIGH if one or both inputs to the gate are HIGH.  

If neither of the input is HIGH, the output signal is LOW. 

A B A OR B 

0 0 0 

0 1 1 

1 0 1 

1 1 1 

 

The output signal is HIGH if one, and only one of the inputs to the gate is HIGH. 

If both inputs are LOW or both are HIGH, the outputs signal is LOW. 

A B A XOR B 

0 0 0 

0 1 1 

1 0 1 

1 1 0 

 

The outputs signal is LOW only if both the inputs to the gate are HIGH.  

If one or both inputs are LOW, the output signal is HIGH. 

A B A NAND B 

0 0 1 

0 1 1 

1 0 1 

1 1 0 

 

The output signal is HIGH output results if both the inputs to the gate are LOW. 

If one or both input is HIGH, the outputs signal is LOW  

A B A NOR B 

0 0 1 

0 1 0 

1 0 0 

1 1 0 

 

The outputs signal is HIGH if both inputs to the gate are the same.  

If one but not both inputs are HIGH, the outputs signal is LOW. 

A B A XNOR B 

0 0 1 

0 1 0 

1 0 0 

1 1 1 
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16.2.2 Function blocks 

Symbol Name Description 

 

Flip Flop Reset 

Dominant  
(Flip Flop RS) 

The Flip Flop gate is also called latch or bi-stable relay 

and acts like a memory. R and S stand for Reset and Set. 
The stored bit is present on the output marked Q1.  

If S receives a positive flank (transition low to high) while 

R1 is low, then the Q1 output goes high, and stays high 
when S returns low.  

If R1 goes high while S is low, then the Q1 output goes 

low, and stays low when R1 goes inactive.  

If S goes high while R1 is high, then the output Q1 

remains low since priority is given to the R1 input. 

S R1 Q1 

0 0 Keep state (memory) 

1 0 1 

0 1 0 

1 1 0 (Reset dominant) 
 

 

Flip Flop Set Dominant  

(Flip Flop SR) 

If S1 receives a positive flank while R is low, then the Q1 

output goes high, and stays high when S1 returns low.  

If R goes high while S1 is low, then the Q1 output goes 

low, and stays low when R returns low. 

If R goes high while S1 also is high, then the Q1 output 
remains high since priority is given to the S1 input. 

 

S
1 

R Q1 

0 0 Keep state (memory) 

1 0 1 

0 1 0 

1 1 1 (Set dominant) 
 

 

Delay The Delay is implemented as a shift register. It has a 

preset timer (delay time) multiple with the PLC tick. 

PT stands for Preset Time and is configurable. 
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Symbol Name Description 

 

 

Timer ON (TON) The output Q is triggered only if the input IN is held high 

during at least Present Time (PT). The output Q goes low 
when the input IN goes low. 

 

 

Timer OFF (TOF) Q is triggered every time the input IN receives a positive 

flank The output is high during Present Time (PT) after 
the input IN has gone low. 

 

 

Pulse Present Time (PT) corresponds to the pulse ON and OFF 
time.  

The pulse frequency is equal to f = 1 / (2 * PT) Hz 

The output Q is active while the input IN is high. 

 

 

Timer Pulse (TP) Q is triggered for Present Time (PT) after a positive flank.  

Note that if the new input up flanked takes place while Q 

is high it will be ignored. 
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Symbol Name Description 

 

 

Timer Pulse Reset (TPR) Q is triggered for Present Time (PT) after a positive flank.  

Note that if a new positive flank is received while Q is 

high, the “on” timer will be reset and the output will be 

held high for a new PT time. 

 

 

Counter Up (CTU) The CTU has one output Q. 

PV is the preset value of the counter i.e. the counter value 
to reach for the output to be forced high. 

The counter up has a current counter value CV. When CV 
is equal to PV the output Q goes high. 

CV is incremented after every positive flank of the CU 
input  

Note that if CV = PV, then CV is not incremented. 

CV is reset after a positive flank on the input R. 

The output Q is kept high while CV = PV and until R 
receives a positive flank 

 

 

Counter Down (CTD) The CTD has one output Q.  

PV is the preset value of the counter i.e. the start value of 

the counter.  

The counter down has a current counter value CV. When 

CV is equal to zero the output Q goes high. 

CV is decremented after every positive flank of the CD 
input 

Note that if CV = 0, CV is not decremented. 

CV is reloaded (CV is set equal to PV) after a positive 
flank on the input LD. 

The output Q is kept high while CV = 0 and until LD 
receives a positive flank. 
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16.3 Logic Configurator setup 

The first step to program the 

Logic Configurator is to open 

a Configurator sheet. 

Right-click Logic 

Configurator in the PF Map 

and select Create new Logic 

Configurator. 

 

ToolsTalk proposes an ID no. 

for the new Configurator sheet, 

but this can also be chosen by 

the user.  

Select a name that relates to the 

function the Configurator sheet 

should have. 

Click OK to confirm. 

A warning appears. 

Click OK. 
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A new window appears where the next step is to define the number of inputs for the Configurator sheet. 

 

Click the Set number of inputs key. 
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 Move the slide bar (or type in the number 

directly) to set an input count. 

Click OK. A new window appears that shows the 

layout of the Configurator sheet with the 

selected number of inputs.  

Click OK again to reach the setup window. 

Now it is time to configure the inputs, outputs 

and logical gates. 

 

Let’s start with the inputs. Click on the Input key to select the input event. By selecting Digital input 

from the first drop-down menu, the events tied to the inputs of the Power Focus can be reached.  

If choosing Digital outputs, the list of events will contain the signals generated in the Power Focus. 
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Next, let’s define what the output signal of the Configurator sheet should be used for. 

If the output signal should be used as input to another Configurator sheet, or be put out directly on a 

physical Relay, no action is required in this window. The output signal from the Configurator sheet is 

automatically labeled “Logic Relay #”, where “#” is the number of the Configurator sheet. The signal 

“Logic Relay #” is available in the drop-down menu of e.g. the Relay setup window under “Accessories” 

in the PF Map. 

If the output of the Configurator sheet should be used for other purposes, click on the Output. Then select 

up to four events under Trigger digital inputs, or one of the three quick choices (Select Job, Select Pset 

and Use text). 

Click OK when finished. 
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Now the logical grid remains to be set up. 

By clicking on the keys in the gate symbol, a drop-down menu showing the logic functions appear. 

 
See table in section Logic gates for a description of the available gates (AND, OR, XOR, 

NAND, NOR, XNOR). 

See table in section Function blocks for a description of the available functions (Pass, NOT, 

Timer, Delay, Flip Flop, Counter). 
 

Select the gate and where applicable, the timer or counter value. 

If the depth of the grid (right-to-left) needs to be increased for your functionality, click on the Plus icon to 

insert a new level. To reduce the depth of the grid, click the corresponding Minus sign. 
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16.3.1 Simulation 

The Logic Configurator features an off-line simulator that helps verifying the logical grid. The line at the 

lower part of the window is blue and low as long as the input settings and logic gates result in a LOW 

output signal. When the inputs and the grid result in a HIGH output signal, the line turns green and alters 

to the high position. The transitions up and down of the simulator will shift to the right in the window 

due to the time factor. 

Correspondingly, the colors of the connections in the logical grid changes color – blue when inactive and 

green when active. 

Manipulate the simulator input signals by clicking on the switch symbol in the input blocks. One click 

will toggle the status of the signal between HIGH and LOW. 

 
Click the Restart simulation key to clear (set zero) all signals. 

 

Click Store to save all settings. 
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17 Monitors 

ToolsTalk PF offers various monitors to present real-time information about the processes 

that Power Focus is involved in (see the table below). 
 

Function Description 

Result monitor Result monitor displays tightening results and statistics. 

Job monitor Job monitor displays Jobs and provides functionality for managing Jobs. 

Operator monitor  Operator monitor displays tightening result information, also containing graphic representation such as 

charts and status indicators.  

Picture monitor Picture monitor displays a visual description of the tightening process, suitable for training purposes. 

Get all results  Get all results displays result information stored in the Power Focus and export possibilities.  

Trace Trace displays detailed chart information from the latest tightening.  
 

To open monitors:  

 In the main Menu list, select Window > Activate > Result. 

 In the PF Map, expand the Monitors branch and double-click on the monitors. 

 On the Toolbar, use the drop menu to the right of the Monitor icon. 
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17.1 Result Monitor 

In the PF Map Monitor branch, double-click on Result Monitor. 

 

The Result Monitor presents the latest tightening results from the Power Focus and the used Pset.  

The tightening result includes the Final torque, Final angle, Overall status, Torque chart and Angle chart. 

Select between Torque Chart, Angle Chart or Torque/Angle Plot to display results for a unique Pset. 

It is possible to display several windows with different views, with a maximum limit of four. 
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17.2 Job Monitor 

In the PF Map Monitor branch, double-click on Job Monitor. 

Job Monitor displays Jobs and provides functionality for managing 

Jobs. 

For a function description (Restart Job, Decrement, Increment, 

Bypass, Abort Job and Job off) see section Job. 

 

 



 Monitors 

9836 3123 01 263 (428) 

17.3 Operator Monitor 

In the PF Map Monitor branch, double-click on Operator Monitor. 

 

Select Operator Monitor. 

Click OK and the monitor appears (see figure and table 

below). 
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Part Description 

PF name Name of PF 

Pset Pset used to perform the tightening 

VIN Vehicle Identification Number 

Overall status Indicator for the overall status of the tightening 

Final torque Final torque of the tightening 

Final torque status Status-indicator for final torque.  

(yellow-low/ green-OK/red-high) 

Final angle The final angle of the tightening 

Final angle status Status-indicator for the final angle.  

(yellow-low/ green-OK/red-high) 

Batch The order of the current operation in the batch 

Batch order The overall status of the respective operation in the batch 

Plot chart Displays the final torque and final angle, relative to the acceptance window 

Torque chart Displays the torque as a function of time 

Events  Warnings and events 
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Right-click anywhere in the window to open the Options menu. 

 

Option Description 

Activate presentation User preferences for the content of the operator 

monitor 

Set background Color The option to set the background color of the operator 

monitor 

Toggle window Maximize or minimize the window  

Toggle mouse cursor The mouse is visible or invisible 

Set label color Option of setting the label color for the operator 

monitor 
 

Choosing Activate Presentation the user customizes the 

information shown in the Operator Monitor by checking the 

boxes. 

Click OK. 

 



Monitors 

266 (428) 9836 3123 01 

17.3.1 Picture Monitor 

The Picture Monitor is a feature that gives the user visual guidance throughout the Job sequence. The next 

tightening (Pset) in a running Job can be presented graphically with an image, e.g., a picture of the area 

where a bolt is placed. 

To open the picture monitor, select Picture Monitor and 

click OK. 

To edit Picture Monitoring, click Picture Setup. 

Click Set Picture and select an image-file using the file 

selector window. 

 
The user has the possibility to associate an 

image-file with a Pset (available format; 

*.jpg”, *.bmp”, *.ico, *.emf and *.wmf). 

Select a Pset from the list. 
 

 

To import saved settings for the picture monitor, click Read from file. 

To save the settings click on Store to file. A save as-window appears and the user can choose where to 

store the file containing the settings. When finished click OK. 
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17.4 Identifier Monitor 

In the PF Map Monitor branch, double-click on Identifier Monitor. 

Identifier monitor displays the status (accepted/not accepted) of 

the identifier included in the Work order and Optional identifier 

(not included in work order). For more information, see section 

Identifier. 

 
In the example below, all Identifier input sources are 

set to “Ethernet/serial”. 
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Function Description 

Bypass identifier Skips a specified identifier type in a work order.  

If a type is not included in the work order, bypassing the first type in the work order is not possible. 

Reset latest identifier The latest accepted identifier string is cleared with the command (or digital input) Reset latest identifier. 

It is not possible to perform Reset latest identifier for the last type in a work order. 

Reset all identifier All accepted identifier strings are cleared with the command (or digital input) Reset all identifiers. 
 

17.5 Get all results 

Power Focus can store up to 5000 individual tightening results. With the Get all results option, the user is 

able to retrieve and view these. The user also has the choice of saving them to a text file or an Excel file. 

In the Toolbar, select Get all results. 



 Monitors 

9836 3123 01 269 (428) 

 

Choose a specific Pset or 

Multistage and click OK. 

 

 

The tightening results from that Pset/Multistage appear. Picking up data takes some time depending on 

the type of connection and the number of results. 

By choosing Save to file the results are saved into a text file.  

The user can also choose to open and view the results in Microsoft Excel by selecting Open in Excel. 

This, of course, requires a properly installed version of Microsoft Excel. 
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18 Trace 

ToolsTalk PF provides a Trace function designed to present extensive information about the 

tightenings. 
 

There are three different ways to open the Trace monitor: 

 In the PF Map, and double-click Trace. 

 In the main Menu list, select Window > Activate > Trace. 

 Click the Trace icon on the Toolbar. 

 

18.1 The trace window 
Select which type of chart to view; Torque over time, Angle over time, Speed over time, Torque and angle 

over time, Torque over angle, Torque and Speed over time. 

Press Scale limits to configure the axis according to preference. 

With Angle offset selected, Trace shows graph from the P120 Start final angle torque value i.e. the Angle 

axis is set to zero according to the P120 value. Traces that are below this value are shown in grey color. If 

deselected, Trace shows graph from P110 Cycle start torque value. 

With Envelop selected, the sample spread between traces is shown. Envelop is made of two traces; one 

made of the maximum sample values and one with the minimum sample values taken from all displayed 

traces. 
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With Auto update selected, the charts are automatically updated as new tightening data arrives. If 

deselected, the user can choose which trace to view.  

The Limits function allows the user to customize the limits in the chart.  

History settings make it possible to view previous OK/ NOK traces. To view History set the Index 

according to the number of the trace that should be displayed and press Get. E.g. Index 2 results in that the 

second last OK/ NOK trace is displayed. The number of stored traces is limited by C607 No. of Traces. 

There are two alternatives for saving traces from this window; saving the active trace or saving all traces. 

Note that from the File menu it is also possible to print the latest trace as it is shown in the window, or 

print all types of charts for the latest trace. 

Zooming in to a smaller part of the chart is done by selecting an area (i.e. clicking the mouse button 

somewhere in the chart, moving the cursor down and to the right, and releasing the mouse button).  

Unzooming is done by clicking the mouse button and moving it up to the left before releasing it.  
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19 Statistics 
Power Focus has extensive statistics functionality. The values are updated after each tightening, and can 

be shown on the display in real time, or sent to a PC. It is also possible to send statistical reports to a 

printer. On the front panel of PF there is a LED for statistical alarms. 

Settings are made in PF Map>Pset>Statistic Programming. Statistics are calculated based on the following 

result parameters: 

Result Unit Description 

Torque Nm* Final torque in selected tq presentation unit. 

Angle Deg Final angle in degrees. 

* = Other units can be used. 

The following statistical results are calculated and displayed for torque and angle parameters: 

Results Description 

# Results Total number of results that the stat calculations are based on for the analyzed Pset. 

Min Lowest result in analyzed Pset 

Max Highest result in analyzed Pset 

R Range (Max - Min) 

Low % low tightenings in analyzed Pset 

OK % OK tightenings in analyzed Pset 

High % high tightenings in analyzed Pset 

X  
The mean value for the selected Pset 

σ Sigma. Shows the calculated standard deviation. σ 

X -3 σ 
Mean - 3 sigma 

X +3 σ 
Mean + 3 sigma 

6 σ 6 sigma 

Cr Cr is a calculated viability number (capability). The lower the value, the better the process. 

Cp Cp is a viability factor. The higher the value the better process. 

Cpk Cpk is a viability factor. The higher the value the better process. 

Cam Viability factor. The higher the value the better the process. 

  

Sub-group 
results 

Description 

Min Lowest result in the latest completed subgroup 

Max Highest result in the latest completed subgroup 

R Range for the latest completed subgroup 
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Sub-group 
results 

Description 

x  
Mean value for the latest completed subgroup 

σ Sigma for the latest completed subgroup 

Other definitions Description 

R  
Mean of subgroup range (number of subgroups) 

X  
Mean of subgroup mean (number of subgroups) 

 

In order to rapidly detect changes in the process, Power Focus is equipped with a number of statistical 

alarm limits based on the x  and R calculations for torque and angle. 

Statistical Process Control (SPC) functions are used on torque and angle. 

All calculations are performed on the Pset that the tool is currently running with.  

If any of the following criteria are true, then the stat alarm is lit and a relay (if used) is activated. The tool 

may still run even if an alarm is issued. The alarm is only a warning. The alarm signals remain active until 

the process falls within all limits again or the result memory is cleared. This means that the alarm does not 

switch off during tightening.  

19.1 Statistic alarm 

x > UCL 

x < LCL 

R > UCL 

R < LCL 

Cp < 2.0 

Cpk < 1.33 

SPC x  and R compared with LCL / UCL alarms cannot function until the LCL and UCL have been 

programmed. 
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19.2 Trend deviation alarm 
Trend deviation check and alarm are measured and compared against X-bar and the range for the currently 

used Pset. 

7 points consecutively increasing 

7 points consecutively decreasing 

7 points consecutively above average ( X and / or R ) 

7 points consecutively below average ( X and / or R ) 

1 point outside X  or R   2 sigma (sigma for the whole population) 

Point = subgroup 

The mean is the average of x  and r X and R ). This means that the SPC trend alarms cannot function until 

the number of tightenings in the memory corresponds with the user-specified number of subgroup 

parameters. 

19.3 Calculation of UCL and LCL 
Power Focus calculates recommended values for UCL and LCL. The operator can then choose if he wants 

to use these values or enter another value. 

Subgroup size, Subgroup frequency and number of subgroups parameters are used in the calculations. 

19.4 Calculation of mean values 

Power Focus calculates the mean values X  and R . The operator can then choose if he wants to use these 

values or enter another value. Sub group size, subgroup frequency and number of subgroups parameters 

are used in the calculations. 
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19.5 Calculation formulas 
When a stat display is requested, the whole memory is calculated. This is also done when shifting Pset. 

Power Focus controls the lowest and highest values. If some of these drop out from memory once it is full 

(first in – first out), the entire memory is recalculated. 

The formula for group range is calculated after each completed subgroup. 

The formulas for the statistic parameters used by Power Focus: 

 iX  = value 

 n = number of tightenings 

 Min = minimum value from all the tightenings in the Power Focus memory 

 Max = maximum value from all the tightenings in the Power Focus memory 

 minl = minimum acceptable value 

 maxl = maximum acceptable value 

Range R Max Min    
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iX         1iX      2iX   3iX   4iX  

5iX   6iX   7iX   8iX   9iX  

10iX  11iX  12iX  13iX  14iX   

...iX  

 

A subgroup is a group of tightenings. Subgroup size is freely programmable and in the example above it is 

set to 5, which means that all values in the same group range from i to i+4. 

X-bar is the calculated average of the last completed subgroup. 

Subgroup size = Group size = z 
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The formula for CAM is calculated using the first 6 subgroups. After that, a new calculation is made using 

each completed subgroup in conjunction with the last 6 subgroups. 
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32 , DA  and 4D are tabular constants and depend on the subgroup size. 

19.6 Constants for calculation of SPC variables 

Sub group 
size 

Divisors for 
estimation of 
standard div. 

Factors for control limits  

N D2 C4 A2 D3 D4 A3 B3 B4 

2 1.13 0.798 1.88 - 3.27 2.66 - 3.27 

3 1.69 0.886 1.02 - 2.57 1.95 - 2.57 

4 2.06 0.921 0.73 - 2.28 1.63 - 2.27 

5 2.33 0.940 0.58 - 2.11 1.43 - 2.09 

6 2.53 0.952 0.48 - 2.00 1.29 0.03 1.97 

7 2.70 0.959 0.42 0.08 1.92 1.18 0.12 1.88 

8 2.85 0.965 0.37 0.14 1.86 1.10 0.19 1.82 

9 2.97 0.969 0.34 0.18 1.82 1.03 0.24 1.76 

10 3.08 0.973 0.31 0.22 1.78 0.98 0.28 1.72 

11 3.17 0.975 0.29 0.26 1.74 0.93 0.32 1.68 

12 3.26 0.978 0.27 0.28 1.72 0.89 0.35 1.65 

13 3.34 0.979 0.25 0.31 1.69 0.85 0.38 1.62 

14 3.41 0.981 0.24 0.33 1.67 0.82 0.41 1.59 

15 3.47 0.982 0.22 0.35 1.65 0.79 0.43 1.57 

16 3.53 0.984 0.21 0.36 1.63 0.76 0.45 1.55 

17 3.59 0.985 0.20 0.38 1.62 0.74 0.47 1.53 

18 3.64 0.985 0.19 0.39 1.61 0.72 0.48 1.52 

19 3.69 0.986 0.19 0.40 1.60 0.69 0.50 1.50 

20 3.74 0.987 0.18 0.42 1.59 0.68 0.51 1.49 

21 3.78 0.988 0.17 0.42 1.58 0.66 0.52 1.48 

22 3.82 0.988 0.17 0.43 1.57 0.65 0.53 1.47 

23 3.86 0.989 0.16 0.44 1.56 0.63 0.55 1.46 

24 3.90 0.989 0.16 0.45 1.55 0.62 0.56 1.45 

25 3.93 0.990 0.15 0.46 1.54 0.61 0.57 1.44 
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20 Quick reference guide 
Use this appendix in conjunction with as a reference guide when programming the Power Focus. A more 

general description of the tightening and control strategies available can be found in the previous chapters. 

 

 

A joint is regarded as hard if α (clamping angle) is small, and soft if α is 

large. There is no limit, but test standards define α < 30 as hard. The 

dynamic effects on tightening increase dramatically if angles go down 

substantially (approximately 15). 

On the following pages, different control and monitoring strategies are calculated. Study the graphs and 

the parameters that need to be set. Note that the graphs are presented schematically, which means that 

programming results may look different compared to the graph. 
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20.1 Tq con 

20.1.1 One stage 
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20.1.2 Two stage 
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20.1.3 Quick step 
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20.1.4 Ergo ramp 
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20.2 Tq con/ang mon  

20.2.1 One stage 
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20.2.2 Two stage 

 

P120 Start final angle 
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20.2.3 Quick step 

 

P120 Start final angle 
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20.2.4 Ergo ramp 

 

P120 Start final angle 

P137 Ergo ramp 
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20.3 Tq con/ang con (AND) and Tq con/ang con (OR) 

20.3.1 One stage 
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20.3.2 Two stage 

 

P120 Start final angle 
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20.3.3 Quick step 

 

P120 Start final angle 
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20.3.4 Ergo ramp 

 

P120 Start final angle 

P137 Ergo ramp 
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20.4 Ang con/tq mon 

20.4.1 One stage 
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20.4.2 Two stage 

 

P120 Start final angle 
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20.4.3 Quick step 

 

P120 Start final angle 
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20.4.4 Ergo ramp 

 

P120 Start final angle 

P137 Ergo ramp 
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20.5 Reverse ang 
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20.6 Rotate spindle forward and Rotate spindle reverse  
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20.7 Home position forward and reverse  
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20.8 DS con 

20.8.1 One stage 

This strategy is not available in DS control. 

20.8.2 Two stage 

 

P120 Start final  
angle 
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20.8.3 Quick step 

 

P120 Start final  
angle 
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20.8.4 Ergo ramp 

 

P120 Start final angle 
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20.9 Snug gradient 

20.9.1 One stage 
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20.9.2 Two stage 
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20.9.3 Quick step 
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21 Digital I/O and fieldbus items 
The following sections list the digital inputs and outputs (relays) and the fieldbus items. 

21.1 Digital output (relay) and fieldbus items from PF  
In this section follows a description of the possible items to select when data menu from the Power Focus 

is configured. 

For fieldbus: Set signal = a signal to set a bit/byte/bytes in the PLC. Reset signal = a signal to reset a 

bit/byte/bytes in the PLC. 

Name Description 

Fieldbus items  Duration Tensor ST/SL 

String 
length 

Value 
Set signal 
/ Reset signal 
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Alarm Follow the Alarm 

light on the PF 
front. 

1 bit 0 = Off 

1 = On 

Alarm on 

/ Alarm off 

  X X X  X 

Angle 

status 

Status Angle result. 1 byte 

ASCII 
character 

O = OK  

L = Low 

H = High 

Tightening result  

/ Start new 

tightening or new 

Pset selected or 
new Job selected 

       

2 bits 

BF 

00 = Not used 

01 = OK 

10 = High 

11 = Low 

Angle 

status 
HIGH 

 

Angle result is 

above max limit. 

1 bit 0 = Not used 

1 = High 

Tightening result 

/ Start new 

tightening or new 

Pset selected or 
new Job selected 

       

Angle 

status 
LOW 

 

Angle result is 

below min limit. 

1 bit 0 = Not used 

1 = Low 

Tightening result 

/ Start new 

tightening or new 

Pset selected or 
new Job selected 
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Name Description 

Fieldbus items  Duration Tensor ST/SL 

String 
length 

Value 
Set signal 
/ Reset signal 
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Angle 

status OK 

Angle result is 

within limits. 

1 bit 0 = Not used 

1 = OK 

Tightening result 

/ Start new 

tightening or new 

Pset selected or 

new Job selected 

       

Batch done Indicate batch 

finished. Batch 
done OK or NOK. 

1 bit 0 = Not 

completed 

1 = Done 

Batch finished / 

Reset result 

X X X X X  X 

Batch 
status 

Batch OK (done) or 
NOK  

1 byte 
ASCII 

character 

O = OK  

N = NOK 

Tightening result 

/ Start new 

tightening or new 

Pset selected or 

new Job selected 

       

2 bits 

BF 

00 = Not used 

01 = OK 

10 = NOK 

       

Batch 
status NOK 

Batch is NOK. 1 bit 0 = Not used 

1 = NOK 

Tightening result  

/ Start new 

tightening or new 

Pset selected or 

new Job selected 

       

Batch 

status OK 
(nxOK) 

Batch is OK 
(nxOK). 

1 bit 0 = Not used 

1 = OK 

Tightening result 

/ Start new 

tightening or new 

Pset selected or 

new Job selected 

       

Battery 
empty 

Indicates tool 
battery empty 

1 bit 0 = Not used 

1 = Battery 
empty 

Tool battery empty 
/ no signal 

  X X X  X 

Battery low Indicates tool 

battery low 

1 bit 0 = Not used 

1 = Battery low 

Tool battery low / 

no signal 

  X X X  X 

Calibration 
alarm 

Calibration date 

expired. New date 
to be entered. 

1 bit 0 = Off 

1 = On 

Calibration date 

expired / Reset or 

set a new 

calibration date 

  X X X  X 

Channel ID Gives the channel 

ID number on the 

fieldbus Power 

Focus. 

2 - 8 bits in 

the same 
byte 

BF 

0000 0001=CH 
1 

0001 0000=CH 

16 

PF ready and 

channel ID 

programmed in 

config / No signal 
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Name Description 

Fieldbus items  Duration Tensor ST/SL 

String 
length 

Value 
Set signal 
/ Reset signal 
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16 bits in 

one word 

U16 

00….0001=CH 

1 

00….1000=CH 
8 

       

Channel 

name 

Shows C311 

Channel name 

16-200 bits 

CSC, CSCI 

 Channel name 

stored in controller 
set / No signal 

       

Current Indicates tightening 

result final current 

in percent (%). 

2 – 8 bits 

BF 

Integer number Tighten result / 

Tighten started or 

Pset Selected or 
Job selected 

       

16 bits 

U16 

Integer number        

Completed 

batch 

 BF 

U16 

 Batch Counter 

Changed / No 
signal 

       

Completed 

batch bit 
(0-6) 

Display currently completed batch.   X     

Cycle abort Display cycle 

aborted by cycle 
abort timer expired 

1 bit 0 = Not used 

1 = Cycle abort 

Cycle Abort / Reset 

result 

  X X X   

Cycle 

complete 

Indicates that a 

tightening is 

finished. Do not 

care about the 
result. 

1 bit 0 = Not used 

1 = Cycle 

complete 

Tightening done / 

Start new tightening 

or new Pset 

selected or new Job 
selected 

X X  X X  X 

Cycle start Indicate cycle 
started. 

1 bit 0 = Not used 

1 = Cycle started 

Cycle start / Start 
new tightening 

X X      

DigIn# # = 
1-4 

Mimic the status on 

a DigIn in Power 

Focus or I/O 

Expander. The 

input must be 

configured to 

fieldbus DigIn # X. 

There are four 
different items. 

1 bit 0 = Input Off 

1 = Input On 

DigIn # X On / 
DigIn # X Off 

       

DigIn 

controlled 
# 1-4 

Controlled by 

DigOut monitored 1 
– 4 To PF 

1 bit 0 = DigIn bit 

reset 

1 = DigIn bit set 

DigIn control1Set / 

Reset 

  X X X  X 
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Name Description 

Fieldbus items  Duration Tensor ST/SL 

String 
length 

Value 
Set signal 
/ Reset signal 
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Dir switch 

CW 

Indicates tool 

Switch is in CW 
direction. 

1 bit 0 = Ring CCW 

1 = Ring CW 

Ring CW / Ring 

CCW 

  X X X  X 

Dir switch 

CCW 

Indicates tool 

Switch is in CCW 
direction. 

1 bit 0 = Ring CW 

1 = Ring CCW 

Ring CCW / Ring 

CW 

  X X X  X 

Direction 

alert 

Direction alert is active   X     

Disabled 

FB job 
status 

Mimic the status on a 

digital input Disable 

FB Job status in 

Power Focus or I/O 
Expander. 

1 bit 0 = Enabled 
Job status 

1 = Disabled 
Job status 

Disable FB Job 

Status / Enable FB 
Job status 

       

Dset 

calibration 
value 

Shows the tool 

calibration value in 

selected engineering 
units. 

4 bytes 

fixed 
point 

See Item 

Final Torque. 

Dset data / No signal        

Effective 

loosening 

Set when the Power Focus reaches the minimum loosening torque 

(defined in % of tool max torque). 

X X  X X  X 

Enable 
scanner 

The relay enable scanner is set when the tool trigger is pressed during tool 
locked condition, and if no job is running. 

X X  X X  X 

Error code Shows event code. 2 bytes 

U16 

Binary 

representatio
n 

(Decimal 0-
65535) 

Event occurs / Event 

acknowledge or time 
out 

  X X    

External 

controlled 
1-10 

Relay controlled by external source outside Power Focus.   X     

Fieldbus 

carried 

signals 
disabled 

Indicates fieldbus signals disable.   X     

Fieldbus 

handshake 
ack 

Indicates handshake 

from PLC received 
by Power Focus. 

1 bit 0 = Not used 

1 = Handshake 

Handshake set / 

Handshake reset 

       

Fieldbus 

offline 

When fieldbus goes offline the light on this bit turns off.   X X X  X 

Fieldbus 
relay 1-4 

Relays controlled from fieldbus.   X X X  X 
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Final angle Final angle result. 2 byte 

U16 

Binary 

representation 

(Decimal 0-65 
535) 

Tightening done / 

Start new tightening 

or new Pset 

selected or new Job 
selected 

       

Final angle 
start 

Indicate final angle 
started. 

bit  Final Angle Start / 
Cycle Completed 

       

Final 

torque 

Final torque result. 4 byte The value is 2 

digits if torque 

value is less than 

100, one digit if 

100 <= torque 

value < 1000 and 

0 if torque value 

>= 1000. For 

example, if 

torque value is 

25.64, the two 

byte integer part 

shows 25 and the 

two byte decimal 

part shows 64; if 

torque value is 

345.5, the integer 

part shows 345 

and decimal part 

shows 5; if 

torque value is 

2431, the integer 

part shows 2431 

and decimal part 

shows 0. The 

value is 

represented in 

the selected 

engineering units 

in the Power 
Focus. 

Tightening done / 

Start new tightening 

or new Pset 

selected or new Job 
selected 

       

Function 
button 

Function button pressed.   X X X  X 

Function 
button ack. 

Function button pressed acknowledge. X X  X X  X 

High Any result is above any of the programmed max limits. X X  X X  X 
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High angle Angle result is higher than max angle limit. X X  X X  X 

High 
current 

Current status is high. X X  X X  X 

High PVT 

monitoring 

PVT monitoring is high X X  X X  X 

High PVT 
selftap 

PVT selftap is high X X  X X  X 

High 

rundown 
angle 

Rundown angle is high X X  X X  X 

High 

torque 

Torque result is higher than max torque limit. X X  X X  X 

Home 

position 

Indicates that the 

socket has reached 

the position set by 

digital input Set 

home position, or 

an Open end head 
in open position. 

1 bit 0 = Not used 

1 = Home 

position 

Socket in home 

position / Start new 
tightening 

  X X   X 

Identifier 

identified / 

Identifier 
recognized 

An identifier with 

Type 1, 2, 3, 4 has 

been entered in 

correct order and 

has been accepted 
by the system logic. 

1 bit 0 = not used 

1 = identified 

Identifier identified 

/ Start new 
tightening 

X X  X X  X 

Identifier 
multi 

Shows an identifier, 

Max length 100 
bytes. 

16 – 800 
bits 

CC 

Max 100 char in 
a string 

Multi identifier 
selected / No signal 

       

16 – 800 

CSCI 

Max 100 char        

Identifier 

result part 
A-D 

Show identifier 

result part, witch in 

each tightening 
result. 

16 – 200 

bits 

CSC 

Max 25 char Tighten result / 

Start new tightening 

       

Identifier 

type #  

# = 1-4 

Received 

An identifier with 

Type 1, 2, 3, 4 has 

been entered in 

correct order and 

has been accepted 
by the system logic. 

1 bit   Received identifier 

type / Bypass 

identifier / Reset 

latest Identifier / 
Reset all identifier 

X X  X X  X 
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Identifier 

received 

Becomes active 

when an identifier 

is sent to the PF, 

regardless of the 

source of the 

identifier (RS232, 

field bus, keyboard 
etc.) 

   X X X X X  X 

Illuminator Echo tool 

illuminator LED. 

1 bit 0 = Led off 

1 = Led on 

Light on / light off   X X X  X 

Job done 
status 

Job OK (done) or 

NOK (done) or 
aborted (reset). 

1 byte 
ASCII 

character 

O =OK  

N = NOK 

A = Aborted 

Job done or reset / 

Start new tightening 
or new Job selected 

       

2 bits 

BF 

00 = Not used 

01 = OK 

10 = NOK 

11 = Aborted 

       

Job done 

status job 

aborted / 
Job aborted 

Shows Job aborted. 1 bit 0 = Not used 

1 = Job aborted 

Job aborted / Start 

new tightening or 
new Job selected 

X X  X X  X 

Job done 

status NOK 
/ Job NOK 

Job is NOK (Not all 

tightening OK). 

1 bit 0 = Not used 

1 = NOK 

Job done / Start 

new tightening or 
new Job selected 

X X  X X  X 

Job done 

status OK 

(nxOK) / 
Job OK 

Job is OK (nxOK) 1 bit 0 = Not used 

1 = OK 

Job done / Star new 

tightening or new 
Job selected 

X X  X X  X 

Job off Job is in Off mode; 

1: Job Off; 0: Job 
On. 

1 bit 0 = Job on 

1= Job off 

Job off / Job on   X X X  X 

Job running A Job is selected 

and “running”. 

1 bit 0 = Job done and 

no Job selected 

1 = Job is 

running 

Job selected / Job 

done 

  X X X  X 

Keep alive 
ack 

Indicates fieldbus 

communication 

alive, which sends 

back the save value 
received from PLC. 

2 - 8 bits 

in the 

same byte 

BF 

00000000 = 0 

11111111 = 255 

Keep alive value 
changed / No signal 
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Lifted 

socket 
number 

Indicates which 

socket is lifted.  

16 bits  

OA 

Byte 0=Device 

ID 

Byte 1=lifted 

socket number, if 

255=more than 

one socket lifted 

Socket lifted / 

socket back to 
position 

       

Line 

control 

alerted 1 

Indicates Line 

control alert 1 

received by Power 
Focus. 

1 bit 0 = Not used 

1 = Line control 
alerted 1 

Line control alerted 

1 / Start new 

tightening 

X X X X X  X 

Line 

control 

alerted 2 

Indicates Line 

control alert 2 

received by Power 
Focus. 

 

1 bit 0 = Not used 

1 = Line control 
alerted 2 

Line control alerted 

2 / Start new 

tightening 

X X X X X  X 

Line 

control 
done 

Indicates Job with 

line control finished 

before line control 
alert2 input. 

1 bit 0 = Not used 

1 = Line control 
done 

Line control done / 

Start new tightening 

X X  X X  X 

Line 

control 
start ack 

Indicates that 

Power Focus 

received Line 
control start. 

1 bit 0 = Line control 

start reset 

1 = Line control 
start 

Line control start 

bit set / Line control 
start bit reset 

X X  X X   

Line 

control 

started 

Indicates line 

control start set in 

Power Focus. 

Activate with J330 
set to Yes.  

1 bit 0 = Not used 

1 = Line control 
start 

Line control started 

/ Start new 

tightening 

X X  X X  X 

Lock at 

batch done 

Indicate tool locked 

at batch done which 
is activated by P152 

1 bit 0 = Not used 

1 = Tool locked 

Lock at batch done 

/ Unlock tool 

  X X X  X 

Logic relay 

1-10 

The result of a logic configuration with the corresponding number. 

(PF4000 only.) 

  X X X  X 

Loosening 
disabled 

Loosening function currently disabled.   X X X  X 

Low Any result is below any of the programmed min limits. X X  X X  X 

Low angle Angle result is lower than min angle limit. X X  X X  X 

Low 

current 

Current status is low. X X  X X  X 
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Low PVT 

monitoring 

PVT monitoring is low X X  X X  X 

Low PVT 
selftap 

PVT selftap is low X X  X X  X 

Low 

rundown 
angle 

Rundown angle is low X X  X X  X 

Low torque Torque result is lower than min torque limit. X X  X X  X 

Max 

coherent 

NOK 
reached 

Indicates Max 

coherent NOK 

tightening counter 
value is reached 

1 bit 0 = Not used 

1 = Max NOK 
reached 

Max NOK reached / 
Reset NOK counter 

X X X X X  X 

Motor 

tuning 

disabled 

Motor tuning function currently disabled.   X X X  X 

N x OK Batch OK. 

Only available in the Job function. 

X X  X X  X 

N x NOK Batch status NOK. X X  X X  X 

Necking 
failure 

    X X  X X  X 

New Job 

selected 

Indicates a new Job is 

selected JobID>0 

1 bit 0 = Not used 

1 = New Job 

New Job Selected / 

Start new tightening 

X X  X X  X 

New Pset 

selected 

Indicates a new Pset 

is selected PsetID>0 

1 bit 0 = Not used 

1 = New Pset 

New Pset Selected / 

Start new tightening 

X X  X X  X 

Next tight Indicates that PF started a new tightening. X   X X  X 

No tool 

connected 

Indicates controller 

has no connection 
with tool 

1 bit 0 = Not used 

1 = Tool 

connected 

Controller has  no 

connection with tool 
/ no signal 

  X  X   

NOK Any result is above or below any of the programmed max or min limits, or 
some other not approved result such as rehit. 

X X  X X  X 

Off Output is not used.        

OK All results are within the specified limits. X X  X X  X 

Open End 

tuning 
disabled 

Open End function currently disabled   X X X  X 
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Open 

protocol 

commands 
disable 

Set when the Open Protocol Commands DigIn has been activated. In this 

case all the commands that the Power Focus can receive via Open 
Protocol are disabled. 

  X X X  X 

Open 

protocol 
conn lost 

Indicates 

connection with 
open protocol lost. 

1 bit 0=connected 

1=disconnected 

Open protocol 

disconnected / 

Open protocol 
connected 

  X X X  X 

PF ready No severe errors in 

PF. 

1 bit 0=Errors in PF 

1=No errors in 
PF 

PF ready (no errors) 

/ PF not ready 
(errors) 

  X X X  X 

PIN code 

OK 

A PIN code entered on the RFID card reader has been validated by the 

Power Focus. 

X       

Positioning 
disabled 

Positioning function currently disabled.   X X X  X 

Power ON  Indicates that PF is power supplied.   X     

Pset final 

angle min / 

Pset final 

angle max / 

Pset step1 

speed / Pset 

step2 

speed/ Pset 

rundown 
angle min/ 

Pset 

rundown 

angle max. 

Shows Pset 

parameters from the 

running Pset. Pset 

step1 speed / Pset 

step2 speed shown 

in percentage of 

max speed or rpm 

depending on P139 
Speed unit. 

2 bytes 

U16 

Binary 
representation 

(Decimal 0-
65535) 

New Pset selected 

or updated / No 

signal. On until 

new Pset is selected 

or current Pset 
updated 

       

Pset final 

target / Pset 

final torque 

min / Pset 

final torque 

max / Pset 

start final 

angle 

Shows Pset 

parameters from the 

running Pset in 

selected 
engineering units. 

4 bytes 

Fixed point 

See Item 
Final Torque. 

New Pset selected 

or updated / No 

signal. On until 

new Pset is selected 

or current Pset 
updated 
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Pset Target 

Angle 

Show Pset 

parameter P123 
Target angle. 

2 bytes 

U16 

 New Pset selected 

or updated / No 

signal. On until 

new Pset is selected 

or current Pset 

updated 

       

PVT 
compensate 

Indicates PVT 
compensate  

4 bytes 

Fixed point 

2 bytes 

integer part 

and 2 bytes 
decimal part 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

PVT mon 

status / Run 

down angle 

status / 

PVT 

selftap 

status / 

Current 
status 

Status on one of the 

result parameters 

PVT mon, 

Rundown angle, 

PVT selftap or 

Current. 

1 byte ASCII 

character 

O = OK  

L = Low 

H = High 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

2 bits 

BF 

00 = Not used 

01 = OK 

10 = High 
11 = Low 

       

PVT mon 

status 

HIGH / 

Run down 

angle status 

HIGH / 

PVT 

selftap 

status 

HIGH / 

Current 

status 
HIGH 

Result is above max 

limit. There are 

three different 

variables in the 
setup. 

1 bit 0 = Not used 

1 = High 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 
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PVT mon 

status 

LOW / Run 

down angle 

status 

LOW / 

PVT 

selftap 

status 

LOW / 

Current 

status 
LOW 

Result is below min 

limit. There are 

three different items 
in the setup. 

1 bit 0 = Not used 

1 = Low 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

PVT mon 

status OK / 

Run down 

angle status 

OK / PVT 

selftap 

status OK / 

Current 
status OK 

A result is within 

limits. There are 

three different 

variables in the 
setup. 

1 bit 0 = Not used 

1 = OK 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

Read result 

Handshake 

ack 

Handles read result 1 byte 

BF 

0 = Not used 

1 = Read 

2 = Skip 

4 = Flush 

8 = Result 
data in queue  

Result is in the 

queue or Readresult 

Handshake is set in 
To PF / No signal 

       

Received 

identifier 

Indicates identifier 

has been received 
by PF. 

1 bit 0 = Not used 

1 = Received 
identifier 

Received identifier 

/ Start new 
tightening 

X X  X X   

Rehit Indicates tool is 

rehit 

1 bit 0 = Not used 

1 = Rehit 

Tightening result / 

Reset result 

X X  X X  X 

Remaining 

batch 

Display currently 

remaining batch 

BF 

U16 

 Batch Counter 

Changed / No 
signal 

       

Remaining 

batch bit 0-
6 

Display currently remaining Batch. Batch Counter 1 to 99 can be 

displayed. “0” means that there is no remaining batch counter (batch is 
completed). 

  X     
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Result type Shows what type of 

result is, i.e. 

tightening result, 

loosening result and 
so on. 

2 – 8 bits 

BF 

1 to 13 is defined 

for the different 
result type 

Tighten result / 

Reset result 

       

Ring button 
ack 

Ring button pressed 
acknowledge. 

1 bit 0 = Not used 

1 = New Pset 

Ring Button 

Pressed / Start new 
tightening 

       

Rundown 

Angle 

Show Result 

Rundown angle 

2 bytes 

U16 

 Tightening result / 

Start new tightening 

or new Pset 

selected or new Job 

selected 

       

Running 
job ID 

Running Job 

identification 

number. 

2 - 8 bits 

in the 

same byte 

BF 

0000 0001 = Job 
1 

0001 0000 = Job 

16 

Job selected / Job 
done 

       

16 bits in 
one word 

U16 

00….0001 = Job 
1 

00….1000 = Job 
8 

       

Running 

Job bit 0-8 

Shows selected Job. Bit pattern analogue to input Job select bits. 

0 = no running Job. 

  X     

Running 
Pset ID 

Running Pset 

identification 

number. 

2 - 8 bits in 

the same 

byte 

BF 

0000 0001 = 
Pset 1 

0001 0000 = 
Pset 16 

Pset selected / No 

signal. On until new 

Pset is selected 

       

16 bits in 
one word 

U16 

00….0001 = 
Pset 1 

00….1000 = 
Pset 8 

       

Running 

Pset bit 0-9 

Shows selected Pset. Bit pattern analogue to input Pset select bits. 

0 = no Pset selected, tool locked. 

  X     

Running 

Pset ID 0 is 
1  

Shows running Pset 

and Pset number is 

bit field number +1, 

i.e. 00 is Pset 1. 

2 - 8 bits 

in the 
same byte 

BF 

0000 0001=Pset2 

0001 0000=Pset 
17 

Pset selected / No 

signal. On until new 
Pset is selected 
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Safe to 

disconnect 
tool 

 1 bit Ack for 

disconnect tool 

request from 
fieldbus. 

Disconnect tool 

allowed / Done 

  X     

Sent 

tightening 
ID 

Indicates which 

tightening result is 
sent to PLC. 

2 bytes 

U16 

Integer value Result is sent to 

PLC / No signal 

       

Selected 

channel in 
Job 

Indicates selected 

channel in a forced 
order Cell Job. 

1 bit 0 = Not used 

1 = Selected 

channel 

Prompt selected 

channel / Cancel 
prompt channel 

  X X   X 

Selector 
socket info 

Indicates the socket 
status on a selector 

16 bits  

OA 

Byte 0=Device 
ID 

Byte 1=lifted 
socket position 

Socket lifted / 

socket back to 

position 

       

Selector 
info 

Indicates selector 

socket and LED 
information. 

32 bits 

OA 

Byte 0 = device 
ID 

Byte 1=lift sock 
no. 

Byte 2, 3 
=selector LED 

Select Led or 

socket changed / 
No signal 

       

Service 

indicator 

alarm / 

Service 
indicator 

Indicates that the 

number of 

tightenings in the 

tool memory has 

reached the service 
interval limit. 

1 bit 0 = Alarm Off 

1 = Alarm On 

Service indicator 

alarm on / Reset 
counter 

  X X X  X 

Start 

trigger 
active 

Used to let the tool trigger or the external tool start trigger control 

Illuminator. This relay function is available for Illuminator only. 

  X X    

Stat alarm Echo display stat 

LED. 

1 bit 0 = Off 

1 = On 

Stat alarm On / Stat 

alarm Off 

X X  X X  X 

Sync 

channel# 

Green/Red/

Yellow 

LED # = 1-
10 

A result from a 

Sync channel. 

Follow tool light. 

There are 30 (3x10) 

different items in 
the setup. 

1 bit 0 = Not used 

1 = green / red / 
yellow 

Sync tightening 

result / Start new 

tightening or new 

Pset selected or 

new Job selected 
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Sync ch1 

status /..../ 

Sync ch10 
status 

Indicate Sync 

channel XX result 
status. 

2 bits 

BF 

00 = Not used 

01 = Sync 

Channel OK 

10 = Sync 

Channel OK 

Sync tightening 

result / Start new 

tightening or new 

Pset selected or 
new Job selected 

       

8 bits 

character 

O = Sync 
Channel OK 

N = Sync 

Channel NOK 

       

Sync ch1 

status NOK 

/.../ sync 

ch10 status 
NOK  

 

/ Sync 

spindle (1-
10) NOK 

Indicates Sync 

channel XX result 
status NOK. 

1 bit 0 = Not used 

1 = Sync 
Channel NOK 

Sync tightening 

result / Start new 

tightening or new 

Pset selected or 
new Job selected 

X X  X X  X 

Sync ch1 

status OK 

/…/ Sync 

ch10 status 

OK 

 

/ Sync 

spindle (1-
10) OK 

Indicates Sync 

channel XX result 
status OK. 

1 bit 0 = Not used 

1 = Sync 
Channel OK 

Sync Tightening 

result / Start new 

tightening or new 

Pset selected or 

new Job selected 

X X  X X  X 

Sync total 

status  

Indicates Sync total 

result status. 

2 bits 

BF 

00 = Not used 

01 = Sync Total 

Status OK 

10 = Sync Total 

Status NOK 

Sync Tightening 

result / Start new 

tightening or new 

Pset selected or 
new Job selected 

       

8 bits 

character 

O = Sync Total 
Status OK 

N = Sync Total 
Status NOK 

        

Sync total 

status NOK 

/ Sync 

NOK 

Indicates Sync total 

result status NOK. 

1 bit 0 = Not used 

1 = Sync Total 
Status NOK 

Sync tightening 

result / Start new 

tightening or new 

Pset selected or 
new Job selected 

X X  X X  X 
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Sync total 

status OK / 
Sync OK 

Indicates Sync total 

result status OK. 

1 bit 0 = Not used 

1 = Sync Total 

Status OK 

Sync tightening 

result / Start new 

tightening or new 

Pset selected or 
new Job selected 

X X  X X  X 

Tightening 
date 

Tightening date 

taken from the most 

recent result. 

Format 
YYYY:MM:DD 

80 bit (10 

characters
/ bytes) 

CSC 

I.e. 2000:05:07 

( 10 ASCII 
characters) 

Tightening result / 

Start new tightening 

or new Pset 

selected or new Job 
selected 

       

80 bits 

CSCI 

I.e. 70:50:0002 

( from right to 
left) 

       

Tightening 

date day 

The tightening date 

(day part only) 

taken from the most 
recent result. 

16 bit 

(one 
word) 

U16 

1 – 31 Tightening result / 

Start new tightening 

or new Pset 

selected or new Job 

selected 

       

Tightening 
date month 

The tightening date 

(month part only) 

taken from the most 

recent result. 

16 bit 

(one 
word) 

U16 

1 – 12 Tightening result / 

Start new tightening 

or new Pset 

selected or new Job 
selected 

       

Tightening 

date year 

The tightening date 

(year part only) 

taken from the most 
recent result. 

16 bit 

(one 
word) 

U16 

Year number 4 

digits  

Tightening result / 

Start new tightening 

or new Pset 

selected or new Job 
selected 

       

Tightening 

disabled 

Tightening function currently disabled.   X X X  X 

Tightening 

status 

Combined status for 

all tightening result 

parameters that are 
used. 

1 byte 

ASCII 

Character 

OK = O  

NOK = N 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

2 bits 

BF 

00 = Not used 

01 = OK 

10 = NOK 

       

Tightening 
status high 

Indicate tightening 
result status is high.  

1 bit 0 = Not used 

1 = High 

Tighten result / 
Reset result 

       

Tightening 

status low 

Indicate tightening 

result status is low.  

1 bit 0 = Not used 

1 = Low 

Tighten result / 

Reset result 
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Tightening 

time 

The tightening time 

taken from the most 

recent result. 
Format HH:MM:SS 

64 bit (8 

characters) 

CSC 

I.e. 08:15:08 

(8 ASCII 

characters) 24 
hour 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

64 bits 

CSCI 

I.e. 80:51:80 ( 

from right to left) 

       

Tightening 
time hour 

The tightening time 

(hour part only) 

taken from the most 

recent result.  

16 bit (one 
word) 

U16 

0 – 24 hour Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

Tightening 

time min 

The tightening time 

(minutes only) 

taken from the most 
recent result. 

16 bit (one 

word) 

U16 

0 - 60 min Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

Tightening 

time sec 

The tightening time 

(seconds only) 

taken from the most 
recent result. 

16 bit (one 

word) 

U16 

0 - 60 sec Tightening result / 

Start new 

tightening or new 

Pset selected or 

new Job selected 

       

Tightening 
status NOK 

Tightening result 

has one or more 

Not OK results.  

1 bit 0 = Not used 

1 = NOK 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

Tightening 

status OK 

All tightening result 

is OK.  

1 bit 0 = Not used 

1 = OK 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

Tool 
connected 

Indicates 

connection 

established between 

tool and controller 

1 bit 0 = Not used 

1 = Tool 
connected 

Tool is connected / 
no signal 

  X X X  X 

Tool 
disabled 

Indicates if the tool 
is disabled or not.  

1 bit 0 = Tool enabled 

1 = Tool disabled 

Tool disable / Tool 
enable 

       

Tool 

enabled 

Indicates if the tool 

is enabled or not. 

1 bit 0 = Tool disabled 

1 = Tool enabled 

Tool enable / Tool 

disable 
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Tool green 

light 

This item follows 

the tool green light. 

1 bit 0 = Not used 

1 = Green 

 

Tightening result 

or flash green light 

/ Start new 
tightening or 

Reset LED 

  X     

Tool in 

product 
space 

Tool is located in product space   X    X 

Tool in 

work space 

Tool is located in work space   X    X 

Tool 
locked 

Tool is locked (tool not ready).   X X X  X 

Tool 

loosening 

Indicates that the 

tool is loosening. 

1 bit 0 = Tool is not 

loosening 

1 = Tool is 
loosening 

Tool is loosening / 

Tool is stopped 

  X     

Tool ready Indicates that the 

tool is ready for 
tightening.  

1 bit 0 = Tool is not 

ready 

1 = Tool is ready 

Tool is ready / 

Tool is not ready 

  X X X  X 

Tool red 
light 

This item follows 
the tool red light. 

1 bit 0 = Not used 

1 = Red 

Tightening result / 

Start new 

tightening 

  X     

Tool 
running 

Indicates that the 

tool is rotating CW 
or CCW.  

1 bit 0 = Tool is not 
run 

1 = Tool is 
running 

Tool is running / 
Tool is stopped 

  X     

Tool serial 

no 

Show tool serial 

number after each 
tightening 

32 bits 

U32 

Intel Endian 32 

bits integer 

Tighten result / 

Start new 
tightening 

       

32 bits 

U32_HN
W 

Intel Endian 32 
bits integer 

       

Tool start 

switch 

Indicates tool is 

switching. 

1 bit 0 = Not used 

1 = rotating 

Tool is rotating / 

Tool stopped 

  X     

Tool 
tightening 

 1 bit 0 = Tool is not 
tighten 

1 = Tool is 

tightening 

Tool is Tightening 
/ Tool is stopped 

  X     
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Tool 

yellow 
light 

This item follows 

the tool yellow 
light.  

(If ”PF_ control _3” 

is selected yellow 

LED shows the 

fatal error and reset 

when error 
acknowledged) 

1 bit 0 = Not used 

1 = Yellow 

Tightening result 

or fatal error / Start 

new tightening or 
error Ack 

  X     

Tools Net 

conn lost 

Indicates 

connection with 
Tools Net lost. 

1 bit 0 = connected 

1 = disconnected 

Tools Net 

connection lost / 
Connected 

  X X X  X 

Torque 

status 

Status torque result.  1 byte 

ASCII 

Character 

O = OK  

L = Low 

H = High 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

2 bits  

BF 

00 = Not used 

01 = OK 

10 = High 

11 = Low 

       

Torque 

status 
HIGH 

Torque result is 

above max limit.  

1 bit 0 = Not used 

1 = High 

Tightening result / 

Start new 

tightening or new 

Pset selected or 

new Job selected 

       

Torque 

status 

LOW 

Torque result is 
below min limit.  

1 bit 0 = Not used 

1 = Low 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

Torque 

status OK 

Torque result is 

within limits. 

1 bit 0 = Not used 

1 = OK 

Tightening result / 

Start new 

tightening or new 

Pset selected or 
new Job selected 

       

Tracking 
disabled 

Tracking function currently disabled   X X X  X 
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VIN input Shows the VIN 

number input from 

fieldbus, serial or 

Ethernet. Changes 

as soon as the 

number is given. 

This is not the VIN 

used in the 
tightening result.  

If the VIN is longer 

than the VIN input 

length the Power 

Focus will take the 

first x characters 

and cut the end. If 

the VIN number is 

shorter then this 

parameter length 

the Power Focus 

will not fill with 
zero. 

24-208 bit 

(3-26 
bytes) 

CSI 

One ASCII sign 

for each 
character. 

First byte is 

counter. Counter 

increases each 

time a new 

identifier string 
inputted. 

Identifier selected  

/No signal 

       

16-200 bit 

(2-25 
bytes) 

CSC 

Identifier input 

character string. 

One ASCII sign 

for each 
character. 

       

16-192 bit 

(2-24 
bytes) 

CSCI 

In Intel Endian 

mode, whole 
words. 

One ASCII sign 

for each 
character. 

       

32-208 bit 

(4-26 
bytes) 

CSII 

In Intel Endian 

mode, whole 
words. 

One ASCII sign 

for each 

character.  

First byte is 

counter. Counter 

increases each 

time a new 

barcode inputted. 

       

U32 Convert barcode 

to U32 number. 

Corresponding to 

Identifier U32 in 
To PF side. 
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U32_HN

W 

Convert barcode 

to U32_HNW 

number. 

Corresponding to 

identifier 

U32_HNW in To 
PF side. 

       

U16 Convert barcode 

to U16 number. 

Corresponding to 

identifier type 

U16 in To PF 

side. 

       

VIN used 

in 
tightening 

Shows the VIN 

number used in a 

tightening. This is 

the VIN used in the 
tightening result.  

If the VIN is longer 

than the VIN input 

length the Power 

Focus will take the 

first x characters 

and cut the end. If 

the VIN number is 

shorter then this 

parameter length 

the Power Focus 

will not fill with 

zero. 

16 – 200 

bit (2-25 
bytes) 

CSC 

One ASCII sign 

for each 
character. 

Tightening result  

/ Start new 

tightening or new 

Pset selected or 

new Job selected 

       

16 – 192 

bits (2 – 
24 bytes) 

CSCI 

Only show in 

Intel Endian and 

must be whole 

words. 

       

16 bits 

U16 

Convert barcode 

to U16 number. 

Corresponding to 

identifier type 

U16 in To PF 
side. 

       

32 bits 

U32 

Convert barcode 

to U32 number. 

Corresponding to 

identifier U32 in 
To PF side. 

       

32 bits 

U32_HN

W 

Only show in 

Intel Endian. 

Convert barcode 

to U32_HNW 

number. 

Corresponding to 

identifier 

U32_HNW in To 
PF side. 
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16 – 200 

bits 

CSCI 

Max 25 char        

Wear 

indicator 

Active until service is performed (i.e. while wear alarm is pending)   X X X  X 

 

21.2 Digital input and fieldbus items to PF  
This section contains a description of the items that can be selected when data to the Power Focus is 

configured. 

For fieldbus: Set signal = a signal to set a bit/byte/bytes in the PLC. Reset signal = a signal to reset a 

bit/byte/bytes in the PLC. 

 

 Description Fieldbus items Digital inputs 

Name Description 

String 
length 

Data type Value 

Set signal 
/Reset signal 
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Abort Job Aborts the running Job. Job 

status is Job aborted. 

1 bit 0 = Not used 

1 = Abort 

Abort Job /no 

signal 

X X X X 

8 bit (1 

byte) 

Character 

A = Abort 

Abort Job and 
status 

Abort Job And Reset all result 
status 

1 bit 0 = Not used 

1 = Abort 

Abort job and 
status /no signal 

    

Ack error message Acknowledge event/error 

message.  

1 bit 0 = Not Used 

1 = Ack Error 

Ack event 

message /no 
signal 

X X X X 
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Batch decrement Decrements the batch counter 

with one. In Job, batch 

decrement is only possible from 

the Job reference and it is not 

possible to decrement batch 

once the Job is completed 

1 bit 0 = Not used 

1 = Decrement 

Batch decrement 

/no signal 

X X X X 

Batch increment Increments the batch counter 

with one. Batch status is 

dependent on C243 Batch status 
at increment  

1 bit 0 = Not used 

1 = Increment 

Batch increment 

/no signal 

X X X X 

Bypass Identifier Bypasses the next identifier in 

the Work order for entering 
identifier types.  

1 bit 0 = Not used 

1 = Bypass Id 

Bypass next 

identifier /no 
signal 

X X X X 

Bypass Pset in Job Skips the next Pset or 

Multistage in the running Job. 

Batch status is dependent on 
C243 Batch status at increment  

1 bit 0 = Not used 

1 = Bypass Pset 
in Job 

Bypass Pset /no 

signal 

X X X X 

Click Wrench 1-4 Use in combination with the click wrench tightening strategy to confirm a click 

wrench operation. 

X X X X 

Dig out monitored 
# = 1-4 

Monitored by DigIn Controlled 
1 - 4  

1 bit 0 = reset 

1 = set 

Set DigIn 

controlled /Reset 

DigIn controlled 

X X X X 

Disable fieldbus 
carried signals 

When this digital input goes high following events occur:  

Fieldbus communication is disabled. 

Relay fieldbus carried signals disabled goes high. 

In ToolsTalk PF monitoring mode on fieldbus “To PF” side, it is possible to display 

changes in signals sent to PF over the fieldbus. (Note that the signals have no effect 
on the Power Focus, since all fieldbus communication is disabled). 

On the fieldbus side “From PF” will all bits be reset to zero. 

The traffic of “keep alive” signals continues on the fieldbus. In this way no event 
codes (i.e. No connection on fieldbus) will be displayed. 

All tools are enabled (presupposed that the tools were disabled from a source over 
the fieldbus before then). 

If there is a running Job, which has been selected via the fieldbus, the Job will be 

aborted. 

X X X X 

Disable ST 
scanner 

Disables scanning from ST 
scanner. 

1 bit 0 = Not used 

1 = disable ST 

scan 

Disable ST 
scanner  

/no signal 

X X  X 

Disconnect tool Sends disconnect tool request. 1 bit 0 = Not used 

1 = disconnect 

Disconnect tool  

/no signal 

X X   
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External 

monitored 1-8 

Used for external input, for example from a PC application. X X X  

Fieldbus digin  

1-4 

These inputs give a direct link to fieldbus. Fieldbus digital input numbers must be 

configured in Power Focus, I/O Expander and in fieldbus. Fieldbus mimics the status 

of a digital input. 

X X X  

Fieldbus 
handshake 

Sends to PF to check if fieldbus 
works.  

1 bit 0 = Not used 

1 = Handshake 

Fieldbus Hand 

shake Set  

/Fieldbus 

Handshake 
Reset 

    

Flash tool green 

light, or 

Tool light flash 
green  

Activates the tool green light 

(flashing at approximately 1.33 

Hz). The light is on until 

tightening starts. After 

tightening the tool light 

indicates status according to 

result. This input is ignored 
during rundown. 

1 bit 0 = Not used 

1 = Tool light 

flash 

Tool light flash 

green 

/no signal 

X X X X 

Flash tool yellow 

light, or Tool 
lights flash yellow 

Activates the tool yellow light 

(flashing at approximately 1.33 

Hz). The light is on until 

tightening starts. After 

tightening the tool light 

indicates status according to 

result. This input is ignored 
during rundown. 

1 bit 0 = Not used 

1 = Tool light 
flash 

Tool light flash 

yellow 

/no signal 

X X X X 

Forced CW once The tool will be forced to perform one loosening even if the ring is positioned in 

CW.  

After the loosening has been performed the tool will return to the current ring 

position 

   X 

Forced CW toggle The tool will be forced to perform loosening until the function has been selected 

again. 

After the function has been selected again the tool will return to the current ring 

position. 

   X 

Forced CCW once The tool will be forced to perform one loosening even if the ring is positioned in 

CW.  

After the loosening has been performed the tool will return to the current ring 
position 

   X 

Forced CCW 

toggle 

The tool will be forced to perform loosening until the function has been selected 

again. 

After the function has been selected again the tool will return to the current ring 
position. 

   X 
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ID-card Signal input from card reader to indicate that an ID-card is inserted in the reader. X X X  
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Identifier Input of VIN number from the 

PLC. Set identifier input source 
in PF to “Fieldbus”. 

0 string is ignored. 

24 – 208 bit 

(3-26 bytes) 

CSI 

One ASCII sign 

for each 
character  

First byte is 
counter 

New VIN input   

/no signal 

 

16 – 200 bit 

(2-25 bytes) 

CSC 

One ASCII sign 

for each 
character  

2 bytes in 

the same 
word 

U16 

U 16: If the 

value is less than 

5 digits decimal, 

PF will fill with 
zeros in front. 

4 bytes in 

two words 

U32 

U32: If the value 

is less than 10 

digits decimal, 

PF will fill with 

zeros in front. 

4 bytes in 
two words 

U32_HNW 

Only for Intel 
format 

16 – 192 (2 

– 24 bytes 

CSCI 

One ASCII sign 

for each 

character, string 

is in Intel byte 

order 

32 – 208 
bytes) 

CSII 

One ASCII sign 

for each 
character.  

First byte is 

counter. 

String is in Intel 
byte order. 

Identifier_Multi Max 100 characters in identifier 
string. 

16 – 800 
bits 

CSC 

Char string Identifier 

/no signal 

 

16 – 800 

bits 

CSCI 

Intel Endian 
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16 bits in 

one word 

U16 

00….0001 = Job 

1 

00….1000 = Job 
8 

Job off Gets off Job mode and unlocks 

tool.  

1 bit 0 = Job On 

1 = Job Off 

Job Off 

/Job On 

X X   

Job select bit (0-8) Job select input when selecting Job from digital input.  X X X  

Job select Selects a Job. Job select source 

must be set to Fieldbus. Job 0 = 

no Job selected. 

2 – 8 bits in 

the same 

byte. 

BF 

0000 0001 = Job 
1 

0001 0000 = Job 

16 

Select Job 

/no signal 

    

16 bits in 
one word 

U16 

00….0001 = Job 
1 

00….1000 = Job 
8 

Keep alive Sends to PF to check if fieldbus 

communication alive. 

2 – 8 bits in 

the same 
byte 

BF 

00000000 = 0 

11111111 = 255 

Keep alive 

changed 

/no signal 

    

Last DigIN Must be the last one        

Line control alert1 Input for a position breaker. 

Gives alarm if a Job with line 
control is not finished.  

1 bit 0 = Not Used 

1 = Line control 
alert 1 

Line control 

alert 1 

/no signal 

X X X  

Line control alert2 Input for a position breaker. 

Gives alarm if a Job with line 
control is not finished. 

1 bit 0 = Not Used 

1 = Line control 
alert 2 

Line control 

alert 2 

/no signal 

X X X  

Line control start Input signal to start the line 

control function. 

Activate with J330 set to Yes. 

1 bit 0 = Not Used 

1 = Line control 

Line control 

start set  

/Line control 
start reset 

X X X  

Logic digin 1-10 DigIn not connected to any function but used by the Logic Operator function. 

(PF4000 only) 

X X   

MasterUnlockTool Unlocks all locks which are 
regarded as event controlled. 

1 bit 0 = Not used 

1 = Master 

Unlock 

Master unlock 
tool 

/no signal 

X X X X 

Open protocol 

commands disable 

When activated all the commands received by the Power Focus via Open Protocol 

are rejected. 

X X X X 
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Off The input is not used.     

Pset select bit (0-
9) 

Pset select input when selecting Pset from digital input. The table shows the relation 
between bit set and Pset ID. 

Bit 2 Bit 1 Bit 0 Pset/Job ID 

0 0 0 0 

0 0 1 1 

0 1 0 2 

0 1 1 3 

1 0 0 4 

... ... ... ... 
 

X X X  

Pset select Select a Pset. C200 Pset must be 

set to “Fieldbus”. Pset0 = no 
Pset selected. 

2 – 8 bits in 

the same 
byte. 

BF 

0000 0001 = 

Pset 1 

0001 0000 = 
Pset 16 

Select Pset 

/no signal 

    

16 bits in 

one word 

U16 

00….0001 = 

Pset 1 

00….1000 = 
Pset 8 

    

Pset select 0Is1 Selects a Pset. C200 Pset must 

be set to “Fieldbus”. Pset0  = no 
Pset selected. 

Number 0 = Pset1 number 1 = 
Pset2 etc. 

2 – 8 bits in 

the same 
byte. 

BF 

0000 0001 = 

Pset 2 

0001 0000 = 
Pset 17 

Select Pset 

/no signal 

    

Pset select and set 

batch size 

Selects Pset and sets its batch 

size. 

Byte0: PsetID; Byte1: 
BatchSize 

16 bits 

OA 

Byte 0 = PsetID 

Byte 1 = Batch 

size 

Set Batch Size 

and 

Select Pset 

/no signal 

    

Pset toggle Toggle between Psets connected 

to one socket in a Selector. 

C200 Pset must be set to 

“Selector”. 

1 bit 0 = Not used 

1 = Pset Tog 

Pset Toggle 

/no signal 

X X X X 

Read result 
handshake 

Handles read results. 1 byte 

BF 

0 = Not used 

1 = Read 

2 = Skip 

4 = Flush 

ReadResult 
Handshake 

/no signal 
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Relay pos# # = 1-4 Controls a relay from fieldbus. 

In I/O setup the selected relay 

must be programmed to fieldbus 

relay x. There are four different 

items. 

1 bit 0 = Relay OFF 

1 = Relay ON 

Set fieldbus 

relay x /Reset 
fieldbus relay x 

    

Remote start cont.,  Tool starts tightening. The tool stops if the input signal disappears (equal to a start 
with tool trigger). 

 
The position of the tool direction ring is not taken into 

account. This may cause tool reaction forces in a direction 

unexpected to the operator. 

 

Remote start is not available for Tensor STB tools. 

 

X    

Remote start pulse Tool starts tightening if the input pulse is > 100 ms. Tool runs until target is reached. 

 
The position of the tool direction ring is not taken into 

account. This may cause tool reaction forces in a direction 

unexpected to the operator. 

 

Remote start is not available for Tensor STB tools. 

 

X    

Request ST scan Sends a scan request to ST 

scanner. The scan LED on an 

ST scanner is lit if a scan 

request is configured for the 

LED in ST scan configuration. 
Scanner source must be correct. 

1 bit 0 = Not used 

1 = request 

Request ST Scan 

/no signal 

X X   

Reset all 
Identifiers 

Resets all identifiers and relays 
for identifier. 

1 bit 0 = Not used 

1 = Reset all ID 

Reset all 
identifier 

/no signal 

X X X X 

Reset batch Resets the batch counter to 0. 1 bit 0 = Not used 

1 = Reset the 

batch 

Reset batch /no 

signal 

X X X X 

Reset bistab relay 
1 

Reset bi-stable relay No. 1    X X X  

Reset bistab relay 

1 

Reset bi-stable relay No. 1    X X X  

Reset Job status Resets Job done status. 1 bit 0 = Not used 

1 = Reset Job 
Status 

Reset Job Status  

/no signal 
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Reset latest 

Identifier 

Resets the latest identified 

identifier. 

1 bit 0 = Not used 

1 = Reset latest 
Id 

Reset latest 

identifier  

/no signal 

X X X X 

Reset NOK 

counter 

Unlocks (if locked) and resets 

Possible coherent not ok 

tightening counter. 

1 bit 0 = Not used 

1 = Reset NOK 
counter 

Reset NOK 

counter  

/no signal 

X X X X 

Reset relay Resets all relays except 

tracking event relay 

1 bit 0 = Not used 

1 = Reset 

Reset relay /no 

signal 

X X X  

Reset result status Resets all result status on relay, 
RE-Alarm and fieldbus. 

1 bit 0 = Not Used 

1 = Reset result  

Reset result 
status /no signal 

    

Restart Job Stops current Job and restarts 

the same Job from 0. 

1 bit 0 = Not used 

1 = Restart Job 

Restart Job /no 

signal 

X X X X 

Select next Pset Selects next Pset. 1 bit 0 = Not used 

1 = Select next 
Pset 

Select next Pset 

/no signal 

X X X X 

Select prev Pset Selects previous Pset. 1 bit 0 = Not used 

1 = Select 
previous Pset 

Select previous 

Pset /no signal 

X X X X 

Selector control 
green light 

Used to set green light on 

selector when selector external 

controlled is active. Two bits 

for one position, 01 flash, 10 
solid others off. 

32 bits  

OA 

0=device ID 

1=not used 

2=position 1-4 

3=position 5-8 

Set selector 

green light 

/reset selector 

green light 

    

Selector control 
red light 

Used to set red light on selector 

when selector external 

controlled is active. Two bits 

for one position, 01 flash, 10 
solid others off. 

32 bits  

OA 

0=device ID 

1=not used 

2=position 1-4 
3=position 5-8 

Set selector red 

light 

/reset selector 
red light 

    

Set batch size / Set 

batch size Pset ID 

Sets batch size in indicated Pset 

ID (Set Batch Size Pset ID). 

These two items must be used 
together. 

0<Batch Size<=99 

2 - 8 bits in 

the same 

BF 

00000000 = 0 

11111111 = 255 

Set batch size 

and Pset id /no 
signal 

    

2 bytes 

U16 

Binary 
representation 

(Decimal 0-

65535) 

     

Set bistab relay 1 Activate bi-stable relay No. 1    X X X  

Set bistab relay 2 Activate bi-stable relay No. 2    X X X  
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Set CCW Sets direction according to 

input level. Low level 

corresponds to CW and high 

level corresponds to CCW. SL 

tool only. 

1 bit 0 = set CW 

1 = set CCW 

Set CCW 

/Set CW 

X X  X 

Set home position Sets home position for home 
position strategy. 

1 bit 0 = Not used 

1 = Set home 
position 

Set home 
position 

/no signal 

X X X X 

Set monostab 

relay 1 

Activate mono stable relay No. 

1 

   X X X  

Set monostab 
relay 2 

Activate mono stable relay No. 
2 

   X X X  

Set selector LED Sets/Resets selector LED from 

fieldbus Byte0: DeviceID; 

Byte1: Not used; Byte2: Sel 

LED 1-4; Byte3: Sel LED 5-8 

32 bits 

OA 

Byte 0 = Device 
ID 

Byte 1 = Not 
used 

Byte2, 3 = 
selector LED 

Set selector LED 

/no signal 

    

Start ST scan Sends a scan start request to ST 

scanner. Scanning starts 

directly. Scanner source must 

be correct. 

1 bit 0 = Not used 

1 = Start ST 
Scan 

Start ST Scan 

/no signal 

X X  X 

Store current 

tightening 

program in the 

tool 

This is a command input to 

store the current tightening 

program settings into the 

wireless tool NVRAM. The 

tool must be set in standalone 
mode 

   X X   

Timer enable tool Used with the function Timer 

enable tool that locks the tool 

according to configuration. The 

function unlocks the tool for a 

period of five seconds. Once 

the period expires, the tool is 

locked again. If a start attempt 

is made before five seconds 

have passed, the tool remains 

unlocked until it is stopped or 

button is released (plus that a 
new five seconds period starts). 

1 bit 0 = reset 

1 = set 

Timer Enable 

Tool /Timer 
Enable Released 

X X X X 
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Toggle CW/CCW Toggles direction between CW 

and CCW. SL tool only. 

1 bit 0 = Not used 

1 = Toggle 

Toggle 

CW/CCW 

/no signal 

X X  X 

Toggle CW/CCW 

for next run 

Changes direction and changes 

back automatically after one 

run. SL tool only. 

1 bit 0 = Not used 

1 = Toggle 

Toggle 

CW/CCW for 

next run 

/no signal 

X X  X 

Tool disable n.c. The tool does not start when this input is active. If the tool rotates, it will 
immediately stop. The input is active when the circuit is opened (normally closed). 

X    

Tool disable n.o. The tool does not start when this input is active. If the tool rotates, it will 

immediately stop. The input is active when the circuit is closed (normally open).  

X    

Tool disabled Fieldbus disable tool. To avoid 

conflicts this parameter shall 

not be selected if Tool enabled 
is used. 

1 bit 0 = Enable tool 

1 = Disable tool 

Tool disable 

/Tool enable 

    

Tool enabled  Fieldbus enable tool. To avoid 

conflicts this parameter shall 

not be selected if Tool disabled 
is used. 

1 bit 0 = Disable tool 

1 = Enable tool 

Tool enable 

/Tool disable 

    

Tool in work 

space 

TLS System reports that the 

tool is in work space via Open 
protocol interface. 

   X    

Tool in product 

space 

TLS System reports that the 

tool is in product space via 
Open protocol interface. 

   X    

Tool lights flash green, see Flash tool green light       

Tool loosening 

disable 

The function is similar to Tool 

Disable, but only for loosing. 

1 bit 0 = Loosening 

enable 

1 = Loosening 
disable 

Tool loosening 

disable 

X    

Tool start 

loosening 

Starts the tool in loosening 

direction. Direction depends on 

CW/CCW in PF. Tool start 

input source must be set to 

Fieldbus.  

1 bit 0 = Stop tool 

1 = Start 
loosening 

Start loosening 

/Stop tool 

X    

Tool start 
tightening 

Starts the tool in tightening 

direction. Direction depends on 

CW/CCW in PF. Tool start 

input source must be set to 
Fieldbus. 

1 bit 0 = Stop tool 

1 = Start 

tightening 

Start tightening 

/Stop tool 
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Tool stop Stops the tool.  1 bit 0 = Not used 

1 = Stop tool 

Stop tool 

/no signal 

    

Tool tightening 
disable 

The function is similar to Tool 

Disable, but only for 

tightening. 

1 bit 0 = Tightening 
Enable 

1 = Tightening 
Disable 

Tool tightening 
disable  

/Tool tightening 
enable 

X    

Tool tightening 

pulse 

Tool starts tightening if the 

pulse is longer than 100 ms and 

continues until target or current 

limit is reached 

1 bit 0 = Not used 

1 = Start Tighten 
Pulse 

Tool tightening 

start 

/no signal 

    

Unlock tool Unlocks tool if tool locked by 
batch ok or lock on reject 

1 bit 0 = Not used 

1 = Unlock tool 

Unlock tool  

/no signal 

X X X X 
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22 Parameter list 
This section lists the Power Focus parameters.  

22.1 Pset 

22.1.1 Programming 

Parameter 
number 

Parameter name Description  Default 
setup 

P100 Control strategy For a description of the options, see section Control strategies. 

Tq con 

Tq con/ang mon 

Tq con/ang con (AND) 

Tq con/ang con (OR) 

Ang con/tq mon 

DS con 

DS con/tq mon 

Reverse ang 

Reverse tq 

Click wrench 

Rotate spindle forward 

Rotate spindle reverse 

Home position forward 

Home position reverse 

EP monitoring 

Yield 

Yield / Tq con (OR) 

Pulsor fixed 

Pulsor control 

Snug gradient 

Residual Tq7Time 

Residual Tq/Angle 

Breakaway peak 

Loose and tightening 

Pulsor angle shutoff 

 

The Reverse angle, Rotate spindle forward/reverse, and Home 

position forward/reverse strategies are not applicable for 

Open end tools. 
 

IF DS tool: 
DS con  

ELSE: Tq 

con/ang 

mon 
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Parameter 
number 

Parameter name Description  Default 
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P101 Tightening strategy One stage: tightening is performed in one stage. Control is done from P110 

Cycle start until P113 Final target is reached. 

Two stage: tightening is performed in two stages. Control is done from P110 

Cycle start until P111 First target. The tool stops and then accelerates to a 
lower speed and controls until P113 Final target is reached. 

Quick step: quick step is a variant of a two stage tightening. The difference is 

that the tool speed changes directly from the higher speed to the lower speed 
without stopping. 

Ergo ramp: This is a two stage strategy with a constant increase in torque 

during the second stage of the tightening. Gives the operator constant reaction 

torque in the tool regardless of joint hardness. 

Two stage 

P104 Rundown angle This parameter is optional. If chosen, there are two alternatives. 

From start: The rundown phase starts when the tool trigger is pressed and 
continues until the torque value reaches P116 Rundown complete. 

From cycle start: The rundown phase starts when the torque level exceeds the 

P110 Cycle start torque level and continues until P116 Rundown complete is 
reached. 

No 

P105 Zoom step This parameter enables the zoom step function. Zoom step strategy combines 

quick tightening with high precision and low scatter. 

No 

P107 Click wrench no. This parameter is only used if Click wrench is chosen as P100 Control 

strategy. It is used to connect the click wrench strategy to any one of four 

defined digital input. 

Click 
wrench 1 

P108 Start Trace from Will generate a Trace from Tool start or P110 Cycle start. 

For STwrench, only P110 Cycle start  is available. 

P110 Cycle 
start  

P109 Monitor end time 

from 

Decides if monitoring of end time (cycle complete) will start from P110 

Cycle start or P116 Rundown complete. 

P110 Cycle 

start 

P110 Cycle start Defines the starting level for a tightening cycle. IF P100 

Control 

strategy is 

set to DS 

con or DS 
con/tq mon:  

0.1 * T102 

ELSE: 

0.05 * T102 

Tool max 

torque 

P111 First target Defines the level at which the changeover takes place between the first and 
second stage in a two stage tightening, quick step or ergo ramp. 

0.25 * T102 

Tool max 
torque 

P112 Final tq min Defines the lower torque limit for OK tightening. 0.3 * T102 

Tool max 
torque 
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Parameter 
number 

Parameter name Description  Default 
setup 

P113 Final target  Defines the desired final torque value when a torque (tq) P100 Control 

strategy is used. The tool shuts off when the final target value is reached.  

 

To maintain accuracy when tightening, final target shouldn't 

be lower than specified minimum for the tool in use. Refer to 

tool catalogue for necessary data. 
 

9999 Nm 

P114 Final tq max Defines the upper torque limit for OK tightening. The tool shuts off if the 
torque value exceeds this value. 

0.5 * T102 

Tool max 
torque 

P115 Cycle complete This parameter indicates the torque level when the tightening cycle is 

complete (valid if the tool has shut off prior to reaching this level).. 

0.03 * T102 

Tool max 
torque 

P116 Rundown complete The torque level when the rundown phase is finished. (Only used if P104 

Rundown angle or any of the PVT options are selected). 

0.2 * T102 

Tool max 
torque 

P118 Measure torque at Defines at what point the torque is measured. 

Torque peak: gives the highest torque value during the tightening. 

Angle peak: gives the torque at the highest angle value. 

Shut off: measures the torque when the target condition has been fulfilled. 

Torque 

peak 

P119 Loosening limit Defines the limit for a valid loosening. Adjustable from 0 to T102 Tool max 

torque. 

0.1 * T102 

Tool max 
torque 

P120 Start final angle Angle measurement starts when the torque value exceeds this value. P120 

Start final angle must be selected equal to or greater than P110 Cycle start.  

(If a PVT option is used then it has to be greater than P116 Rundown 

complete.) 

0.25 * T102 

Tool max 
torque  

P121 Measure angle to Defines to what point the final angle is measured. The start point is always 

P120 Start final angle.  

Torque peak: gives the angle at the highest torque value. 

Angle peak: gives the highest angle value during the tightening. 

Cycle complete: measures the angle at P115 Cycle complete. 

Shut off: measures the angle when the target condition has been fulfilled. 

Angle peak 

P122 Final angle min This parameter indicates the lower limit for final angle. If the final angle is 
below this level the tightening is considered as NOK. 

0 deg 

P123 Target angle Indicates the target value for the angle in degrees when angle control, ang 

con, is used. When this value is reached the tool is turned off. 

0 deg 

P124 Final angle max Defines the upper limit for the tightening angle. If the angle exceeds this level 

the tightening is considered as NOK and the tool will shut off. 

9999 deg 

P125 Rundown angle min This parameter indicates the min limit value for P104 Rundown angle. If the 

angle is smaller than this value at P116 Rundown complete, “low” is indicated 

and the tool will shut off. 

0 deg 

P126 Rundown angle 

max 

This parameter indicates the max limit value for P104 Rundown angle. If the 

angle is larger than this value, “high” is indicated and the tool will shut off. 

9999 deg 
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Parameter 
number 

Parameter name Description  Default 
setup 

P127 Final angle max 

mon 

Defines the upper limit for the tightening angle. If the angle exceeds this level 

the tightening is considered as NOK but the tightening will NOT shut off due 
to this. 

9999 deg 

P128 Rehit angle Defines the max angle for rehit detection.  

Only for MW tool. 

0 deg 

P130 Soft start speed Defines the tool speed during the soft start interval. 

Allowed interval is between 1 and 30 percent of maximum tool speed. 

10% 

P131 Step 1 speed Defines the first step speed. 

Speed is adjustable between 1 and 100 percent of max tool speed. 

100% 

P132 Step 2 speed Defines the second step speed. 

Speed is adjustable between 1 and 40 percent of the tool max speed. 

If two stage tightening is used the speed in the second step will increase 

according to the P136 Step 2 ramp until it reaches this value. If quick step is 
used the tool changes to step 2 speed directly without using a ramp. 

40% 

P133 Loosening speed Defines speed during loosening. The value is adjustable between 1 and 100 

percent. 

100% 

P134 Loosening ramp Defines acceleration during loosening. The value is adjustable between 0 and 
100 percent. A low percentage gives fast acceleration. 

0% 

P135 Step 1 ramp Defines step 1 acceleration. The value is adjustable between 0 and 100 
percent. A low percentage gives fast acceleration (0% is normally used). 

0% 

P136 Step 2 ramp Defines step 2 acceleration. A low percentage gives fast acceleration (0-

100%). 

20% 

P137 Ergo ramp Defines the acceleration. The value is adjustable between 0 and 100 percent. 
Only used if ergo ramp is chosen as the P101 Tightening strategy. 

40% 

P138 Zoom step speed Defines the speed used for zoom step strategy. The value is a percentage of 

the tool’s max speed. The value is adjustable between 1 and 20 percent. 

To set zoom step speed, parameter P105 Zoom step must be active. 

10% 

P139 Speed unit Sets speed parameters (P130-P133, P138 and P161) relative to tool max 

speed ("Percent") or absolute ("RPM") for current P-set.  

 

Changes between RPM and % due to less accuracy in % can 

lead to quantization effects in values for speed parameters. 
 

“Percent” 

P141 End time Defines the time required for the torque level to stay below 115 Cycle 

complete before the tightening is aborted (valid if the tool has not shut off 

prior to reaching cycle complete).  
The value is adjustable between 0.02 and 5.0 seconds. 

0.2 s 

P142 Soft start time During this time, from the moment that the tool trigger is pressed, the spindle 

rotates very slowly. This gives the operator a chance to fit the socket on the 
screw. The value is adjustable between 0.0 and 5.0 seconds. 

0.2 s 

P143 Tool idle time Defines the idle time between a completed tightening and the start of the next 

tightening. (Used in Multistage). 

The value is adjustable between 0 and 32 seconds. 

0.0 s 
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Parameter 
number 

Parameter name Description  Default 
setup 

P144 Cycle abort timer If the tool does not reach its shut off point, this timer will shut it off. The 

timer is activated when the tool trigger is pressed. 
The value is adjustable between 0.1 and 60.0 seconds.  

30 s 

P150 Batch count Activates a function that measures how many times a tightening is repeated. 

It must be determined from where P151 Batch size value should be read, if 
this parameter is activated. 

Options: 

Off: batch count functionality is not used. 

Pset: use batch size of a Pset. 

Fieldbus: an external source decides P151 Batch size via fieldbus. 

Ethernet/serial: an external source decides P151 Batch size via Ethernet or 
serial interface. 

 

If batch count is used in a Job (that includes the specific Pset), 

this parameter is recommended to be set to “Off”. 
 

Off 

P151 Batch size The size can be 1 - 99. To set this parameter, the P150 Batch count must be in 

active mode. 

 

Batch size defined in Job overrides batch size defined in Pset. 

 

1 

P152 Lock at batch done The tool will be locked when reaching Batch done. Batch done is reached 
when the number of correct tightenings is equal to P151 Batch size. 

No 

P153 Max coherent 

NOK’s 

Defines the number of possible subsequent NOK (not OK) tightenings. This 

parameter is overruled by M208. To be able to set a value for P153 the 
parameter J301 Job type must be set to 'Forced' or 'Free and forced' 

Range: 1-10. 

0 (Off) 

P160 High speed 

rundown 

High speed rundown is a function for reducing the cycle time by running the 

tool at high speed during rundown.  

High speed rundown is a stage inserted between Soft start and Step 1, i.e. the 

Soft start time and Soft start speed affects the number of degrees of the 

rundown phase. This gives the possibility for fast tightening cycles even for 

long bolts with a small angle that require a slow step-one speed to avoid 
overshoots. 

Off 

P161 Rundown speed Rundown speed in percent. 100 % 

P162 High speed interval High speed rundown interval. 9999 deg 

P163 High speed ramp Defines the acceleration to P161 Rundown Speed during the high speed 

rundown stage. The value is adjustable between 0 and 100 percent. A low 
percentage gives fast acceleration. 

10% 

P164 Disable high speed 

rundown speed once 
if NOK 

Disable the high speed rundown function after a NOK tightening 

and enable high speed rundown speed when the tightening is OK. This 

function is only possible to enable if the P160 is On 

Off 

P170 Adjustable limit Adjustable positioning limit for open end tools. Used to set torque limit for 

the positioning of the tool after tightening. If set to No the internal default 

value is used as limit. 

No 
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Parameter 
number 

Parameter name Description  Default 
setup 

P171 Limit Maximum torque during positioning. Default value is tool dependent and 

stored in tool memory. The max value is limited to T424 Max torque 

positioning limit. 

 

The limit must be lower than the maximum torque in reverse 

specified by the open end gear supplier. Using higher values 

can result in damaging the open end gear. 
 

Tool 

dependent 

P180 Delta angle Gradient angle interval 10 deg 

P181 Delta torque Gradient torque interval Tool 

dependent, 

5% of Tool 
max tq 

P182 Torque limit Torque search limit for snug detection Tool 

dependent, 
Tool max tq 

P183 PVT distance Defines how many degrees before the Snug point the start value of the PVT 

compensation torque shall be used. 

0 deg 

P184 PVT interval The angle interval after the PVT distance point, during which the PVT 
compensate torque is evaluated. 

0 deg 

P185 Compensate value Option to choose between an average value and peak value during the PVT 
interval. 

Average 

P186 Delay monitoring 

after cycle start 

During this interval all Snug Gradients found will be disregarded. The delay 

interval starts when Cycle start has been passed. 

0 deg 

P190 Snug PVT 
monitoring min 

The lowest torque value allowed while searching after Snug point. P110 Cycle 
start 

P191 Snug PVT 

monitoring max 

The highest torque value allowed while searching after Snug point P182 

Torque 
limit 

22.1.2 Programming +  

Parameter 
number 

Parameter name Description  Default 
setup 

P200 Current monitoring 

 

This function is not applicable for DS tools. 

Activates the current monitoring function. 

The spindle torque is proportional to the motor current. By measuring motor 

current a method of measurement that is independent of the torque transducer 

is achieved. The torque forming current is expressed as percentage of 

nominal current at T102 Tool max torque. Set an acceptance window for the 

torque as redundant process control via parameters P201 CM min and P202 

CM max. 

No 

P201 CM min Defines min limit for OK tightening. 0.0% 
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Parameter 
number 

Parameter name Description  Default 
setup 

P202 CM max Defines max limit for OK tightening. 150% 

P210 Selftap Activates the PVT selftap function. 

When the joint has a torque peak at the start of the tightening it can be 

recommended to use the PVT selftap monitoring option to ensure that the 

tightening gets the right characteristics. It also makes it possible to perform 

tightenings where the start torque is higher than P113 Final target or P114 

Final tq max. 

No 

P211 Selftap interval Defines the section where measuring is performed. 

Setting is performed in degrees in the interval 1 to 9999.  

1 

P212 No. of selftap 

windows 

Defines the number of windows that the P211 Selftap interval is to be divided 

into. Each window is then evaluated separately.  

Mean value foundations are calculated from a number of windows to reduce 

the effect of noise. Fewer number of windows mean that more samples will 

be grouped together, hence one odd sample will have less impact on the 

calculated mean value and vice versa. A higher P212 No. of selftap windows 

makes the monitoring more sensitive whereas a lower number will filter more 

noise. 

The number of windows can be chosen between 1 and 9999.  

1 

P213 Selftap min Indicates the lowest torque level for the interval. If the torque level falls 
below this level, a low-level alarm will be generated.  

If P109 Monitor end time from is set to Cycle start, then range is from P115 

Cycle complete value to P214 Selftap max.   

If P109 Monitor end time from is set to Rundown complete, then range is from 
0 to P214 Selftap max. 

P115 Cycle 
complete 

P214 Selftap max This parameter indicates the highest torque level for the interval. If the torque 

level exceeds this level, a high level alarm will be generated. Range is from 
P213 Selftap min to T102 Tool max torque.  

9999 Nm 

P220 PVT monitoring Activates the PVT monitoring function. No 

P221 PVT delay interval Defines delay before P220 PVT monitoring starts. 

Setting is performed in degrees in the interval 0 to 9999. 

0 deg 

P222 PVT monitor 

interval 

Defines the interval during which the P220 PVT monitoring is to be 

performed. 

Setting is performed in degrees in the interval 1 to 9999. 

1 deg 

P223 No. of PVT 

windows 

Defines the number of windows that the P222 PVT monitor interval is to be 

divided into. Each window is then evaluated separately. 

Mean value foundations are calculated from a number of windows to reduce 

the effect of noise. Fewer number of windows mean that more samples will 

be grouped together, hence one odd sample will have less impact on the 

calculated mean value and vice versa. A higher P223 No. of PVT windows 

makes the monitoring more sensitive whereas a lower number will filter more 

noise. 

The number of windows can be chosen between 1 and 9999. 

1  
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Parameter 
number 

Parameter name Description  Default 
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P224 PVT min limit This value is evaluated against the monitor interval peak value at the end of 

the interval. If the torque value falls below this limit, an alarm is generated.  

If P109 Monitor end time from is set to Cycle start, then range is from P115 

Cycle complete value to P225 PVT max limit. 

If P109 Monitor end time from is set to Rundown complete, then range is 
from 0 to P225 PVT max limit. 

P115 Cycle 

complete 

P225 PVT max limit This parameter is monitored in real time during the monitor interval and if 

exceeded, an alarm is generated.  

P116 

Rundown 
complete 

P230 PVT comp When this option is set to “Yes” a prevailing torque PVT compensate is 

(measured at the interval of 20 samples preceding start of P231 PVT comp 

point) used as reference for the torque during the actual tightening cycle. 

 

All torque values; i.e. P113 Final target, P111 First target and 

P114 Final tq max are compensated (subtracted) from the 

prevailing value. Also, the results are compensated. 
 

No 

P231 PVT comp point The value can be set between 0 and 9999 degrees.  10 deg 

P240  Tool tightening 
direction 

CW/CCW 

Select tool rotation direction. “CW” for right hand threaded screws and 

“CCW” for left hand threaded screws. To be able to start in the decided 
direction, turn the tool direction ring to its correct position.  

 

This parameter has no effect when running an Open end tool 

(tube nut tool). 
 

CW 

P241 Soft stop Yes/No 

The PF will ramp down the torque when target is reached. The “Yes” option 
is recommended. 

Yes 

P242 Alarm on rehit Yes/No 

If selected, Power Focus will detect rehits (event code E112 Rehit). The red 

tool LED will be lit when a rehit is detected. The criteria for a rehit are a 

short or a non-existent second stage in combination with a slow speed in the 
first stage.  

No 

P243 Alarm on tq < target Yes/No 

Decides if the tightening should be approved if the final torque is lower than 

the P113 Final target but above P112 Final torque min. 

No 

P244 Alarm on lost 

trigger 

Yes/No 

Power Focus will detect if the tool trigger was released before the P113 Final 

target was reached. 

No 

P245 DS torque tuning 
factor 

Only used if “DS con” is chosen as a P100 Control strategy. It compensates 

for the error that DS measurement induces. The value can be set between 80 

and 220 percent. For information how to adjust the DS torque-tuning factor, 
see section DS con. 

100% 

P246 Alarm on end time 

shutoff 

Yes/No 

If end time times out before P113 Final target was reached then an event code 

will be displayed.  

No 
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Parameter 
number 

Parameter name Description  Default 
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P247 Socket release Rotates the socket approximately three degrees backwards after the tightening 

is done. 

No 

P250 Gradient monitoring Monitors the torque increase or decrease for an angle window. No 

P251 Gradient torque min Minimum increase of the torque for the angle window. 0 

P252 Gradient torque 

max 

Maximum increase of the torque for the angle window. 9999 

P253 Joint hardness Hardness coefficient for the joint.  
1- hard joint, 20- soft joint 

10 

P254 Start torque Torque threshold where the gradient monitoring is to be started. Start final 

angle 

P255 Angle offset Additional angle from P254 Start torque before gradient monitoring is started. 0 deg 

P260  Start torque The torque threshold where the yield control is to be started. 

 

Yield control is activated by selecting the P100 Control strategy 

to Yield or Yield/Tq con (OR). The P101 Tightening strategy 

can be set to One stage, Two stage or Quickstep, and yield 

control will always interact in the second stage of the tightening.  

P105 Zoom step strategy ending is disabled when yield control is 

selected. An additional tightening angle can be added after the 

yield point is reached by setting an angle to the P264 Extra 

angle step parameter. 
 

0.0 Nm 

P261 Step angle Defines the angle interval between the sample windows. 0 deg 

P262 Window angle Defines the length of the angle interval (the window) in which an average of 

the torque values shall be calculated. 

0 deg 

P263 Yield slope ratio This parameter decides the sensitivity of the yield point detection. The set 

value is the percentage of the maximum slope, at which the yield point is 

considered reached. 100% corresponds to the maximum slope during the 

tightening (early shut-off and highest sensitivity), and 0% to a completely 
horizontal portion of the trace (late shut-off close to or after peak torque). 

50 % 

P264 Extra angle step Additional angle step after the yield point is reached. 0 deg 

P280 Post view torque Enable/disable the post view torque functionality. Only useful if torque is to 

be measured during monitoring interval. 

Some joints have a torque peak prior of P116 Rundown complete. Post view 

torque function makes it possible to monitor torque values during two 

specified angular intervals. The interval start is defined as angle prior to 

rundown complete. Torque is then monitored for a specified angular interval. 
Evaluation (OK/NOK) is done when rundown complete is reached. 

 

Not accessible when any PVT-option is selected. 

 

No 

P281 Post view min 
torque 

Defines the low limit for the torque during the entire interval. P110 Cycle 
start 

P282 Post view min 

monitoring start 

Start of min monitor interval. 9999 

P283 Post view min 
monitoring interval 

Length of min monitor interval. 1 
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Parameter 
number 

Parameter name Description  Default 
setup 

P284 Post view max 

torque 

Defines the high limit for the torque during the entire interval. P116 
Rundown 
complete 

P285 Post view max 
monitoring start 

Start of max monitor interval. 1 

P286 Post view max 

monitoring interval 

Length of max monitor interval. 1 

22.1.3 Pset setup 

Parameter 
number 

Parameter name Description  Default 
setup 

P400 View existing Psets To view existing Psets in the current PF channel. Both numbers and logical 
names will be displayed. 

 

P401 Create new Pset To create and open a new Pset. Each Pset has a unique ID number between 1 

and 250 (or up 300 with the configurable memory functionality). 

 

P402 Name Pset Used when a selected Pset is to be named with a logical name. Up to 25 

characters.  

Empty 

string 

P403 Copy Pset Used when a source Pset is to be copied to a destination Pset.   

P404 Delete Pset Used when a Pset is to be removed. 

 

If a Pset is a part of a Job it can not be deleted. 

 

 

P406 Pset updated Timestamp (date and time) for Pset latest modification. Not editable.  

P409 Pset updated by Displays the name of the user who last changed the Pset. Not writable. If no 

user has logged in the filed values are: TTPF if changed via ToolsTalk, 

OPER if changed via the controller, and BLANK if the Pset has been created 
in an earlier version of the software. 

 

P410 Delete Pset results Used when all results that belong to the current Pset are to be cleared.  

P411 Delete all results Used when all Pset results are to be cleared.  

P420 Comment The comments displayed here are entered in a dialog box each time a Pset is 

stored. A prerequisite is that parameter C600 is set to Pset comments. Length 
0-100 characters.  

No 

22.1.4 Statistic programming 

Parameter 
number 

Parameter name Description  Default 
setup 

P500 Min valid stat tq 
limit 

The result must be greater than or equal to this value in order for it to be 
included in the statistical calculations. 

0 Nm 
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Parameter 
number 

Parameter name Description  Default 
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P501 Max valid stat tq 

limit 

The result must be less than or equal to this value in order for it to be 

included in the statistical calculations. 

9999 Nm 

P502 Subgroup size Defines the subgroup size for statistical diagrams and control limits. If this 

parameter is changed, the results will be recalculated. 

Group size can be set between 2 and 20. 

4 

P503 No. of subgroups Power Focus can automatically calculate statistical control limits. In order for 

these limits to be reasonable, they must be performed on a greater number of 

tightenings. This parameter is used to set the number of subgroups used for 
these calculations. 

10 

P504 Subgroup frequency Defines which subgroups that will be used in the statistical calculations. If the 

frequency is 4 then only every fifth subgroup will be used.  

1 

P505 Latest n values The latest number of values (1 - 100) that is used in the statistical 
calculations. 

30 

P506 SPC alarm tq With this parameter it is possible to switch on or off the torque SPC alarm 

function. 

Off 

P507 SPC alarm angle With this parameter it is possible to switch on or off the angle SPC alarm 

function. 

Off 

P508 SPC alarm CM With this parameter it is possible to switch on or off the current SPC 
monitoring alarm function. 

Off 

P510 Torque X-bar LCL The lower control limit for mean value. 

Calculated automatically or entered manually. 

0 Nm 

P511 Torque X-bar UCL The upper control limit for mean value. 

Calculated automatically or entered manually. 

9999 Nm 

P512 Torque range LCL The lower control limit for range. 

Calculated automatically or entered manually. 

0 Nm 

P513 Torque range UCL The upper control limit for range. 

Calculated automatically or entered manually. 

9999 Nm 

P514 Torque X-bar-bar The desired mean value for calculated mean values for groups of tightenings. 0 Nm 

P515 Torque range-bar The desired mean value for calculated mean ranges for groups of tightenings. 0 Nm 

P520 Angle X-bar LCL The lower control limit for mean value. 

Calculated automatically or entered manually. 

0 deg 

P521 Angle X-bar UCL The upper control limit for mean value. 

Calculated automatically or entered manually. 

9999 deg 

P522 Angle range LCL The lower control limit for range. 

Calculated automatically or entered manually. 

0 deg 

P523 Angle range UCL The upper control limit for range. 

Calculated automatically or entered manually. 

9999 deg 

P524 Angle X-bar-bar The desired value for calculated mean values for groups of tightenings. 0 deg 
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Parameter 
number 

Parameter name Description  Default 
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P525 Angle range-bar The desired value for calculated mean ranges for groups of tightenings. 0 deg 

P530 Rundown angle X-
bar LCL 

The lower control limit for mean value. 

Calculated automatically or entered manually. 

This function is only available if parameter P104 Rundown angle is selected. 

0 deg 

P531 Rundown angle X-

bar UCL 

The upper control limit for mean value. 

Calculated automatically or entered manually. 

9999 deg 

P532 Rundown angle 

range LCL 

The lower control limit for range. 

Calculated automatically or entered manually. 

This function is only available if parameter P104 Rundown angle is selected. 

0 deg 

P533 Rundown angle 

range UCL 

The upper control limit for range. 

Calculated automatically or entered manually. 

This function is only available if parameter P104 Rundown angle is selected. 

9999 deg 

P534 Rundown angle X-

bar-bar 

The desired mean value for calculated mean values for groups of tightenings. 

This function is only available if parameter P104 Rundown angle is selected. 

0 deg 

P535 Rundown angle 

range-bar 

The desired mean value for calculated mean ranges for groups of tightenings. 

This function is only available if parameter P104 Rundown angle is selected. 

0 deg 

P540 Selftap X-bar LCL The lower control limit for mean value. 

Calculated automatically or entered manually. 

This function is only available if parameter P210 Selftap is selected. 

0 Nm 

P541 Selftap X-bar UCL The upper control limit for mean value. 

Calculated automatically or entered manually. 

This function is only available if parameter P210 Selftap is selected. 

9999 Nm 

P542 Selftap range LCL The lower control limit for range. 

Calculated automatically or entered manually. 

This function is only available if parameter P210 Selftap is selected. 

0 Nm 

P543 Selftap range UCL The upper control limit for range. 

Calculated automatically or entered manually. 

This function is only available if parameter P210 Selftap is selected. 

9999 Nm 

P544 Selftap X-bar-bar The desired value for calculated mean values for groups of tightenings. 

This function is only available if parameter P210 Selftap is selected. 

0 Nm 

P545 Selftap range-bar The desired value for calculated mean ranges for groups of tightenings. 

This function is only available if parameter P210 Selftap is selected. 

0 Nm 

P550 PVT X-bar LCL The lower control limit for mean value. Calculated automatically or entered 

manually. 

This function is only available if P220 PVT monitoring is selected. 

0 Nm 

P551 PVT X-bar UCL The upper control limit for mean value. Calculated automatically or entered 
manually. 

This function is only available if P220 PVT monitoring is selected. 

9999 Nm 
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Parameter 
number 

Parameter name Description  Default 
setup 

P552 PVT range LCL The lower control limit for range. Calculated automatically or entered 

manually. 

This function is only available if P220 PVT monitoring is selected. 

 

0 Nm 

P553 PVT range UCL The upper control limit for range. Calculated automatically or entered 

manually. 

This function is only available if P220 PVT monitoring is selected. 

9999 Nm 

P554 PVT X-bar-bar The desired value for calculated mean values for groups of tightenings. 

This function is only available if P220 PVT monitoring is selected. 

0 Nm 

P555 PVT range-bar The desired value for calculated mean ranges for groups of tightenings. 

This function is only available if P220 PVT monitoring is selected. 

0 Nm 

P560 CM (X-bar) LCL The lower control limit for mean value. 

Calculated automatically or entered manually. 

0% 

P561 CM (X-bar) UCL The upper control limit for mean value. 

Calculated automatically or entered manually. 

9999% 

P562 CM R LCL Defines the low limit for permitted variations in the range calculations. 0% 

P563 CM R UCL Defines the high limit for permitted variations in the range calculations. 9999% 

P564 CM (X bar-bar) Defines the desired CM average for all of the subgroups calculated 

automatically or entered manually. (If calculated: In each subgroup the 

average tightened CM value is calculated. Then an average is calculated 

based on all of the averages.) 

0% 

P565 CM (R bar) Defines the desired average of the CM variation for all of the subgroups. 

Calculated automatically or entered manually. (In each subgroup the average 

tightened CM variation is calculated. Then an average is calculated based on 
all of the averages.) 

0% 

22.2 Multistage 

22.2.1 Setup 

Parameter 
number 

Parameter name Description 

M100  View existing 
Multistages 

To view all existing Multistages. 

M101 Create new 
Multistage 

To create a new Multistage. 

M102 Copy Multistage Used for the copying of an existing Multistage. 

M103 Delete Multistage Used when a Multistage is to be deleted. 
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22.2.2 Multistage programming 

Parameter 
number 

Parameter name Description Default 
setup 

M200 Multistage name Used when a selected Multistage should be given a name (optional).  

M201 Stage list Stage list specifies the list of available Psets that can be linked together into a 

Multistage. Executes the specified link list of Psets into a Multistage. 

Pset 1 

M202 Batch count Activates a function that measures how many times a Multistage tightening is 

repeated. It must be determined from where the batch size value should be 
read, if the batch count is activated. 

Options: 

Off: batch count is not used. 

Pset: use Psets batch size. 

Fieldbus: An external source decides batch size via fieldbus. 

Ethernet/serial: an external source sets batch size via Ethernet or serial 

interface. 

 

If batch count is used in a Job (that includes the specific 

Pset), this parameter is recommended to be set to “Off”. 
 

Off 

M203 Batch size Specifies the number of Multistage tightenings in a batch. The range is 0 to 
99. 

1 

M204 Lock at batch OK The next time batch OK is reached the tool will be disabled until it is 

unlocked by the operator.  

No 

M208 Max coherent 
NOK’s 

Defines the maximum allowed amount of possible NOK (not OK) 
subsequent tightenings. This parameter overrules P153 Max coherent NOK’s. 

Off 

M210 Torque result Defines from what stage the torque result will be received. 

Accessible when torque is selected as a P100 Control strategy. 

Last stage 

M211 Angle result Defines from what stage the angle result will be received. 

Accessible when angle is selected as a P100 Control strategy. 

Last stage 

M212 Rundown result Defines from what stage the rundown angle result will be received. 

Accessible when parameter P104 Rundown angle is used. 

Last stage 

M213 PVT Selftap result Defines from what stage the PVT selftap result will be received. 

Accessible when P210 Selftap is activated. 

Last stage 

M214 PVT mon. result Defines from what stage the PVT mon. result will be received. 

Accessible when P220 PVT monitoring is activated. 

Last stage 

M215 CM result Defines from what stage the current monitoring result will be received. 

Accessible when P200 Current monitoring is activated. 

Last stage 

M216 Trace Defines the point from what stage the graph results (Trace diagram) will be 
received.  

Last stage 

M217 Post view torque 

result 

Defines from what stage the graph will be received. 

Accessible when P280 Post view torque is activated. 

Last stage 
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Parameter 
number 

Parameter name Description Default 
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M220 Min valid stat tq 
limit 

>=Cycle start, < Max valid stat tq limit 

The result must be greater than or equal to this value to be included in the 
statistical calculations. 

Not accessible when a DS strategy or reverse is selected (see P100 Control 

strategy). 

 

Results are only stored in the Multistage, not in the 

individual Pset. 
 

P110 Cycle 
start 

M221 Max valid stat tq 
limit 

>Min valid stat tq limit, <=tool max torque 

The result must be less than or equal to this value to be included in the 

statistical calculations. 

Not accessible when a DS strategy or reverse is selected (see P100 Control 

strategy). 

 

Results are only stored in the Multistage, not in the 

individual Pset. 
 

T102 Tool 
max torque  

M222 Subgroup size 2 - 20 

Defines the size of the subgroup that forms the basis for the statistical 

calculations. If this parameter is changed, all statistics have to be recalculated 
or deleted. 

Not accessible when a DS strategy or reverse is selected (see P100 Control 

strategy). 

 

Results are only stored in the Multistage, not in the 

individual Pset. 
 

4 

M223 No. of subgroups 1 - 7500 

Power Focus calculates control limits on request. For these limits to be 

relevant they must be based on a large number of data, at least 100. This 

parameter defines the number of subgroups to be used in the statistical 

calculations. If this parameter is changed, all the results have to be 
recalculated. 

Not accessible when a DS strategy or reverse is selected (see P100 Control 

strategy). 

10 

M224 Subgroup frequency 1 – 7500 

This parameter indicates the number of subgroups that are disregarded 

between every stored subgroup. 

Not accessible when a DS strategy or reverse is selected (see P100 Control 

strategy). 

1 

M225 Latest n values 1 – 100 

The number of tightening values which are included in the latest statistical 

calculations. Not accessible when a DS strategy or reverse is selected (see 
P100 Control strategy). 

30 

M226 SPC alarm tq This parameter switches the torque SPC alarm function on or off. 

Not accessible when a DS strategy or reverse is selected (see P100 Control 

strategy). 

Off 



Parameter list 

356 (428) 9836 3123 01 

Parameter 
number 

Parameter name Description Default 
setup 

M227 SPC alarm angle This parameter switches the angle SPC alarm function on or off. 

Not accessible when a DS strategy or reverse is selected (see P100 Control 

strategy). 

Off 

M228 SPC alarm CM This parameter switches the current monitoring SPC alarm function on or off. 

Accessible when P200 Current monitoring is activated. 

Off 

22.3 Job 

22.3.1 Setup 

Parameter 
number 

Parameter name Description Default 
setup 

J100 View existing Jobs To view existing Jobs in the current PF channel. Both numbers and logical 
names will be displayed. 

 

J101 Create new Job Create and open a new Job.  

Each Job has a unique ID number between 1 and 99 (or up 400 with the 

configurable memory function). Combining selected Psets/Multistages creates a 
Job. 

The new Job contains default values on all parameters. 

1 

J102 Name  The name of the Job helps the operator to identify the different Jobs (maximum 

25 characters). 

None 

J103 Copy Job Power Focus offers the possibility to copy the properties of an already existing 

Job to another Job. If the target Job has not already been created it will be 

created automatically. The source Job keeps its Job ID and the target Job gets a 
new Job ID. 

 

J104 Delete Job This function deletes an already existing Job from the Power Focus memory and 

the RBU. A running Job will be considered as aborted before it is deleted. 
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22.3.2 Programming 

Parameter 
number 

Parameter name Description Default 
setup 

J300 Job list The Job list specifies the Psets and Multistages that can be included in the 
Job. The total number of Psets/Multistages in one Job can not exceed 50.  

This parameter contains: 

PF channel: Power Focus channel ID that the selected Pset and Multistage 
belongs to. 

Pset/Ms (Event): identification number of Psets/Multistages included in 

the Job. The Psets/Multistages specified in the Job must be predefined, and 

they can be included in more than one Job. Same Pset/Multistage can be 

used several times in a Job. 

Pset name: name of the selected Psets/Multistages. (Pset name is not 
visible in Job list on PF Graph). 

Auto select: yes = auto select, no = manually select.  

With auto select the Job functionality automatically chooses the next Pset. 

With a manually selected Pset/Multistage the operator must manually 

choose the next Pset.  

 

This function is only available for forced order Jobs. 

It is not possible to use the auto select functionality for free 

order Jobs (see parameter J301 Job order type). 

A Job has override privileges, in comparison to a single 

Pset/Multistage, on a defined maximum allowed amount of 

possible NOK (not OK) subsequent tightenings. 

Batch size: A batch size should be specified for each Pset or Multistage in 

a Job. The batch size specifies the number of tightenings to be performed 

for each Pset or Multistage. Maximum batch size is 99. It is possible to 

define free running Psets/Multistages by setting batch size to 0. In this 

case, the bypass function must be used to be able to continue the selected 
Job. 

Max coherent Not OK tightenings (NOK’s): Max coherent Not OK 

tightenings (NOK’s) are a defined maximum allowed amount of possible 
NOK (not OK) subsequent tightenings for each Pset/Multistage in a Job.  

If P153 Max coherent NOK’s or M208 Max coherent NOK’s is used for the 

Psets or Multistages included in the Job, these settings are ignored by the 

Job setting. 

The tool will be locked (for both tightening and loosening) when number 

of possible not OK tightenings is reached for each batch. 

When the tool is locked due to possible not OK tightenings the only ways 
to unlock the tool are: 

Reset counter for performed not OK tightening via a digital input. 

Select abort Job (in case the selected Job shall not lock the tool). 

Select Job off. 
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Parameter 
number 

Parameter name Description Default 
setup 

J301 Job type A Job must be defined as forced order Job, free order Job or free and 
forced order Job. 

Free order: offers the operator to perform Psets/Multistages in any order. 

The Job members work independently from each other. In a Cell Job with 

free order, all Job members are able to perform tightenings at the same 
time. 

Forced order: Psets/Multistages must be performed in the order specified 

in the Job list. One Job member at a time performs a tightening while the 
other Job members are locked. 

Free and forced order: allows the operator to perform Psets/Multistages in 

the same PF channel as the order defined Job, but the operator is free to 

perform tightening from any channel in the Job. 

Forced 

J302 Lock at Job done Yes: tools of the Job members will be disabled during a Job except the 

member who performs tightening according to the Job list. After a Job is 

completed or aborted, tools of all Job members will be disabled for both 

tightening and loosening. The tool remains locked until a new Job is 
selected or the tool is enabled again. 

No: the tool will be enabled for all Job members after the Job is completed. 

For those Job members who are not involved in the Job the tool will be 

enabled also while the Job is in progress.  

Yes 

J303 Tool loosening This parameter controls the tool loosening functionality during a running 
Job. 

Enable: tool loosening functionality is unlocked during a running Job. Tool 

loosening is enabled for all Job members. 

Disable: tool loosening functionality will be locked during a running Job. 

Enable only on NOK tightening: The tool loosening is disabled during a 

Job but it will be enabled when a NOK tightening is performed. 

Disable at Batch start: The tool loosening functionality is locked until the 

batch is done.  

Enable 

J304 Repeat Job After a Job is completed, the Job will be automatically restarted. To turn 

off this feature the Job must be aborted, deleted or the Job off mode must 

be selected. 

No 

J310 Increase batch at 
tightening 

OK: Specifies that only accepted tightenings will be considered performed 
and counted. 

OK+NOK: Specifies that also not accepted tightenings will be considered 
performed and counted. 

 

This will also have directly effect on the batch status, 

which will be NOK (nxNOK when not accepted tightening 

is performed and counted in a Job). 
 

OK 

J311 Batch status at 

increment/bypass 

OK: The batch status will be OK at batch Increment or bypass event. The 

nxOK LED on PF Graph or PF Compact will light. 

NOK: The batch status will be NOK  at batch increment or bypass event.  

NOK 
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Parameter 
number 

Parameter name Description Default 
setup 

J312 Decrement batch at 
OK loosening 

Yes/No/If last tightening OK 

If YES, an OK Loosening generates a batch decrement for both OK and 

NOK tightening. Set to If last tightening OK to decrement only for OK 
tightening.  

It is not possible to go back one step after the Job has been completed. 

 

If ”batch counter type” is set to OK and last tightening was 

a NOK tightening, an OK loosening will not decrease the 

batch counter. 

When the control strategy “Ds con” is implemented and 

this parameter is set to “Yes”, the batch does not 

decrement after an OK loosening. 
 

No 

J320 Max time to start 
Job 

This parameter defines the time limit, from when the Job is running to 

when the first tightening is started or batch increment/bypass is performed. 

If the time limit is exceeded the Job will be aborted. The timer restarts if a 
Job is reselected.  

Allowed values are between 1 - 9999 seconds. Value 0 (seconds) 
deactivates this function. 

0 

J321 Max time to 

complete Job 

This parameter defines time limit, from Job is up running to the last 

tightening in the Job is started. If the time limit is exceeded the Job will be 
aborted. 

Allowed values are between 1 - 9999 seconds. Value 0 (seconds) 
deactivates this function. 

0 

J322 Display result at 

auto select 

This parameter is a timer for Jobs with auto selected Psets/Multistages. It 

defines the time for tightening result to be displayed on a PF Graph or PF 

Compact. The result disappears, and LED OK, NOK and nxOK shuts off, 
when the tool trigger is pushed or if the time limit is exceeded. 

The timer also works for restart Job, when a Job is completed, before 
another Pset/Multistage is selected or when a Pset/Multistage is deselected. 

Allowed values are between 1 - 60 seconds. Value 0 (seconds) deactivates 

this function. 

0 

J330 Use line control The Job will be ready to start when a Job with activated Line control has 
been selected and the line control start signal has been received. 

Otherwise, if line control start signal has not been received the Job will not 

be ready to start and the tool will be locked until the line control start 

signal is received.  

A line control start signal is an external signal defined to be received by PF 

from a digital input. This signal can be received before or after a Job 
selection.  

Line control start signal status will be cleared when the running Job has 
been completed or aborted. 

Line control related inputs/outputs have only an effect on a Job reference 
and when this parameter is set to Yes. 

No 
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Parameter 
number 

Parameter name Description Default 
setup 

J341 Result of non-
tightenings 

Yes/No 

Yes: The non-tightening events; OK loosening, batch increment or batch 

decrement, and not performed tightenings due to digital inputs, Bypass 
Pset in Job or Abort Job, generate a result that is stored in the PF database.  

No: No non-tightening results for Job are stored in the Power Focus 

database. If this parameter is set to Yes, parameter C211 for Pset and 
Multistage is disregarded in Job.  

No 

J342 Reset all identifiers 

at Job done 

If activated, a reset will be made for all identifiers (Type 1, Type 2, Type 3 

and Type 4) at Job done. 

No 

J350 Header in result 

view 

Select whether running Pset name, Job name or PF name shall be 

displayed in the header of result view (PF Graph display). 

Pset name 

22.4 Controller 

22.4.1 Information 

Parameter 
number 

Parameter name Description 

C100 Main code version The version number of the Power Focus software release (i.e. the full software package). 

C101 Application code 
version 

The version number of the application code. 

C102 Parameter tree 

version 

The version of the parameter-tree.  

C103 RBU code version The version number of the RBU-code. 

C104 Boot code version The version number of the Boot-code. 

C105 DSP code version The version number of the DSP-code. 

C106 MC code version The version number of the MC-code. 

C110 Controller type The type of the Power Focus. 

C111 Serial number The serial number of the Power Focus unit. It is possible to change the number.  

C115 RBU type The type of RBU (Rapid Backup Unit) inserted in the Power Focus. The available RBU 
types are; Bronze, Silver, Gold, DS, X or a Customer special. 

C116 RBU serial number The serial number of the RBU (the hard-coded, unique, MAC-address). 

C118 MAC address Ethernet MAC address. 

C119 Drive size Shows the drive size of the controller. Available drive sizes are: 

SL, Small, Medium, Large, Uni, IRC. 
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22.4.2 Configuration 

Parameter 
number 

Parameter name Description Default 
setup 

C200 Pset Defines what device is to be used when selecting the running Pset. 

Available options; Off, Selector, DigIn, Ethernet/Serial, Identifier, Fieldbus, 
PF Keyboard, Fieldbus selector, STwrench tag and ST Selector. 

Off 

C201 Job Defines what device is to be used when selecting the running Job.  

The option is accessible when Job is accessible (RBU type). 

Available options; Off, DigIn, Ethernet/Serial, Identifier, Fieldbus and PF 
Keyboard 

Off 

C202 Job override Defines what device is to be used when selecting the running Job. 

This source has a higher priority than C201 Job. The option is accessible when 
Job is accessible (RBU type). 

Available options; Off, DigIn, Ethernet/Serial, Identifier, Fieldbus and PF 

Keyboard 

Off 

C210 Lock on reject When this parameter is activated, the tool locks when a NOK tightening has 
occurred.  

Available options; No, DigIn unlock and Rev ring unlock  

To unlock tool use digital input unlock, rev ring unlock, Fieldbus or the 
Ethernet/serial protocol. 

No 

C211 Result of non-
tightenings 

Yes/No 

If Yes is selected, then a non-tightening event i.e. loosening, batch operation 
will generate a result. 

If the checkbox is selected, then the non-tightening events; OK loosening, 

batch increment or batch decrement generate a result that is stored in the PF 
database. This parameter is used for Pset and Multistage. For Job, see J341. 

No 

C220 Disable loosening at 
OK 

Yes/No 

Used to prevent the operator from loosening a correctly tightened joint. 

No 

C230 OE positioning type Reverse/Forward/Reverse Torque Based 

Selects type of positioning mode for open end. 

Forward 

C240 Reset batch at Pset 
change 

Yes/No  

Resets the batch counter when a new Pset is selected. 

Yes 

C241 Reset batch at Pset 

store 

Yes/No 

Used if batch counter for a Pset is to be stored, and a reset of batch counter is 
wanted. 

Yes 

C242 Decrement batch at 
OK loosening 

Yes/No/If last tightening OK 

If YES, an OK Loosening generates a batch decrement for both OK and NOK 
tightening. Set to If last tightening OK to decrement only for OK tightening.  

 

This function only works with a single spindle, NOT with Sync. 

 

No 

C243 Batch status at 

increment 

OK/NOK 

Defines if an increment or bypass operation is OK or NOK. 

NOK 
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Parameter 
number 

Parameter name Description Default 
setup 

C244 Increase batch at 
tightening 

OK tightening 

OK+NOK tightening 

Defines if batch counter shall be increased at OK tightenings or at OK+NOK 
tightenings. 

OK 

C250 Use last Pset Yes/No 

Use last Pset which was selected before Power Focus reboot. 

No 

C260 Set Time and date are set by this command.  

C270 Events Opens the window for event log and display options.  

22.4.3 Network 

Parameter 
number 

Parameter name Description Default 
setup 

C300 IP address The IP address is a number for identification in a network. 0.0.0.0 

C301 Subnet mask Specifies the number of IP addresses on the subnet and also the number of PF 

that can be placed below a Net reference, if no router is used. 

0.0.0.0 

C302 Default router IP address of the router used on the subnet. 0.0.0.0 

C310 Channel ID Identification number of the channel/system to which the programming refers. 

Valid values are 0-20. 0 is only used for standalone PF. 

0 

C311 Channel name Name of PF. It is possible to use up to 25 characters.  

C312 Cell reference IP Defines the IP address to the Power Focus acting Cell reference. 

The Cell reference monitors and collects information from the Cell members 
included in the group. 

 

This IP address must be written into each included Cell member. 

 

0.0.0.0 

C313 Cell ID number The Cell ID is a unique number for the Cell reference (a kind of identification 
number). 

Valid values are 0-1000. Accessible when the Power Focus is a Cell reference. 

0 

C314 Cell name A unique name to be able to find the Cell in the network. 

It is possible to use up to 25 characters. Accessible when the Power Focus is a 
Cell reference. 

 

C315 Net reference IP  Defines the IP address to the Power Focus acting Net reference. 

The Net reference monitors and collects information from the Net members 
included in the group. 

 

This IP address must be written into each included Net member. 

 

0.0.0.0 
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Parameter 
number 

Parameter name Description Default 
setup 

C316 Job reference IP  Defines the IP address to the Power Focus acting Job reference. 

The Job reference monitors and collects information from the Job members 
included in the group. RBU dependent. 

 

This IP address must be written into each included Job member. 

 

0.0.0.0 

C317 Sync reference  Defines the IP address to the Power Focus acting Sync reference. 

The Sync reference monitors and collects information from the Sync members 
included in the group. RBU dependent. 

 

This IP address must be written into each included Sync member. 

 

0.0.0.0 

C320 Multicast On/Off. Enable/disable Multicast functionality. Off 

C321 Multicast IP address It is possible to set this IP address between 224.0.0.1 (all devices on this sub 

net) and 239.255.255.255 (multicast standard).  

Only valid if C320 Multicast is activated. 

225.6.7.8 

C322 Port Port number for multicast communication. 8086 

C323 Results None/All/Not ok 

The results that are reported to the multicast address. 

All 

C324 Traces None/All/Not ok 

The traces that are reported to the multicast address. 

None 

C325 Sync status On/Off. Used if sending Sync status on multicast. Off 

C326 Event code On/Off. Used if sending event code on multicast. Off 

C330 Port Port number for open protocol server Ethernet communication. 4545 

C331 Serial cable loss 
detection 

When enabled, Power Focus detects cable loss when running open protocol 
serial on serial port 1 or 2. 

On 

C340 Port Port number for ToolsTalk PF Ethernet communication.  6543 

C350 ToolsNet On/Off 

Result after each tightening is recorded in ToolsNet. A ToolsNet database 

registers and stores the results from tightenings, traces, data and history. Each 

PF units can store information from approximately 5000 tightenings. But the 

capacity in the ToolsNet database is, in principle, unlimited. The information 
can be mapped against the Power Focus, object or VIN-number, as desired. 

Off 

C351 IP address IP address for ToolsNet server. Only valid if C350 ToolsNet is activated. 0.0.0.0 

C352 Port Port number for ToolsNet communication. 

 

Port 6570 is not to ToolsNet but to the PIM server which connects 

PF units to ToolsNet. 
 

6570 

C353 Traces None/All/Not ok 

The traces reported to ToolsNet. 

None 
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Parameter 
number 

Parameter name Description Default 
setup 

C354 Keep Pset date on 
restore 

Used to keep Pset time stamp when Pset data is read from file.  

On: Pset date is kept when uploading file to controller. Off: Pset date is changed 
to current date when uploading file to controller. 

None 

C360 Port Port number for Acta Ethernet connection. 6540 

22.4.4 COM ports 

Parameter 
number 

Parameter name Description Default 
setup 

C400 Baud rate The baud rate of the Serial 1 COM port on the MC-card of the Power Focus. 

Available options: 2400, 4800 and 9600 

9600 bits/s 

C401 Protocol The type of protocol running on the serial 1 COM port on the MC-card of 

PF. 

Available options: None, ASCII, 3964R and IDESCO 

ASCII 

C410 Baud rate The baud rate of the Serial 2 COM port on the CC card of the Power Focus. 

Available options: 2400, 4800, 9600, 19200, 38400, 57600 and 115200 bits/s 

9600 bits/s 

22.4.5 Display 

Parameter 
number 

Parameter name Description Default 
setup 

C500 Language Select language for the Power Focus display. 

Options available in ToolsTalk: Chinese, English, French, German, Italian, 
Japanese, Brazil, Spanish and Swedish 

English 

C501 Torque unit Select unit for showing torque. 

Options available: Nm, lbf.ft, lbf.in, kpm, kgf.cm, ozf.in, and dNm. 

Nm 

C503 Torque with PVT 

comp 

Add PVT compensate value to display torque value. No 

C510 One channel Shows how the result after a tightening will be presented in the PF Graph user 

interface. 

Four variables can be shown at the same time. In PC, activate the part window 

with the left mouse button, open the list with variables with the right mouse 
button, and select the variable to follow. 

 

C511 Two channels Possible to show two PF channels at the same time. Select window to edit with 

keys 1, 2, 3 and 4. Then press the enter key to activate list of options. Pset and 

PF channel no. is changed with Pset (-/+) and change (-/+) keys. This function is 
valid only for the PF Graph user interface. 

 

C512 Compact display Used to set-up the compact display.  

C520 Viewing angle Set the PF Graph display-viewing angle to modify display visibility. (Not for 
ToolsTalk PF user). 
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C530 Soft keys enabled Function that connects and disconnects the menu selection keys. On the PF 

Graph display, the five top keys will be locked. On the PF Compact the 

functions Autoset, plus (+) and minus (-) key will be locked. 

Yes 

C540 Backlight auto off If selected, the lights on the PF Graph display will turn off after 30 minutes of 
inactivity. The light will turn on again after a key is pushed or after a tightening. 

Yes 

C550 Theme Selected color theme.  

Available options: PF4000, Classic, Night 

PF4000 

C551 OK background Background color in result windows for OK results. 

Available options: Default, Black, White, Green 

Default 

C552 OK foreground Foreground (text) color in result windows for OK results. 

Available options: Default, Black, White, Green 

Default 

C553 NOK background Background color in result windows for NOK results. 

Available options: Default, Black, White, Green 

Default 

C554 NOK foreground Foreground (text) color in result windows for OK results. 

Available options: Default, Black, White, Green 

Default 

22.4.6 Memory 

Parameter 
number 

Parameter name Description Default 
setup 

C600 Type Presents different options to configure the memory. 

Access is depending on RBU type. 

Available options: Default configuration, More Psets, More Jobs, More 

results, More events, More Identifiers and Totally configurable, Pset 
comments. 

Default 
configuration 

C601 No. of Psets Number of Psets possible to configure. 

Always readable. Writable if C600 Type is set to “Totally configurable”. 

Scope: 1 to 600 

250 

C602 No. of Jobs Number of Jobs possible to configure. 

Always readable. Writable if C600 Type is set to “Totally configurable”. 

Scope: 1 to 700 

99 

C603 No. of Results Number of results possible to save. 

Always readable. Writable if C600 Type is set to “Totally configurable”. 

Scope: 1 to 9000 

5000 

C604 No. of Identifier 
result parts 

Number of VINs possible to save in each result. 

Always readable. Writable if C600 Type is set to “Totally configurable”. 

Scope: 1 to 4 

1 

C605 No. of Events Number of events possible to save. 

Always readable. Writable if C600 Type is set to “Totally configurable”. 

Scope: 1 to 800 

100 

C606 No. of Statistical 

events 

Number of statistical events possible to save. 

Always readable. Writable if C600 Type is set to “Totally configurable”. 

Scope: 1 to 500 

100 
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Parameter 
number 

Parameter name Description Default 
setup 

C607 No. of Traces Number of traces possible to save 

Always readable. Writable if C600 Type is set to “Totally configurable”. 

Scope: 1 to 100 

8 

C609 Estimated memory 

usage 

Command that informs the user about the memory allocation. 

Always readable. Not writable. 

 

C610 Delete all results Tightening and statistical database for the Power Focus is deleted.  

C611 Total reset Totally reset of the Power Focus memory. 

 
All programming, tightenings and statistics will be deleted. 

 

 

C612 Reset general event 

log 

All events in the general event log are deleted.  

C613 Reset statistical 

event log 

All events in the statistical event log are deleted.  

22.4.7 Accessibility 

Parameter 
number 

Parameter name Description Default 
setup 

C800 Use Prevents parameter updates on the Power Focus keyboard and from ToolsTalk 

PF applications. 

No 

C801 Entry Specify unit allowed to enter the password. Available options: Tools Talk and 
All 

All 

C802 Setup password Choose a password, which will give write access to all parameters except those 

for the network. 

 

C803 Communication 

password 

Choose a password, which will give write access to the network parameters.  

22.5 Tool 
The tool parameters are visible depending on which tool is connected. For STB, most parameters are 

invisible when the tool is offline. 

22.5.1 Information 

Parameter 
number 

Parameter name Description Default 
value 

T100 Type Shows information about the connected tool type.  
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Parameter 
number 

Parameter name Description Default 
value 

T101 Usage Type of tool, fixed or handheld. Fixed tools have a lower max speed, which 

means that this parameter has to be evaluated when calculating the speed 
factor. 

Options available. Handheld and Fixed 

Accessible when a tool is connected, except STB offline. 

 

T102 Tool max torque Shows the maximum tightening torque for the tool in chosen unit. Possible 

values between 0.1 and 6553 Nm. 

The value is possible to change if correct password privileges are met. 

Accessible when a tool is connected, except STB offline. 

 

This parameter must only be changed by users with tool 

knowledge. Read only access for ST/SL tools and STB online. 

 

Nm 

T103 Gear ratio Shows the mechanical gear ratio for the tool.  

T104 Production date Tool production date. In Unix format.  

T105 Serial number Shows the serial number of the tool.  

T106 Denomination   

T107 Product number   

T110 Size Shows information about the motor size in the tool.   

T111 Type Shows information about the connected Tensor tool type. 

Accessible when an ETX tool is connected. 

 

T112 Serial number Shows the serial number of the tool. 

Accessible when an ETX tool is connected. 

 

T113 Denomination Accessible when an ETX tool is connected.  

T114 Product number Accessible when an ETX tool is connected.  

T120 Serial number Shows the serial number of the tool. 

Accessible when an ETX tool is connected. 

 

T121 Denomination Accessible when an ETX tool is connected.  

T122 Product number Accessible when an ETX tool is connected.  

T130 Application code 
version 

Shows the version number of the application code.  

T131 Boot code version Shows the version number of the boot-code.  

22.5.2 Configuration 

The tool parameters are visible depending on which tool is connected. For STB, most parameters are 

invisible when the tool is offline. 
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Parameter 
number 

Parameter name Description Default value 

T200 Tool start select 
source  

Defines which device is allowed to start the tool. 

When safety trigger is used, GPIO 4 function must be set to ”Off”. 

To start the tool, safety trigger and start trigger must be pushed 

simultaneously (second button must be pushed within 0.5 s from first 

button, order is arbitrary). If any safety trigger or start trigger is released 

while tool is running, tool will stop immediately. 

Once tool has been started using safety trigger, both buttons must first 

be released to allow the tool to be started again. 

Options available: Tool trigger, DigIn, Fieldbus, Sync start, Remote 

start, Front/Push start, Front/Push start AND Tool trigger, Front/Push 

start OR Tool trigger, Safety trigger 

 

Remote start is not available for Tensor STB tools. 

 

Tool trigger 

T201 Timer enable tool Determines if and how the tool shall be locked by default, and requires 
to be unlocked by digital input Timer enable tool. 

The function unlocks the tool for a period of T202 seconds. Once the 

period expires, the tool will be locked again. If a start attempt is made 

before T202 seconds have passed, the tool will remain unlocked until it 
is stopped or button is released. 

Options:  

Off: timer enabled tool functionality will not be in use. 

Always: timer enabled tool functionality will be in use, and that 

tightening, loosening and positioning (for Open end tools) will be 
disabled. 

Tightening: timer enabled tool functionality will be in use, and that 
tightening will be disabled. 

Loosening: timer enabled tool functionality will be in use, and that 

loosening will be disabled. 

Positioning: timer enabled tool functionality will be in use, and that 
positioning (for Open end tools) will be disabled. 

 

At least one input source must be configured to use 

digital input Timer enable tool, otherwise the 

configuration will be useless (the tool will be disabled 

and it will not be possible to enable it). 
 

Off 

T202 Timer enable tool 
time 

Timer function within range 0.5 to 5.0 seconds. 

For more information, see section 647HTool. 

0,5 s 

T203 Direction alert Possibility to add alert to tool direction. Options: Off, CW, CCW. Off 

T204 Alert type Defines the type of alert for T203. Options: Buzzer, flash tool LEDs, 

buzzer and LEDs.  

 

T210 Mode Defines the function of the Tool accessory bus. 

Available options: Off, Power on, General purpose IO, ST Bus 

Not applicable on SL drives 

Off 

T220 Enable  On 

T221 Volume Available options: Low, Medium, High High 
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Parameter 
number 

Parameter name Description Default value 

T224 Events The event-sound configuration.  

T230 CW pressed Defines the function of function button when ring is in CW position. 

Available functions are described in chapter. 

For SL-drive:97 

(Toggle CW 
CCW) 

Otherwise: Off 

T231 CCW pressed Defines the function of the function button when ring is in CCW 

position. Available functions are described in chapter. 

For SL-drive:97 

(Toggle CW 
CCW) 

Otherwise: Off 

T232 CW single push Defines the function of function button single push when ring is in CW 
position.  Available functions are described in chapter. 

Off 

T233 CCW single push Defines the function of function button single push when ring is in 
CCW position. Available functions are described in chapter. 

Off 

T234 CW double push Defines the function of function button double push when ring is in CW 

position. Available functions are described in chapter. 

Off 

T235 CCW double push Defines the function of function button double push when ring is in 

CCW position. Available functions are described in chapter. 

Off 

T236 Push detection 
interval 

Defines the maximum time that may elapse from button down to button 
up for a push to be detected. Range: 250 to 1000 ms. 

300 

T237 Next push interval Defines the maximum time that may elapse from successful detection of 
a push for a new push to be detected. Range: 250 to 1000 ms. 

300 

T240 Events The blue LED is used to highlight events similar to the relays of the 

controller. The blue LED may be set to highlight several events. Use the 

add key to add events and set duration. Remove events with the remove 
key. Available functions are described in chapter. 

Off 

T250 Illuminator mode Defines operation mode of illuminator (LED’s in front of the tool and 

corresponding relay function). Available selections are off, on, tracking 
event and event controlled. 

Off 

T251 On event Defines which event (relay function) that is used to turn on illuminator 

while operating in “tracking event” or “event controlled” mode. For 
available events see 648HDigital I/O and fieldbus items (Blue LED). 

Off 

T252 Off event Defines which event (relay function) that is used to turn off illuminator 

while operating in “event controlled” mode. For available events see 
649HDigital I/O and fieldbus items (Blue LED). 

Off 

T253 On time Defines how long illuminator will remain lit, if not turned off by event, 

while operating in “tracking event” or “event controlled” mode. 

On time period starts to elapse when on event occurs. In case on event 

occurs again before on time has elapsed, the on time period will be 
restarted. 

60 
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Parameter 
number 

Parameter name Description Default value 

T260 Control type Selection of tool light control sources. Defines which protocol the tool 
lights should follow: 

Available options: PF-controlled:1, PF-controlled:2, PF-controlled:3, 
Light off. 

The table below shows the functionality of the tool LED’s for each 

option. 

Option Yellow tool light Red tool light Green tool light 

PF-
controlled:1 

LOW. Torque 

and/or angle 

values under 

specified limits. 

HIGH. Torque 

and/or angle 

values over 

specified limits. 

OK. Torque and 

angle values 

within specified 

limits. 

PF-
controlled:2 

Customer specific. 

PF-

controlled:3 

Event code to be 

acknowledged 

Tightening 

NOK 

Tightening OK 

Light off Tool LED’s functionality disabled. 
 

PF-controlled:1 

T261 Use on time On/Off. Defines whether the tool LED’s should light for a specified 

period of time (on) or continuously (off) after a tightening. Default is 
off. 

Off 

T262 On time Select time for tool light LED, can be set between 0 and 300 seconds. 

Only valid if C261 Use on time is on. 

 

T263 Indicator mode Configures ST tool to show selected Pset (Pset 1-8) on the tool LED's. 

Available options: Off, Pset indication 

Applicable only if an ST tool is connected. 

Off 

T270 Power save timeout Tool will turn off automatically if inactive for this period of time. 

Unit: Minutes. Min value: 1. Max value: 120. 

30 

T271 Start condition Tool radio start condition 

Alternatives: Off, Connected, Start request 

Off 

T272 Link timeout After this timeout the tool is considered offline. 

Unit: Milliseconds. Min value: 1000. Max value: 60000.  

5000 

T276 Max sender power Max sender power on the IRC module. Only IRC-B. Full 

T277 Torque and angle 

trace 

Whether or not a torque and angle trace should be produced for every 

tightening.  Only IRC-B. 

No 

T278 Power save Sets if the parameter T270 Power save timeout is active or not. On 

T279 Delay "tool lock" This setting determines if a tool lock request shall be delayed until the 

current tightening/loosening/positioning is completed. 

On 

T290 Primary tool Expected primary tool connection. Cable or IRC. Cable 

T292 IRC pairing When selected, IRC pairing starts if tool is in pairing mode and tool 
connection is IRC-B.   

T293 Power Focus IP port Port for STB tool IP connection. 6677 

T294 Serial port Serial port where IRC-B device is connected. Serial 2 or internal. Serial 2 
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Parameter 
number 

Parameter name Description Default value 

T296 IRC-W operational 
mode 

Operational mode when IRC-W is used. Ad-hoc or Infrastructure Ad-hoc 

T297 IRC-W channel Radio channel when IRC-W is used. Valid channels: Auto, 1-14, 36, 40, 

44, 48 
Auto 

22.5.3 Diagnostic 

The tool parameters are visible depending on which tool is connected. For STB, most parameters are 

invisible when the tool is offline. 

Parameter 
number 

Parameter name Description 

T300 Sensor tracking Sensor tracking monitors the torque and angle sensors in real-time. A window with torque, 

angle and zero offset values updates continuously. Sensor status is monitored while the 

spindle is rotated (manually) or if the tool is heated/cooled etc. The motor does not run. An 

exit-button ends the command and returns the user to the main diagnostic window. 

 

Sensor tracking function is not possible to use during a tightening. 

For DS tools have torque and zero offset tracking no validity since they 

have no transducer. The value presented is therefore set to zero (0). 
 

T310 Trigger Diagnostics for tool LED's and buttons. 

T311 Direction ring Diagnostics for tool LED's and buttons. 

T312 Function button Diagnostics for tool LED's and buttons. 

T313 Lights Diagnostics for tool LED's and buttons. 

T320 Motor temp. Shows the current motor temperature. 

T321 Motor temp. limit Temperature when the motor is considered overheated. 

T322 No. of over temp. Number of times the motor has reached its temperature limit. 

T323 Peak motor temp. Maximum measured motor temperature. 

22.5.4 Maintenance 

The tool parameters are visible depending on which tool is connected. For STB, most parameters are 

invisible when the tool is offline. 

Parameter 
number 

Parameter name Description Default 
value 

T400 Calibration value Shows the calibration value stored in the tool.   

T401 Calibration date Shows the date of latest calibration for the tool. Automatically updated when 

the calibration value is set.  
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Parameter 
number 

Parameter name Description Default 
value 

T402 Set calibration value This parameter sets the T400 Calibration value and the T401 Calibration date in 

the tool memory, and performs a shunt calibration. The shunt calibration is 

useful for determining if the shunt calibration value received at a previous 

shunt calibration tends to drift away. The shunt calibration is also performed 
before each new tightening, and the same checks and boundaries apply.  

 

T403 Normalization value Shows the normalization value for the tool. 

Valid scope: 100 to 9999.  

1000 

T404 Calibration alarm 0 = No alarm is active, 1 = activating of parameter T405 Calibration alarm 

date. (Unix format no of seconds from 1970-01-01). 
0 

T405 Calibration alarm 

date 

This parameter makes it possible to change date for next calibration alarm.  

T406 Set calibration 

alarm date 

Not applicable in the PF Graph HMI.  

T410 Total no. of 
tightenings 

Total number of tightenings performed by the tool during its entire lifetime.  

T411 Service indicator Enable/disable (on/off) tool service indicator alarm function.  

T412 Number of 

tightenings since 
service 

Number of performed tightenings since latest tool service.   

T413 Service interval  Number of tightenings between tool services. This parameter serves as service 

indicator alarm limit. Value between 1 and 250 (x 10 000). 

 

T414 Latest service date Shows the date of when the latest service was performed. Automatically 
updated when Service counter reset is performed.  

Possible to set manually to any date.  

 

T415 Service counter 

reset 

Sets T412 Number of tightenings since service to zero, sets T414 Latest service 

date to current date and sets T411 Service indicator to off. 

 

T416 Lock tool on alarm Enables/disables lock on alarm. Tool will be locked while service indicator 

alarm or while wear indicator alarm is activated. 

 

T417 User message Shows a user specified message-string of maximum 35 characters plus a null-
termination. The message shall be stored in the tool memory. 

 

T420 Use Open end Defines if a tool with an Open end head should be used.   

T421 Inverted motor 

rotation 

Shows if the Open end has to use an inverted motor rotation.  

T422 Open end tightening 

direction 

Defines if Open end CW (clockwise) or CCW (counter clockwise) is to be 

used. 

 

T423 Open end tune The Open end tune command sets the reference position of the Open end 

head, and measures the gear ratio and gear play. The tool rotates slowly in the 

reverse direction until its true open position at the mechanical stop in the 

Open end head is reached. Open end tuning measures the total T103 Gear ratio 

and writes the new value to the tool memory. 

 

T424 Max torque 

positioning limit 

Defines the max value for P171 Limit  
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Parameter 
number 

Parameter name Description Default 
value 

T430 Wear indicator Enables/disables (on/off) the wear indicator alarm function.   

T431 Wear used For every tightening the wear is calculated through a formula with in-

parameters: torque, speed and temperature etc. 

As soon as a tightening or loosening is started, the wear is calculated and 

added to T431, which is the accumulated wear since last service. 

When the T431 has reached 100%, it's time for service 

When the tool has been serviced this parameter is set to 0. 

 

T432 Remaining 
tightenings 

Estimated number of tightenings that can be performed before wear indicator 
alarm occurs. 

 

T433 Alarm factor Using T433, the customer can scale the effective service interval (time to 

wear alarm is activated). In case T433 is set to 25%, the alarm will activate 4 

times earlier than by default. In case T433 is set to 400%, the alarm will 

activate 4 times later than default. 

100% 

T434 Min wear 
tightenings 

An additional condition for activation of wear indicator alarm. Specifies the 

minimum amount of tightenings (since latest service) that must be performed 

before wear indicator alarm activates. 

250000 

T440 QRTT on On/Off 

Automatic tool calibration using the ACTA 4000 and a QRTT device is 

enabled in this branch. A tool calibration session is started by connecting the 

ACTA to the Power Focus and fit the QRTT device to the spindle. One 

Multistage with three Psets is used when the calibration is run, one torque 

tightening (for torque calibration) and two different rotate spindle (for 
loosening and angle calibration) Psets. 

It is necessary for the Power Focus to have enough memory space available to 

store the Multistages and Psets needed. If the calibration shows an 

unsatisfactory result the operator is assumed to take the appropriate action. No 

calibration value (calibration- or normalization value etc.) will be changed 
automatically. 

Off 

T441 QRTT Pset 1 Pset used by ACTA. 0 

T442 QRTT Pset 2 Pset used by ACTA. 0 

T443 QRTT Pset 3 Pset used by ACTA. 0 

T444 QRTT Mset Multistage used by ACTA. 0 

T445 Create QRTT Creates the QRTT Pset and Multistage. Use only when tool is connected.  

T450 Perform motor 

tuning 

When selected, this parameter will perform motor tuning on the connected 

tool.  

 

T451 Perform Sync motor 
tuning 

When selected, this parameter will perform Sync motor tuning on the 
connected tools (a Sync group must exist). 

 

T460 Disconnect tool Disables reading and writing to the tool memory and allows the user to 

change tools without power off. 
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22.5.5 Buzzer configuration 

The tool parameters are visible depending on which tool is connected. For STB, most parameters are 

invisible when the tool is offline. 

Parameter 
number 

Parameter name Description Default 
value 

E100 Name Sound buzzer name.  

E101 Frequency Valid scope: 400 - 4000 Hz 800 

E102 Time On Valid scope: 0.01 - 65.0 Seconds 0.1 

E103 Time Off Valid scope: 0.01 - 65.0 Seconds 0.2 

E104 Repetition Valid scope: 0 - 100 times 3 

E105 Volume Valid scope: 0 - 100 % 

This parameter is relative (in percent) to parameter T221 Volume, which could 

be set to high, medium or low. T221 Volume is found in the sound setup 
window. 

50 

22.5.6 Sound configuration 

The tool parameters are visible depending on which tool is connected. For STB, most parameters are 

invisible when the tool is offline. 

Parameter 
number 

Parameter name 

W102 Stream name 
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22.6 Accessories 

22.6.1 Digital I/O 

Parameter 
number 

Parameter name Description 

A110 Relay status Shows the usage and status of the relay devices. 

A111 DigIn status Shows the usage and status of the digital input devices. 

A112 Relay test Performs a test of the relays used.  

 
Be aware of that changing the state of a relay may effect equipment 

connected to it. Please ensure that no damage or injury can be caused by 

the connected equipment before activating. 

 

It is not possible to have Power Focus in normal operation during the test. 
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22.6.2 I/O bus 

Parameter 
number 

Parameter name Description Default 
setup 

A230 Selector confirm Available when A232 Selector external controlled is set to No. Options: off, on, 
on with acknowledge.  

Off: function disabled. 

On: when a new Pset/Multistage is selected Power Focus needs a confirmation 

signal from the selector. This is made by lifting a socket from the indicated 

socket tray. The exception is when a Pset/Multistage from the same socket tray 
is selected sequentially. Then no confirmation is needed. 

On with acknowledge: Every time a new Pset/Multistage is selected Power 

Focus needs a confirmation signal from the selector. This is made by lifting a 
socket from the indicated socket tray. 

With this option there is no exception when a Pset/Multistage from the same 

socket tray is selected sequentially. Then the Power Focus still needs a 

confirmation signal from the selector 

 

Selector confirmation is also applicable when selecting 

Psets/Multistages in a Job. 
 

Off 

A231 Selector lost mode Determines whether the last selected Pset or “No Pset” is selected when 

communication with a selector is lost. Available when A232 Selector external 

controlled is set to No. 

Last Pset 

A232 Selector external 

controlled 

Turns selectors into externally controlled mode. Used to externally control the 

Selector LED’s via fieldbus items Selector control green light and Selector 

control red light. For more information, see section Digital I/O and fieldbus 
items. 

No 
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22.6.3 Tool bus 

Parameter 
number 

Parameter name 

A310 GPIO 

A311 ST selector 

A312 ST scanner 

A313 Internal ST selector 

A314 TLS ST Tool Tag  

22.6.4 Printer 

Parameter 
number 

Parameter name Description Default 
setup 

A400 Brand With parameter printer type the printer is selected. Options are: IBM, HP and 

Epson. 

IBM 

A401 Paper size With parameter paper size the paper format is selected. 

Options are: A4, US Letter or Printer roll.. 

A4 

A402 Continuous print With this parameter selected, the results after each tightening are automatically 
sent to the printer port. 

No 

A403 Trace with angle 

offset 

Used when printing a trace from the Power Focus printer port.  No 

A404 New page at Job 

done  

With A402 Continuous print and this parameter selected, each new job is printed 

on a new page.  

No 

A405 Include C311 P402 
VIN 

Adds an extra header containing Channel name, Pset name and VIN to the 

beginning of each batch. 
 

 

22.7 Sync 

22.7.1 Programming 

 
Sync programming options are only available if PF is a Sync reference. 
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Parameter 
number 

Parameter name Description Default 
value 

S100 Sync group list Create a Sync group list by selecting available PF units.  

S101 Tightening strategy Defines strategy to use for Sync tightening. 

Available options: Stage and SynchroTork 

SynchroTork allows continuous Synchronization of up to six spindles 

during final tightening. This will improve assembly quality in the joints 

where an even clamp force build-up is critical, such as in U-bolt 

applications. The torque difference between the spindles is minimized 
during the tightening stage by adjusting the individual speeds. 

Synchronization of the tools is assured through high-speed communication 

via the proprietary Power Focus accessory bus. It should be noted that this 

function does not eliminate the need for a reaction bar, or similar, in higher-
torque applications. 

 

Option SynchroTork is only available for PF 4000. 

SynchroTork is not applicable for angle and DS control 

strategies. 
 

State Sync 

S102 Loosening strategy Normal/Sync loosening. Sync loosening is a safety feature that makes all 

spindles sense torque before loosening starts. Normal means that all spindles 

are loosening with full speed and power. 

Normal 

S103 Continue if Sync 
failed 

Yes/No. If this option is selected the Sync group is allowed to continue 

tightening with the Sync members that reached the first target value in time. 

The spindles that did not reach the first target value in time are disabled. 
Only valid for two stage tightenings. 

No 

S104 Sync OK time Used together with continue if Sync failed and defines the time that the 

spindles in the Sync group wait, after reaching the first target value, for all 

spindles to reach the same status. If this time limit is exceeded, the Sync 

tightening continues without the spindles that did not reach the first target in 
time. 

Permitted values are between 0 and 13 seconds. 

2 

22.8 Identifier 

22.8.1 Identifier setup 

Parameter 
number 

Parameter name Description Default 
value 

I100 Input source Defines what source is accepted when an identifier from Type 1 is read. 

Available options: Off, Scanner, Fieldbus, Ethernet/Serial, Ethernet/Serial 

& scanner, ST scanner, Scanner & Fieldbus, All. 

List menu 

I101 Significant 
positions 

A string of integers that tells PF which positions to look at in the VIN.   
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Parameter 
number 

Parameter name Description Default 
value 

I102 Significant strings A table that matches each filtered string from VIN to a Pset or Job 
number. 

 

I103 Send identifier Makes it possible to send a 100 character long identifier to the Power 

Focus. 

Input menu 

I104 Significant 

positions for Result 
Part 1 

A string of integers that tells PF which positions in the scanned barcode 

that are considered for result part A. 

 

I105 Belongs to Type An integer that tells which ID type result part A belongs to.  1 

I107 Length Length of the incoming identifier string. Input menu 

I180 Identifier work 

order 

Defines in which order different Identifier types are entered 1 

I181 Tool locked during 
work order 

If selected, the tool is locked until the work order is completed. 0 

I183 Reset all identifiers 
at Pset batch done 

If selected, all identifiers (in the work order) for the selected Pset are 

deleted at batch done and the work order needs to be recreated for the next 

Pset. If not selected, usually only one identifier type needs to be changed 

(in the work order) for the next Pset.  

0 

I184 Ignore Identical 
Work Orders 

If selected, all Work Orders that are repetitive will be discarded 0 

22.9 Fieldbus 

Parameter 
number 

Parameter 
name 

Description 

F100 Fieldbus type This parameter must be selected first. It includes the types; DeviceNet, ProfiBus-DP, 

InterBus, ModBusPlus, ModBus/TCP, ControlNet, Ethernet/IP, Profinet-IO, FL-net, and 
InterBus 2Mb.  

If there is no fieldbus configuration inside the Power Focus when open fieldbus icon or read 

from PF, “None” will be shown in the setup window. If offline programming is used, “None” 

is selected when starting. If there is no fieldbus card installed in Power Focus, fieldbus 
programming only works in offline mode. 

F102 From PF data 

length 

From PF data length is the total length of the data string sent from PF to the PLC. The lengths 

must be the same as defined in the PLC. Because swap bytes are needed for some fieldbus 

types, only even numbers should be programmed (2, 4, 8, 10, etc.). Data length should be a 
number higher than zero. 

The maximum length that can be programmed is different for each fieldbus type. 

 

If InterBus is used, PF has to be restarted when the data length is changed. 
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Parameter 
number 

Parameter 
name 

Description 

F103 To PF data length To PF data length is the total length of the data string send from the PLC to PF. The length 

must be the same as defined in the PLC. Because swap bytes are needed for some fieldbus 

types, only even numbers should be programmed (2, 4, 8, 10, etc.). Data length should be a 

number higher than zero. 

The maximum length that can be programmed is different for each fieldbus type. 

 

If InterBus is used, PF has to be restarted when the data length is changed. 

 

F104 From PF global 

data length 

From PF global data length is the length of sending broadcast data to the network. This is a 

special function for ModBusPlus, not available for other fieldbus types. If only point-to-point 
data is transferred, set this parameter to zero. 

 

From PF data length - From PF global data length = From PF point-to-point 

data length (which is only available in ModBusPlus). 
 

F105 To PF global data 
length 

To PF global data length is the length of receiving broadcast data from the network. This is a 

special function for ModBusPlus, not available for other fieldbus type. Max length = 64 
bytes. If only point-to-point data is received, set this parameter to zero. 

 

To PF data length - To PF global data length = To PF point-to-point data 

length (which is only available in ModBusPlus). 
 

F106 From PF data 
offset 

The FL-net memory area 2 for cyclic data transfer is 8192 words. This area is shared by all 

nodes in the network. Each node configures the part of the area it will update. "From PF data 

offset" is the start address for data from PF. 

F107 To PF data offset The FL-net memory area 2 for cyclic data transfer is 8192 words. This area is shared by all 

nodes in the network. Each node configures the part of the area it will update. To PF data 
offset is the start address for data to PF. 

F110 Set node address 

and baud rate 
from 

Some buses can use a SW-configured node address and baud rate. This parameter has two 
selections: 

Software: Makes it possible to program node address and baud rate from user interface. 

Hardware: Node address and baud rate is configured with the switches on the fieldbus card. 

 

Normally the switches on the fieldbus card must be set in a specific way to 

enable these parameters from ToolsTalk PF. 
 

F111 FB node address This parameter specifies the network ID number used in the fieldbus system. Two controllers 

in the same fieldbus network cannot have the same node address. 

Valid for DeviceNet (0-63).  

F112 Baudrate Communication speed on the fieldbus system.  

 

The baud rate shall be the same in all PF units and in the PLC. 

 

F113 Connection mode  This parameter manages the way the fieldbus system detects changes of data on the different 

controllers. Some fieldbus types have the possibility to set different connection modes. 

There are three modes; polled, bit strobe and change of state. 

 

The settings in PF and the PLC must be the same. 
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Parameter 
number 

Parameter 
name 

Description 

F120 Set node address 
from 

Some buses can use a SW-configured node address. This parameter has two selections: 

Software: Makes it possible to program node address from user interface. 

Hardware: Node address is configured with the switches on the fieldbus card. 

 

Normally the switches on the fieldbus card must be set in a specific way to 

enable these parameters from ToolsTalk PF. 
 

F121 FB node address  This parameter specifies the network ID number used in the fieldbus system. Two controllers 

in the same fieldbus network cannot have the same node address. 

Valid for Profibus-DP (1-124), ModbusPlus (1-99), and ControlNet (1-64).  

F130 PCP length Provides a way to send longer data strings than the standard 20 bytes process data. The data 

package that is sent to or from the Power Focus can be longer than the 20 bytes process data. 

The part exceeding the process data is sent in small packages. The PCP length defines the 
package length. PCP data has lower priority then the process data. 

Available selections are 0, 1, 2, and 4. These numbers are the lengths in words. 0 = no PCP. 

 

The PF has to be restarted when the PCP length is changed. The length must be 

the same in the PLC. 
 

F131 Process data 

length  

Process data length is the first part of the InterBus message. The length has to be same for 

both input and output data. Maximum process data length is 20 bytes minus the PCP length in 
bytes. This means that the highest Process string length is 20 bytes if PCP is zero. 

 

The PF has to be restarted when the process data length is changed. The length 

must be the same in the PLC. 
 

F140 Set Source 

address from 

ModBusPlus global data exchanges require a source address, which is a node address where 

to get the global data from. 

Software: the node address is set from user interface. 

Hardware: the node address only can be set from the switches on ProfiBus card. 

F141 Source address Source address is the network ID number used in the fieldbus system. Set address to get 
global data from this source. 

F150 IP address Set an Ethernet connection IP address for fieldbus module, such as ModBus/TCP, 
Ethernet/IP, Profinet-IO, FL-Net. 

F151 Subnet mask Set an Ethernet connection Subnet mask for fieldbus module, such as ModBus/TCP, 

Ethernet/IP, Profinet-IO. 

F152 Gateway Set an Ethernet connection Gateway for fieldbus module, such as ModBus/TCP, Ethernet/IP, 

Profinet-IO. 

F155 Device name A set for Profinet-IO, define a device name and master need to know the device name to get 
communicate with it. 

F157 Assembly 

instance 

Parameter valid only for Ethernet/IP and works only on Anybus FW 2.xx or later. It makes 

possible to configure Anybus card with Assembly Instances as in FW 1.32 or earlier. 

For 0: it is ODVA compatible, 1:  FW 1.32 compatible (Listen-only 4, Input-only 3)   

F160 Virtual fieldbus This is a choice to make a virtual fieldbus. One virtual master can have four virtual members 

F161 Virtual from PF 
data length 

From PF Data length for the virtual member. 
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Parameter 
number 

Parameter 
name 

Description 

F162 Virtual to PF data 
length 

To PF Data length for the virtual member. 

F163 Virtual from PF 

data offset 

From PF data offset for the virtual member. 

F164 Virtual to PF data 

offset 

To PF data offset for the virtual member. 

F200 FB update 
interval 

If the fieldbus system is heavily loaded, it might be necessary to slow down the update 

interval in Power Focus fieldbus card. If  this parameter is set to 0.5 seconds, the Power Focus 

updates the bus every 0.5 seconds. The average data traffic must be possible to fit within the 

programmed interval. If the traffic has a higher peak load the messages are buffered. Default 

value 0.10 s. 

Valid settings range from 0.05 to 10 seconds. 

F210 Tool stop at 

offline 

If the fieldbus system goes down or Power Focus goes offline it might be necessary to stop 

running tool for safety purpose. 

No tool stop: does not stop running tool. 

Tool stop - fieldbus start: stops running tool if tool start select source is fieldbus. 

F220 Read result 
handshake 

If selected, the result is not sent until the PLC sends the read command. To enable this 

function, ReadResultHandshake in To PF Setup, and ReadResultHandshakeAck and 

SentTighteningId in From PF setup have to be added in the bitmap.  

F300  Bitmap select This parameter makes it possible to view the bitmap in the same way in Power Focus and the 
PLC configuration software. It defines if byte 0 or byte 1 shall be to the left.  

Default settings are the type that is common for the selected fieldbus type. 

For DeviceNet, Intel Endian must be used. For ProfiBus, Motorola Endian must be used. 
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23 Event codes 

Event codes are displayed as popup windows to inform users of the status of Power Focus. All events are 

stored in the Statistics event log or the General event log, depending on the event code type. The number 

of events that can be stored in the log depends on memory configuration (see section 650HMemory). Once the 

log is full, the oldest events will be overwritten by the most recent ones.  

There are three severity levels defined for the events. The characteristics for each one are: 

 Info: Events that only informs the user of some activity, for example 'PF Started'. 

o PF4000 Graph: White background 

o TTPF: Info symbol 

 Warning: Events that may indicate unexpected behavior, for example 'Torque high'. 

o PF4000 Graph: Yellow background 

o TTPF: Warning symbol 

 Error: Severe errors in the system or events that indicates a failure of some sort. Almost all events 

with this severity level needs to be acknowledged, for example "Current limit reached".  

o PF4000 Graph: Red background 

o TTPF: Error symbol 

To open the event log, click Get Event Log in the 

Options list. 

The Event Log window appears. 

Click Clear to delete all events in the log. 

Click Save to file to store the event log as a text file. 

Click Open in Excel to export the log to the 

Microsoft Excel software. 

Click Read to update the status of the event code 

window. 

When option Automatic update is checked, the 

events in the log are showed in real-time (in the 

same way as event pop up widows). 
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The event codes are logged with four integer parameters shown in the Control column. For some event 

codes, these parameters are used to store extra information about the event. 

As default, all events are displayed and logged.  

It is possible to configure PF to show or log selected events only.  

Open Controller>Configuration>Events and click the Event button to open the Controller Events window.  

Select Log to log the event in the Power Focus Statistic or General event log.  

Select Show to display the event in Graph and TTPF interfaces. 
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The Statistic and General event log can also be 

cleared from the system setup branch. 

Open Controller>Memory and click Reset general 

event log and/or Reset statistical event log. Confirm 

the command in the pop-up window.  

 

23.1 Event code list 
The event codes are listed with number, name, description and a procedure to clear the event. The 

Acknowledge column indicates that the event has to be acknowledged before proceeding. An 'x' in the 

columns for PF ready and Tool ready indicate that the relay and corresponding fieldbus item are affected, 

and that an action (described under 'Procedure') has to be taken before proceeding. 

Before any work is performed, ensure that the safety instructions for the controller and the tool have been 

read and understood. Note that some of the procedures described only can be performed by an Atlas 

Copco authorized service provider.  
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See also the General safety instructions in this manual, and Product Information for the controller and the 

tool.  

The events are grouped according to the table below. 

 
Event 
code 

Group Description 

E001-E099 0 Rundown failures 

E100-E199 1 Event related errors 

E200-E299 2 User input events 

E300-E399 3 Statistical events 

E400-E499 4 Communication events 

E500-E599 5 Hardware events (tool) 

E600-E699 6 Hardware events 

E700-E799 7 Hardware events 

E800-E899 8 Software events 

E900-E999 9 Events MMI 

23.1.1 E001-E099 Rundown failures 

Event 
code 

Event name Description Procedure 
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E003 Torque measurement 

possibly invalid 

The programming is incorrect as 

no movement is possible in the 
second stage. 

Check the programming for the 

Pset.  

Ensure that there is some movement 
in the second stage. 
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23.1.2 E100-E199 Event related errors 

Event 
code 

Event name Description Procedure 
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E102 Rundown prohibited 

due to Lock on 
Reject 

An attempt to make a tightening is 

made and tightenings are disabled by 

the parameter C210 Lock on reject 
because the result was not OK.   

Additional parameter information:  

First integer parameter: 0=Locked 

during tightening, 1=locked during 
loosening 

Second integer parameter 0=Service 
denied, 1=service aborted. 

Depending on C210 Lock on reject 

configuration, either unlock the tool by 

the direction ring or by digital input 
Unlock tool or Master unlock tool. 

If applicable, reconfigure C210 Lock 

on reject.  

 

  x 

E103 Tool locked by 
digital input 

One or several of the digital input 

functions lock the tool: Tool disable, 

Tool tightening disable, Tool loosening 

disable. 

Additional parameter information:  

First integer parameter: 0=Locked 

during tightening, 1=locked during 
loosening 

Second integer parameter 0=Service 
denied, 1=service aborted. 

Unlock the tool with one of the 
following digital input functions: 

Tool disable, Tool tightening disable, 
Tool loosening disable 

Note: Unlock tool or Master unlock 

tool will not act as unlock trigger. 

 

 

  x 

E107 Rundown prohibited 

due to Line control, 
batch not enabled 

A Job using line control is selected with 

parameter Use J330 line control. The 

Job does not start until a line control 

start signal is received from digital 

input function Line control start signal. 

 

Additional parameter information:  

First integer parameter: 0=Locked 

during tightening, 1=locked during 
loosening 

Second integer parameter 0=Service 
denied, 1=service aborted. 

Unlock the tool with one of the 

following digital input functions: Line 

control start signal, Job abort or 
Master unlock tool. 

 

  x 

E112 Rehit An attempt to tighten an already 

tightened bolt was made. 

For information only.    

E113 Current limit reached 
- Rundown aborted 

The current limit has been reached, the 
drive is disabled.  

Acknowledge the event.  

Perform a motor tuning. 
Tool>Maintenance>Motor tuning.  

x x x 
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E117 Tool locked – cannot 
access RBU 

Power Focus cannot communicate with 

the RBU and must be rebooted to 

protect data.  

 

Additional parameter information:  

First integer parameter: 0=Locked 

during tightening, 1=locked during 
loosening 

Second integer parameter 0=Service 
denied, 1=service aborted. 

Acknowledge the event.  

Turn off PF and check that the RBU is 
correctly connected.  

Reboot PF.  

x x x 

E120 Motor tuning failure The connection between the tool and 

PF is incorrect or faulty, or the remote 

start connector is missing or incorrectly 
wired. 

Acknowledge the event. Check that 

the remote start connector on PF is 
present and correctly wired. 

Check that the tool cable and 

connectors are undamaged and 
correctly connected. 

Service the tool.  

x x x 

E121 Open end tuning 

failure 

This event indicates that the Open end 

tuning command has not been 
successfully performed.  

Acknowledge the event.  

Check that the remote start connector 
on PF is present and correctly wired. 

Verify that parameters T421-T422 

match the geometry of the attached OE 
head. 

Check that the mechanical stop is 
undamaged and working properly. 

x x x 

E122 Open end positioning 
failure 

Open end positioning failed due to too 
much torque during positioning phase. 

Remove the tool from the joint.  

Restart the positioning.  

   

E125 Alarm on timeout / 

Alarm on torque lost 

This event is issued when parameter 

P246 Alarm on end time shutoff is 

activated and the time defined in P141 

End time is exceeded before final 
torque is reached.  

The reason can be that the tool has 
slipped off the joint, for example. 

Redo the tightening. 

If the event reappears, set P141 End 

time to a higher value or set P246 

Alarm on end time shutoff to No.  
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E126 Multistage aborted This event indicates that the current 

running Multistage has not been 

performed entirely (the drive has been 

shut off or the tool trigger was released 
before the end).  

 

Check the additional information to 
see which events occurred.  

Follow the procedure for those events. 

 

If the second parameter in the sub 

information is zero (no event is 

indicated), activate P244 Alarm on lost 

trigger and P246 Alarm on end time 

shutoff in the stage in which the 
multistage was aborted. 

   

E126 additional parameter information 

 The first integer parameter indicates at which stage that the Multistage was aborted. 

 The second integer parameter indicates which event occurred. 0= no event occurred.  

 The third and fourth integer parameters, each containing 32 bits, indicate what went wrong with the 

tightening.  

 

 

Example 1: E126 (2, 113, 9, 8) 

The multistage was aborted (E126) in stage 2 (first digit), when the tightening reached current limit (E113 

Current limit reached rundown aborted). The third digit, 9, equals 1+8 that correspond to Multistage 

aborted and Current limit reached. The fourth digit, 8, corresponds to Final angle max exceeded.  

NOTE: Current Limit Reached is one of few event codes for which there is a corresponding tightening 

error bit. 

 

Example 2: E126 (3, 129, 1, 16896) 

The multistage was aborted (E126) in stage 3 (first digit), when torque lower than target occurred (E129 

Torque lower than target). The third digit, 1, means Multistage aborted, and the fourth digit 16896 equals 

16384+512, Torque less than target and Current monitoring max exceeded. 
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First integer Second integer Third integer Fourth integer 

The stage 
when the 
Multistage 
aborted 

The event code  Error bits part I  Error bits part II 

    Dec Event Dec Event 

n Stage n nnn No of event that 

occurred 
1 

Multistage aborted 1 Rundown angle max exceeded 

    2 Rehit 2 Rundown angle min not reached 

    
4 

Torque measurement 

possible invalid 

4 Final torque max exceeded 

    8 Current limit reached 8 Final angle max exceeded 

    
16 

Timeout on end time 

shutoff 

16 Self tap max exceeded 

    32 Remove fastener limit 32 Self tap min not reached 

    64 Drive disabled 64 PVT monitoring max exceeded 

    
128 

Transducer lost 128 PVT monitoring min not 
reached 

    256 Transducer short circuit 256 PVT Compensate overflow 

    
512 

Transducer corrupt 512 Current monitoring max 

exceeded 

    
1024 

Sync timeout 1024 Post view torque min not 
reached 

    2048 Dynamic CM Min Tq 2048 Post view torque max exceeded 

    4096 Dynamic CM Max Tq 4096 Post view torque angle too small 

    8192 Angle Max mon 8192 Trigger lost 

    16384 Yield nut off 16384 Torque less than target 

    32768 Yield too few samples 32768 Tool hot 
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E127 PVT shut off This event indicates that the drive was 

shut off in the selftap or prevail phase of 

the rundown, or the compensate conditions 
were not fulfilled. 

In the Trace monitor, check the result 

and change the settings accordingly.  

   

E128 Trigger lost When the function trigger lost is activated 

in the Pset, this event indicates that the 

trigger of the tool was released before final 

target. 

For information only.    

E129 Torque lower than 
target 

When the function torque lower than 

target is activated in the Pset, this event 

indicates that the torque result is below 

final target. The torque status is NOK even 

if the torque result was larger than final 
torque min. 

For information only. 

 

Note: Check also E128 to see if E129 

is issued because the trigger was 
released before final target.  

   

E130 Post view torque 

shut off 

Post view torque conditions were not 

fulfilled. 

In the Trace monitor, check the result 

and change the settings accordingly.  

 x  

E131 Tool Disconnected This event code is generated when the tool 

is disconnected (logically or physically) 

from PF. The event code is also generated 

when an attempt to start a disconnected 

(logically or physically) tool is done.  

Additional parameter information:  

First integer parameter: 0=locked during 

tightening, 1=locked during loosening, 

2=locked during positioning, 3=locked 

during motor tuning, 4=locked during 
open end tuning. 

Second integer parameter 0=Service 
denied, 1=service aborted. 

 

 

A damaged cable can result 

in a disconnected tool. 
 

Acknowledge the event.  

If the tool has been logically 

disconnected, disconnect physically 
also.  

 

Note: The tool can be logically 

disconnected if the user requests 

disconnection or if the open end 
settings are modified.  

 

x x x 

E132 Wrong tool start 
input setting 

T200 Tool start select source is not 

corresponding to the remote start jumper 
position. 

Acknowledge the event. 

Check the wiring of the remote start 
connector. 

Verify that the tool trigger is not 

pressed during hot swap or system 

start-up. 

x x x 
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E133 Tool locked by 

Tools Talk 

The tool is prohibited via ToolsTalk PF. 

 

Additional parameter information:  

First integer parameter: 0=locked during 

tightening, 1=locked during loosening, 

2=locked during positioning, 3=locked 

during motor tuning, 4=locked during 
open end tuning. 

Second integer parameter 0=Service 

denied, 1=service aborted. 

Unlock the tool by  

- sending an “Enable tool” message via 
ToolsTalk PF protocol or 

- using digital input Master unlock 
tool. 

  x 

E136 Tool locked by 
batch OK 

This event code is displayed if the tool is 

locked by the function P152 Lock at batch 
OK.  

Additional parameter information:  

First integer parameter: 0=locked during 

tightening, 1=locked during loosening, 

2=locked during positioning, 3=locked 

during motor tuning, 4=locked during 
open end tuning. 

Second integer parameter 0=Service 
denied, 1=service aborted. 

Unlock the tool by  

- using the digital inputs Unlock tool 
or Master unlock tool or  

- sending an “Enable tool” message on 

fieldbus, Open protocol or ToolsTalk 

PF protocol. 

  x 

E137 Tool locked by 
fieldbus 

The tool is locked by fieldbus.  

Additional parameter information:  

First integer parameter: 0=locked during 

tightening, 1=locked during loosening, 

2=locked during positioning, 3=locked 

during motor tuning, 4=locked during 

open end tuning. 

Second integer parameter 0=Service 
denied, 1=service aborted. 

Unlock the tool by  

- sending an “Enable tool” message via 
fieldbus or  

- using the digital input Master unlock 
tool. 

  x 

E138  Wrong tool start 

input source 

It is only possible to start the tool from 

selected tool start select source.  

Check the setting for T200 Tool start 

select source.  

   

E139 Tool locked by 
Open protocol 

The tool is locked by open protocol.  

Additional parameter information:  

First integer parameter: 0=locked during 

tightening, 1=locked during loosening, 

2=locked during positioning, 3=locked 

during motor tuning, 4=locked during 
open end tuning. 

Second integer parameter 0=Service 
denied, 1=service aborted. 

Unlock the tool by  

- sending an “Enable tool” message via 
Open protocol or  

- using the digital input Master unlock 
tool. 

  x 
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E140 Insert user ID card 

to release tool 

The tool is locked; the user must insert his 

ID card in the card reader to release the 
tool.  

Additional parameter information:  

First integer parameter: 0=locked during 

tightening, 1=locked during loosening, 

2=locked during positioning, 3=locked 

during motor tuning, 4=locked during 
open end tuning. 

Second integer parameter 0=Service 
denied, 1=service aborted. 

Insert a valid ID card.   x 

E141 Tool locked during 

work order 

Multiple identifiers; tool is locked during 

work order. Tool will be unlocked when 

all expected identifiers have been received 
in correct order. 

Check the work order settings in the 

Options dialog in the Identifier branch.  

Scan the identifiers in the correct work 
order without pushing the trigger. 

Unlock the tool by  

Restoring of identifier configuration is 
done 

Reset all identifiers command is 

performed via digital input, open 
protocol or identifier monitor 

Reset latest identifier command is 

performed after the first type in the 
work order is accepted.  

  x 

E143 Tool locked by 

system 

The PF has detected a serious condition 

and needs to lock the tool. 

Usually this is an operator error. 

Check configuration in PF. 

x  x 

E145 Tool locked by 

Timer enable tool 

The tool is locked by digital input Timer 

enable tool when the Job was not started 

within the time set in J320 Max time to 

start Job.  

Unlock the tool with digital input 

Timer enable tool.  

If applicable, set J320 Max time to start 

Job to a higher value. 

  x 

E146 No tool cable 

detected 

Incorrect or damaged cable. Ensure that the tool cable is correctly 

connected and without damage. 

Replace the cable. 

  x 

E147  Tool locked by 
click wrench Pset 

A Pset with click wrench tightening 
strategy is selected for a tool. 

 

Additional parameter information:  

First integer parameter: 0=Locked during 
tightening, 1=locked during loosening 

Second integer parameter 0=Service 

denied, 1=service aborted. 

Use the correct combination of tool 
and Pset.  

 

  x 
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E149 Tool locked 

disable loosening 
at OK 

The function C220 Disable loosening at 

OK has locked the tool.  

 

Additional parameter information:  

First integer parameter: 1=locked during 
loosening 

Second integer parameter 0=Service 
denied, 1=service aborted. 

Unlock the tool by selecting forward 

on the tool, or by digital input Master 
unlock tool.  

Continue tightening. 

  x 

E150 Job client does not 

respond 

When running a Cell Job, this event is 

displayed by the Job reference when one 
of the Job members does not respond.  

 

Additional parameter information:  

The first integer parameter indicates the 

channel ID for the Job client that does not 
respond. 

Check which controller in the Cell that 

is not responding.  

Check the cables and connections 

between the Cell member and the Cell 
reference.  

Check that the IP addresses in the Cell 
group are correct.  

Check that IP addresses within the Cell 
is not used by someone else.  

   

E151 Job in OFF mode It is not possible to select a new Job. The 
Power Focus is in Job off mode. 

In the Job monitor, clear the Job off 
check box.  

Select new Job.  

   

E152 PF locked in Job 

mode 

Conditions within the job functionality 

have locked the tool. E.g. due to not 

currently active tool in or after job 

sequence, or tool not enabled after job 

selection etc.  

 

Additional parameter information:  

First integer parameter: 0=locked during 

tightening 

Second integer parameter 0=Service 

denied, 1=service aborted. 

Activate the controller. 

If possible, disable J302 Lock at Job 

done. 

 

 

  x 

E153 Not ok to select 
new Job 

A Job must be completed or aborted 

before selecting a new Job. A Job must be 

selected on a Job master.  

Finish running the present Job. 

If needed, abort running Job or select 
new Job on Job master.  

   

E154 Remote Job 

running 

When running a Cell Job, this is displayed 

by the Job members when a Cell Job is 
selected on the Job reference. 

For information only.    

E155 Remote Job 

aborted 

When running a Cell Job, this is displayed 

by the Job members when a Cell Job is 

aborted. 

For information only.    
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E156 Job members lost  When running a Cell Job, this is displayed 

by the Job reference when it has lost 
contact with one of the Job members.  

 

Additional parameter information:  

The first integer parameter indicates the 

channel ID for the lost Job client.  

Check cables and connections to the 

lost Job client. 

In the Controller menu of the lost Job 

client, open Network and check that 

the Job reference IP-address is correct, 

and that the Job member is part of the 

same cell as the Job reference.  

In the Job menu of the Job reference, 

check that the all PFs are present in the 
Job list. 

   

E157 Job reference lost When running a Cell Job, this is displayed 

by the Job clients when they have lost 
contact with their Job reference. 

Check cables and connections to the 

Job reference. 

In the Controller menu, check the 

network settings for the Job reference 

and the Job clients. All Job clients and 

the Job reference must belong to the 
same cell.  

   

E158 Invalid Job ID When the selected Job does not exist.  In the Job reference, open the PF Map 

and check the ID of all defined Jobs.   

   

E159 No Pset in selected 
Job 

When the selected Job does not contain 
any Pset. 

In the Job reference, open PF Map > 

Job, and double-click the selected Job.  

Add the correct Psets and store the 
settings.   

   

E160 Job select source 
not valid 

Attempt to select a Job with the wrong 
input source. 

In the Job reference PF Map, open 
Controller>Configuration.  

In the Select source view, check the 
settings for C201 Job.   

   

E161 Line control alert 

1 

The line control has been activated, and 

the first control alert limit has been 
reached. 

For information only.    

E162 Line control alert 

2 

The line control has been activated, and 

the second control alert limit has been 
reached. 

For information only.    
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E166 Job aborted This event will be displayed when a 

running Job is aborted. 

Additional parameter information.  

First integer parameter: 

2 Digital input 

3 Ethernet/serial (PC 

5 Field bus 

6 Keyboard 

7 Reserved 

8 Reserved 

9 Manual mode (the current active 

job is aborted and a new job 

becomes active when selected from 

digital input)  

10 Timer 1 (max time to start job) 

11 Timer 2 (max time to complete job) 

12 Deleted (a pending job is deleted 

from PF database) 

13 Job off mode 

14 Line control  
Alarm 2 

15 Job override 
 

For information only.     

E167 Max coherent Not 

OK tightenings 
reached 

When the number of NOT OK tightenings 

in a row is reached, then the tool will be 

locked and can be unlocked only via a 
digital input (reset NOK counter). 

For information only.   x 

E168 ST scanner 

settings not 
production default 

Issued at ST scanner power-on if scan 

engine settings are not the same as 
production defaults. 

For information only.    

E169 ST scanner 

settings not at 

highest security 
level 

Issued at ST scanner power-on if scan 

engine settings are not at the highest 
security level. 

For information only.    

E175 Configuration will 

be erased at next 
reboot 

The Power Focus will erase the 

configuration in the Power Focus memory 

and the RBU since the memory setup has 

been changed. 

Accept or reject the memory re-

configuration. 

   

E177 Functionality not 
in RBU 

The user is trying to use functionality that 
is not enabled in the RBU. 

Replace the RBU or use another 
functionality. 
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E178 Memory allocation 

error 

The user is trying to allocate more 

memory than exists in the Power Focus. 

Check settings for Controller > 

Memory. 

Decrease the number of results, Psets 

or Jobs until the memory usage is 
below 100%. 

   

E179 Totally 

configurable 
memory needed 

Not possible to configure this functionality 

without function “totally configurable 
memory”. 

Save the PF configuration to file. 

Open Controller > Memory. 

C600 Memory type must be set to 
Totally configurable memory. 

Reboot PF, the PF memory is 
remapped and erased. 

Reload the configuration without the 
memory settings. 

   

E190 Wrong ST scan 

source 

Attempt to scan from wrong source. Open PF Map >  Accessories > Tool 

bus and double click Configuration. 

In the Tool bus configuration dialog 
box, click ST scanner. 

Ensure that the Scanner source item 
list selection is applicable.   

   

E191 ST scanner 

overheated 

The ST scanner temperature has exceeded 

max temperature. 

Disconnect the tool 

Let the scanner cool for 15 minutes 

   

E199 Not possible to 

store Reference 

Trace 

If You try to store the Reference 

Trace(In Multiple Traces menu), but it 

does not exist anymore. 

Make new tightenings and find a 

new Reference Trace and press 

store again. 
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E206 Pset number 
invalid  

An attempt was made to perform a 
tightening with the wrong Pset number.  

Additional parameter information:  

First integer parameter: 0=Locked during 

tightening, 1=locked during loosening 

Second integer parameter 0=Service 

denied, 1=service aborted. 

Check parameter C200 Pset and select 
a Pset from the correct source. 

  x 

E207 Wrong Pset 
Select Source 

Attempt to select Pset from a source not 
specified for parameter C200 Pset. 

Check parameter C200 Pset and select 
a Pset from the correct source. 

   

E208 Not ok to select 

new Pset 

It is not allowed to select new Pset when 

the already selected Pset is auto selected 
by Job. 

Proceed in the Job order until the Job 

is finished.  

To select a new Job or Pset;  

Select C202 Job override, select new 
Job, or select Job off. 

   

E209 Pset configuration 

updated 

The configuration of the Pset has been 

changed. 

For information only.    

E210 Identifier source 

disabled 

An Identifier source is disabled. All 

Identifiers sent by a disabled source are 
discarded. 

Switch back to Automatic Mode to 

enable the Identifier source. 

   

E211 Wrong identifier 

input source 

Wrong input source for an identifier 

string. 

Open Identifier>Type setup and 

check that the input source is correct. 

Scan the identifier string. 

   

E212 Pset/Multistage 
stored 

Event displayed every time a Pset or 
Multistage is stored or restored. 

Additional parameter information:  

First integer parameter: Pset or Multistage 
number 

Second integer parameter 0=Pset, 
1=Multistage 

For information only.    

E213 Pset number not 
present 

An attempt to start a Job containing a Pset 
not present in PF has been performed. 

Choose correct Job or reprogram the 
Job. 

   

E220 Fastener broken Displayed if fastener (screw or nut) 

breaks during yield control. 

Ensure that more than one comparison 

is obtained before yield is reached.  

In ToolsTalk, open the trace monitor 
and analyze the tightening. 

Change the applicable parameter.  

   

E221 Too few samples 

for yield control Too few samples for mean torque 

calculation in yield algorithm.  

Increase parameter P262 Window 

angle or reduce speed during yield 
control.  

   



 Event codes 

9836 3123 01 399 (428) 

Event 
code 

Event name Description Procedure 

A
c

k
n

o
w

le
d

g
e
 

P
F

 r
e

a
d

y
 

T
o

o
l 

re
a

d
y
 

E233 Final Target 
range error 

This event code is displayed when an 

attempt is made to tighten with a final 

target out of range (larger than tool max 

torque or 9999). 

 

Additional parameter information:  

First parameter: Pset number 

Second parameter: Parameter number 

with an incorrect value 

Third parameter: Parameter in second 
integer is dependent on this parameter 

Fourth parameter: Parameter in second 
integer violates this limit. 

Change the value for “Final Target” to 
a value within tool limits. 

Store and try again. 

  

  x 

E234 Start final angle 

range error 

This event code is displayed when an 

attempt is made to tighten with a P120 

Start final angle out of range. 

 

First parameter: Pset number 

Second parameter: Parameter number 
with an incorrect value 

Third parameter: Parameter in second 
integer is dependent on this parameter 

Fourth parameter: Parameter in second 
integer violates this limit. 

Change the value for P120 Start Final 

Angle to a value within tool limits. 

Store and try again.  

  x 

E235 Incompatible 

system 
configuration 

Some configurations are not compatible. 

Some combinations of devices, tools and 
accessories can not be configured. 

Usually this is an operator error. 

Check configuration in PF. 

x  x 

E236 Configuration set 

inconsistent 

This event code is displayed if one device 

on the I/O bus has the correct ID but 

incorrect type specified (for example a 

Selector is connected and an RE-Alarm is 

configured). 

 

Additional parameter information:  

First integer parameter: Number of I/O 

device with configuration problems. 

Second integer parameter 2=I/O-expander 

or Operator panel, 3=RE-alarm, 5=Four-

position socket selector, 6=Eight-position 

socket selector. 

Acknowledge the event.  

Ensure that the ID and the type of I/O 
device are the same. 

 

x x x 
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E237 Strategy 

configuration 
error 

No valid control strategy was chosen for 
the stored Pset. 

Additional parameter information: 

First parameter: Pset number 

Second parameter: Parameter number 
with an incorrect value 

Third parameter: Parameter in second 
integer is dependent on this parameter 

Fourth parameter: Parameter in second 

integer violates this limit. 

Change control strategy valid for used 
tool. 

Check that the Pset parameters are 
correct and store the Pset.  

 

  x 

E238 Not possible to 

run a Multistage 

with a Click 

Wrench Pset 

An attempt was made to perform a 

Multistage tightening containing at least 
one Pset with a click wrench strategy.  

Open the Multistage. 

Remove the click wrench Pset.  

Add an applicable Pset and store the 
settings. 

  x 

E239 Serial number 

missing 

Tightening and loosening prohibited 

due to missing serial number 

   TNR 

E240 Password 

Incorrect Input 
Source 

The password is entered from an invalid 

source according to the configuration. 

Enter the password from ToolsTalk or 

change parameter C801 Entry.   

   

E250 Max time for first 

tightening run out 
(Job) 

This message is displayed and the Job is 

terminated if the first tightening is not 
performed within the specified time. 

If needed, open PF Map > Job > 

Timer and change the parameter J320 

Maxtime to start Job, or set to 0 to shut 
off timer.   

Store Job and try again. 

   

E251 Max time to 

complete Job run 
out 

This message is displayed and the Job is 

terminated if the Job is not completed 

within the specified time in Job 
configuration. 

If needed, open PF Map > Job > 

Timer and change the parameter J321 

Maxtime to complete Job, or set to 0 to 
shut off timer. 

Store Job and try again.   

   

E281 Identifier not 

accepted, the 

length is not 
correct. 

The length of the incoming barcode string 

is wrong. 

Open PF Map > Identifier and check 

that the string Length matches the 

scanned string, and that the scanned 
string does not exceed 100 characters.  

   

E282 Identifier not 

accepted, does 

not match any 

type 

The incoming barcode string does not 
match any type. 

Open PF Map > Identifier and check 

Input source, string Length and 

Significant position are correctly 

configured.  

   

E285 Bypass Identifier 

not possible 

The Type 1 identifier can not be bypassed 

when an optional Type exists.  

Open PF Map > Identifier and 

remove optional Type if not used. 
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E286 Reset Identifier 
not possible 

Reset latest identifier is not possible when 

a complete Work Order has been 
accepted. 

Use digital input Reset all identifiers.    

E287 All Result Parts 
can not be stored 

All Result Parts can not be stored. Make sure that the Job Master and all 

of the Job Members have the same 

number of Result Parts in the 

configuration. 

Make sure that the Sync Master and 

all of the Sync Members have the 

same number of Result Parts in the 
configuration. 

   

23.1.4 E300-E399 Statistical events 

Event 
code 

Event name Description Procedure 

E333 Not allowed 
subscription 

The requested statistic subscription is not allowed. For 

example it is not allowed to set an angle statistic 

subscription for a Pset using only the torque control 

strategy. 

Change the subscription. 

E334 No statistic available 
for this Pset 

The Pset strategy is not suitable to calculate statistics (no 
strategy is chosen). 

For information only. 

E335 Not enough data Not enough data is available to calculate the statistic 

control limits. 

Do more tightenings to get 

enough data.  

Calculation used: nbrofsubgroups 

* subgroupsize * (1 + subgroup 
frequency) 

Check and if necessary change 
P503 No of subgroups.  

E336 Mem alloc fail It is not possible to allocate enough memory for the 

statistic subscription. 

Open Controller > Memory and 

set C600 Type to Totally 
configurable.  

Check settings. 
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E340 Xucl tq The last subgroup mean torque value is larger than the 
upper control limit. 

The statistic events give an 

indication of irregularities in the 
tightening process. 

If needed: 

 

Check the programming. 

Check the tool status. 

Check the tightening material and 
joint components. 

Check the work station set-up and 

procedure.   

E341 Xlcl tq The last subgroup mean torque value is lower than the 
lower control limit. 

See E340 Xucl tq 

E342 Rucl tq The last subgroup range torque value is larger than the 
upper control limit. 

See E340 Xucl tq 

E343 Rlcl tq The last subgroup range torque value is lower than the 

lower control limit. 

See E340 Xucl tq 

E344 Cp tq The torque Cp is lower than 2. See E340 Xucl tq 

E345 Cpk tq The torque Cpk is lower than 1.33. See E340 Xucl tq 

E346 7inc x tq Trend deviation alarm, the subgroup torque mean value 

has increased 7 times consecutively. 

See E340 Xucl tq 

E347 7dec x tq Trend deviation alarm, the subgroup torque mean value 
has decreased 7 times consecutively. 

See E340 Xucl tq 

E348 7inc r tq Trend deviation alarm, the subgroup torque range value 
has increased 7 times consecutively. 

See E340 Xucl tq 

E349 7dec r tq Trend deviation alarm, the subgroup torque range value 

has decreased 7 times consecutively. 

See E340 Xucl tq 

E350 7above x tq Trend deviation alarm, the subgroup torque mean value 

has been above the average mean value of the average of 
the latest ten subgroups 7 times consecutively.  

See E340 Xucl tq 

E351 7below x tq Trend deviation alarm, the subgroup torque mean value 

has been below the average mean value of the average of 
the latest ten subgroups 7 times consecutively. 

See E340 Xucl tq 

E352 7above r tq Trend deviation alarm, the subgroup torque range value 

has been above the average range value of the average of 

the latest ten subgroups 7 times consecutively. 

See E340 Xucl tq 
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9836 3123 01 403 (428) 

Event 
code 
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E353 7below r tq Trend deviation alarm, the subgroup torque range value 

has been below the average range value of the average of 
the latest ten subgroups 7 times consecutively. 

See E340 Xucl tq 

E354 2sigma x tq Trend deviation alarm, the last subgroup torque average 
is outside Xtq-bar-bar - 2 sigma. 

See E340 Xucl tq 

E355 2sigma r tq Trend deviation alarm, the last subgroup torque range 

average is outside Rtq-bar-bar - 2 sigma. 

See E340 Xucl tq 

E360 Xucl ang The last subgroup mean angle value is larger than the 

upper control limit. 

See E340 Xucl tq 

E361 Xlcl ang The last subgroup mean angle value is lower than the 
lower control limit. 

See E340 Xucl tq 

E362 Rucl ang The last subgroup range angle value is larger than the 

upper control limit. 

See E340 Xucl tq 

E363 Rlcl ang The last subgroup range angle value is lower than the 

lower control limit. 

See E340 Xucl tq 

E364 Cp ang The angle Cp is lower than 2. See E340 Xucl tq 

E365 Cpk ang The angle Cpk is lower than 1.33. See E340 Xucl tq 

E366 7inc x ang Trend deviation alarm, the subgroup angle mean value 

has increased 7 times consecutively. 

See E340 Xucl tq 

E367 7dec x ang Trend deviation alarm, the subgroup angle mean value 
has decreased 7 times consecutively. 

See E340 Xucl tq 

E368 7inc r ang Trend deviation alarm, the subgroup angle range value 

has increased 7 times consecutively. 

See E340 Xucl tq 

E369 7dec r ang Trend deviation alarm, the subgroup angle range value 

has decreased 7 times consecutively. 

See E340 Xucl tq 

E370 7above x ang Trend deviation alarm, the subgroup angle mean value 

has been above the average mean value of the average of 
the latest ten subgroups 7 times consecutively.  

See E340 Xucl tq 

E371 7below x ang Trend deviation alarm, the subgroup angle mean value 

has been below the average mean value of the average of 
the latest ten subgroups 7 times consecutively. 

See E340 Xucl tq 

E372 7above r ang Trend deviation alarm, the subgroup angle range value 

has been above the average range value of the average of 

the latest ten subgroups 7 times consecutively. 

See E340 Xucl tq 
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Event 
code 

Event name Description Procedure 

E373 7below r ang Trend deviation alarm, the subgroup angle range value 

has been below the average range value of the average of 
the latest ten subgroups 7 times consecutively. 

See E340 Xucl tq 

E374 2sigma x ang Trend deviation alarm, the last subgroup angle average is 
outside Xang-bar-bar-2 sigma. 

See E340 Xucl tq 

E375 2sigma r ang Trend deviation alarm, the last subgroup angle range 

average is outside Rang-bar-bar-2 sigma. 

See E340 Xucl tq 

E380 Xucl cm The last subgroup mean CM value is larger than the 

upper control limit. 

See E340 Xucl tq 

E381 Xlcl cm The last subgroup mean CM value is lower than the lower 
control limit. 

See E340 Xucl tq 

E382 Rucl cm The last subgroup range CM value is larger than the 

upper control limit. 

See E340 Xucl tq 

E383 Rlcl cm The last subgroup range CM value is lower than the 

lower control limit. 

See E340 Xucl tq 

E384 Cp cm The CM Cp is lower than 2. See E340 Xucl tq 

E385 Cpk cm The CM Cpk is lower than 1.33. See E340 Xucl tq 

E386 7inc x cm Trend deviation alarm, the subgroup CM mean value has 

increased 7 times consecutively. 

See E340 Xucl tq 

E387 7dec x cm Trend deviation alarm, the subgroup CM mean value has 
decreased 7 times consecutively. 

See E340 Xucl tq 

E388 7inc r cm Trend deviation alarm, the subgroup CM range value has 

increased 7 times consecutively. 

See E340 Xucl tq 

E389 7dec r cm Trend deviation alarm, the subgroup torque range value 

has decreased 7 times consecutively. 

See E340 Xucl tq 

E390 7above x cm Trend deviation alarm, the subgroup CM mean value has 

been above the average mean value of the average of the 
latest ten subgroups 7 times consecutively. 

See E340 Xucl tq 

E391 7below x cm Trend deviation alarm, the subgroup torque mean value 

has been below the average mean value of the average of 
the latest ten subgroups 7 times consecutively. 

See E340 Xucl tq 

E392 7above r cm Trend deviation alarm, the subgroup CM range value has 

been above the average range value of the average of the 

latest ten subgroups 7 times consecutively. 

See E340 Xucl tq 
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E393 7below r cm Trend deviation alarm, the subgroup CM range value has 

been below the average range value of the average of the 
latest ten subgroups 7 times consecutively. 

See E340 Xucl tq 

E394 2sigma x cm Trend deviation alarm, the last subgroup CM average is 
outside XCM-bar-bar-2 sigma. 

See E340 Xucl tq 

E395 2sigma r cm Trend deviation alarm, the last subgroup CM range 

average is outside RCM-bar-bar-2 sigma. 

See E340 Xucl tq 

23.1.5 E400-E499 Communication events 
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E401 Duplicate device 

IDs on I/O bus 

Two I/O devices with the same ID are 

present on the I/O bus. This event occurs 

even if the devices are not configured in 

PF. 

Acknowledge the event.  

Make sure that all of the devices on the 
bus have a unique ID. 

x x x 

E403 I/O device not 
responding 

I/O device is not properly connected or the 

ID of the device is not the same as the one 
configured. 

Additional parameter information:  

First integer parameter: Number of device 

not responding.  

Check IO cables. 

Check the configuration of the 

accessories on the IO bus and compare 
it with the devices on the IO bus. 

x x x 

E407 IO device has 

invalid ID 

selected 

An I/O device has selected ID 0, which is 
invalid. 

Additional parameter information:  

First integer parameter: Number of device 
not responding.  

On the device, select an ID between 1 

and 15 (in ToolsTalk) or 1-F (on 

selector) 

x x x 

E417 Too many 

communication 

sessions at one 

time 

There are too many connections at the 

same time (ToolsTalk PF, Tools Net, 

Operator Panel etc.) The most common 

problem is that an external program 
allocates all the communication.  

Wait until the other sessions are done 

and close their connection. 

   

E420 ST Accessory not 

supported. 

A device connected to the ST-bus is not 

recognized by PF. 

Acknowledge the event.  

Upgrade PF software. 

x x x 

E421 Safety trigger not 

supported by tool 

software 

The tool software version does not support 

safety trigger function. 

Acknowledge the event.  

Upgrade the tool software. 

x x x 
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E433 No RBU present No RBU detected at start-up or RBU 
found missing at runtime. 

Acknowledge the event. 

Check that there is an RBU and that it 
is connected properly. 

x x x 

E434 RBU Timeout RBU did not respond to command from 

Power Focus. 

Acknowledge the event. 

Check that the RBU is connected 

properly. 

Reboot PF. 

If the event reappears, replace the 
RBU 

x x x 

E436 RBU file system 

warning 

RBU file system warning because of 

download interruption.  

Reboot PF.  

If the event reappears, replace the 
RBU 

   

E437 RBU file system 
corrupt 

RBU file system fault. An attempt will be 

made to repair it by means of erasing the 
RBU. 

Acknowledge the event. 

Reboot PF.  

Replace the RBU.  

x x x 

E438 RBU file 

mismatch 

A file with incorrect name or size was 

returned to a read request. 

Acknowledge the event. 

Reboot PF. 

Replace the RBU. 

x x x 

E440 RBU no files  RBU file system fault. Acknowledge the event. 

Reboot PF.  

Replace the RBU. 

x x x 

E441 RBU access too 
busy 

RBU has answered to the poll but Power 
Focus is too busy to receive the reply. 

Acknowledge the event. 

Acknowledge the event.  

Upgrade PF software. 

x x x 

E442 RBU no such file RBU file system fault. Acknowledge the event. 

Reboot PF.  

Replace the RBU. 

x x x 

E444 RBU packet 

rejected 

RBU responds with an answer not 

matching the last request. This is probably 

due to duplicates sent when the Power 
Focus does not acknowledge packages.  

Acknowledge the event. 

Reboot PF.  

Replace the RBU. 

x x x 

E445 RBU corrupt RBU software fault. Acknowledge the event. 

Reboot PF.   

Replace the RBU. 

x x x 

E446 RBU read error RBU read operation failed. Acknowledge the event. 

Try read again 

Reboot PF 

Replace the RBU 

x x x 
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E447 RBU write error  RBU write operation failed. Acknowledge the event. 

Try write again. 

Reboot PF. 

Replace the RBU. 

x x x 

E448 RBU delete error RBU delete operation failed. Acknowledge the event. 

Try delete again. 

Reboot PF. 

Replace the RBU. 

x x x 

E449 RBU flush error RBU erase operation failed. Acknowledge the event. 

Try erase again. 

Reboot PF. 

Replace the RBU. 

x x x 

E450 RBU list error RBU update operation failed. Acknowledge the event. 

Try update again. 

Reboot PF. 

Replace the RBU. 

x x x 

E451 RBU update 
failed 

Database synchronization between Power 
Focus and RBU failed. 

 

Acknowledge the event. 

Try update again. 

Reboot PF. 

Replace the RBU. 

x x x 

E460 Fieldbus type 

mailbox message 

fault 

Error detected in initialization of fieldbus. Contact the Atlas Copco service 
representative.  

   

E461 Fieldbus type gen 
com fault 

Error detected in initialization of fieldbus. Contact the Atlas Copco service 
representative. 

   

E462 Fieldbus mailbox 

message fault 

Error detected in initialization of fieldbus. Contact the Atlas Copco service 

representative. 

   

E463 Fieldbus gen com 

fault 

Error detected in initialization of fieldbus. Contact the Atlas Copco service 

representative. 

   

E464 Fieldbus 

hardware fault 

The fieldbus module is broken and has to 

be replaced. 

Acknowledge the event. 

Contact the Atlas Copco service 
representative. 

x x x 

E465 Fieldbus dip 
switch error 

The software tries to configure the value of 

node address or baud rate, but the address 

switch on the fieldbus module is not in the 

right position to enable software setting.  

Switch off PF. 

See chapter Fieldbus for information 
about how to set the switch position.  

Correct the switch and turn on PF.  

   

E466 Fieldbus offline The fieldbus went from online to offline.  Check if PF is connected to the 

network.  

Check if the PLC is down.  
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E467 Fieldbus 

configuration 
fault 

Error detected in initialization of fieldbus. Contact the Atlas Copco service 
representative. 

   

E468 Fieldbus 

hardware 
mismatch 

The fieldbus module installed in Power 

Focus is not the same fieldbus type as 

configured with ToolsTalk PF. Change 

fieldbus module or configuration to get a 
match. 

Check the configured filedbus type.  

Check which fieldbus type is installed 
in PF. 

Reconfigure to match the installed 
fieldbus type.  

   

E469 Fieldbus init 

error 

Error detected in initialization of fieldbus. Contact the Atlas Copco service 

representative. 

   

E470 Fieldbus PCP 

error 

InterBus PCP length error. Maximum 

length is 20 bytes. 

Check the length of the process data 

and the PCP data.  

If the data exceeds 20 bytes, then 
correct the configuration.  

   

E471 Fieldbus claim 

area failed, lost 
one message 

Too much data traffic has caused one 

packet lost. 

Reduce the data from the PLC that 

needs acknowledgement from PF.  

   

E472 Fieldbus release 

area timeout 

Release area command timed out. Information event.  

If the event occurs frequently, then 

reduce the data from the PLC that 
needs acknowledgement from PF. 

   

E473 Fieldbus 

communication 

buffer alarm 

Communication buffer full due to too 

many input signals or incorrect fieldbus 

update interval.  

Check if there is a frequent input 

signal, or if F200 FB Update Interval 

needs to be changed.  

Decrease the input signals and/or 
decrease the fieldbus update interval.  

   

E474 Fieldbus monitor 

buffer alarm 

Fieldbus monitor buffer full.  In TTPF, turn off the fieldbus monitor.     

E475 Fieldbus PsetID 

mismatch 

Selector lifted 
socket 

Fieldbus selected Pset does not match the 
lifted socket. 

In the PLC, check the Pset ID. 

If the Pset and socket do not 

correspond, then lift the correct socket 

or change the Pset.  

   

E480 Channel ID not 
valid  

The channel ID configured is not within 

the limits permitted. The channel ID must 
be configured between 1 and 20. 

Acknowledge the event. 

Open PF Map > Controller > 

Network > Cell and change parameter 

C310 Channel ID to be within 1 and 20 

and unique within the cell. 

x x x 
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E481 Cell member 
registration failed 

The Cell member registration failed 

because one Cell member is already 
registered with the same channel ID. 

Acknowledge the event. 

In the cell member, open PF Map > 

Controller > Network > Cell and 

change parameter C310 Channel ID to 

be within 1 and 20 and unique within 
the cell. 

x x x 

E482 SW version not 

compatible with 
cell 

The application code version differs from 

the cell reference. To be able to run the 

cell functionality, ensure that all members 

in the cell use the same release as the cell 
reference.  

In the cell members, open PF Map > 

Controller > Information and check 
C101 Application code version. 

Ensure that all cell members have the 
same SW version.  

   

E490 Cell ID not valid The Cell ID configured is not within the 

limits permitted. The Cell ID must be 
configured between 1 and 999. 

Acknowledge the event. 

Open PF Map > Controller > 

Network > Cell and set C313 Cell ID 

to a correct number unique within the 
network. 

x x x 

E491 Net member 

registration failed 

The Net member registration failed 

because one Net member is already 
registered with the same Cell ID. 

Acknowledge the event. 

In the Net member, open PF Map > 

Controller > Network > Cell and set 

C313 Cell ID to a correct number 
unique within the network. 

x x x 

E492 SW version not 

compatible with 
net cell 

The application code version differs from 

the net reference. To be able to run the net 

cell functionality, ensure that all cell 

references in the net use the same release 

as the net reference.  

In the cell members, open PF Map > 

Controller > Information and check 
C101 Application code version. 

Ensure that all cell members have the 
same SW version. 

   

23.1.6 E500-E599 Hardware events (tools) 
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E500 New tool 

connected 

A new tool has been connected to the drive     
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E501 Tool overheated The tool is too hot and the drive is 

disabled.  

 

Additional parameter information:  

First integer parameter indicates at which 

stage the tool was locked: 

0=Tightening, 1=Loosening, 

2=Positioning, 3=Motor tuning, 4=open-
end tuning,  

Second integer parameter: 0=Service 
denied, 1=service aborted. 

Let the tool rest until it is cool enough 

to run.  

If the event reappears, reconsider the 

workstation set-up and the tightening 
strategy.  

Service the tool.  

 x x 

E502 Tool service 

interval expired 

Service the tool. See parameter T413 

Service interval.  

Additional information: 

The event appears, for 3 seconds, every 

100 tightenings after T412 No of 

tightenings since service exceeds T413 

Service interval, and T411 Service indicator 

= ON. The alarm LED indicates tracking 
during this period.  

The tool is locked if T416 Lock tool on 

alarm is checked. 

Acknowledge the event.  

Service the tool.  

Open Tool > Maintenance > Service, 

click Service counter reset and confirm 
by clicking OK. 

Note: To remove the event and unlock 

the tool, set T411 Service indicator to 
Off. 

 

   

E503 Calibration date 

expired 

The calibration date has expired. Use a torque measurement equipment 

to calculate a calibration value. 

Update tool calibration value using 
T402 Set calibration value. 

Update parameter T405 Calibration 

alarm date. 

   

E504 Tool wear 

indicator alarm 

Tool wear indicator alarm indicates that the 

tool should be serviced. 

Service the tool. 

Connect tool to ToolsTalk Service and 

reset the wear indicator. 

   

E505 Tool rebuilt 
to/from OE-type 

Tool redesigned. E.g. angled tool type 
redesigned to an OE-tool type. 

For information only.  x x 

E506 Tightenings 

prevented by 
RBU 

Tool locked due to incurred software 

release and with wrong RBU.All Hea d 

build requires a FieldTest RBU to be able 

to perform tightenings. 

Change to a RBU that supports the 
used build. 

 x x 

E507 Motortuning 
performed 

A motortuning has been performed. 

Measured values from the tool motortuning 

process are entered in sub information 
arguments 1 to 4 

For information only.   x x 
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E508 Motortuning 

warning 

Measured values from the tool motortuning 

process indicates that the tool is not 

running optimally. The tool may run 

warmer than normal. Values for supporting 

this decision are entered in sub information 

arguments 1 to 4. 

(This event is default off). 

The accuracy of the tool is not 

influenced by this problem. However, 

if the performance of the tool is 

considered to be a problem, send it to 
motor service. 

  x x 

E510 Tool type not 

supported by 
RBU 

The tool type is not supported by the RBU. Acknowledge the event.  

Check which RBU-level the tool 
requires.  

Replace the RBU. 

x x x 

E511 Tool-Power 

Focus 3000 size 
mismatch 

Mismatch between the tool and PF 3000 

controller (for example S4/S7 tool 
connected to a S9 controller).  

Acknowledge the event.  

Replace the PF3000 with the correct 

PF3000 or a PF4000, to match the 
tool. 

x x x 

E512 Tool revision not 

supported by this 
drive SW 

The tool is not supported by the drive 

(drive version too old) 

Change tool or PF SW 

 

x x x 

E513 Tool EEPROM 

corrupt - service 
tool 

Checksum indicates that tool memory is 

corrupt. Tool must be serviced. 

Acknowledge the event.  

Reprogram the tool and restore the 

memory, using Tools Talk service.  

x x x 

E514 Motortune 

parameters 

invalid - 

Motortune 

Checksum indicates that the motor tuning 
or the open-end tuning table is corrupt.  

Additional parameter information:  

First integer parameter indicates at which 

stage the tool is locked: 0= tightening, 1= 

loosening, 2=positioning, 3=motor tuning, 
4=open-end tuning, 5=tracking 

Second integer parameter 0=Service 
denied, 1=service aborted. 

Acknowledge the event.  

Open Tool>Maintenance and do a 
motor tuning or an open-end tuning.  

x x x 

E517 Tool max torque 

invalid 

Tool max torque invalid, service tool. Acknowledge the event.  

Set parameter T102 to an appropriate 

value. 

For S/DS/ETX tools: use TTPF or 

Graph. 

Other tools: use TTS. 

x x x 
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E518 Tool 

normalization 
out of range 

Tool normalization value out of range, 

service tool. 

Acknowledge the event. 

Use a torque measurement equipment 
to calculate a normalization value. 

Use the strategy DS-control during 

measurements. 

Open Tool > Maintenance > 

Calibration and update T403 

Normalisation value.  

x x x 

E519 Tool calibration 

value out of 
range 

Tool calibration value out of range, service 

tool. 

Acknowledge the event.  

Recalibrate the tool, using ACTA.  

If the event reappears, replace the tool. 

x x x 

E520 Wear indicator 

data in tool 
invalid 

Data in tool memory used for wear 

indicator is invalid. Service tool. 

Open Tool > Maintenance > Wear 

and set T434 Min wear tightenings to 
<100000. 

   

E521 Wear data in tool 

not updated 

Tool memory or MC software not 

responding. 

Acknowledge the event. 

Check that the tool cable and 

connectors are undamaged and 

correctly connected.  

Please reboot PF 

x   

E535 Torque 

transducer error 

Cables to transducer cut off or shorted. Acknowledge the event. 

Check that the tool cable and 

connectors are undamaged and 

correctly connected.  

If the event reappears, service the tool. 

x x x 

E536 No transducer 
(sensor) 

Cables to transducer cut off or shorted. Check that the tool cable and 

connectors are undamaged and 

correctly connected.  

 x  

E537 Calibration not 

OK, offset 

outside limits 

Calibration offset outside limits. Service the tool.    

E538 Calibration not 

OK, CalVal 

outside limits 

Calibration value outside limits. Service the tool.    

E539 Calibration not 

OK, Offset 

changed > 5% of 

max value since 
last calibration 

Calibration not OK, offset changed > 5% 
of max value since last calibration. 

Try to calibrate again.  

If the event reappears, service the tool. 

   



 Event codes 

9836 3123 01 413 (428) 

Event 
code 

Event name Description Procedure 

A
c

k
n

o
w

le
d

g
e
 

P
F

 r
e

a
d

y
 

T
o

o
l 

re
a

d
y
 

E540 Calibration not 

OK, CalVal 

changed > 5% of 

max value since 
last calibration 

Calibration not OK, calibration value 

changed > 5% of max value since last 
calibration. 

Service the tool.    

E541 Transducer 

(sensor) lost 
during tightening 

Cables to transducer cut off or shorted. Acknowledge the event. 

Service the tool. 

x x x 

E542 Transducer 

(sensor) lost 

during tightening 
from drive 

When tightening values are lost the process 

reads the tool register and finds out that 

one or several error bits have been set. 

Symptom of failure in transducer 

electronics inside the tool. 

Acknowledge the event. 

Service the tool. 

x x x 

E543 Transducer 

(sensor) lost 

during tightening 
from DSP 

When tightening values are lost the process 

reads the tool register and finds out that 

NO error bits have been set. Symptom of 

failure in connection between tool and 

PowerFocus. 

Acknowledge the event. Check for 

damage connection path between 

PowerFocus and the tool: sockets and 

plugs contact pins, the cable.  

Service the tool, PowerFocus or the 

cable.  

x x x 

E544 Spindle rotated 

during 

transducer 

calibration 

Rotation of spindle during calibration 

indicates that operator possibly strained 
transducer creating offset/gain change 

Make sure that all parts are still 
relative to each other at tool start 

   

E550 Radio contact 

with tool 

established, tool 
accessible 

Radio contact with tool established, tool 
accessible. 

 

For information only.    

E551 Radio contact 

with tool lost, 
tool inaccessible 

Radio contact with tool lost, tool 

inaccessible.  

Re-establish connection.    

E552 Communication 

error with tool 

An intermittent communication 

disturbance between tool and controller. 

For information only. 

If occurring frequently, reposition 

Serial Port Adapter. 

If re-occurring, contact your Atlas 

Copco representative. 

   

E553 Pairing attempt 

with wireless 

tool failed 

An attempt to pair the Power Focus with a 
wireless tool failed.  

Set the tool in pairing mode according 
to the pairing procedure.  

Perform another pairing attempt.  

If the event reappears, replace the tool. 

   

E554 Command not 

performed, 

wireless tool 
inaccessible 

A command (batch increment, reset batch 

etc.) could not be performed and was 

discarded because the tool was currently 
inaccessible. 

Re-establish connection. 

Perform the action causing the event 
again. 
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E555 Condition 

change not 

reflected in tool, 

wireless tool 
inaccessible 

A condition change in the controller (Pset 

selection, Job selection, Job aborted etc.) 

could not be reflected in the tool. The tool 
was currently inaccessible. 

Re-establish connection. 

The condition change is now 
automatically transferred to the tool. 

   

E556 Tool battery low Tool battery voltage is low. Replace the tool battery. 

Place the discharged battery in the 
battery charger.  

   

E557 Tool battery 

empty 

Tool battery empty. Tool locked. Replace the battery. 

The tool is unlocked automatically. 

   

E558 Tool software 

version 
mismatch 

The implemented protocol version in 

Power Focus for connected tool differs 
from the protocol version in tool. 

Additional parameter information:  

First parameter is Power Focus protocol 

version. Second parameter is tool protocol 

version. 

Upgrade the software in tool or PF to 
match each other.  

   

E559 IRC pairing 
completed 

An IRC paring sequence has been 
successfully completed. 

For information only.    

E560 Tool RBU error An RBU error was detected by the tool 
software. 

Check that the RBU is correctly 
mounted, otherwise service tool. 

   

E561 Tool locked,  do 

Store standalone 

Tool locked since no Pset has been actively 

stored in the tool. 

Do Store Standalone or deselect 

Standalone, parameter T470 Use 
Standalone. 

   

E562 Condition 

change not 

reflected in tool, 

wireless tool 

stand alone 

A condition change in the controller (Pset 

selection, Job selection, Job aborted …) 

could not be reflected in the tool. The tool 
was currently stand alone 

Make changes in the stand alone 

interface instead if the change is meant 
to apply. 

   

E563 IRC 

configuration 

mismatch 

Not possible to establish radio connection 
with wireless tool 

Check if tool is in correct operation 

mode (Ad-hoc and not Infrastructure 

mode);  

Also check the PF IRC settings. 

X   

E564 Reboot of 

wireless tool 

needed for 

changes to take 
effect 

Reboot of wireless tool needed for changes 
to take effect 

Acknowledge the event on the PF and 
power cycle the wireless tool. 

X   

E565 Locked while 

updating 
Pset/Job in tool 

The controller has locked the tool while 

updating the Pset/Job in the (for instance 
wireless) tool. 

For information only.   X 
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E601 System voltage 

low 

DC voltage too low. Tool locked. Acknowledge the event.  

Power Focus: Verify that the input 

voltage is within specified limits and 
reboot the system. 

STB: Replace battery. If occurring 
frequently, check Pset, service tool. 

x x x 

E602 DC-bus HI 
during rundown 

DC voltage too high Acknowledge the event.  

Verify that the input voltage is within 
specified limits. 

   

E603 Drive 

overheated 

The DC drive is too hot, drive deactivated. Let the system cool for 15 minutes 

Continue operation. 

  x 

E604 24V output error 24 V output disabled (overload or short 
circuit) 

Acknowledge the event.  

Check that the cable and connectors 

are undamaged and correctly 
connected.  

Reduce overload by disconnecting one 
or more devices.  

Connect an external isolated 24V 

power source to the 24V DC input of 
the devices. 

x x x 

E619 Drive 

deactivated 

DC drive deactivated during operation. Contact the Atlas Copco service 

representative. 

   

E620 Tool stall Tool motor stall. Check that the tool cable and 

connectors are undamaged and 

correctly connected.  

If possible use a shorter tool cable. 

For STB, see E601 

   

E621 Current 

measurement 
error 

Current measurement error. Current cannot 
reliably be measured. 

Contact the Atlas Copco service 
representative. 

x   

E622 Angle transducer 
error 

The controller has received invalid angle 
information from the tool. 

 

Acknowledge the event.  

Open Tool>Maintenance>Motor 
tuning and perform a motor tuning.   

   

E623 Safety current 

monitoring error 

The torque measured by the torque 

transducer is inconsistent with the torque 
estimated from the measured current. 

Contact the Atlas Copco service 

representative. 

x   

E624 Battery failure DC voltage too high or too low: 

battery failure. 

Contact the Atlas Copco service 

representative and send back 

x x x 
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battery to Atlas Copco (do not 

reuse it!) 

23.1.8 E700-E799 Hardware events 
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E700 PF started  This event code is only visible in the event 

log and indicates when PF is started.  

For information only.    

E701 Backup battery 

low level 

The backup battery level is low. The 

battery should be changed.  

Replace the backup battery.     

E702 Backup battery 

empty or 

missing 

The backup battery level is very low or the 

battery is missing. A new battery should be 

inserted as soon as possible.  

Replace the backup battery.    

E703 Ground fault in 
tool circuit 

An earth (ground) fail detected, probably a 
tool circuit failure 

Acknowledge the event. 

Rebuild the tool. 
x   

E710 ACTA/QRTT 
calibration 

An ACTA/QRTT calibration has been 

performed. See below for additional 
information. 

For information only.     

E720 Protective earth 

to tool 
interrupted 

Protective earth between tool and 
controller is interrupted. 

Acknowledge the event. 

Check tool cable, tool and controller. 
x x x 

E721 Tool internal 

error - Service 
tool 

Indicator board overcurrent error. Tool 
service needed. 

Acknowledge the event. 

Service the tool. 

x x x 

E722 Illegal ring 

position 

The direction ring is not in a defined 

position. 

Place the direction ring correctly.   x 

E723 Swivel lock 

activated 

There is a mismatch between swivel 

lock and tool start source 

   x 

E724 Wrong gear 

box 

Wrong gear box is mounted on the tool  Mount the correct gearbox.   x 

E799 Internal info Internal info in event log info. Only of 

interest to design department. 
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ACTA/QRTT calibration information 

When an ACTA/QRTT calibration batch is completed, event code E710 ACTA/QRTT calibration is 

displayed.  

Torque result bits show the result of the torque calibration. All bits are sent as an unsigned 16 bit integer. 

Angle result bits show the result of the angle calibration. All bits are sent as an unsigned 16 bit integer. 

First integer Second integer Third integer Fourth integer 

Torque result bits Angle result bits   

Dec Event Dec Event Not used Channel number. 

1 Batch result torque OK. 1 Batch result angle OK. 

2 Torque min failed. 2 Angle min failed. 

4 Torque max failed. 4 Angle max failed. 

8 Torque LCLx failed. 8 Angle LCLx failed. 

16 Torque UCLx failed. 16 Angle UCLx failed. 

32 Torque LCLr failed. 32 Angle LCLr failed. 

64 Torque UCLr failed. 64 Angle UCLr failed. 

128 Torque CP > failed. 128 Angle CP > failed. 

512 Torque CPK > failed. 256 Angle CPK > failed. 

1024 Torque CAM > failed. 512 Angle CAM > failed. 

2048 T Diff < failed. 
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E805 PF Model 

unknown 

This event indicates that the RBU revision 

is not supported by the controller (for 

example an RBU bronze in a PF Graph 

controller), the RBU is missing, or the 

RBU license file is missing or corrupt.  

Acknowledge the event. 

Check that the correct RBU is 
connected to PF.   

If the event reappears, then upgrade the 

PF software.  

x x x 

E808 Error condition 

detected by 
software 

An error condition was detected in 

software. 

Power Focus: The probable cause is that an 

external application has started too many 
subscriptions. 

STB: Software error 

Power Focus: Close external programs 

connected to Power Focus. 

STB: Return tool to service. 

   

E810 Database is 

corrupt 
Database must be cleared, db version 

is not correct 

 x   

E822 No Job ACK 

from control 

Tightening initialization phase failed. 

Hardwar e failure.  

Acknowledge the event.  

Contact the Atlas Copco service 

representative. 

x x x 

E823 No calibration 
result 

No calibration was received from the drive 

during the tightening initialization phase 

(timeout 100 ms). 

Acknowledge the event. 

Check tool cable. 

Reboot PF. 

x x x 

E824 Cycle abort 

timeout 

No tightening result was received from the 

drive before the cycle abort timeout.  

If necessary, increase the P144 Cycle 

abort timer in Pset.  

   

E831 Autoset wrong 
angle 

Autoset could not be executed. The 
calculated angle was too small. 

Acknowledge the event. 

Program the Pset manually or by 
Quick programming.  

x   

E833 Autoset tight 
NOK result 

The Autoset could not be executed, four 
NOK tightenings were performed. 

Acknowledge the event. 

Program the Pset manually or by 
Quick programming.  

x   

E834 Autoset rejected 

Pset in CCW 
direction 

Auto set is only permitted on a CW Pset. Program the Pset manually or by 

Quick programming.  

If Quick programming is used, then 

change the direction from CW to CCW 
after programming.  

   

E840 Feature Not 

Available In 

Software 

Revision 

This event is displayed when an attempt is 

made to run Multistage with a RBU 

bronze, or handle a Pset with a PsetID 

larger than the max number of Psets. 

Reconfigure to an allowed 

configuration or an available function. 
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E841 SW function 

Not Available 
for this tool type 

The software function is not available for 

this tool type. 

Change to the correct tool type.    

E851 Connection with 

Tools Net server 
lost 

The connection with the Tools Net server 

is lost and the Power Focus is trying to 

reconnect. The Tools Net server might be 

down or it might be an Ethernet cable 

problem. 

 

 

Check the network configuration and 

in particular the ToolsNet IP address, 
Subnet mask and Default router. 

Check if the ToolsNet server is down. 

Check that the Ethernet cables are OK. 

Check that the routers and switches are 

correctly connected and without 
damage. 

   

E856 Router 

unreachable 

The router in the configuration setting 

could not be reached. Check the network 

configuration and in particularly the subnet 

mask and the default router. 

Check the network configuration and 

in particular the Subnet mask and the 
Default router. 

Ping the router to see if it is alive. 

Check the Ethernet cable. 

   

E857 Reboot needed 

before changes 
take effect 

The configuration changes will not take 

effect until after a system reboot. 

Acknowledge the event.  

Reboot PF. 

If the event reappears, the PF is faulty. 

Contact the Atlas Copco service 
representative.  

x   

E858 IP address 

already in use 

The IP address of this PF is already in use 

by another system. 

Acknowledge the event. 

Change the IP-address in PF. 

x   

E859 IP address 

collision 

Another system attempts to use the same 

IP address as this PF. 

Check the network settings. 

 

   

E860 Memory 
allocation error 

Configuration changes has not taken effect Acknowledge the event and reboot x   

E861 Session handler 
internal error 

Configuration changes has not taken effect Acknowledge the event and reboot x   

E862 Ethernet 

overload Error 

The Ethernet driver of the PF is 

temporarily switched off due to an 
overloaded network. 

Check the network. 

 

   

E863 IP Port already 

in use 

An attempt was made to bind a TCP or 

UDP socket to a port already in use. For 

instance, a user protocol might be using 
the same port as ToolsTalk PF. 

Acknowledge the event. 

Check all network settings. 

x   
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E864 Ethernet echo 

detected 

An Ethernet packet was discarded, since its 

source MAC address was equal to the 

Power Focus’ own MAC address. Notice 

that this message only occurs once during 

runtime, even if several such packets are 

detected. There is most likely a problem in 

the network. 

Check the network. 

 

   

E865 Reboot and new 

IRC pairing 
needed 

The configuration changes will not take 

effect until after a system reboot and new 
IRC pairing after that. 

Acknowledge the event.  

Reboot PF and perform a new IRC 

pairing. 

If the event reappears, the PF is faulty. 

Contact the Atlas Copco service 
representative. 

x  x 

E870 Sync member 

registration 
failure 

The Sync member registration failed 

because of a mismatch in the sync 
configuration list.  

In the sync reference, open PF Map > 

Sync > Options > Sync group list 
dialog box, and check that all IDs are 
correct and unique. 

In the sync reference, open Controller 

> Network settings, and check that the 
IP address and ID are correct. 

  x 

E871 Sync reference 

configuration 
failure 

The channel ID of the Sync reference is 
not first in the Sync list as required.  

In the sync reference, open PF Map > 

Sync > Options, and check that the 

sync reference is at the top of the Sync 

group list.  

 x x 

E872 Sync 

initialization 

failure 

Tightening synchronization initialization 
failed.  

Check the I/O bus cable between all 
sync members. 

Check that all Sync members have the 

same active Pset/multistage. 

Check the external start bridge.  

  x 

E874 Sync members 
missing 

Only Sync reference is defined in the Sync 
group list. 

Acknowledge the event. 

In the sync reference, open PF Map > 

Sync > Options and add sync 
members to the Sync group list. 

x   
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E901 MMI Start-up 

Error 

Error in MMI detected. Acknowledge the event.  

Reboot PF. 

x x X 
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A 

Abbreviations, 15 

Abort Job, 123 

Accessibility 

controller parameters, 354 

Accessories, 25, 165 

parameters, 363 

Acta 

port, 131 

ACTA, 158 

tool calibration, 158 

ACTA 4000, 28 

Activate 

menu list, 57 

Ang con/tq mon, 83 

Application 

under Options, 63 

Autoset, 75 

B 

Batch count, 81 

Fieldbus settings, 209 

multistage parameter, 342 

Batch size 

in job, 116 

Blue LED, 151 

Buzzer configuration 

tool parameters, 362 

Buzzer wave, 147 

Bypass 

job, 123 

C 

CC-Link, 233 

Cell, 130 

Cell and Net, 131 

Cell Job, 115 

Cell members, 132 

Cell reference, 132 

Character string 

fieldbus, 205 

Click wrench, 86 

COM ports, 135 

controller parameters, 352 

Configuration 

controller parameters, 349 

of controller, 127 

tool parameters, 355 

Configuring a tool offline, 71 

Connect 

toolbar, 60 

Connecting a PF, 66 

Connecting devices, 29 

connection 

of PF with cell or net configuration, 134 

Control options, 96 

Control strategies, 82 

Controller, 125 

parameters, 348 

toolbar, 58 

ControlNet, 228 

Current monitoring, 98 

D 

DeviceNet, 214 

Diagnostic 

tool parameters, 359 

Diagnostic mode, 202 

Digital I/O, 165 

parameters, 363 

Digital input, 318 

Digital inputs, 166 

connecting, 36 

digital output, 297 

Digital outputs 

connecting, 37 

Disconnect 

toolbar, 60 

Disconnect tool, 160 

Display, 136 

controller parameters, 352 

DS con, 89 

DS con/tq mon, 90 

dynamic job, 115 

E 

earth protector, 11 

Edit 

menu list, 55 

Electrical safety, 11 

emergency mode 

fieldbus configuration, 203 

Ergo ramp 

tightening strategy, 96 

Ethernet, 130, 131 
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connecting, 36 

Ethernet connection, 66 

Ethernet/IP, 225 

Event code list, 374 

Event codes, 371 

Event Log, 371 

Event Monitor, 27 

external source 

lock tool from, 162 

F 

Factory Overview, 27 

Fieldbus, 197 

parameters, 367 

toolbar, 59 

Fieldbus data, 203 

Fieldbus selector, 208 

File 

menu list, 55 

Fixed point number 

fieldbus, 206 

Flip Flop gate, 238 

FL-Net, 232 

Focus 

menu list, 55 

for Illuminator, 152 

Function blocks, 238 

Function buttons 

for tools, 149 

Functions in the Job monitor, 122 

G 

General purpose I/O, 174 

Get all results, 258 

GPIO, 24 

Gradient monitoring, 104 

H 

Hardware 

in controller view, 126 

Help 

menu list, 57 

toolbar, 60 

Home position, 87 

Hot swap, 162 

I 

I/O bus, 168 

I/O Bus, 38 

I/O Diagnostic, 167 

I/O Expander, 25 

Identifier, 59, 187 

Identifier Monitor, 257 

Identifier setup 

parameters, 366 

Information 

controller parameters, 348 

tool parameters, 355 

input to PF, 318 

InterBus/InterBus2MB, 219 

J 

Job, 115 

parameters, 344 

toolbar, 58 

Job group, 115 

Job monitor. See Functions in the Job monitor 

Job Monitor, 252 

Job off, 123 

Job override, 120 

Job status, 123 

joint angle, 76 

L 

line control 

job parameter, 347 

Line control 

in Job, 119 

Logic Configurator, 235 

toolbar, 59 

logic gate, 235 

Logic gates, 237 

M 

MAC-address, 30 

Main power connector, 40 

Maintenance 

tool parameters, 359 

Memory, 137 

controller parameters, 353 

Memory reset, 140 

Memory setup, 138 

Menu list, 54 

Modbus/TCP, 228 

ModBusPlus, 221 

Monitor mode, 202 

Monitors, 249 

toolbar, 59 

Multicast, 131 
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Multistage, 111 

parameters, 341 

toolbar, 58 

Multistage programming 

parameters, 342 

N 

Net reference, 132 

Network 

controller parameters, 350 

settings in controller, 129 

Network setup, 133 

NOK 

in Job, 118 

O 

Offline, 70 

One stage 

tightening strategy, 94 

Open Protocol, 27, 115 

port, 131 

open-end 

start-up, 32 

Open-end tuning, 156 

Operator Monitor, 253 

Operator Panel, 26 

Options 

menu list, 56 

Programming +, 103 

Output test, 167 

P 

Parameter list, 329 

Part Id scan, 188 

Password, 141 

Personal safety, 12 

PF 3000, 19 

PF 4000, 18 

PF List 

menu list, 58 

under Options, 65 

PF Map, 60 

toolbar, 59 

PF user interface, 41 

Picture Monitor, 256 

PLC, 208 

Fieldbus, 197 

Post view torque, 107 

Printer, 176 

Connecting, 35 

parameters, 365 

Printout 

under Options, 64 

ProfiBus-DP, 211 

Profinet, 230 

Programming 

job parameters, 345 

Pset, 78 

Pset parameters, 329 

Sync parameters, 365 

Programming +, 97 

Pset parameters, 334 

Programming help, 77 

Pset, 73 

toolbar, 58 

Pset comment, 109 

Pset setup, 108 

Pset parameters, 338 

PVT, 97 

PVT compensate, 102 

PVT monitoring, 100 

PVT selftap, 99 

Q 

QRTT, 158 

Quick programming, 76 

Quick reference guide, 271 

Quick step 

tightening strategy, 95 

R 

RBU, 30 

Read PF from file, 69 

Rehit, 97 

Relays, 166 

Remote start connector 

connecting, 39 

remote start input, 103 

Restart Job, 122 

Result Monitor, 250 

Reverse ang, 85 

Rotate spindle forward/reverse, 86 

Rundown angle, 96 

Running Job 

menu list, 57 

S 

Safety trigger, 145 

Selected Controller 

menu list, 57 
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Sensor tracking, 154 

Serial connection, 35, 66 

Settings 

ToolsTalk settings, 61 

Setup 

job parameters, 344 

parameters, 341 

simulator 

in logic configurator, 246 

Snug gradient, 91 

socket selector 

fieldbus configuration, 208 

Socket Selector, 26 

Software 

in controller view, 126 

Sound, 147 

Sound configuration 

tool parameters, 362 

ST scanner, 24, 175, 176 

ST selector, 24, 175 

start-up 

of PF, 30 

Start-up instruction 

for open-end tools, 32 

static job, 115 

Statistic 

toolbar, 59 

Statistic alarm, 266 

Statistic programming, 110 

Pset parameters, 338 

Statistics, 265 

Store 

fieldbus configuration, 203 

Store PF to file, 68 

Storing, 67 

ST-selector connection, 34 

Sync, 59, 179 

parameters, 365 

Sync motor tuning, 159, 160 

T 

Tightening strategies, 93 

Tool, 143 

parameters, 354 

toolbar, 59 

Tool bus, 173 

parameters, 365 

Tool configuration, 145 

Tool diagnostic, 154 

Tool information, 143 

Tool lock functionality, 162 

Tool maintenance, 155 

Tool rotation direction, 103 

Tool tightening direction, 103 

Toolbar, 58 

Tools, 22 

Tools Talk 

port, 131 

ToolsNet, 27, 131 

ToolsNet., 131 

ToolsTalk overview, 54 

ToolsTalk PF, 20 

starting TTPF, 53 

Tq con, 82 

Tq con/ang con (AND) / (OR), 84 

Tq con/ang mon, 83 

Trace, 261 

toolbar, 59 

Two stage 

tightening strategy, 94 

U 

USB connection, 67 

W 

Wave, 148 

Window 

menu list, 56 

Y 

Yield control, 88, 105 

Yield/Tq con (OR), 88 

Z 

Zoom step, 96 
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